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Limited Liability Statement

Extreme care should be exercised when using or servicing this equipment. It should be used or serviced
only by personnel with knowledge of and training in the use and maintenance of oceanographic
electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing
of this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment
or of choosing the personnel to operate it, and therefore cannot take steps to comply with laws
pertaining to product liability, including laws which impose a duty to warn the user of any dangers
involved in operating this equipment. Therefore, acceptance of this system by the customer shall be
conclusively deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use or servicing of
this system.
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Section 1: Introduction

This section includes a brief description of Seasoft V2 and its components, and
a more detailed description of SBE Data Processing.

Sea-Bird welcomes suggestions for new features and enhancements of our
products and/or documentation. Please contact us with any comments or
suggestions (seabird@seabird.com or 425-643-9866). Our business hours are
Monday through Friday, 0800 to 1700 Pacific Standard Time (1600 to 0100
Universal Time) in winter and 0800 to 1700 Pacific Daylight Time (1500 to
0000 Universal Time) the rest of the year.

Summary

Note:

The following Seasoft-DOS

calibration modules are not available

in Seasoft V2:

e OXFIT — compute oxygen
calibration coefficients

o OXFITW — compute oxygen
calibration coefficients using
Winkler titration values

e PHFIT — compute pH coefficients

See the Seasoft-DOS manual.

Seasoft V2 consists of modular, menu-driven routines for acquisition, display,
processing, and archiving of oceanographic data acquired with Sea-Bird
equipment. Seasoft V2 is designed to work with a PC running Win XP Service
Pack 2 or later, Windows Vista, or Windows 7.

Seasoft V2 is actually several stand-alone programs:

o SeatermV?2 (a launcher for Seaterm232, Seaterm485, SeatermIM, and
SeatermUSB), Seaterm, and SeatermAF terminal programs that send
commands for status, setup, data retrieval, and diagnostics to a wide
variety of Sea-Bird instruments.

Note: SeatermV2 is used with our newest generation of instruments,
which have the ability to output data in XML.

e Seasave V7 program that acquires and displays real-time and raw
archived data for a variety of Sea-Bird instruments.

e SBE Data Processing program that converts, edits, processes, and plots
data for a variety of Sea-Bird instruments.

e  Plot39 program for plotting SBE 39, 39-IM, 39plus, and 48 data.

This manual covers only SBE Data Processing.
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System Requirements

Seasoft V2 was designed to work with a PC running Win XP Service pack 2 or
later, Windows Vista, or Windows 7.

Products Supported

Notes:

e SBE 37-Sl and 37-SIP - SBE Data
Processing can be used with data
uploaded from firmware version 3.0
and later. Earlier versions of these
MicroCATs did not have internal
memory, and SBE Data
Processing is not compatible with
real-time MicroCAT data.

e SBE 39, 39-IM, 39plus, and 48
data - SBE Data Processing
support is limited; see Processing
SBE 39, 39-IM, and 48 Data and
Processing SBE 39plus Data in
Section 3: Typical Data Processing
Sequences.

SBE Data Processing supports the following Sea-Bird products:

SBE 9plus CTD with SBE 11plus Deck unit (often referred to as 911plus)
or with SBE 17 or 17plus Searam (often referred to as 917plus)

SBE 16 SeaCAT C-T (optional pressure) Recorder

SBE 16plus and 16plus-IM SeaCAT C-T (optional pressure) Recorder
SBE 16plus V2 and 16plus-IM V2 SeaCAT C-T (optional pressure)
Recorder

SBE 19 SeaCAT Profiler

SBE 19plus SeaCAT Profiler

SBE 19plus V2 SeaCATProfiler

SBE 21 SeaCAT Thermosalinograph

SBE 25 Sealogger CTD

SBE 25plus Sealogger CTD

SBE 37-SM, 37-SMP, 37-IM, 37-IMP, 37-SI, and 37-SIP MicroCAT
Conductivity and Temperature (optional pressure) Recorder

SBE 37-SMP-IDO, 37-IMP-IDO, and 37-SIP-IDO MicroCAT
Conductivity, Temperature, and Dissolved Oxygen (optional pressure)
Recorder

SBE37-SMP-ODO, 37-IMP-ODO, and 37-SIP-ODO MicroCAT
Conductivity, Temperature, Optical Dissolved Oxygen (optional pressure)
Recorder

SBE 39 and 39-IM Temperature (optional pressure) Recorder

SBE 39plus Temperature (optional pressure) Recorder

SBE 45 MicroTSG Thermosalinograph

SBE 48 Hull Temperature Sensor

SBE 49 FastCAT CTD Sensor

SBE Glider Payload CTD (GPCTD)

Additionally, SBE Data Processing supports many other sensors / instruments
interfacing with the instruments listed above, including Sea-Bird oxygen, pH,
and ORP sensors; SBE 32 Carousel Water Sampler and SBE 55 ECO Water
Sampler; and assorted equipment from third party manufacturers.
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Software Modules

SBE Data Processing includes the following modules:

Type Module Name Module Description
Instrumen.t Define instrument configuration and
configuration Configure o .

; calibration coefficients.
See Section 4.
Convert raw .hex or .dat data to
Data engineering units, and store converted
D Conversion | data in .cnv file (all data) and/or .ros file
ata ) (water bottle data).
conversion Bottle Summarize data from water sampler .ros
See Section 5. . .
Summary file, storing results in .btl file.
Mark Scan Create .bsr bottle scan range file from
.mrk data file.
Align CTD Align data (typically conductivity,

temperature, oxygen) relative to pressure.

Bin Average

Average data, basing bins on pressure,
depth, scan number, or time range.

Compute Brunt Viiséld buoyancy and

See Section 9.

Buoyancy stability frequency.
Cell Thermal | Perform conductivity thermal
Mass mass correction.
Data Calculate salinity, density, sound
processing Derive velocity, oxygen, etc. based on EOS-80
Performed on (Practical Salinity) equations.
converted data Derive Calculate salinity, density, sound
from a .cnv file. velocity, etc. based on TEOS-10
See Section 6. TEOS-10 (Absolute Salinity) equations.
Filter Low-pass filter columns of data.
Mark scan with badflag if scan fails
Loop Edit pressure reversal or minimum
velocity test.
Wild Edit Mark dgta value with badflag to eliminate
wild points.
Window Filter Filter flata with tr%angle., cosine, boxcar,
Gaussian, or median window.
Add header information to .asc file
ASCILIn containing ASCII data.
Output data and/or header from .cnv file
to ASCII file (.asc for data, .hdr for
. ASCII Out header). Used to export converted data
File . . for processing by non-Sea-Bird software.
g:):rgel;zl;t?n Section Ext.ract daFa TOws frorp .cnv file.
Split Split data in .cnv file into upcast and
downcast files.
Strip Extract data columns from .cnv file.
Convert data in .cnv file from ASCII to
Translate . .
binary, or vice versa.
Data plotting Plot data (C, T, P as well as derived
Performed on variables, overlay plots, and TS contour
converted data Sea Plot plots). Plots can be printed, or saved to a
from a .cnv file. file or clipboard. Can plot data at any
See Section 8. point after Data Conversion has been run.
Miscellaneous
Performed on Calculate derived variables from one
data typed in SeaCalc 111 user-input scan of temperature,
by user. pressure, etc.
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Section 2: Installation and Use

Seasoft V2 was designed to work with a PC running Win XP Service pack 2 or
later, Windows Vista, or Windows 7.

Installation

Note:
Sea-Bird supplies the current version
of our software when you purchase
an instrument. As software revisions
occur, we post the revised software
on our FTP site.
¢ You may not need the latest
version. Our revisions often include
improvements and new features
related to one instrument, which
may have little or no impact on
your operation.
See our website (www.seabird.com)
for the latest software version
number, a description of the software
changes, and instructions for
downloading the software from the
FTP site.

If not already installed, install SBE Data Processing and other Sea-Bird
software programs on your computer using the supplied software CD:

1.

2.

3.

Insert the CD in your CD drive.

Double click on SeasoftV2_date.exe (where date is the date the software
release was created).

Follow the dialog box directions to install the software.

The default location for the software is c:\Program Files\Sea-Bird. Within that
folder is a sub-directory for each program. The installation program allows
you to install the desired components. Install all the components, or just install
SBE Data Processing.

Note that the following additional software is installed with SBE Data
Processing, in the same directory as SBE Data Processing:

StripNullChars.exe — This program removes null characters from an
uploaded SBE 25plus data file; the file can then be processed in SBE Data
Processing’s Data Conversion module.

»  Run StripNullChars.exe from a DOS window, following instructions
provided in the software.

» Note that the null characters in the file also prevent uploading of the
data from the SBE 25p/us via RS-232. You must open the 25plus and
upload via the internal USB connector.

NMEATest.exe — This program simulates a NMEA navigation device;

see the manual for your deck unit (SBE 11plus, 33, or 36 Deck Unit).

phFit.exe — This program calculates a new offset and slope for a pH

sensor; see Application Note 18-1

(www.seabird.com/application_notes/AN18 1.htm).
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Getting Started

Note:

SBE Data Processing modules can
be run from the command line.
Also, batch file processing can be
used to process a batch file to
automate data processing tasks.
See Appendix I: Command Line
Options, Command Line Operation,
and Batch File Processing.

SBE Data Processing Window

To start SBE Data Processing:

Double click on SBEDataProc.exe

(default location c:\Program Files\Sea-Bird\SBEDataProcessing-Win32), or
Left click on Start and follow the path
Programs\Sea-Bird\SBEDataProcessing-Win32

The SBE Data Processing window looks like this:

EZ SBE Data Processing -0l x|

Run  Configure  Help
1

. Data Conversion. ..
. Filter, ..

. Blign CTD...

. Zell Thermal Mass. ..
. Loop Edit...

. Derive. .,

, Derive TEODS-10,.,

. Bin Average...

[ B L R L I L)

9, Botkle Summary. ..
- 10, Mark 5can,..

11, Buovancy...

12, wild Edit. ..

13, ‘Window Filcer. ..

14, ASCII In..,
15, ASCIT Out, .,
16, Section...
17. split...

18, Skrip...

19, Translate. ..

20, Sea Plot, ..

21, SeaCalc II1...

Command Line Options. ..

Exik

The window’s menus are described below.

Run -

» List of data processing modules, separated into categories: typical
processing for profiling CTDs (1-8), other data processing (9-13), file
manipulation (14-19), plotting (20), and seawater calculator (21).
Select the desired module to set up the module parameters and
process data. Module Dialog Box provides an overview of the module
dialog box for all modules except Sea Plot and SeaCalc I11;

Sections 5 through 9 provide details for each module.

» Command Line Options: Select Command Line Options to assist in
automating processing. See Appendix I: Command Line Options,
Command Line Operation, and Batch File Processing.

»  Exit: Select to exit the program.

Configure - List of instruments that require a configuration (.con or

.xmlcon) file, which defines the number and type of sensors interfacing

with the instrument, as well as the sensor calibration coefficients. Select

the desired instrument to modify or create a .con or .xmlcon file. See

Section 4: Configuring Instrument (Configure).

Help - General program help files as well as context-specific help.

10
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Module Dialog Box

To open a module, select it in the Run menu of the SBE Data Processing
window. Each module’s dialog box has three menus:

e File -

vV VYV VvV VY V¥V VYV V

Start Process - begin to process data as defined in dialog box
Open - select a different program setup (.psa) file

Save or Save As - save all current settings to a .psa file

Restore - reset all settings to match last saved .psa file

Default File Setup - reset all settings on File Setup tab to defaults
Default Data Setup - reset all settings on Data Setup tab to defaults

Exit or Save & Exit - exit module and return to SBE Data
Processing window

e  Options (where applicable) —

>

Confirm Program Setup Change -

- If selected, program provides a prompt to save the program setup
(.psa) file if you make changes and click the Exit button or select Exit
in the File menu without clicking or selecting Save or Save As.

- If not selected, program changes Exit to Save & Exit; to exit
without saving changes, use the Cancel button.

Confirm Instrument Configuration Change -

- If selected, program provides a prompt to save the configuration
(.con or .xmlcon) file if you make changes and then click the Exit
button in the Configuration dialog box without clicking Save or Save
As.

- If not selected, program changes Exit button to Save & Exit; to exit
without saving changes, use the Cancel button.

Overwrite Output File Warning -

- If selected, program provides a warning if output data will
overwrite an existing file.

- If not selected, program automatically overwrites an existing file
with the same file name as the output file.

Inconsistent Data Setup Warning -

- If selected, program provides a warning if the configuration (.con or
xmlcon) file and/or the input data file are inconsistent with the
selected output variables. For example, if the user-selected output
variables include conductivity difference, but you remove the second
conductivity sensor from the configuration file, a warning will
appear. The warning details what output variable cannot be
calculated, and allows you to retain the change to the configuration
file (and remove the inconsistent output variable) or restore the
configuration file to the previous configuration.

- If not selected, program automatically changes the user-selected
output variables to be consistent with the selected configuration or
data file.

11
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Note:

The dialog box for Sea Plot and
SeaCalc Il differ from the other
modules. See Section 8:

Data Plotting Module — Sea Plot

and Section 9: Miscellaneous Module
— SeaCalc Ill.

»  Sort Input Files (applicable only to Sea Plot) —
- If selected, Sea Plot sorts the input files in alphabetical order.
- If not selected, Sea Plot maintains the order of the files as you
selected them using the Ctrl key; use this feature if there is a
particular data set you want to use as the base on a waterfall overlay
plot. Note that using the Shift key to select files will not maintain the
selected order.

» Diagnostics log — 1f selected, brings up a Diagnostics dialog box.
- Select Keep a diagnostics log to enable diagnostics output.
- Click Select Path to select the location and name for the diagnostics
file. The default location is %USERPROFILE%\Application Data\
Sea-Bird; the default name is PostProcLog.txt
(Example c:\Documents and Settings\dbresko\Application Data\
Sea-Bird\PostProcLog.txt).
- Select the Level of diagnostics to include: Errors, Warnings (includes
Errors), or Information (includes Errors and Warnings).
- If desired, click Display Log File to display the contents of the
indicated file, using Notepad.
- If desired, click Erase Log File to erase the contents of the indicated
file. If not erased, SBE Data Processing appends diagnostics data to
the end of the file.
- Click OK.

e Help - contains general program help files as well as context-specific help
(where applicable)

Each module’s dialog box typically has three tabs - File Setup, Data Setup,
and Header View. The File Setup and Header View tabs are similar for most
modules, and are discussed below. The Data Setup tab contains input
parameters specific to the module. Additionally, Data Conversion and Derive
have a fourth tab — Miscellaneous. See the module discussions in Sections 5
through 7 for details.

12
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The following examples and discussion of the File Setup and Header View
tabs is for Data Conversion. The other modules (except Sea Plot and SeaCalc
IIT) are similar; however, not all fields are applicable to all modules.

File Setup Tab

See note above.

EZE Data Conversion
File Options

Directory and file name for
instrument configuration
(.con or .xmicon) file, which
defines instrument
configuration and sensor
calibration coefficients.
This file is used in Data
Conversion, Bottle
Summary, and Derive.
Select to pick a different
file, or Modify to view
and/or modify instrument
configuration.

Directory and file names
for input data. Select to
pick a different file. To
process multiple data files
from same directory:

1. Click Select.

2. In Select dialog box,
hold down Ctrl key
while clicking on each
desired file.

If multiple files are

selected, header in each

file must contain same set
of sensors and variables.

Click Start Process to
begin processing data.
Status field shows
Processing complete
when done.

Directory and file name for file to store all information input in File Setup and Data
Setup tabs. Open to select a different .psa file, Save or Save As to save current
settings, or Restore to reset all settings to match last saved version.

Help

File Setup I Data Setup | Mizcela

e Select to have program find .con or .xmlcon
file with same name and in same directory as
data file. For example, if processing test.dat
and this option is selected, program searches
for test.xmlcon (in same directory as test.dat);
if it does not find test.xmlcon, it searches for

ous I Header Wiew test con

Program zetup file

Also select if more than 1 data file is to be

Open...

IK:'\data'\Debhie'\D atChw. pza

\ .
\
I Save bs... I

processed, and data files have different
configuration files. For example, if processing

test.dat and test1.dat, and this option is

Save Festare |

selected, program searches for test.xmlcon

and test1.xmlcon (in same directory as test.dat

Ingtrument configuration file

and test1.dat); if it does not find .xmlcon files,
it searches for .con files.

Select...

K. hdata\Debbiehtest con

tadify... I [ 1 ch instrument configuration to input file

|nput directony

|K:\data\Debbie

Input files, 1 zelected

I test.dat j Select... |
Output directon
[ datahDebbie Select.. |

Directory and file name for output data.

Mame append I

* If more than 1 data file is to be processed, Output file field disappears
g and output file name is set to match input file name. For example,

Dutput file

Ite&t.cnv

if processing test.dat and test1.dat, output files will be test.cnv
and test1.cnv.

Mot processing

o SBE Data Processing adds Name append to (each) output file name,
before extension. For example, if processing test.dat and test1.dat

with a Name append of datcnv, output files will be testdatcnv.cnv and
test1datcnv.cnv. Use Name append to save intermediate data files
when input and output files have same extension.

AN

Y
Start Process

/ E xit Cancel

/

/

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Header View Tab

&% Data Conversion

File ©ptions Help

File Setupl Dats Setupl Miscellaneous  Header View I

Fricr I [d et I

=10l

" Sea-Bird SBE 9 Raw Data File:

" Software Wersion 4.218

* Temperature SH = 2037

* Conductivity SM = 1562

* Mumber of Bytes Per Scan = 27
* Wumber of Yoltage Words = 3

* latitude: 58 005
* longitude: 173 00E

“END*

Begin processing data.
Status field on File Setup tab
shows Processing complete
when done.

Kil

“FileMarne = C:ACTDDATANDITO 22.DAT

* System UpLoad Time = Jan 10 1936 16:09:21

o

\Start Process |

/ E =it I

Cancel |

/

/

Return to SBE Data Processing window.
L]

If Confirm Program Setup Change was selected in Options menu -

If you made changes in the File Setup or Data Setup tab and did not
Save or Save As, program asks if you want to save changes.

If Confirm Program Setup Change was not selected in Options menu -
Button says Save & Exit. If you do not want to save changes made on

the File Setup or Data Setup tab, use Cancel button to exit.
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File Formats

File extensions are used by Seasoft to indicate the file type:

Extension

Description

.afm

Bottle sequence, date and time, firing confirmation, and 5 scans
of CTD data, created by Auto Fire Module (AFM) or (when used
for autonomous operation) SBE 55 ECO Water Sampler.

.asc

Data file:

e Data portion of .cnv converted data file written in ASCII by
ASCII Out

o File written by Seaterm for data uploaded from SBE 37
(firmware < 3.0), 39, 39-IM, or 48.
Notes:
1. Convert button on Seaterm’s toolbar can convert .asc file to
.cnv file that can be used by SBE Data Processing to process
data.
2. Not applicable to SBE 37 IDO or ODO MicroCATs.

e File written by SeatermV?2 for data uploaded from
SBE 39plus.

.bl

Bottle log information - output bottle file, containing bottle firing
sequence number and position, date, time, and beginning and
ending scan numbers for each bottle closure. Beginning and
ending scan numbers correspond to approximately 1.5-second
duration for each bottle. Seasave writes information to file each
time bottle fire confirmation is received from SBE 32 Carousel
Water Sampler or SBE 55 ECO Water Sampler or (only when
used with SBE 911plus) G.O. 1016 Rosette. File can be used by
Data Conversion.

.bmp

Sea Plot output bitmap graphics file.

bsr

Bottle scan range file created by Mark Scan, and used by Data
Conversion to create a .ros file.

.btl

Averaged and derived bottle data from .ros file, created by Bottle
Summary.

Notes:

o Configuration files (.con or .xmlcon)
can also be opened, viewed, and
modified with DisplayConFile.exe, a
utility that is installed in the same
folder as SBE Data Processing.
Right click on the desired
configuration file, select Open With,
and select DisplayConFile. This
utility is often used at Sea-Bird to
quickly open and view a
configuration file for troubleshooting
purposes, without needing to go
through the additional steps of
selecting the file in SBE Data
Processing or Seasave.

o We recommend that you do not
open .xmlcon files with a text editor
(i.e., Notepad, Wordpad, etc.).

.cnv

Converted (engineering units) data file, with ASCII header
preceding data. Created by:
e Data Conversion.
o SecatermV2’s Convert XML data file (in Tools menu) for
SBE 39plus.
e Upload menu in Seaterm232 (SBE Glider Payload CTD only)
e Secaterm’s Convert button (SBE 37 [firmware < 3.0], 39,
39-IM, or 48 only).
Note: Not applicable to SBE 37 IDO or ODO MicroCATs.

.con or
.xmlcon

Instrument configuration - number and type of sensors, channel
assigned to each sensor, and calibration coefficients. SBE Data
Processing uses this information to interpret raw data from
instrument. Latest version of configuration file for your
instrument is supplied by Sea-Bird when instrument is
purchased, upgraded, or calibrated. If you make changes to
instrument (add or remove sensors, recalibrate, etc.), you must
update configuration file. Can be viewed and/or modified in SBE
Data Processing in Configure, Data Conversion, Derive, and
Bottle Summary; and in Seasave.
e .xmlcon files, written in XML format, were introduced with
SBE Data Processing and Seasave 7.20a. Instruments
introduced after that are compatible only with .xmlcon files.

.dat

Data file - binary raw data file created by older versions
(Version < 6.0) of Seasave from real-time data stream from
SBE 91 1plus. File includes header information.
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hdr

Header recorded when acquiring real-time data (same as header
information in data file), or header portion of .cnv converted data
file written by ASCII Out. Header information includes software
version, sensor serial numbers, instrument configuration, etc.

Note:

Seatermv2 version 1.1 and later
creates a .hex file from data
uploaded from an SBE 37. Earlier
versions of SeatermV2, and all
versions of Seaterm, created a .cnv
file.

.hex

Data file:

e Hexadecimal raw data file created by Seasave from real-time
data stream from SBE 9plus (Seasave > 7.0), 16, 16plus,
16plus V2, 19, 19plus, 19plus V2, 21, 25, 25plus, or 49.

e Data uploaded from memory of SBE 16, 16plus, 16plus-IM,
16plus V2, 16plus-IM V2, 17plus (used with SBE 9plus
CTD), 19, 19plus, 19plus V2, 21, 25, or 37.

e Converted (engineering units) data file created by Seasave
from real-time data stream from SBE 45.

File includes header information.

-ipg

Sea Plot output JPEG graphics file.

.mrk

Mark scan information - output marker file containing sequential
mark number, system time, and data for selected variables.
Information is written to file by Seasave when user clicks on
Mark Scan during real-time data acquisition to mark significant
events in the cast. File can be used by Mark Scan.

.psa

File containing input file name and data path, output data path,
and module-specific parameters used by SBE Data Processing. -
- Primary .psa file default location, if available, is:
%LOCALAPPDATA%\Sea-Bird\SBEDataProcessing-Win32\
(Example
c:\Users\dbresko\AppData\Local\Sea-Bird\SBEDataProcessing-
Win32\DatCnv.psa)

- Secondary .psa file default location is:
%APPDATA%\Sea-Bird\SBEDataProcessing-Win32\
(Example

c:\Documents and Settings\dbresko.SEABIRD\Application
Data\Sea-Bird\SBEDataProcessing-Win32\DatCnv.psa)

PostProcSuite.ini contains a list of paths and file names for
recently used .psa files. To view list, click File in module dialog
box and select Recent Setup Files.

- Primary PostProcSuite.ini file default location, if available, is:
%LOCALAPPDATA%\Sea-Bird\IniFiles\

(Example

c:\Users\dbresko\AppData\Local\Sea-Bird\IniFiles\
PostProcSuite.ini)

- Secondary PostProcSuite.ini file default location is:
%APPDATA%\Sea-Bird\IniFiles\

(Example

c:\Documents and Settings\dbresko.SEABIRD\

Application Data\Sea-Bird\IniFiles\PostProcSuite.ini)

J0S

File containing data for each scan associated with a bottle
closure, as well as data for a user-selected range of scans before
and after each closure; created by Data Conversion.

txt

e Easy-to-read file (for viewing only; cannot be modified) that
shows all parameters in .con or .xmlcon file. Created by
clicking Report in Configuration dialog box. SBE Data
Processing creates this as a femporary file; to save it to
document your settings, select Save and exit and enter desired
file name and location. Alternatively, create file by running
ConReport.exe.

e File written by Seaterm232 for data uploaded from SBE
25plus, containing data from serial sensors.
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wmf

Sea Plot output Windows metafile graphics file.

Note:

Seatermv2 version 1.1 and later
automatically creates a .hex file from
the .xml data file uploaded from an
SBE 37. Earlier versions of
SeatermV2, and all versions of
Seaterm, created a .cnv file.

xml

Sensor calibration coefficient file. This file can be exported
and/or imported from the dialog box for a sensor. This allows
you to move a sensor from one instrument to another and
update the instrument’s .con or .xmlcon file while eliminating
need for typing or resulting possibility of typographical
errors.

File written by Seaterm232, Seaterm485, or SeatermIM for
data uploaded from all SBE 37 IDO and ODOs, and other
SBE 37s with firmware version 3.0 and later (Note:
Seaterm232, Seaterm485, and SeatermIM [all version 1.1 and
later] automatically convert .xml file to .hex file that can be
used by SBE Data Processing to process data).

File written by Seaterm232 or SeatermUSB for data uploaded
from SBE 39plus.

File written by Seaterm232 for data uploaded from SBE
25plus.

.Xxmlcon

See .con extension above.

Converted Data File (.cnv) Format

Converted files consist of a descriptive header followed by converted data in
engineering units. The header contains:

1.

2.

3.

Header information from the raw input data file (these lines begin with *).

Header information describing the converted data file (these lines begin
with #). The descriptions include:

e number of rows and columns of data

e variable for each column (for example, pressure, temperature, etc.)
e interval between each row (scan rate or bin size)

e historical record of processing steps used to create or modify file

ASCII string *END to flag the end of the header information.

Converted data is stored in rows and columns of ASCII numbers

(11 characters per value) or as a binary data stream (4 byte binary floating
point number for each value). The last column is a flag field used to mark
scans as bad in Loop Edit.
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Editing Raw Data Files

Note:

See Section 5: Raw Data
Conversion Modules and
Section 7: File Manipulation
Modules for converting the data
to a .cnv file and then editing
the data.

Note:

Although we provide this
technique for editing a raw .hex
file, Sea-Bird’s strong
recommendation, as described
above, is to always convert the
raw data file and then edit the
converted file.

Sometimes users want to edit the raw .hex, .dat, or .xml data file before
beginning processing, to remove data at the beginning of the file
corresponding to instrument soak time, remove blocks of bad data, edit the
header, or add explanatory notes about the cast. Editing the raw file can
corrupt the data, making it impossible to perform further processing
using Sea-Bird software. We strongly recommend that you first convert
the data to a .cnv file (using Data Conversion), and then use other

SBE Data Processing modules to edit the .cnv file as desired.

.hex Files
If the editing is not performed using this technique, SBE Data Processing
may reject the edited data file and give you an error message.

1. Make a back-up copy of your .hex data file before you begin.

2. Run WordPad.

3. In the File menu, select Open. The Open dialog box appears. For Files of
type, select All Documents (*.*). Browse to the desired .hex data file and
click Open.

4. Edit the file as desired, inserting any new header lines after the System
Upload Time line and before *END*. Note that all header lines must
begin with an asterisk (*), and *END* indicates the end of the header. An
example is shown below, with the added lines in bold:

Sea-Bird SBE 21 Data File:
FileName =

C:\0dis\SAT2-0DIS\oct14-19\ocl5_ 99.hex

Software Version Seasave Win32 v1.10
Temperature SN = 2366
Conductivity SN = 2366

System UpLoad Time = Oct 15 1999
Testing adding header lines
Must start with an asterisk
Place anywhere between System Upload Time & END of header

10:57:19

ok ok % ok ok ok ok ok ok Kk

*

NMEA Latitude =

NMEA Longitude =
NMEA UTC
Store Lat/Lon Data =

30 59.70 N

081 37.93 W

Oct 15 1999 10:57:19

Append to Every Scan and Append to

(Time) =
.NAV File When

<Ctrl F7> is Pressed

* *

* %

* %

* *

* *

Sea-Bird
Sea-Bird Header Test

Ship:
Cruise:
Station:
Latitude:
Longitude:

*END*

5. In the File menu, select Save (not Save As). Something similar to the

following message displays:
You are about to save the document in a Text-Only format, which
will remove all formatting. Are you sure you want to do this?

Ignore the message and click Yes.
6. In the File menu, select Exit.

.dat Files
Sea-Bird is not aware of a technique for editing a .dat file that will not
corrupt it. Opening a .dat file with any text editor corrupts the file by leaving
behind invisible characters (for example, carriage returns, line feeds, etc.)
when the file is closed. These characters, inserted semi-randomly through the
file, corrupt the data format. Sea-Bird distributes a utility program, called
Fixdat, which may repair a corrupted .dat file.
o Fixdat.exe is installed with, and located in the same directory as,

SBE Data Processing.
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SBE Data Processing

Section 3:

Typical Data Processing Sequences

Notes:

e The processing sequence may
differ for your application.

e Sea Plot can display data at any
point after a .cnv file has been
created.

e Use ASCII Out to export
converted data (without header)
to other software.

e Oxygen computed by Seasave
and Data Conversion differs from
oxygen computed by Derive. Both
algorithms use the derivative of
the oxygen signal with respect to
time:

» Quick estimate - Seasave and
Data Conversion compute the
derivative looking back in time,
because Seasave cannot use
future values while acquiring
real-time data.

» Most accurate results - Derive
uses a user-input centered
window (equal number of points
before and after scan) to
compute the derivative.

This section includes #ypical data processing sequences for each instrument,
broken into four categories:

Profiling CTDs that have a configuration (.con or .xmlcon) file—
SBE 9plus, 19, 19plus, 19plus V2, 25, 25plus, and 49.

Other instruments (moored CTDs and thermosalinographs) that have a
configuration (.con or .xmlcon) file — SBE 16, 16plus, 16plus-IM,
16plus V2, 16plus-IM V2, 21, and 45.

MicroCATs with data uploaded using SeatermV?2 version 1.1 or later,
providing a .hex data file and a .xmlcon configuration file- SBE 37-SM,
37-SMP, 37-SMP-IDO, 37-SMP-ODO, 37-IM, 37-IMP, 37-IMP-IDO,
37-IMP-ODO, 37-SI, 37-SIP, 37-SIP-IDO, and 37-SIP-ODO.

MicroCATs with data uploaded using Seaterm or SeatermV2 version
1.00i or earlier, providing a .xml or .asc data file (and no configuration
[.con or .xmlcon] file) — SBE 37-SM, 37-SMP, 37-IM, 37-IMP, 37-SI,
and 37-SIP.

Instruments that do not have a configuration (.con or .xmlcon) file and
have limited compatibility with SBE Data Processing —

SBE 39, 39-IM, and 48.

SBE 39plus.

Glider Payload CTD
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Notes:

e The example assumes that a
configuration (.con or .xmlcon) file
is available. A configuration file is
provided by Sea-Bird when the
instrument is purchased, based on
the user-specified configuration
and the factory-calibration. An
existing configuration file can be
modified in Configure, Data
Conversion, Derive, or Bottle
Summary, or in Seasave. If you do
not have a configuration file, use
SBE Data Processing’s Configure
menu to create the file.

The order for running Bin Average
and Derive can be switched,
unless oxygen is being
computed in Derive.

See the program modules for Sea-
Bird recommendations for typical
parameter values for filtering,
aligning, etc. Use judgment in
evaluating your data set to
determine the best values.

Processing Profiling CTD Data (SBE 9plus, 19, 19plus, 19plus V2, 25, 25plus, and 49)

The processing sequence is based on a typical situation with a boat at low
latitude lowering an instrument at 1 meter/second.

Program / Module Function
1. Seasave, Acquire real-time raw data (Seasave) or
Seaterm232, upload data from memory (Upload menu in
Seaterm, or Seaterm232 for 19plus V2 or 25plus, or Upload
SeatermAF button in Seaterm or SeatermAF, as applicable).
Convert raw data to a .cnv file, selecting ASCII as
data conversion format. Converted data includes:
e  pressure, temperature, and conductivity
e (if applicable) dissolved oxygen current and
2. Data dissolved oxygen temperature (SBE 13 or 23);
Conversion dissolved oxygen signal (SBE 43);
dissolved oxygen phase delay and thermistor
voltage (SBE 63)
e (if applicable) light transmission, pH,
fluorescence, etc.
Low-pass filter pressure to increase pressure
3. Filter resolution for Loop Edit, and low-pass filter

temperature and conductivity to smooth high
frequency data.

4. Align CTD

Advance conductivity, temperature, and oxygen
relative to pressure, to align parameters in time.
This ensures that calculations of salinity, dissolved
oxygen, and other parameters are made using
measurements from same parcel of water.

5. Cell Thermal
Mass

Perform conductivity cell thermal mass correction if
salinity accuracy of better than 0.01 PSU is desired in
regions with steep gradients.

Note: Do not use Cell Thermal Mass for freshwater
data.

6. Loop Edit

Mark scans where CTD is moving less than minimum
velocity or traveling backwards due to ship roll.

7. Derive
(EOS-80,
Practical
Salinity)

Compute:

e  Practical Salinity, density, and other parameters

e oxygen from oxygen current and oxygen
temperature (SBE 13 or 23); oxygen signal
(SBE 43); or oxygen phase delay and thermistor
voltage (SBE 63)

Note that input file must include conductivity,

temperature, and pressure.

8. Derive TEOS-10

(optional) Compute thermodynamic properties based

(TEOS-10, on TEOS-10.

Absolute

Salinity)
9. Bin Average Average data into desired pressure or depth bins.
10.Sea Plot Plot data.
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Processing SBE 16, 16plus, 16plus-IM, 16plus V2, 16plus-IM V2, 21, and 45 Data

Notes:

e The example assumes that a
configuration (.con or .xmlcon) file is
available. A configuration file is
provided by Sea-Bird when the
instrument is purchased, based on
the user-specified configuration and
the factory-calibration. An existing
configuration file can be modified in
Configure, Data Conversion, Derive,
or Bottle Summary, or in Seasave. If
you do not have a configuration file,
use SBE Data Processing’s
Configure menu to create the file.

e Even if your instrument does not
have a pressure sensor (SBE 21
and 45; SBE 16, 16plus, 16plus-IM,
16plus V2, and 16plus-IM V2 without
optional pressure sensor): Select
pressure as an output variable in
Data Conversion if you plan to
calculate salinity, density, or other
parameters that require pressure in
Derive or Sea Plot. For the SBE 16
series instruments, Data Conversion
inserts a column with the moored
pressure (entered in the .con or
.xmlcon file Data dialog) in the
output .cnv file. For the SBE 21 and
45, Data Conversion inserts a
column of O’s for pressure in the
output .cnv file.

e The SBE 45 outputs data in
engineering units. However, you
must still run Data Conversion to put
the data in a format that can be
used by SBE Data Processing’s
other modules.

e For an SBE 21 or 45 with a remote
temperature sensor, Seasave,

Data Conversion, Derive, and
Derive TEOS-10 all use the remote
temperature data when calculating
density and sound velocity.

Program / Module Function
1. Seasave, Acquire real-time raw data (Seasave) or
Seaterm232, upload data from memory:
Seaterm485, e Upload menu in Seaterm232 or Seaterm485 for
SeatermIM, or 16plus V2 or SeatermIM for 16plus-IM V2;
Seaterm e Upload button in Seaterm.
Convert raw data to a .cnv file, selecting ASCII as
data conversion format. Converted data includes:
e  pressure, temperature, and conductivity
e (if applicable) dissolved oxygen current and
2. Data dissolved oxygen temperature (SBE 13 or 23);
Conversion dissolved oxygen signal (SBE 43); dissolved
oxygen phase delay and thermistor voltage (SBE
63)
e (if applicable) light transmission, pH,
fluorescence, etc.
Compute:
e  Practical Salinity, density, and other parameters.
3. Derive e oxygen from oxygen current and oxygen
(EOS-80, temperature (SBE 13 or 23); oxygen signal (SBE
Practical 43); or oxygen phase delay and thermistor
Salinity) voltage (SBE 63)
Note that input file must include conductivity,
temperature, and pressure.
4. Derive TEOS-10 | (optional) Compute thermodynamic properties based
(TEOS-10, on TEOS-10.
Absolute
Salinity)
5. Sea Plot Plot data.
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Processing SBE 37-SM, SMP, SMP-IDO, SMP-ODO, IM, IMP, IMP-IDO, IMP-ODO, SI, SIP,
SIP-IDO, and SIP-ODO Data with a .hex data file and .xmlcon configuration file

Note:

SBE 37-Sl and 37-SIP with firmware
version 3.0 and later have internal
memory; follow the procedure
described here to upload and
process the data. Earlier versions of
the 37-Sl and 37-SIP did not have
internal memory; SBE Data
Processing cannot be used to
process the real-time data obtained
with these older instruments.

Program / Module

Function

1. Seaterm232,

Seaterm48S, or
SeatermIM (all
version 1.1 or
later)

For SBE 37 (without oxygen) with firmware > 3.0
and all IDO and ODO SBE 37- Use Upload menu to
upload data (in engineering units). SeatermV?2
uploads data as an XML (.xml) file. It automatically
converts data to .hex format, and creates a
configuration (.xmlcon) file; .hex and .xmlcon file.

. Data

Conversion

Convert raw data to a .cnv file, selecting ASCII as

data conversion format. Converted data includes:

e conductivity, temperature, and pressure

e (for IDO and ODO MicroCATs) dissolved
oxygen signal

. Derive (EOS-80,

Practical
Salinity)

Compute:
e  Practical Salinity, density, and other parameters.
e oxygen from oxygen signal

. Derive TEOS-10

(optional) Compute thermodynamic properties based

(TEOS-10, on TEOS-10.
Absolute
Salinity)

5. Sea Plot Plot data.

Processing SBE 37-SM, SMP, IM, IMP, SI, and SIP Data without a configuration file

Note:

SBE 37-Sl and 37-SIP with firmware
version 3.0 and later have internal
memory; follow the procedure
described here to upload and
process the data. Earlier versions of
the 37-Sl and 37-SIP did not have
internal memory; SBE Data
Processing cannot be used to
process the real-time data obtained
with these older instruments.

Program / Module

Function

1. Seaterm232,

Seatermd485, or
SeatermIM (all
version 1.001 or
earlier), or
Seaterm

Seaterm232, Seaterm485, or SeatermIM for SBE 37
(non-IDO) with firmware version > 3.0 - Use Upload
menu to upload data (in engineering units) in XML
(.xml) format. Use Convert . XML data file in Tools
menu to convert .xml to .cnv file, which can be used
by SBE Data Processing. or

Seaterm for SBE 37 (non-IDO) with firmware version
< 3.0 - Use Upload button to upload data (in
engineering units) in ASCII (.asc) format. Use
Convert button to convert .asc to .cnv file, which can
be used by SBE Data Processing.

. Derive (EOS-80,

Practical
Salinity)

Compute Practical Salinity, density, and other

parameters.

Note: An SBE 37 stores calibration coefficients

internally, and does not have a .con or .xmlcon file.

However, Derive requires you to select a .con or

.xmlcon file before it will process data. You can use a

.con or .xmlcon file from any other Sea-Bird

instrument; the contents of the file will not affect the

results. If you do not have a .con or .xmlcon file for

another Sea-Bird instrument, create one:

1. Click SBE Data Processing’s Configure menu
and select any instrument.

2. In the Configuration dialog box, click Save As,
and save the .con or .xmlcon file with the desired
name and location.

. Derive TEOS-10

(optional) Compute thermodynamic properties based

(TEOS-10, on TEOS-10.
Absolute
Salinity)

4. Sea Plot Plot data.
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Processing SBE 39, 39-IM, and 48 Data

Note: Program / Module Function
The .cnv file from an SBE 39, 39-IM, Use Upload button to upload data (in engineering
or 48 cannot be processed by any 1. Seaterm units) in ASCII (.asc) format. Use Convert button to
SBE Data Processing modules : convert .asc to .cnv file, which can be used by
other than Sea Plot and ASCII Out. SBE Data Processing.
2. Sea Plot Plot data.
Processing SBE 39plus Data
Note: Program / Module Function

The .cnv file from an SBE 39plus
cannot be processed by any

SBE Data Processing modules
other than Sea Plot and ASCII Out.

1. SeatermV2

Use Upload button in appropriate program to upload
data (in engineering units) in XML and ASCII (.asc)
format. Use Convert XML data file in Tools menu to
convert to .cnv file, which can be used by SBE Data
Processing.

2. Sea Plot

Plot data.

Processing Glider Payload CTD Data (GPCTD)

Notes:

e The example assumes that a
configuration (.xmlcon) file is
available. A configuration file is
created by Seaterm232 when data
is uploaded from memory, based
on the factory configuration and
the calibration data programmed
into the instrument. An existing
configuration file can be modified
in Configure or Derive. If you do
not have a configuration file, you
can use SBE Data Processing’s
Configure menu to create the file.

¢ Use judgment in evaluating your
data set to determine the best
values for filtering, aligning, etc.

The processing sequence is based on a typical situation with the Glider
Payload CTD acquiring data via Continuous Sampling.

Program / Module

Function

1. Seaterm232

Upload data from memory (Upload menu in
Seaterm232).

2.Filter

Low-pass filter pressure to increase pressure
resolution for low-pass filter temperature and
conductivity to smooth high frequency data.

3.Align CTD

Advance conductivity, temperature, and oxygen
relative to pressure, to align parameters in time.
This ensures that calculations of salinity, dissolved
oxygen, and other parameters are made using
measurements from same parcel of water.

4.Cell Thermal
Mass

Perform conductivity cell thermal mass correction if
salinity accuracy of better than 0.01 PSU is desired in
regions with steep gradients.

S.Derive (EOS-80,
Practical Salinity)

Compute:

e  Practical Salinity, density, and other parameters
e oxygen (optional)

Note that input file must include conductivity,
temperature, and pressure.

6.Derive TEOS-10

(optional) Compute thermodynamic properties based

(TEOS-10, on TEOS-10.
Absolute Salinity)
7.Sea Plot Plot data.
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Section 4: Configuring Instrument
(Configure)

Module Name Module Description
Define instrument configuration and
Configure o .
calibration coefficients.

Summary; or in Seasave.

¢ Configuration files (.con or
.xmlcon) can also be opened,
viewed, and modified with
DisplayConFile.exe, a utility that is
installed in the same folder as SBE
Data Processing. Right click on the
desired configuration file, select
Open With, and select
DisplayConFile. This utility is often
used at Sea-Bird to quickly open
and view a configuration file for
troubleshooting purposes, without
needing to go through the
additional steps of selecting the file
in SBE Data Processing or
Seasave.

e Appendix II: Configure (.con or
.xmlcon) File Format contains a
line-by-line description of the
contents of the configuration file.

e An SBE 37, 39, 39-IM, 39plus, and
48 stores calibration coefficients
internally, and does not have a
.con or .xmlcon file.

Introduction
Configure creates or modifies a configuration (.con or .xmlcon) file to define
the instrument configuration and sensor calibration coefficients. The .con or
.xmlcon file is used in both SBE Data Processing and in Seasave. Configure is
applicable to the following instruments:
e SBE 9plus with SBE 11plus Deck Unit or SBE 17plus Searam
(SBE 9plus is listed as the 911/917plus in the Configure menu)
Notes: e SBEI16
e Sea-Bird supplies a .con or *  SBE 16plus (including 16plus-IM)
.xmlcon file with each instrument. e SBE 16plus V2 (including 16plus-IM V2)
The file must match the existing e SBE 19
instru_ment configuration and e SBE 19plus
cor_ltaln_cur_rent sensor o SBE 19plus V2
calibration information.
Exception: An .xmlcon file is e SBE2I
generated by Seaterm232 when e SBE25
you upload data from an SBE e SBE 25plus
Glider Payload CTD; Sea-Bird e SBE37
ioes nott provide the fiIIe. , e SBE45
e An existing .con or .xmlcon file can
be modified in Configure; in Data * SBE 49,
Conversion, Derive, or Bottle * SBE Glider Payload CTD

The discussion of Configure is in five parts:

Instrument Configuration covers the Configuration dialog box - number
and type of sensors on the instrument, etc. - for each of the instruments
listed above. Unless noted otherwise, SBE Data Processing supports only
one of each brand and type of auxiliary sensor (for example, you cannot
specify two Chelsea Minitracka fluorometers, but you can specify a
Chelsea Minitracka and a Chelsea UV Aquatracka fluorometer). See the
individual sensor descriptions in Calibration Coefficients for Voltage
Sensors for those sensors that SBE Data Processing supports in a
redundant configuration (two or more of the same sensor interfacing with
the CTD).

Calibration Coefficients for Frequency Sensors covers calculation of
coefficients for each type of frequency sensor (temperature, conductivity,
Digiquartz pressure, IOW sound velocity, etc.).

Calibration Coefficients for A/D Count Sensors covers calculation of
coefficients for A/D count sensors (temperature and strain gauge pressure)
used on the SBE 16plus (and -IM), 16plus (and -IM) V2, 19plus,

19plus V2, 37, and 49.

Calibration Coefficients for Voltage Sensors covers calculation of
coefficients for each type of voltage sensor (strain gauge pressure, oxygen,
pH, etc.).

Calibration Coefficients for RS-232 Sensors covers specification of an
Aanderaa Optode, which can be integrated with an SBE 19plus V2.
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Access Configure by selecting the desired instrument in the Configure
menu in the SBE Data Processing window.

2= SBE Data Processing =

Fun EEHiREES Help

. 5BE 16 Seacat CTD...

. SBE 16plus Seacak CTD...

. SBE 16plus Y2 Seacat CTD...

. 5BE 19 Seacat CTD...

. SBE 19plus Seacat CTO...

. 3BE 19plus Y2 Seacat CTD..,

. 3BE 21 Seacat Thermosalinograph...
. S3BE 25 Sealogger CTD...

. 3BE #5plus Sealoager CTD...

. SBE 37 Microcak...

. SBE 45 MicroTSG Thermosalinograph. ..
. SBE 49 Fastcat CTD...

. SBE 91 1plus/917plus CTO...

14, SEE Glider Payload CTD...

B o e = L o I N

_
[ I % ]

v Confirm Configuration Change

e Before selecting the instrument, review the status of Confirm
Configuration Change in the Configure menu. If Confirm Configuration
Change is selected, the program provides a prompt to save the
configuration (.con or .xmlcon) file if you make changes and then click the
Exit button in the Configuration dialog box without clicking Save or Save
As. If not selected, the program changes the Exit button to Save &
Exit; to exit without saving changes, use the Cancel button.
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SBE Data Processing

Instrument Configuration

SBE 9plus Configuration

Channel/Sensor table reflects this
choice. Typically:

e 0 =SBE 3 or 4 plugged into JB5
on 9plus (dual redundant sensor
configuration)

1 = SBE 3 or 4 plugged into

JB4 on 9plus and not using JB5
connector (single redundant
sensor configuration)

e 2 =noredundant T or C sensors

Connector
Words to Keep

11plus > 5.0: Seasave sends
AddSpar= command to Deck Unit,
consistent with configuration file
selection for Surface PAR.

11plus < 5.0: Surface PAR
acquisition is set in Deck Unit with
dip switch.

17plus: Data uploaded from 17plus
memory.

None: Not using 11plus or 17plus;
see Appendix I: Command Line
Operation.

\Eonfiguraliun file: opened: Mone

External Voltage (not spare)

Channel/Sensor table reflects this choice. Voltage channel 0 in .con or .xmlcon file
corresponds to sensor wired to channel 0 on end cap connector, voltage channel 1 to
sensor wired to channel 1 on end cap connector, etc. Total voltage words is 4; each word
contains data from two 12-bit A/D channels. Deck Unit and Searam suppress words above
highest numbered voltage word used. Words to suppress =4 - Words to Keep.

Oor1 2o0r3 4o0rb5 6or7
AUX 1 AUX 2 AUX 3 AUX 4
1 2 3 4

Configuration for the SBE 911plus/917plisCTD

Frequency channels suppressed |7 »|  Vollage words suppressed o

™ Dieck unit or SEARAM
Cormputer interface

Scans to average

word = 2 channels)

X

ISBE1 1plus Firmisare Yersion »= 5.0 j

|H5-232E 'l

IEEE-448 or RS-232C for
CTD data interface between
Deck Unit and computer.

—

NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked. Note: Whether NMEA
device was connected to a deck
unit or directly to computer during
data acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.
Surface PAR - Select if Surface
PAR sensor used; must agree with
Deck Unit setup if 11plus firmware
< 5.0. Seasave appends Surface
PAR data to every scan. Adds 2
channels to Channel/Sensor table.
Do not decrease Voltage words
suppressed to reflect this; Voltage
words suppressed reflects only
external voltages going directly to
9plus from auxiliary sensors. See
Application Note 118S.

Scan time — Select if Seasave
appended time (seconds since
January 1, 1970 GMT) to each
data scan.

[V NMEA position data added

{+ MME# device connected to deck unit

(" NME£ device connected to PC

[~ MMES denth data added

For full rate (24 Hz) data, set to
1. Example: If scans to
average=24, Seasave averages
24 scans, saving data to
computer at 1 scan/second.

[~ HMES time added

IV Surface PAR voltage added

¥ Scan time added

Shaded sensors cannot be
removed or changed to
another type; others are
optional.

/

Channegl Sergor |

/K ! New to create new .con or
1. Frequency Temperature e xmicon file for this CTD.
2. Frequency Canductivity el ggﬁz:?xﬁ:gg;?;gérem
3. Frequency Pressure, Digiquartz with TC Saye | Save or Save As to save
—_—————— === current .con or .xmicon file
4 /0 voltage I | pH settings.
| e Savehg
B &/0 voltage 1 | Owpgen, 5BE 43 —_—
B.AD valtage 2 | Fluorometer, WET Labs ECO CDOM
— e Sieleat.. |
7 &0 vokage3 | Alimeter
B SPAR volage | Unavailable fndfy | Click a sensor and click
e . === Modify to view/ch
3 SPAR voltage SPAR/Sutace Inadiance ca(l)iblra);io%\gi\gff?cé:?sefor

Click a (non-shaded) sensor and click Select to pick a different
sensor for that channel; dialog box with list of sensors appears.
After sensor is selected, dialog box for calibration coefficients
appears. Select sensors after Frequency channels suppressed
and Voltage words suppressed have been specified above.

Help...

/Hepmt...

Cancel

Exit \

that sensor.

Opens a .txt file (for viewing only; can

modified) that shows all parameters in .con
or .xmlcon file. For command line generation
of report, see Appendix Ill: Generating .con
or .xmlcon File Reports — ConReport.exe.

not be

Return to SBE Data Processing window.

o |f Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

¢ |f Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above, for an SBE 9plus
used with an SBE 11p/us Deck Unit. Shown below the appropriate lines are the
commands used in Seaterm to modify the setup of parameters critical to use of
the 9plus with Seasave and processing of data with

SBE Data Processing, as well as any explanatory information.

SBE 1lplus V 5.1f

Number of scans to average = 1
(11plus reads this from .con or .xmlcon file in Seasave when data acquisition is
started.)

pressure baud rate = 9600
NMEA baud rate = 4800

surface PAR voltage added to scan
(11plus reads this from .con or .xmlcon file in Seasave when data acquisition is
started.)

A/D offset = 0

GPIB address = 1
(GPIB address must be 1 [GPIB=1] to use Seasave, if Computer interface is IEEE-
488 (GPIB) in .con or .xmlcon file.)

advance primary conductivity 0.073 seconds
advance secondary conductivity 0.073 seconds

autorun on power up is disabled
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SBE Data Processing

Channel/Sensor table reflects this
choice. Must agree with SBE 16 setup
for SVn (n=0, 1, 2, 3, 4); see reply from
DS. Voltage channel 0 in .con or
.xmlcon file corresponds to sensor
wired to channel 0 on end cap
connector, voltage channel 1
corresponds to sensor wired to channel
1 on end cap connector, etc.

Corfiquration file apened: Mone

Fressure senzor type

| Extemal voliage channels |2 vI

Firmware verzion

Time between scans. Must agree with
SBE 16 setup (SI); see reply from DS.

— Sarnple interval seconds I15

Select if using with deck unit
connected to NMEA navigation
device. Seasave adds current
latitude, longitude, and universal time
code to data header; appends NMEA
data to every scan; and writes NMEA
data to .nav file every time Ctrl F7 is
pressed or Add to .nav File is clicked.

L NMEA position data added

SBE 16 Seacat C-T Recorder Configuration

Strain gauge, Digiquartz with or without temperature
compensation, or no pressure sensor. If no pressure

Configuration for the SBE 16 Seacat CTD PSSy Digiquartz without Temp Comp is selected,

Data button accesses dialog box to input additional
parameter(s) needed to process data.

IND Pressure Sensor »| Daa. |

See reply from DS. Used to determine strain gauge
pressure sensor data format.

Select if Seasave appended time (seconds since

Wersionry=40 *
| J January 1, 1970 GMT) to each data scan.

Shaded sensors cannot be removed
or changed to another type of
sensor. All others are optional.

[ Sean time added

Charnel S ensar | Wbty New to create new .con
or .xmlcon file for this
1. Frequency Temperature / - CTD.
i PEM...| Open to select different
2. Frequency Conductivit . .con or .xmlcon file.
3 &/ voltage 0 | User Polyramial Saye |Save or Save As to save
T T : g o current .con or .xmlcon
4. A/D voltage 1 P&R radiance, Biosphenical/Licor & v s | file settings.

Click a (non-shaded) sensor and click Select to pick a
different sensor for that channel. A dialog box with a
list of sensors appears. Select sensors after number
of voltage channels have been specified above.

Click a sensor
and click Modify
to change
calibration
coefficients for

|~ Gelech., |
>
Modk |

Opens a .txt file (for viewing only;
cannot be modified) that shows all
parameters in .con or .xmlcon file. For
command line generation of report,
see Appendix Ill: Generating .con or
.xmlcon File Reports — ConReport.exe.

Hepnrt...l Help... |

that sensor.

Euit Cancel

L~

Return to SBE Data Processing window.

o |f Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o |f Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the SBE 16 with

Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SEACAT V4.0h SERIAL NO. 1814 07/14/95 09:52:52.082

(If pressure sensor installed, pressure sensor information appears here in status
response; must match Pressure sensor type in .con or .xmlcon file.)

clk = 32767.789, iop = 103, vmain = 8.9, vlith = 5.9

sample interval = 15 sec
(Sample interval [SI]| must match Sample interval seconds in .con or .xmlcon file.)

delay before measuring volts = 4 seconds

samples = 0, free = 173880, lwait = 0 msec

SW1l = C2H, battery cutoff = 5.6 volts

no. of volts sampled = 2
(Number of auxiliary voltage sensors enabled [SVn] must match External voltage

channels in .con or .xmlcon file.)
mode = normal

logdata = NO
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Note:

The SBE 16plus is available with an
optional RS-485 interface. All
commands to a particular 16plus with
RS-485 are preceded by #ii, where
ii = instrument ID (0-99). Therefore,
commands mentioned in the dialog
box description below have a slightly
different form for the RS-485 version
(#iiDS, #iiPType=, #iiVoltn=, and
#iiSamplelnterval=).

Channel/Sensor table reflects
this choice (0, 1, 2, 3, or 4).
Must agree with 16plus setup

SBE 16plus or 16plus-IM Seacat C-T Recorder Configuration

The SBE 16plus can interface with one SBE 38 secondary temperature sensor,
one SBE 50 pressure sensor, or up to two Pro-Oceanus Gas Tension Devices
(GTDs) through the SBE 16plus optional RS-232 connector. Data from an

SBE 50 pressure sensor is appended to the data stream, and does not replace the
(optional) internally mounted pressure sensor data.

The SBE 16plus-IM can interface with one SBE 38 secondary temperature
sensor through the 16plus-IM optional RS-232 connector, but cannot interface
with an SBE 50 or GTD. All commands to a particular 16plus-IM are
preceded by #ii, where ii = instrument ID (0-99). Therefore, commands
mentioned in the dialog box description below have a slightly different form for
the 16plus-IM (#iiDS, #iiPType=, #iiVoltN=, and #iiSampleInterval=).

Internally mounted pressure sensor: strain gauge, Digiquartz
with temperature compensation, or no pressure sensor. If no
pressure sensor is selected, Data button accesses a dialog box
to input additional parameter needed to process data. Must
agree with 16plus setup (PType=); see reply from DS. Selection
applies only to internally mounted pressure sensor; if instrument
has no internally mounted pressure sensor but is interfacing with

for VoltN= (N=0, 1, 2, and 3); Confiquration for the SBE 16DRIC St SBE 50 pressure sensor, select No pressure sensor here and
see reply from DS. Voltage g P then select SBE 50 in Serial RS-232C sensor field below.

channel 0 in .con or .xmicon file

Note: Digiquartz without temperature compensation is not

corresponds to first external Caonfiguration file opened: Mone applicable.

voltage in data stream, voltage

channel 1 to second external =
voltage in data stream, etc. Pressure sensar type |5train Gauge ll [ata. |
I
Estemnal voltage channels None, 1 SBE 38 (secondary temperature),
0 2 [ 1 SBE 50 pressure sensor, or up to 2 GTDs

Must agree with 16plus setup
(Samplelnterval=); see reply

Select if using with deck unit
connected to a NMEA

Time between scans. i g ;
Senal BS-232C senzor ITemperaturE, SEEﬁ :l 16plus setup; see reply from DS. Channel/Sensor

from DS. Sample interval seconds |1|]

/P NME posiion data added Shaded sensors cannot be removed or changed to

Charinel SerEOl ‘ New |

(dissolved oxygen or nitrogen). Must agree with

table lists RS-232 sensors below voltage channels.

another type of sensor. All others are optional.

navigation device. Seasave New 10 create now con or
adds current latitude, longitude, 1 Count Temperalure <micon file for s CTD
and universal time code to data _— s Elpen,,, O ¢ lect diff. t-
header; appends NMEA data to 2 Frequency Conductivity il Cgﬁr:) roxsnilsgn ﬁlleeren
every scan; and writes NMEA e . : : :

data to nav file every time Ctrl 3. Count Pressure, Strain Gauge Save f:r‘::n(t)r csoanvgrA: n:?cii\ﬁe
F7is pressed or Add to .nav File| 4 &/D vaolkageD | Osygen, SBE 43 cottings. :

is clicked. e Save fig| settings.

B &/0 valtage 1 pH

B. Serial B5-232 Temperature, SBE 38

ElEct...
Click a (non-shaded) sensor and click Select to pick a different sensor for /?_l

that channel. A dialog box with a list of sensors appears. Select sensors : | :
after number of voltage channels have been specified above. Mc'dlf-l"" \g:gkcﬁciel\r;lizify
e to change
; calibration
Hn;pnrl... | Help... | EH}t Cancel | coefficients for
that sensor.
/ /
/ /

Opens a .txt file (for viewing only; cannot
be modified) that shows all parameters in
.con or .xmlcon file. For command line
generation of report, see Appendix Ill:
Generating .con or .xmlcon File Reports —
ConReport.exe.

Return to SBE Data Processing window.

o |f Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in Seaterm for a 16plus with
standard RS-232 interface that corresponds to the setup shown in the
Configuration dialog box above. Shown below the appropriate lines are the
commands used in Seaterm to modify the setup of parameters critical

to use of the SBE 16plus with Seasave and processing of data with

SBE Data Processing, as well as any explanatory information.

SBE lé6plus V 1.6e SERIAL NO. 4300 03 Mar 2005 14:11:48

vbatt = 10.3, vlith = 8.5, ioper = 62.5 ma,
ipump = 21.6 ma, iext0l = 76.2 ma, iserial = 48.2 ma

status = not logging

sample interval = 10 seconds, number of measurements
per sample = 2

(Sample interval [Samplelnterval=] must match Sample interval seconds in
.con or .xmlcon file.)

samples = 823, free = 465210

run pump during sample, delay before sampling =
2.0 seconds

transmit real-time = yes
(Real-time data transmission must be enabled [TxRealTime=Y] to acquire data
in Seasave.)

battery cutoff = 7.5 volts

pressure sensor = strain gauge, range = 1000.0
(Internal pressure sensor [PType=] must match Pressure sensor type in .con or
.xmlcon file.)

SBE 38 = yes, SBE 50 = no, Gas Tension Device = no
(Selection/enabling of RS-232 sensors [SBE38=, SBES0=, GTD=, DualGTD=] must
match Serial RS-232C sensor in .con or .xmlcon file.)

Ext Volt 0 = yes, Ext Volt 1 = yes, Ext Volt 2 = no, Ext
Volt 3 = no

(Number of external voltage sensors enabled [Volt0= through Volt3=] must match
External voltage channels in .con or .xmlcon file.)

echo commands = yes

output format = raw HEX
(Output format must be set to raw Hex [OutputFormat=0] to acquire data in
Seasave.)

serial sync mode disabled
(Serial sync mode must be disabled [SyncMode=N] to acquire data in Seasave.)
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Note:

The SBE 16plus V2 is available with
an optional RS-485 interface. All
commands to a particular 16plus V2
with RS-485 are preceded by #ii,
where ii = instrument ID (0-99).
Therefore, commands mentioned in
the dialog box description below have
a slightly different form for the
RS-485 version (#iiGetCD, #iiDS,
#iiPType=, #iiVoltn=, and
#iiSamplelnterval=).

Channel/Sensor table reflects
this choice (0, 1, 2, 3, 4, 5, or 6).

4, and 5); see reply from GetCD
or DS. Voltage channel 0 in .con
or .xmlcon file corresponds to

Time between scans. Must

Configuration file opened: 16plusvz. con

SBE 16plus V2 or 16plus-IM V2
SeaCAT C-T Recorder Configuration

Through the CTD’s RS-232 sensor connector, the SBE 16plus V2 and 16plus-
IM V2 can interface with an SBE 38 secondary temperature sensor, SBE 50
pressure sensor, SBE 63 Optical Dissolved Oxygen Sensor, WET Labs sensor
[single, dual, or triple channel ECO; WETStar; or C-Star], Optode, or up to two
Pro-Oceanus Gas Tension Devices (GTDs). This data is appended to the data
stream; SBE 38 and SBE 50 data does not replace the internal CTD data.

All commands to a particular 16plus-IM V2 are preceded by #ii, where ii =
instrument ID (0-99). Therefore, commands mentioned in the dialog box
description below have a slightly different form for the 16plus-IM V2
(#iiGetCD, #iiDS, #iiPType=, #iiVoltN=, and #iiSampleInterval=).

Internally mounted pressure sensor: strain gauge, Digiquartz
with temperature compensation, or no pressure sensor. If no
pressure sensor is selected, Data button accesses dialog box to
input additional parameter needed to process data. Must agree
with 16plus V2 setup (PType=); see reply from GetCD or DS.
Selection applies only to internally mounted pressure sensor; if
16plus V2 has no internally mounted pressure sensor but is

Must agree with 16plus V2 (R T g Ll el & L n 108 i ro| interfacing with SBE 50 pressure sensor, select No pressure
setup for VoltN= (N=0, 1, 2, 3,

sensor here and then select SBE 50 in Serial RS-232C sensor
field below. Note: Digiquartz without temperature compensation
is not applicable.

first external voltage in data Preszure senzor bype |5train Gauge :J [ata;. |
stream, voltage channel 1 to N
zter‘:;?]? :):(t:ernal voltage in data | “Fyoal yrltage charnels |2 .,l None, SBE 38 (secondary temperature), SBE 50

pressure sensor, SBE 63 Optical DO sensor, WET
Labs sensor (up to 3 channels), up to 2 GTDs (DO or

Serial R3-Z3eC sensor ITemperaturE, SBE 35/;' nitrogen), or Optode. Must agree with 16plus V2

agree with 16plus V2 setu ; setup; see reply from GetCD or DS. Channel/Sensor
(3amp|e|nter€al=)' see regly Sample interval seconds Im table lists RS-232 sensors below voltage channels.
from GetCD or DS. T

/E HMEA position data added Shaded sensors cannot be removed or changed to
Select if using with deck unit another type of sensor. All others are optional.

I
connected to a NMEA Charnel Sensor A New Niew to create new .con or
navigation device. Seasave T file f A C
adds current latitude, longitude, 1. Count emperature Ooen gmlcon ile for th|f? TD.
and universal time code to data 2 Frequency Conductivity —EED Cgﬁ':)rt_oxsnfllsg;?;leerem
header; appends NMEA data to e 3 : : :
every scan; and writes NMEA 3. Count Frezzure, Strain Gauge Save [Save or Save As to save
data to .nav file every time Ctrl 4, 470 voltage 0 Oxygen, SBE 43 eaiel Z:trtriigts.con or .xmlcon file
F7is pressed or Add to .nav File| — - . . ave Az :
is clicked A 4/0 voltage 1 Fluorometer, Tumer SCUFA
B. Serial RS-232 Temperature, SEE 38

Click a (non-shaded) sensor and click Select to pick a different sensor for | Select.
that channel. A dialog box with a list of sensors appears. Select sensors - lick
after number of voltage channels have been specified above. Mﬁdlf_'r'..-\l\ Click a sensor

/

land click Modify

to change
calibration
coefficients for
that sensor.

H}fpnrl...l Help... | Ext I Cancel |
/

/

/

Opens a .txt file (for viewing only; cannot
be modified) that shows all parameters in
.con or .xmlcon file. For command line
generation of report, see Appendix Ill:
Generating .con or .xmlcon File Reports —
ConReport.exe.

L
Return to SBE Data Processing window.
o |f Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
o |f Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in a terminal program for a
16plus V2 with standard RS-232 interface that corresponds to the setup shown
in the Configuration dialog box above. Shown below the appropriate lines are
the commands used in the terminal program to modify the setup of parameters
critical to use of the SBE 16plus V2 with Seasave and processing of data with
SBE Data Processing, as well as any explanatory information.

SBE l6plus V 2.0 SERIAL NO. 6001 24 Oct 2007 14:11:48

vbatt = 10.3, vlith = 8.5, ioper = 62.5 ma,
ipump 21.6 ma, iext0l = 76.2 ma, iserial = 48.2 ma

status = not logging

samples = 0, free = 3463060

sample interval = 10 seconds, number of measurements
per sample = 1

(Sample interval [SampleInterval=] must match Sample interval seconds in
.con or .xmlcon file.)

pump = run pump during sample, delay before sampling =
2.0 seconds

transmit real-time = yes
(Real-time data transmission must be enabled [TxRealTime=Y] to acquire data
in Seasave.)

battery cutoff = 7.5 volts

pressure sensor = strain gauge, range = 1000.0

(Internal pressure sensor [PType=] must match Pressure sensor type in .con or .xmlcon
file.)

SBE 38 = yes, SBE 50 = no, WETLABS = no, OPTODE = no,

SBE63 = no, Gas Tension Device = no

(Selection/enabling of RS-232 sensors [SBE38=, SBES0=, WetLabs=, Optode=, SBE63=,
GTD=, DualGTD=] must match Serial RS-232C sensor in .con or .xmlcon file.)

Ext Volt 0 = yes, Ext Volt 1 = yes,

Ext Volt 2 = no, Ext Volt 3 = no,

Ext Volt4 = no, Ext Volt 5 = no

(Number of external voltage sensors enabled [Volt0= through Volt5=] must match
External voltage channels in .con or .xmlcon file.)

echo characters = yes

output format = raw HEX
(Output format must be set to raw Hex [OutputFormat=0] to acquire data in Seasave.)

serial sync mode disabled
(Serial sync mode must be disabled [SyncMode=N] to acquire data in Seasave.)
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Channel/Sensor table reflects this choice. Must
agree with SBE 19 setup for SVn (n=0, 2, or
4); see reply from DS. Voltage channel 0 in
.con or .xmicon file corresponds to sensor
wired to channel 0 on end cap connector,
voltage channel 1 corresponds to sensor wired
to channel 1 on end cap connector, etc.

SBE 19 Seacat Profiler Configuration

Seasave and SBE Data Processing always treat the SBE 19 as if it is a Profiling
instrument (i.e., it is in Profiling mode). If your SBE 19 is in Moored Mode,
you must treat it like an SBE 16 (when setting up the .con or .xmlcon file,
select the SBE 16).

Configuration for the SBE 19 Seacat CTD

Confiquration file opened: Nore

Presaure sensor fype

Estemal voltage channels

Firrniare version

0.5 second intervals

NMEA - Select if NMEA navigation device
used, and if NMEA depth data and NMEA time
data were also appended. Seasave adds
current latitude, longitude, and universal time
code to data header; appends NMEA data to
every scan; and writes NMEA data to .nav file
every time Ctrl F7 is pressed or Add to .nav
File is clicked.

Note: Whether NMEA device was connected to
a deck unit or directly to computer during data
acquisition in Seasave has no effect on data
file used by SBE Data Processing, and
therefore has no effect on data processing.
Surface PAR - Select if using with deck unit
connected to Surface PAR sensor. Seasave
appends Surface PAR data to every scan.
Adds 2 channels to Channel/Sensor table.

Do not increase External voltage channels

to reflect this; External voltage channels
reflects only external voltages going

directly to SBE 19 from auxiliary sensors.
See Application Note 47.

Scan time added - Select if Seasave
appended time (seconds since January 1,
1970 GMT) to each data scan.

X

Strain gauge or Digiquartz with
temperature compensation.

7
Strain Gauge /

#

L

See reply from DS. Used to determine strain
gauge pressure sensor data format.

Vewimn’@ j

between samples.

Number of 0.5 second intervals

SBE 19 setup (SR); see reply from DS.

Must agree with

B

v NME# position data added
(¥ NMEA device connected to deck unit

(" NMEA device cannected ta PC

[ NMEA depth data added
[ HES tne added

Shaded sensors
cannot be
removed or
changed to
another type of
sensor. All others

for that channel. A dialog box with a list of sensors appears. Select
sensors after number of voltage channels have been specified above.

7;

Fi/epult...l Help... |

/Exil | Cancel

WV Sutace PR votage added [~ Scan fime added are optional.
il
Charinel Sensor New [New to create new
.con or .xmlcon file
1. Frequency Temperature i el
B T . ..|Open to select
2 Frequency ol Conductivity different .con or
o .xmicon file.
3.4/ V0|t-398 I F'H 79E 1 Save or Save As to
i save current .con or
4 800 vohage1 | Transmizsometer, Chelsea/Seatech/Wetab Gy s | xmicon filesattings.
. Pressure valtage | Pressure, Shrain Gauge
B. SPAR valtage | Unavallable
S PAR e | SPARSuface [nad /3elecl .| |click a sensor
7. SPAR valtage Ltace lIradiance = _|and click Modify
Click a (non-shaded) sensor and click Select to pick a different sensor H ij( to change
Modfy.. calibration

coefficients for
that sensor.

Appendix Ill: Generating .con

Opens a .txt file (for viewing only;
cannot be modified) that shows all
parameters in .con or .xmlcon file. For
command line generation of report, see

.xmlcon File Reports — ConReport.exe.

or

Return to SBE Data Processing window.
If Confirm Configuration Change was selected in

Configure menu - If you made changes and did

not Save or Save As, program asks if you want to

save changes.

If Confirm Configuration Change was not selected

in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
button to exit.
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Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the SBE 19 with

Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SEACAT PROFILER V3.1B SN 936 02/10/94 13:33:23.989

strain gauge pressure sensor: S/N = 12345,

range = 1000 psia, tc = 240

(Pressure sensor (strain gauge or Digiquartz) must match Pressure sensor type in
.con or .xmlcon file.)

clk = 32767.766 iop = 172 vmain = 8.1 vlith = 5.8

mode = PROFILE ncasts = 0
(Mode must be profile [MP] if setting up .con or .xmlcon file for SBE 19; create
.con or .xmlcon file for SBE 16 for SBE 19 in moored mode [MM].)

sample rate = 1 scan every 0.5 seconds
(Sample rate [SR] must match 0.5 second intervals in .con or .xmlcon file.)

minimum raw conductivity frequency for pump turn on =
3206 hertz

pump delay = 40 seconds
samples = 0 free = 174126 lwait = 0 msec
battery cutoff = 7.2 volts

number of voltages sampled = 2
(Number of auxiliary voltage sensors enabled [SVn| must match External voltage
channels in .con or .xmlcon file.)

logdata = NO
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Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with 19plus setup for VoltN=

(N=0, 1, 2,and 3); see reply from
DS. Voltage channel 0 in .con or
.xmlcon file corresponds to first
external voltage in data stream,
voltage channel 1 to second
external voltage in data stream,
etc.

Interval between scans in Moored
mode. Must agree with 19plus
setup (Samplelnterval=); see reply
from DS.

— Sample interval seconds

o NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data
acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.

o Surface PAR - Select if using with
deck unit connected to Surface
PAR sensor. Seasave appends
Surface PAR data to every scan.
Adds 2 channels to
Channel/Sensor table. Do not
increase External voltage channels
to reflect this; External voltage
channels reflects only external
voltages going directly to 19plus
from auxiliary sensors. See
Application Note 47.

e Scan time added - Select if
Seasave appended time (seconds
since January 1, 1970 GMT) to
each data scan.

SBE 19plus Seacat Profiler Configuration

X

Canfiguration file opened: Mone

Strain gauge (only selection
applicable to 19plus).

Pressure sensor bype

i

Strain [auge

Estemnal voltage channels

‘[
d

Must agree with 19plus setup (MP for Profiing
mode, MM for Moored mode); see reply from DS.

tode

Profie <7 |

I

Scans o average 1

Number of samples to average (samples at 4 Hz)
in Profiling mode. Must agree with 19plus setup
(NAvg=); see reply from DS.

[V NME& position data added
{+ NMEA device connected to deck unit [~ HBEL fme added

" NME device connected to PC

[~ NME# depth data added

[™ Sutace PAR voltage added [~ Scan time added

Channel Sersor | New |New fo create new
.con or .xmlcon file
1 Court Temperature Shaded sensors for this CTD.
ol i Al cannot be Elpen Open to select
Conductit removed or - ldifferent .con or
2 Frequenc:y 4 : changed to xmlcon file.
3 Count Frezzure, Shiain Gaugg another type of Save [Save or Save As
sensor. All others et t0 save current
4. &/[ voltage [ Cwpgen, SBE 43 are optional. .con or .xmlcon file
Save bg. settings.
BAD valtage 1 |pH
B A4/0 voltage 2 | Transmissometer, Chelsea/3eatech/wetlab
; Helect, -
7. &0 volage 3 A ltimeter ____|Click a sensor
and click
Click a (non-shaded) sensor and click Select to pick a MEILT.[_,'/ Modify to
—|different sensor for that channel. Dialog box with a list of - change
sensors appears. Select sensors after number of voltage | calibration
— channels have been specified above. coefficients for
that sensor.

Hepn&t... Help... | | Euit

| Cancel

/ [

Opens a .txt file (for viewing only;
cannot be modified) that shows all
parameters in .con or .xmlcon file.
For command line generation of
report, see Appendix Ill:
Generating .con or .xmlcon File
Reports — ConReport.exe.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did not Save
or Save As, program asks if you want to save changes.

o If Confirm Configuration Change was not selected in
Configure menu - Button says Save & Exit. If you do not
want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the 19p/us with

Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SeacatPlus V 1.5 SERIAL NO. 4000 22 May 2005 14:02:13

vbatt = 9.6, vlith = 8.6, ioper = 61.2 ma,
ipump = 25.5 ma, iext0l = 76.2 ma, iext23 = 65.1 ma

status = not logging

number of scans to average = 1
(Scans to average [NAvg=| must match Scans to Average in .con or .xmlcon file.)

samples = 0, free = 381300, casts = 0

mode = profile, minimum cond freq = 3000,

pump delay = 60 sec

(Mode [MP for profile or MM for moored] must match Mode in .con or .xmlcon
file.)

autorun = no, ignore magnetic switch = no
battery type = ALKALINE, battery cutoff = 7.3 volts

pressure sensor = strain gauge, range = 1000.0
(Pressure sensor [PType=|] must match Pressure sensor type in .con or .xmlcon file.)

SBE 38 = no, Gas Tension Device = no
(RS-232 sensors (which are used for custom applications only) must be disabled to
use Seasave.)

Ext Volt 0 = yes, Ext Volt 1 = yes, Ext Volt 2 = yes,

Ext Volt 3 = yes

(Number of external voltage sensors enabled [Volt0= through Volt3=] must match
External voltage channels in .con or .xmlcon file.)

echo commands = yes

output format = raw Hex
(Output format must be set to raw Hex [OutputFormat=0] to acquire data
in Seasave.)
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Channel/Sensor table reflects this
choice (0, 1, 2, 3, 4, 5, or 6). Must
agree with 19plus V2 setup for
VoltN= (N=0, 1, 2, 3, 4, and 5); see
reply from GetCD or DS. Voltage
channel 0 in .con or .xmlcon file
corresponds to first external
voltage in data stream, voltage
channel 1 to second external
voltage in data stream, etc.

Interval between scans in Moored
mode. Must agree with 19plus V2
setup (Samplelnterval=); see reply
from GetCD or DS.

o NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data
acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.

e Surface PAR - Select if using with
deck unit connected to Surface
PAR sensor. Seasave appends
Surface PAR data to every scan.
Adds 2 channels to
Channel/Sensor table. Do not
increase External voltage channels
to reflect this; External voltage
channels reflects only external
voltages going directly to
19plus V2 from auxiliary sensors.
See Application Note 47.

e Scan time added - Select if
Seasave appended time (seconds
since January 1, 1970 GMT) to
each data scan.

SBE 19plus V2 SeaCAT Profiler Configuration

Through the CTD’s RS-232 sensor connector, the SBE 19p/us V2 can interface
with an SBE 38 secondary temperature sensor, SBE 63 Optical Dissolved
oxygen sensor, WET Labs sensor [single, dual, or triple channel ECO;
WETStar; or C-Star], Optode, or up to two Pro-Oceanus Gas Tension Devices
(GTDs). This data is appended to the data stream; SBE 38 data does not replace
the internal 19plus V2 temperature data.

X

Configuration file opened: Mone

Fressure sensor tupe

External vaoltage channels

Mode

Senal B5-232C sensar

I~
Sample interval seconds |1|:|

Scans to average

Strain gauge or Digiquartz with
temperature compensation.

Strain Fauge

E

¢

Must agree with 19plus V2 setup (MP for Profiing mode,
MM for Moored mode); see reply from GetCD or DS.

|Profe” ¥

None, SBE 38 (secondary temperature), SBE 63
Optical DO sensor, WET Labs sensor (up to 3
I_/ channels), up to 2 GTDs (dissolved oxygen or

None nitrogen), or Optode. Must agree with 19plus V2
setup; see reply from GetCD or DS. Channel/Sensor
table lists RS-232 sensors below voltage channels.

—

Number of samples to average (samples at 4 Hz)
in Profiling mode. Must agree with 19plus V2
setup (NAvg=); see reply from GetCD or DS.

¥ MME& position data added

(¢ NMEA device connected ta deck unit

" WMEA device connected to PC

[~ NME& depth data added

™ HHEZ time added

[ Surface PAR valtage added

[~ Sean time added

Charinel Senzar Mew
1. Count Temperature Shaded sensors
i) cannot be removed I:Ipen...
2. Frequency Conductivity or changed to
. another type of .
3. Count Pressure, Strain BaU08 .o cor Al others are | 2 94E
4 &/D voltage 0 | Oxygen, SBE 43 optional.
= i Save g,

B A/D voltage 1

B &/D waoltage 2
7. &/0 voltage 3

pH

Transmizzometer, ChelsealSeatech etlab

Altimeter

Click a (non-shaded) sensor and click Select to pick a
different sensor for that channel. Dialog box with a list of
sensors appears. Select sensors after number of voltage |
channels have been specified above.

New to create new
.con or .xmlcon file
for this CTD.
Open to select
different .con or
.xmlcon file.

Save or Save As
to save current
.con or .xmlcon file
settings.

fdmalifi.. |

Click a sensor
and click
Modify to
change
calibration
coefficients for
that sensor.

Return to SBE Data Processing window.
o |f Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

Opens a .txt file (for viewing only; cannot
be modified) that shows all parameters in
.con or .xmlcon file. For command line
generation of report, see Appendix Ili:
Generating .con or .xmlcon File Reports —
ConReport.exe.

o |f Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Hepnrt...l Help... l

Exit

Cancel
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Shown below is an example status (DS) response in a terminal program that
corresponds to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in the terminal
program to modify the setup of parameters critical to use of the 19plus V2 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SBE 19plus V 2.2 SERIAL NO. 4000 05 Jun 2009 14:02:13

vbatt = 9.6, vlith = 8.6, ioper = 61.2 ma,
ipump = 25.5 ma, iext0l = 76.2 ma, iext2345 = 65.1 ma

status = not logging

number of scans to average = 1
(Scans to average [NAvg=| must match Scans to Average in .con or .xmlcon file.)

samples = 0, free = 4386532, casts = 0

mode = profile, minimum cond freq = 3000,

pump delay = 60 sec

(Mode [MP for profile or MM for moored] must match Mode in .con or .xmlcon
file.)

autorun = no, ilgnore magnetic switch = no
battery type = ALKALINE, battery cutoff = 7.5 volts

pressure sensor = strain gauge, range = 1000.0
(Pressure sensor [PType=] must match Pressure sensor type in .con or .xmlcon file.)

SBE 38 = no, WETLABS = no, OPTODE = no, SBE63 = no,

Gas Tension Device = no

(Selection/enabling of RS-232 sensors [SBE38=, WetLabs=, Optode=, SBE63=,
GTD=, DualGTD=] must match Serial RS-232C sensor in .con or .xmlcon file.)

Ext Volt 0 = yes, Ext Volt 1 = yes,

Ext Volt 2 = yes, Ext Volt 3 yes,

Ext Volt 4 = no, Ext Volt 5 = no

(Number of external voltage sensors enabled [Volt0= through Volt3=] must match
External voltage channels in .con or .xmlcon file.)

echo characters = yes

output format = raw Hex
(Output format must be set to raw Hex [OutputFormat=0] to acquire data
in Seasave.)
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SBE 21 Thermosalinograph Configuration

In July 2009, Sea-Bird updated the SBE 21 electronics and firmware. As a

result, there were some changes in capabilities and in commands.

¢ Firmware version < 5.0 — Depending on serial number, these SBE 21s
may be integrated with an SBE 38 remote temperature sensor (if SBE 21
equipped with 4-pin remote temperature connector) or an SBE 3 remote
temperature sensor (if SBE 21 equipped with 3-pin remote temperature
connector).

e Firmware version > 5.0 — These SBE 21s are compatible with an SBE 38
remote temperature sensor, and are not compatible with an SBE 3 remote
temperature sensor.

Channel/Sensor table reflects this choice (shows RS-232 channel if SBE 38 selected, or additional
frequency-based temperature channel if SBE 3 selected). Must agree with SBE 21 setup (SBE38=
and SBE3=); see reply from DS. If remote temperature is selected, Seasave, Data Conversion, and
Derive use remote temperature data when calculating density and sound velocity.

wrl

Channel/Sensor table reflects this choice.

: T Must agree with SBE 21 setup for SV=x (firmware > 5.0) or

Configuration file opened: None SVx (firmware < 5.0) (x=0, 1, 2, 3, or 4 channels); see reply

from DS. Voltage channel 0 in .con or .xmlcon file
corresponds to sensor wired to channel 0 on end cap

Remate temperature |SEE 3 'l connector, voltage channel 1 corresponds to sensor wired

to channel 1 on end cap connector, etc.

Extenal voltage channels [«

)

Time between scans. Must agree with
SBE 21 setup (SI= for firmware > 5.0 or Sl
for firmware < 5.0); see reply from DS.

NMEA - Select if NMEA
navigation device used, and if
NMEA depth data and NMEA
time data were also appended.

|

Sample interval seconds |5

Seasave adds current latitude, ¥ MME& position data added [~ MME& depth data added
longitude, and universal time | : )
code to data header; appends (¥ MMEA device connected to deck unit [~ HRMEL tre added
NMEA data to every scan; and
writes NMEA data to .nav file (" NME& device connected to PC
every time Ctrl F7 is pressed or
Add to .nav File is clicked. ; - )
. . Select if Seasave appended time (seconds since
Note: NMEA time can only be [ Scantime added — January 1, 1970 GMT) to each data scan.
appended if NMEA device
connected to computer. 1
Note: Whether NMEA device Charnel Sensor | Netw  |New to create new .con
was connected to a deck unit 1. Frequency Temperature or .xmlcon file for this
or directly to computer during —_— o Open... |CTD.
data acquisition in Seasave 2. Frequency Corductivity ~—— 1 Open to select different
has no effect on data file used 5 el pe 9 ... |.conor.xmicon file.
by SBE Data Processing, w Temperature, SEE 3 ﬂ Save or Save As to
and therefore has no effect on 4, 4/0 volage 0 pH G save current .con or
i —_— ave Ag.. i i
data processing. Shaded sensors cannot be removed or changed to xmicon file settings.

another type of sensor. All others are optional.
I

e

Click a (non-shaded) sensor and click Select to pick a different sensor for that I Belest, -
channel. A dialog box with a list of sensors appears. Select sensors after Click a sensor

number of voltage and frequency channels have been specified above. M. :l/ and click Modify

to change
calibration
jepurt... | Help... | Exit | Cancel | coefficients for
- — that sensor.
Opens a .txt file (for viewing only;
cannot be modified) that shows
all parameters in .con or .xmlcon Return to SBE Data Processing window.
file. For command line o If Confirm Configuration Change was selected in

generation of report, see
Appendix Ill: Generating .con or
.xmlcon File Reports —
ConReport.exe.

Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

o If Confirm Configuration Change was not selected

in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
button to exit.
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Note:

The status response shown is for an
SBE 21 with firmware > 5.0. The
response, and the commands used
to change the sample interval and the
number of auxiliary voltage sensors,
differs for older firmware.

Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the SBE 21 with

Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SEACAT THERMOSALINOGRAPH V5.0 SERIAL NO. 4300 07/15/2009
14:23:14

ioper = 50.7 ma, vmain = 11.4, vlith = 8.8

samples = 0, free = 5981649

sample interval = 5 seconds, no. of volts sampled = 1
(Sample interval [SI=] must match Sample interval seconds in .con or .xmlcon file.
Number of auxiliary voltage sensors enabled [SV=] must match External voltage
channels in .con or .xmlcon file.)

sample external SBE 38 temperature sensor
(External temperature sensor [SBE38=] must match Remote temperature in .con or
.xmlcon file, this line appears only if SBE 38 is enabled [SBE38=Y])

output format = SBE21
(Output format must be set to SBE 21 [F1] to acquire data in Seasave.)

start sampling when power on = yes
average data during sample interval = yes
logging data = no

voltage cutoff = 7.5 volts
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Used to determine strain gauge
pressure sensor data format. See
reply from DS.

o NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data
acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.

o Surface PAR - Select if using with
deck unit connected to Surface
PAR sensor. Seasave appends
Surface PAR data to every scan.
Adds 2 channels to
Channel/Sensor table. Do not
increase External voltage channels
to reflect this; External voltage
channels reflects only external
voltages going directly to SBE 25
from auxiliary sensor See
Application Note 47.

e Scan time added - Select if
Seasave appended time (seconds
since January 1, 1970 GMT) to
each data scan.

SBE 25 Sealogger Configuration

Corfiguration file opened: None

~Extemal valtage channels Ig 'rl

I\-’ersinn »= 20 "l

Firrnware wersion

Channel/Sensor table reflects this choice (0 - 7). Must
agree with SBE 25 setup (CC); see reply from DS.
Voltage channel 0 in .con or .xmlcon file corresponds to
first external voltage in data stream, voltage channel 1 to
second external voltage in data stream, etc.

1, 2, 4, or 8 scans/second. Must agree with
SBE 25 setup (CC); see reply from DS.

Feal time data output rate |1 P — v]/

[V NME& posttion data added

¢ NMEA device connected to deck urit

" NMEA device connected to PC

[~ MMEA depth data added

™ HHEL time added

¥ Surface PAR voltage added

™ Scan time added

Charinel Sensar Mew |New to create new .con
T or .xmlcon file for this
1. Frequency Emperature Shaded sensors 0 CTD.
2Fequeney | Conductly |oenpotve emoved | _—Ej0pon foseletdiferen
3. Pressure voltage | Pressure, Stain Gau another type of Saye |Save or Save As to save
e e sensor. All others current .con or .xmlcon
4. AD valtage 0 | Dapgen. SBE 43 {are optional. &y g |ile settings.
| ERRATA

Uhavailable

7. SP&R voltage

Fluorarneter, Chelsea Aqua 3

SPAR /Surface Imadiance

Click a (non-shaded) sensor and click Select
to pick a different sensor for that channel.

A dialog box with a list of sensors appears.
Select sensors after number of voltage
channels have been specified above.

\Hepnrt...l Help... |
\

Select, |

1

Cancel

Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

/EHit
/

Opens a .txt file (for viewing
only; cannot be modified)
that shows all parameters in
.con or .xmicon file.

For command line generation
of report, see Appendix IlI:
Generating .con or

.xmicon File Reports —
ConReport.exe.
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save changes.

button to exit.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to

o If Confirm Configuration Change was not selected
in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
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Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the SBE 25 with

Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SBE 25 CTD V 4.la SN 323 04/26/02 14:02:13

external pressure sensor, range = 5076 psia, tcval = -55
xtal=9437363 clk=32767.107 vmain=10.1 iop=175 vlith=5.6
ncasts=0 samples=0 free = 54980 lwait = 0 msec

o)

stop upcast when CTD ascends 30 $ of full scale pressure
sensor range (2301 counts)

CTD configuration:

number of scans averaged=1l, data stored at 8 scans
per second

real time data transmitted at 1 scans per second
(real-time data transmission [CC|] must match Real time data output rate in
.con or .xmlcon file.)

minimum conductivity frequency for pump turn on = 2950
pump delay = 45 seconds
battery type = ALKALINE

2 external voltages sampled
(Number of auxiliary voltage sensors enabled [CC] must match External voltage
channels in .con or .xmlcon file.)

stored voltage #0 = external voltage 0

stored voltage #1 = external voltage 1
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SBE 25plus Sealogger Configuration

Configuration for the SBE 25plus Sealogger CTD

e XML file — if selected,

selections on Real-
Time Options tab are
grayed out.

o .HEX file - if selected,

selections on Serial
Sensors tab are
grayed out.

Shaded
sensors cannot
be removed or
changed to
another type of
sensor.

e

File, T. C. P. Yaltage Sensars l Serial Sensors ] Real-Time Options ]

Cpen |

e New to create new .xmlcon file for

Save this CTD.

| Save Az I

Configuration file opened: 25plustest <mlcar

Configuration file usage:

f* Process =ML file uploaded from CTD memony

(" Collect real-time data with Seazave and/or process real-time _HEX file

Channel
Frequency
Frequency
Count
.-’-'-._.I’D vaoltage [
&40 voltage 1
ASD woltage 2
A0 voltage 3
.-’-'-._.I’D voltage 4
A/D voltage 5
ASD woltage B
A0 woltage 7

Temperature
Conductivity

Frezzure, Strain Gauge

Cwypgen, SBE 43

pH

| Owidation Freduction Potential

Albimeter

- Fluorometer, \WET Labs ECO-4FLAFL
Fluorometer, '"WET Labs ECO COOM

Free
Free

e Open to select different .xmlcon file.
e Save or Save As to save current
xmlcon file settings.

Click a (non-
shaded) sensor and
click Select to pick
a different sensor
for that channel. A
dialog box with a

If processing .HEX file collected in Seasave, must match settings used in Seasave for real-
time data acquisition. If processing .XML file uploaded from memory, selections of real-time

data from voltage channels have no effect.

Help

\ Report
AN

Sensor ﬂ list of sensors
appears.
Modiy. x|
Click a sensor and
£ click Modify to
change calibration
(] Data from coefficients for that
O checked sensor.
vollage
B channels
[] transmitted in
@ real-time, and
included in
L] hexfile.
O
| / Exit | Cancel
/

\

Opens a .txt file (for viewing
only; cannot be modified)
that shows all parameters in

.con or .xmlcon file.

For command line generation
of report, see Appendix lll:

Generating .con or
.xmlcon File Reports —
ConReport.exe.

VA

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

o If Confirm Configuration Change was not selected
in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
button to exit.
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Note:

This tab is grayed out if you selected
Collect real-time data with Seasave
and/or process real-time .HEX file on
the first tab, because the 25plus does
not transmit real-time serial sensor

If you selected Process . XML file uploaded from CTD memory, click the Serial
Sensors tab.

data.
File, T. C. P, Woltage Senzors  Senal Sensorz | Real-Time Optiohs ]
25plus collected serial sensor data ~Serial port 1
ifSetEnableSer1=Y. Serial sensor data ) ) ) i
was included in CTD .xml data file in {* Serial zenzar data included in CTD =ml data file,
memory if SetinlineSer1=Y. Otherwise, it
was placed in a separate .txt file (which " Seral senzor data in separate .kt file
cannot be processed by SBE Data B ' '
Processing); if in a .txt file, all selections ;
are grayed out. Senial R5-232C senzor ]'W'ET Labs _ﬂ
I : Select serial sensor that is on

- Serial part 2- each serial channel: None,
25plus collected serial sensor data SBE 38. SBE 50 SBE 63. and
ifSetEnableSer2=Y. Serial sensor data * Serial senzar data included in CTD =ml data file, WET Labs Trip|e1t. ’
was included in CTD .xml data file in

memory if SetlnlineSer2=Y. Otherwise, it

was placed in a separate .txt file (which " Serial senzor data in separate but file.
cannot be processed by SBE Data
Processing); if in a .txt file, all selections Senal AS-232C sensor Temperature, SEE 39 _:J

are grayed out.

Ehannel | Se.r!gnr . S elact
_ Modiy.._|

Serial H5-232 Fluarometer, WET Labs WE T star

Serie;l. HS-?QE . Tranzmizzometer, \WET Labs C-Star M odify...
Seral B5-232 Turbidity Meter, WET Labz, ECO-MTU

SIEIri.;I.I.:IE-EEIE - Temperature, SBE 38

Report Help Exit Cancel
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Note: If you selected Collect real-time data with Seasave and/or process real-time

This tab is grayed out if you selected . T .
Process XML file uploaded from CTD .HEX file, click the Real-Time Options tab.

memory on the first tab, because data
is memory is always saved at 16 Hz,
and NMEA, Surface PAR, and scan
time data is not available in an
uploaded file.

Configuration for the SBE 25plus Sealogger CTD

File, T. C. P. Waltage Sensors ] Serial Senzarz  Real-Time Options

Select if deck unit used, and select £ Nodeck unit

baud rate at which CTD was set to * SEE 32 ar SBE 36 deck unit
communicate.

CTD baud rate [SetBaudConzale=] | FTyy]

Real-time data output rate iz calculated by the 25plus, bazed on number of
voltages exported, CTD baud rate, and [if CTD baud rate iz 4800), histonic rate.

Must agree with SetHistoricRate= in

I.'H I I = - -H =
25plus. See reply from GetCD. * Histonic rate = 0; Realtime data output rate = 2 Hz or 4 Hz

" Histaric rate = 1; Bealtime data output rate = 4 Hz ar 8 Hz

NMEA - Select if NMEA navigation device

used, and whether NMEA device is v MMEX position data added [ MMEA depth data added
connected directly to Deck Unit or to
computer. You can also append NMEA v MMEA device connected to deck unit il
depth data (3 bytes) and NMEA time data
(4 bytes) after Lat/Lon data. Seasave " MMEA device connected to PC
adds current latitude, longitude, and
universal time code to data header; ; Select if Seasave
appends NMEA data to every scan; and I Suface PAR voltage addec\ I Seantime added appended time
writes NMEA data to .nav file every time ; (seconds since
Ctrl F7 is pressed or Add to .nav File is Configure SPAR Sernsar... | Select if using with deck January 1, 1970
clicked. Note: Whether NMEA device was — L unit connected to Surface GMT) to each
connected to a deck unit or directly to Enter/verify calibration PAR sensor. Seasave data scan.
computer during data acquisition in coefficients for Surface PAR appends Surface PAR
Seasave has no effect on data file used sensor. See Application Note 47. data to every scan.
by SBE Data Processing, and therefore
has no effect on data processing.

P 9 Report Help Exit Cancel
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Shown below is an example status (GetCD) response in Seaterm232 that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in Seaterm 232
to modify the setup of parameters critical to use of the SBE 25plus with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

S>getcd
<ConfigurationData DeviceType='SBE25plus' SerialNumber='0250003"'>
<Serial>
<SerialPort0>
<baudconsole>4800</baudconsole>
<echoconsole>1</echoconsole>
</SerialPort0>
<SerialPortl>
(serial sensor 1 setup data)
</SerialPortl>
<SerialPort2>
(serial sensor 2 setup data)
</SerialPort2>
</Serial>
<Settings>
(assorted settings)
</Settings>
<RealTimeOutput>
<outputformat>0</outputformat>
<historicrate>l</historicrate>
<vout0>1</vout0>
<voutl>0</voutl>
<vout2>0</vout2>
<vout3>1</vout3>
<vout4>0</voutd>
<vout5>1</vout5>
<vout6>0</vout6>
<vout7>0</vout7>
<outputrate>2</outputrate>
</RealTimeOutput>
</ConfigurationData>
<Executed/>
(Number of auxiliary voltage sensors enabled [SetVOut#=] must match real-time
output selection in .xmlcon file.)

46



Manual revision 7.23.2

Section 4: Configuring Instrument (Configure)

SBE Data Processing

Notes:

e The SBE 37 is available with an
RS-232, Inductive Modem (IM
series), or RS-485 interface. All
commands to a particular 37 with IM

SBE 37 MicroCAT C-T Recorder Configuration

The .xmlcon file for the SBE 37 is created by SeatermV?2 (version 1.1 and later)
when you upload data from the SBE 37. Note that you cannot save the SBE 37
configuration as a .con file.

or RS-485 interface are preceded by
#ii, where ii = instrument ID

(0-99). Therefore, commands
mentioned in the dialog box
description below have a slightly
different form for these versions
(#iiGetCD, #iiDS, #iiDC, etc.).

o Commands shown here are for the
current SBE 37 firmware versions.
See the appropriate SBE 37 manual
for commands for your instrument.

Indicates if SBE 37 includes
optional pressure sensor. Must
agree with factory setup; see reply
from DC (display calibration

Configuration for the SBE 37 Microcat

Configuration file opened: None

Time between scans. Must agree with
SBE 37 setup (Samplelnterval=); see
reply from GetCD or DS. For 37-SI, SIP,
and SIP-IDO, see note below.

coefficients); if pressure sensor is

included, response includes
pressure sensor coefficients.

If no pressure sensor included,
additional field for deployment
pressure is used to calculate
conductivity (and derived
variables such as salinity and
sound velocity). Value shown is
based on ReferencePressure=
that was programmed into

SBE 37; you can change this
value in .xmlicon file, if you have
updated deployment depth
information.

Sample interval seconds g0
— Pressure sensor

i Owygen senscr  |cpE £1 —

Deployment pressure dbar

Deployment |atitude

[ Uze deployment latitude in depth calculations

Indicates if SBE 37 includes integrated

reply from GetCC or DS.

dissolved oxygen sensor and type of sensor
(IDOs use SBE 43; ODOs use SBE 63); see

Latitude is needed to calculate local gravity,
used in calculation of salt water depth. If
enabled, software uses input latitude in salt
water depth calculation. If disabled, software

ruses Latitude on Miscellaneous tab of Data

Conversion or Derive in salt water depth
calculation.

.xmicon file for this CTD.
Open. Open to select different

.con or .xmicon file.

Save or Save As to save

New to create new .con or

current .con or .xmlcon file

click Modify to

sensor.

Click a sensor and

change calibration
coefficients for that

Chaninel Senzar New [ I
1. Count Temperature
2. Frequency Conductivity
3 Serial B5-232 (xpgen, SBE 63
Save bz |settings.
bodify...
/Hepnrl... | Help... | / E wit ‘ Cancel |
/ /
VA

/
Opens a .txt file (for viewing only; cannot
be modified) that shows all parameters in
.con or .xmlcon file. For command line
generation of report, see Appendix Ill:
Generating .con or .xmlcon File Reports —
ConReport.exe.

Return to SBE Data Processing window.

o |f Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Note:

For 37-Sl, SIP: Sample interval seconds in the .xmlcon file is based on:
¢ |If SampleMode=2: Sampleinterval=

¢ |f SampleMode=3:

Firmware < 4.0 - 1 sec if SBE 37 has no pressure sensor, 1.5 sec if SBE 37 has pressure sensor
Firmware > 4.0 — 0.9 sec if SBE 37 has no pressure sensor, 1.3 sec if SBE 37 has pressure sensor
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Shown below is an example status (DS) response in a terminal program for a
SBE 37-SMP-IDO with standard RS-232 interface that corresponds to the setup
shown in the Configuration dialog box above. Shown below the appropriate
lines are the commands used in the terminal program to modify the setup of
parameters critical processing of to SBE 37-SMP-IDO data with SBE Data
Processing, as well as any explanatory information.

SBE37SMP-0DO-232 1.0 SERIAL NO. 12345 20 Sep 2012 00:48:50
(‘IDO’ indicates MicroCAT includes integrated oxygen sensor; must match oxygen
sensor enable/disable in .xmlcon file.)

vMain = 13.31, vLith = 3.19

samplenumber = 1728, free = 522560

not logging, stop command

sample interval = 60 seconds

(Sample interval [Samplelnterval=] must match Sample interval seconds in .xmlcon file.)
data format = converted engineering

transmit real-time data = yes

sync mode = no

minimum conductivity frequency = 3000.0

adaptive pump control enabled

If no pressure sensor is installed, a line in the DS response provides user-input
reference pressure information; if the pressure sensor is installed, that line is
missing (as shown in the above example response). This must match the
pressure sensor enable/disable in the .xmlcon file.
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SBE 45 MicroTSG Configuration

The SBE 45 transmits ASCII converted data in engineering units. It converts
the raw data internally to engineering units, based on the programmed
calibration coefficients. See the SBE 45 manual.

stream:
(OutputCond=).
with SBE 45 setup

(OutputSal=).

setup (OutputSV=).

Define data in SBE 45 data

e Output salinity — Must agree

1 1

1 1

¢ Output sound velocity — ! '
Must agree with SBE 45 [~ Output salinity : ¥ SBE38 temperature added!

| |

1 1

See reply from DS for setup [ Output zound velocity
programmed into SBE 45.

wil

Time between scans. Must agree with SBE 45
e Output conductivity - Must Configuration file opened: Naone setup (Interval=); see reply from DS.
agree with SBE 45 setup

Sample interval seconds |1

1
V¥ Output conductivity ¥ Use junction box

v MME# data added

_______________________

Opens a .txt file (for
viewing only; cannot
be modified) that
shows all parameters
in .con or .xmlcon file.
For command line
generation of report,
see Appendix Ill:
Generating .con or
.xmlicon File Reports
— ConReport.exe.

Mews |New to create new .con
or .xmlcon file for this
CTD.

_1 Open to select different
_|-conor .xmlcon file.
—|Save or Save As to save
current .con or .xmlcon
file settings.

Cancel |

/Flepcurt... | Help... | i E wit \I

e Use junction box - Select if SBE 45 data is transmitted to computer
through optional 90402 — SBE 45 Interface Box. Interface Box can
append optional SBE 38 and NMEA data to SBE 45 data stream.

o SBE 38 temperature added — Select if 90402 — SBE 45 Interface
Box is connected to SBE 38 remote temperature sensor. Seasave
appends SBE 38 data to data stream. Seasave, Data Conversion,
and Derive use remote temperature data when calculating density
and sound velocity.

e NMEA data added - Select if 90402 — SBE 45 Interface Box is

connected to NMEA navigation device. Seasave adds current latitude,
longitude, and universal time code to data header; appends NMEA
data to every scan; and writes NMEA data to .nav file every time Ctrl
F7 is pressed or Add to .nav File is clicked.

Return to SBE Data Processing

window.

o |f Confirm Configuration Change
was selected in Configure menu -
If you made changes and did not
Save or Save As, program asks if
you want to save changes.

o If Confirm Configuration Change
was not selected in Configure
menu - Button says Save & Exit.
If you do not want to save
changes, use Cancel button to
exit.

Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the SBE 45 with

Seasave and processing of data with SBE Data Processing, as well as any

explanatory information.

SBE45 V 1.1 SERIAL NO. 1258
logging data

sample interval = 1 seconds

(Sample interval [Interval=] must match Sample interval seconds in .con or .xmlcon

file.)

output conductivity with each sample
(Enabling of conductivity output [OutputCond=] must match OQutput conductivity

in .con or .xmlcon file.)

do not output salinity with each sample
(Enabling of salinity output [OutputSal=] must match Qutput salinity in

.con or .xmlcon file.)

do not output sound velocity with each sample
(Enabling of sound velocity output [OutputSV=| must match Output sound velocity

in .con or .xmlcon file.)

start sampling when power on

do not power off after taking a single sample
(Power off after taking a single sample must be disabled [SingleSample=N] to

acquire data in Seasave.)

do not power off after two minutes of inactivity

A/D cycles to average = 2
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SBE 49 FastCAT Configuration

« NMEA - Select if NMEA navigation | Mt i X

device used, and if NMEA depth data . o
and NMEA time data were also Canfiguration file opened: None

appended. Seasave adds current Number of samples to average per scan. SBE 49 samples at 16 Hz

latitude, longitude, and universal time Scans to average |1 —1(0.0625 seconds), averages data, and transmits averaged data real-
code to data header; appends NMEA time. Must agree with SBE 49 setup (NAvg=); see reply from DS.

ot iy e ot P2 | |7 NMEA posiion data added T NMEA depth dats added

pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data acquisition

" NME& device connected to deck unit [ NMEA time added
{+ NME& device connected to PC

in Seasave has no effect on data file [ Surface PAR volkage added
used by SBE Data Processing, and
therefore has no effect on data [~ Sean bime added
processing. New to create new .con
o Surface PAR - Select if used with or .xmlcon file for this
deck unit connected to Surface PAR Channel Sensor New |cTD.
sensor. Seasave appends Surface 1. Count Open Open to select different
PAR data to every scan. Adds 2 e -|.con or .xmilcon file.
channels to Channel/Sensor table. M Conductivy : Save or Save As to
See Application Note 47. 3. Count Pressure, Strain Gauge 3%l save current .con or
e Scan time - Select if Seasave xmlcon file settings.
appended time (seconds since — Save i
January 1, 1970 GMT) to each data — |

Click a sensor and
scan. 5
ity | click Modify to
change calibration
| coefficients for that

| Hepnrt/ | Help... | Exit | Cancel | censor.
L

Opens a .txt file (for viewing Return to SBE Data Processing window.
only; cannot be modified) that | e If Confirm Configuration Change was selected in Configure
shows all parameters in .con menu - If you made changes and did not Save or Save As,
or .xmlcon file. For command program asks if you want to save changes.
line generation of report, see | |e If Confirm Configuration Change was not selected in
Appendix Ill: Generating .con Configure menu - Button says Save & Exit. If you do not
or .xmlcon File Reports — want to save changes, use Cancel button to exit.
ConReport.exe.

Shown below is an example status (DS) response in Seaterm that corresponds
to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm

to modify the setup of parameters critical to use of the SBE 49 with

Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SBE 49 FastCAT V 1.2 SERIAL NO. 0055

number of scans to average = 1
(Scans to average [NAvg=| must match Scans to average in .con or .xmlcon file.)

pressure sensor = strain gauge, range = 1000.0
minimum cond freq = 3000, pump delay = 30 sec
start sampling on power up = yes

output format = raw HEX
(Output format must be set to raw Hex [OutputFormat=0] to acquire data
in Seasave.)

temperature advance = 0.0625 seconds
celltm alpha = 0.03
celltm tau = 7.0

real-time temperature and conductivity correction disabled
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Select if GPCTD is
integrated with optional
SBE 43F Dissolved
Oxygen sensor.

Must agree with
GPCTD setup
(Oxygenlnstalled=);
see reply from DS.

SBE Glider Payload CTD Configuration

Configuration for the SBE Glider Payload CTD

I~

Configuration file opened: Mone
Sample interval seconds

Iv Oxygen sensor

2. Freguency
2. Count
4 Frequerjn:y

Number of seconds between
samples. Must agree with GPCTD

’1*/ setup (Interval=); see reply from DS.

Channel Senzar Mew |New to create new
: 7 T ! xmlcon file for this CTD.
1. Count il Open to select different

ﬁ .xmlcon file.

Save or Save As to
save current .xmlcon file
settings.

Conductivity

Frezzure, Strain Gauge
Oxpgen, SBE 43F

Save bz, I

Click a sensor and
click Modify to change
calibration coefficients

Ml:lljif_lrl_:__ for that sensor.

E wit | Cancel |

F!/Bpu:urt... | Help...
/

/

Opens a .txt file (for viewing only;
cannot be modified) that shows all
parameters in .con or .xmlcon file. For
command line generation of report, see
Appendix Ill: Generating .con or
.xmlcon File Reports — ConReport.exe.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in Configure
menu - If you made changes and did not Save or Save As,
program asks if you want to save changes.

o If Confirm Configuration Change was not selected in
Configure menu - Button says Save & Exit. If you do not
want to save changes, use Cancel button to exit.

Shown below is an example status (DS) response in Seaterm232 that
corresponds to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in Seaterm232

to modify the setup of parameters critical to processing of Glider Payload CTD
data with SBE Data Processing, as well as any explanatory information.
SERIAL NO. 12345

SBE Glider Payload CTD 1.0 27 Apr 2010 09:38:22

vMain = 9.37, vLith = 3.04
autorun = no
samplenumber = 57, free = 559183, profiles = 3

not logging

sample every 1 seconds
(must match Sample interval seconds in .xmlcon file.)

sample mode is continuous

data format = raw Decimal

do not force on RS232 transmitter
transmit real time data

acquire SBE 43 oxygen
(must match Oxygen sensor installed in .xmlcon file.)

minimum conductivity frequency = 3011.0

custom pump mode disabled
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Accessing Calibration Coefficients Dialog Boxes

In the Configure menu, select the desired instrument.

In the Configuration dialog box, click Open. Browse to the desired .con or
.xmlcon file and click Open.

3. Inthe Configuration dialog box, click a sensor and click Modify to change
the calibration coefficients for that sensor (or right click on the sensor and

select Modify . . Calibration, or double click on the sensor); the calibration
coefficients dialog box for the sensor appears (example is shown for a

pH sensor).

R x|

Serial number ||

N —

Calibration date |

Slope {0.0000

Dffset Ig_gggg

Import | Export Il oK I Cancel |

Importing and Exporting Calibration Coefficients

Calibration coefficient dialog boxes contain Import and Export buttons, which
can be used to simplify entering calibration coefficients. These buttons are
particularly useful when swapping sensors from one instrument to another,
allowing you to enter calibration coefficients without the need for typing or the
resulting possibility of typographical errors. An example dialog box is shown
above for a pH sensor.

The Export button allows you to export coefficients for the selected sensor to
an . XML file. If you move that sensor onto another instrument, you can then
import the coefficients from the . XML file when setting up the .con or .xmlcon
configuration file for that instrument.

The Import button allows you to import coefficients for the selected sensor
from another .con or .xmlcon file or from an . XML file. When you click the
Import button, a dialog box appears. Select the desired file type, and then
browse to and select the file:

e .con or .xmlcon configuration file — opens a .con or .xmlcon file,
retrieves the calibration coefficients from the file for the type of sensor you
selected, and enters the coefficients in the calibration coefficients dialog
box. If the .con or .xmlcon file contains more than one of that type of
sensor (for example, SBE Data Processing can process data for an
instrument interfacing with up to two SBE 43 oxygen sensors, so the .con
or .xmlcon file could contain coefficients for two SBE 43 sensors), a dialog
box allows you to select the desired sensor by serial number. If the .con or
xmlcon file does not contain any of that type of sensor, SBE Data
Processing responds with an error message.

e XML file — imports an . XML file that contains calibration coefficients for
one sensor. If the . XML file you select is not compatible with the selected
sensor type, SBE Data Processing responds with an error message.
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Calibration Coefficients for Frequency Sensors

Notes:

¢ Coefficients g, h, i, j, and fO
provide ITS-90 (Tgo)
temperature; a, b, c, d, and fO
provide IPTS-68 (Tes)
temperature. The relationship
between them is:

Teg =1.00024 Tgo

e See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird.

e See Calibration Coefficients for
A/D Count Sensors below for
information on temperature
sensors used in the
SBE 16plus (and -IM),
16plus (and -IM) V2, 19plus,
19plus V2, 37, and 49.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box. For
all calibration dialog boxes, enter the sensor serial number and calibration date.
Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor.
Temperature, conductivity, and Digiquartz pressure sensors are covered first,
followed by the remaining frequency sensor types in alphabetical order.

Temperature Calibration Coefficients

Enter g, h, i, j (or a, b, c, d), and 0 from the calibration sheet.
Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for temperature sensor drift between calibrations:

Corrected temperature = (slope * computed temperature) + offset

where

slope = true temperature span / instrument temperature span

offset = (true temperature — instrument reading) * slope; measured at 0 °C

Temperature Slope and Offset Correction Example

At true temperature = 0.0 °C, instrument reading = 0.0015 °C
At true temperature = 25.0 °C, instrument reading = 25.0005 °C
Calculating the slope and offset:

Slope = (25.0 — 0.0) / (25.0005 — 0.0015) = + 1.000040002
Offset = (0.0 — 0.0015) * 1.000040002 = - 0.001500060

Sea-Bird temperature sensors usually drift by changing offset, typically
resulting in higher temperature readings over time for sensors with serial
number less than 1050 and lower temperature readings over time for sensors
with serial number greater than 1050. Sea-Bird’s data indicates that the drift is
smooth and uniform with time, allowing users to make very accurate
corrections based only on pre- and post-cruise laboratory calibrations.
Calibration checks at sea are advisable to ensure against sensor malfunction;
however, data from reversing thermometers is rarely accurate enough to make
calibration corrections that are better than those possible from shore-based
laboratory calibrations.

Sea-Bird temperature sensors rarely exhibit span errors larger than £ 0.005 °C
over the range —5 to +35 °C (0.005 °C/(35 -[-5])C/year = 0.000125 °C/C/year),
even after years of drift. A span error that increases more than

1 0.0002 °C/C/year may be a symptom of sensor malfunction.
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Note:

Use coefficients g, h, i, j, Ctcor,
and Cpcor (if available on
calibration sheet) for most
accurate results; conductivity for
older sensors was calculated

based on a, b, ¢, d, m, and Cpcor.

Note:

See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird or from
salinity bottle samples taken at
sea during profiling.

Note:

See Application Note 94 for
information on wide-range
calibrations.

Conductivity Calibration Coefficients

Enter g, h, 1, j, Ctcor (or a, b, ¢, d, m) and Cpcor from the calibration sheet.

e  Cpcor makes a correction for the highly consistent change in dimensions of
the conductivity cell under pressure. The default is the compressibility
coefficient for borosilicate glass (-9.57e-08). Some sensors fabricated
between 1992 and 1995 (serial numbers between 1100 and 1500) exhibit a
compression that is slightly less than pure borosilicate glass. For these
sensors, the (hermetic) epoxy jacket on the glass cell is unintentionally
strong, creating a composite pressure effect of borosilicate and epoxy.

For sensors tested to date, this composite pressure coefficient ranges from -
9.57¢-08 to -6.90e-08, with the latter value producing a correction to deep
ocean salinity of 0.0057 PSU in 5000 dbars pressure (approximately

0.001 PSU per 1000 dbars).

Before modifying Cpcor, confirm that the sensor behaves differently from
pure borosilicate glass. Sea-Bird can test your cell and calculate Cpcor.
Alternatively, test the cell by comparing computed salinity to the salinity
of water samples from a range of depths, calculated using an AutoSal.

Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for conductivity sensor drift between calibrations:

Corrected conductivity = (slope * computed conductivity) + offset

where

slope = true conductivity span / instrument conductivity span

offset = (true conductivity — instrument reading) * slope; measured at 0 S/m

Conductivity Slope and Offset Correction Example

At true conductivity = 0.0 S/m, instrument reading = -0.00007 S/m
At true conductivity = 3.5 S/m, instrument reading = 3.49965 S/m
Calculating the slope and offset:

Slope = (3.5 — 0.0) / (3.49965 - [- 0.00007]) =+ 1.000080006
Offset = (0.0 - [-0.00007]) * 1.000080006 = + 0.000070006

The sensor usually drifts by changing span (slope of the calibration curve),
typically resulting in lower conductivity readings over time. Offset error

(error at 0 S/m) is usually due to electronics drift, and is typically less than
+0.0001 S/m per year. Because offsets greater than + 0.0002 S/m are a
symptom of sensor malfunction, Sea-Bird recommends that drift corrections be
made by assuming no offset error, unless there is strong evidence to the
contrary or a special need.

Wide-Range Conductivity Sensors

A wide-range conductivity sensor has been modified to provide conductivity
readings over a wider range by inserting a precision resistor in series with the
conductivity cell. Therefore, the equation used to fit the calibration data is
different from the standard equation. The sensor’s documentation includes the
equation as well as the cell constant and series resistance to be entered in the
program.

If the conductivity sensor serial number on the conductivity calibration sheet

includes a w (an indication that it is a wide-range sensor; for example, 4216w):

1. After you enter the calibration coefficients and click OK, the Wide Range
Conductivity dialog box appears.

2. Enter the cell constant and series resistance (from the instrument’s
documentation) in the dialog box, and click OK.
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Note:

See Calibration Coefficients for
A/D Count Sensors below for
information on strain gauge
pressure sensors used on the
SBE 16plus (and -IM),

16plus (and -IM) V2, 19plus,
19plus V2, and 49.

See Calibration Coefficients for
Voltage Sensors below for
information on strain gauge
pressure sensors used on
other instruments.

Pressure (Paroscientific Digiquartz) Calibration Coefficients

Enter the sets of C, D, and T coefficients from the calibration sheet. Enter zero

for any higher-order coefficients that are not listed on the calibration sheet.

Enter values for slope (default = 1.0; do not change unless sensor has been

recalibrated) and offset (default = 0.0) to make small corrections for

sensor drift.

e For the SBE 9plus, also enter AD590M and AD590B coefficients from the
configuration sheet.

Oxygen (SBE 43Il) Calibration Coefficients

The SBE 431 is the Integrated Dissolved Oxygen sensor used on the SBE 37
(37-SMP-IDO, 37-IMP-IDO, and 37-SIP-IDO). The calibration coefficients for
this sensor are as described for the SBE 43 voltage sensor (see Calculation
Coefficients for Voltage Sensors below).

Bottles Closed (HB - IOW) Calibration Coefficients

No calibration coefficients are entered for this parameter.

The number of bottles closed is calculated by Data Conversion

based on frequency range.

Sound Velocity (IOW) Calibration Coefficients

Enter coefficients a0, al, and a2.
Value = a0 + al * frequency + a2 * frequency *
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Calibration Coefficients for A/D Count Sensors

Notes:

¢ These coefficients provide
ITS-90 (Tgo) temperature.

e See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird.

Note:

See Calibration Coefficients for
Voltage Sensors below for
information on strain gauge
pressure sensors used on other
instruments. See Calibration
Coefficients for Frequency
Sensors above for information
on Paroscientific Digiquartz
pressure sensors.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box. For
all calibration dialog boxes, enter the sensor serial number and calibration date.
Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor:
temperature and strain gauge pressure sensor.

Temperature Calibration Coefficients

For SBE 16plus (and -IM), 16plus (and-IM) V2, 19plus, 19plus V2, 37, and 49:
Enter a0, al, a2, and a3 from the calibration sheet.
Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for temperature sensor drift between calibrations:

Corrected temperature = (slope * computed temperature) + offset

where

slope = true temperature span / instrument temperature span

offset = (true temperature — instrument reading) * slope; measured at 0 °C

Temperature Slope and Offset Correction Example

At true temperature = 0.0 °C, instrument reading = 0.0015 °C
At true temperature = 25.0 °C, instrument reading = 25.0005 °C
Calculating the slope and offset:

Slope = (25.0 — 0.0) / (25.0005 — 0.0015) = + 1.000040002
Offset = (0.0 — 0.0015) * 1.000040002 = - 0.001500060

Sea-Bird temperature sensors usually drift by changing offset, typically
resulting in lower temperature readings over time. Sea-Bird’s data indicates that
the drift is smooth and uniform with time, allowing users to make very accurate
corrections based only on pre- and post-cruise laboratory calibrations.
Calibration checks at sea are advisable to ensure against sensor malfunction;
however, data from reversing thermometers is rarely accurate enough to make
calibration corrections that are better than those possible from shore-based
laboratory calibrations.

Sea-Bird temperature sensors rarely exhibit span errors larger than £ 0.005 °C
over the range —5 to +35 °C (0.005 °C/(35 -[-5])C/year = 0.000125 °C/C/year),
even after years of drift. A span error that increases more than

1 0.0002 °C/C/year may be a symptom of sensor malfunction.

Pressure (Strain Gauge) Calibration Coefficients

For SBE 16plus (and -IM), 16plus (and IM) V2, 19plus, and 19plus V2
configured with a strain gauge pressure sensor, and for all SBE 37s and 49s:
Enter pAO, pAl, pA2, ptempAO, ptempAl, ptempA2, pTCAO, pTCAL, pTCA2,
pTCBO, pTCB1, and pTCB2 from the calibration sheet. Offset is normally zero,
but may be changed for non-zero sea-surface condition. For example, if the in-
air pressure reading is negative, enter an equal positive value.
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Calibration Coefficients for Voltage Sensors

Note:

Unless noted otherwise, SBE Data
Processing supports only one of each
auxiliary sensor model on a CTD (for
example, you cannot specify two
Chelsea Minitracka fluorometers, but
you can specify a Chelsea Minitracka
and a Chelsea UV Aquatracka
fluorometer. See the sensor
descriptions below for those sensors
that SBE Data Processing supports
in a redundant configuration (two or
more of the same model interfacing
with the CTD).

Note:

See Calibration Coefficients for A/D
Count Sensors above for information
on strain gauge pressure sensors
used on the SBE 16plus (and -IM),
16plus (and -IM) V2, 19plus,

19plus V2, and 49.

See Calibration Coefficients for
Frequency Sensors above for
information on Paroscientific
Digiquartz pressure sensors.

Note:

In Seasave, enter the altimeter
alarm set point, alarm hysteresis,
and minimum pressure to enable
alarm.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box. For
all calibration dialog boxes, enter the sensor serial number and calibration date.
Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor. Strain
gauge pressure sensors are covered first, followed by the remaining voltage
sensor types in alphabetical order.

Pressure (Strain Gauge) Calibration Coefficients

Enter coefficients:
e  Pressure sensor without temperature compensation

> Enter AO, Al, and A2 coefficients from the calibration sheet

»  For older units with a linear fit pressure calibration, enter M (A1) and
B (A0) from the calibration sheet, and set A2 to zero.

» For all units, offset is normally zero, but may be changed for non-zero
sea-surface condition. For example, if the in-air pressure reading is
negative, enter an equal positive value.

e  Pressure sensor with temperature compensation

Enter ptempAO0, ptempA 1, ptempA2, pTCAO, pTCA1, pTCA2, pTCBO,

pTCBI1, pTCB2, pAO, pAl, and pA2 from the calibration sheet.

Altimeter Calibration Coefficients

Enter the scale factor and offset.

altimeter height = [300 * voltage / scale factor] + offset

where

scale factor = full scale voltage * 300/full scale range

full scale range is dependent on the sensor (e.g., 50m, 100m, etc.)
full scale voltage is from calibration sheet (typically 5V)

Fluorometer Calibration Coefficients

e Biospherical Natural Fluorometer
Enter Cfn (natural fluorescence calibration coefficient), A1, A2, and B
from calibration sheet.
natural fluorescence Fn = Cfn * 10V
production = A1 * Fn/ (A2 + PAR)
chlorophyll concentration Chl = Fn /(B * PAR)
where
V is voltage from natural fluorescence sensor
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Note:

See Application Note 39 for complete
description of calculation of Chelsea
Aqua 3 calibration coefficients.

Note:

See Application Note 61 for complete
description of calculation of Chelsea
Minitracka calibration coefficients.

Chelsea Aqua 3

Enter VB, V1, Vacetone, slope, offset, and SF.

Concentration (pg/l) = slope*[(10.0(V/SF) - 10.0VB)/(10.0V! - 10.(0Vacetone)]
+ offset

where

VB, V1, and Vacetone are from calibration sheet

Slope (default 1.0) and offset (default 0.0) adjust readings to conform to

measured concentrations

Scale factor SF = 1.0 if CTD gain is 1; SF =2 if CTD gain is 2.0

V is output voltage measured by CTD

Note: SBE Data Processing can process data for an instrument interfacing

with up to two Chelsea Aqua 3 fluorometers.

Chelsea Aqua 3 Example - Calculation of Slope and Offset
Current slope = 1.0 and offset = 0.0
Two in-situ samples:
Sample 1 Concentration—
from SBE Data Processing = 0.390, from water sample = 0.450
Sample 2 Concentration—
from SBE Data Processing = 0.028, from water sample = 0.020
Linear regression to this data yields slope = 1.188 and offset = - 0.013

Chelsea Minitracka

Enter Vacetone, Vacetonel00, and offset.

Concentration = (100 *[V - Vacetone]/[Vacetone100 - Vacetone]) + offset
where

Vacetone (voltage with 0 pg/l chlorophyll) and Vacetonel00 (voltage with
100 pg/l chlorophyll) are from calibration sheet

Chelsea UV Aquatracka

Enter A and B.

Concentration (ug/l) = A * 10.0V - B

where

A and B are from calibration sheet

V is output voltage measured by CTD

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Chelsea UV Aquatracka fluorometers.

Dr Haardt Fluorometer - Chlorophyll a, Phycoerythrin, or
Yellow Substance
Enter AO, Al, B0, and B1.
These instruments may have automatic switching between high and low
gains. Select the gain range switch:
»  Output Voltage Level if the instrument indicates gain by output voltage
level (< 2.5 volts is low gain, > 2.5 volts is high gain)
Low gain: value = A0 + (Al * V)
High gain: value = B0 + (B1 * V)
»  Modulo Bit if the instrument has control lines custom-wired to bits in
the SBE 9plus modulo word
Bit not set: value = A0 + (A1 * V)
Bit set: value = B0 + (B1 * V)
»  None if the instrument does not change gain
value = A0 + (Al *V)
where
V = voltage from sensor

Dr Haardt Voltage Level Switching Examples

Example: Chlorophyll a

Low range scale= 10 mg/l and Gain= 10/2.5 =4 mg/l/volt
A0=0.0 Al1=4.0

High range scale =100 mg/l and Gain = 100/2.5 =40 mg/l/volt
B0 =-100 B1=40.0
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Note:

See Application Note 54 for complete
description of calculation of Seapoint
fluorometer calibration coefficients.

Note:

See Application Note 77 for complete
description of calculation of Seapoint
ultraviolet fluorometer calibration
coefficients.

Notes:

e See Application Note 9 for
complete description of calculation
of WET Labs FLF and Sea Tech
fluorometer calibration coefficients.

e Offset and scale factor may be
adjusted to fit a linear regression of
fluorometer responses to known
chlorophyll a concentrations.

Seapoint

Enter gain and offset.

Concentration = (V * 30/gain) + offset

where

Gain is dependent on cable used (see cable drawing, pins 5 and 6)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seapoint fluorometers.

Seapoint Rhodamine

Enter gain and offset.

Concentration = (V * 30/gain) + offset

where

Gain is dependent on cable used (see cable drawing, pins 5 and 6)

Seapoint Ultraviolet

Enter range and offset.

Concentration = (V * range / 5) + offset

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seapoint ultraviolet fluorometers.

Sea Tech and WET Labs Flash Lamp Fluorometer (FLF)
Enter scale factor and offset.

Concentration = (voltage * scale factor / 5) + offset

where

Scale factor is dependent on fluorometer range:

Switch-Selectable Range Scale
Fluorometer . 3 . . Factor
(milligrams/m- or micrograms/liter)
0-3 3
0 — 10 (default) 10
0-30 30
Sea Tech 0-100 100
0-300 300
0-1000 1000
0-100 100
WEFTLIFJabS 0— 300 (default) 300
0 - 1000 1000

Offset is calculated by measuring voltage output when the light sensor is
completely blocked from the strobe light with an opaque substance

such as heavy black rubber:

offset = - (scale factor * voltage) / 5

Turner 10-005

This sensor requires two channels - one for the fluorescence voltage and
the other for the range voltage. Make sure to select both when configuring
the instrument.

For the fluorescence voltage channel, enter scale factor and offset.
concentration = [fluorescence voltage * scale factor / (range * 5)] + offset
where

range is defined in the following table

Range Voltage Range
< 0.2 volts 1.0
>0.2volts and <0.55 volts 3.16
>0.55volts and < 0.85 volts 10.0
> (.85 volts 31.0
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Note:

See Application Note 74 for complete
description of calculation of Turner
Cyclops fluorometer calibration
coefficients.

Notes:

e To enable entry of the mx, my,
and b coefficients, you must
first select the Turner SCUFA
(OBS/Nephelometer/Turbidity).

o See Application Note 63 for
complete description of calculation
of Turner SCUFA calibration
coefficients.

Turner 10-AU-005

Enter full scale voltage, zero point concentration, and full scale
concentration from the calibration sheet.

concentration = [(1.195 * voltage * (FSC — ZPC)) / FSV] + ZPC
where

voltage = measured output voltage from fluorometer

FSV = full scale voltage; typically 5.0 volts

FSC = full scale concentration

ZPC = zero point concentration

Turner Cyclops

Enter scale factor and offset, and select measured parameter (chlorophyll,
rhodamine, fluorescein, .phycocyanin, phycoerythrin, CDOM, crude oil,
optical brighteners, or turbidity)

concentration = (scale factor * voltage) + offset

where

scale factor = range / 5 volts

offset = - scale factor * blank voltage

Range and blank voltage are from calibration sheet.

Output units are dependent on selected measured parameter.

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Turner Cyclops fluorometers.

Turner SCUFA

Enter scale factor, offset, units, mx, my, and b from the calibration sheet.
chlorophyll = (scale factor * voltage) + offset

corrected chlorophyll = (mx * chlorophyll) + (my * NTU) + b

where

NTU = results from optional turbidity channel in SCUFA (see Turner
SCUFA in OBS equations below)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Turner SCUFA sensors.

WET Labs AC3

This sensor requires two channels - one for fluorometer voltage (listed
under fluorometers in the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.

Enter kv, Vh2o0, and A*X.

concentration (mg/m’) = kv * (Vout - Vh20) / A*X

where

Vout = measured output voltage

kv = absorption voltage scaling constant (inverse meters/volt)

Vh20 = measured voltage using pure water

A”X = chlorophyll specific absorption coefficient
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Notes:

e Units are dependent on the
substance measured by the
fluorometer. For example, units are
Mg/l for chlorophyll, ppb for
Rhodamine, ppt for Phycocyanin,
etc.

o For complete description of
calibration coefficient calculation,
see Application Note 62.

e For ECO-FL-NTU, a second
channel is required for turbidity.
Set up the second channel as a
WET Labs ECO-NTU, as
described below for
OBS/Nephelometer/Turbidity
SEnsors.

Notes:

e Units are dependent on the
substance measured by the
fluorometer. For example, units are
pg/l for chlorophyll, ppb for
Rhodamine, ppt for Phycocyanin,
etc.

e For complete description of
calibration coefficient calculation,
see Application Note 41 for
WETStar.

WET Labs ECO-AFL and ECO-FL

Enter Dark Output and scale factor.

Concentration (units) = (V — Dark Output) * scale factor

where

V = in situ voltage output

Dark Output = clean water voltage output with black tape on detector

Scale factor = multiplier (units/Volt)

The calibration sheet lists either:

»  Dark Output and scale factor, OR

»  Vblank (old terminology for Dark Output) and Scale Factor, OR

» Vblank (old terminology for Dark Output) and Vcopro (voltage output
measured with known concentration of coproporphyrin tetramethyl
ester). Determine an initial value for the scale factor by using the
chlorophyll concentration corresponding to Vcopro:
scale factor = chlorophyll concentration / (Vcopro - Vblank)

Perform calibrations using seawater with phytoplankton populations that

are similar to what is expected in situ.

Note: SBE Data Processing can process data for an instrument interfacing

with up to six ECO-AFL (or ECO-FL) sensors.

WET Labs ECO CDOM (Colored Dissolved Organic Matter)

Enter Dark Output and scale factor.

Concentration (ppb) = (V — Dark Output) * Scale Factor

where

V = in situ voltage output

Dark Output = clean water voltage output with black tape on detector
Scale Factor = multiplier (ppb/Volt)

Calibration sheet lists Dark Output and Vcdom (voltage output measured
with known concentration of colored dissolved organic matter). Determine
an initial scale factor value by using colored dissolved organic matter
concentration corresponding to Vcdom:

scale factor = cdom concentration / (Vcdom — Dark Output)

Perform calibrations using seawater with CDOM types similar to what is
expected in situ.

Note: SBE Data Processing can process data for an instrument interfacing
with up to six ECO CDOM sensors.

WET Labs WETStar

Enter Blank Output and Scale Factor.

Concentration (units) = (V — Blank Output) * Scale Factor

where

V = in situ voltage output

Blank Output = clean water blank voltage output

Scale Factor = multiplier (units/Volt)

The calibration sheet lists either:

» Blank Output and Scale Factor, OR

» Vblank (old terminology for Blank Output) and Scale Factor, OR

» Vblank (old terminology for Blank Output) and Vcopro (voltage
output measured with known concentration of coproporphyrin
tetramethyl ester). Determine an initial value for the scale factor by
using the chlorophyll concentration corresponding to Vcopro:
scale factor = chlorophyll concentration / (Vcopro - Vblank)

Perform calibrations using seawater with phytoplankton populations that

are similar to what is expected in situ.

Note: SBE Data Processing can process data for an instrument interfacing

with up to six WET Labs WETStar sensors.
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Note:

See Application Note 16 for
complete description of calculation of
OBS-3 calibration coefficients.

Note:

e See Application Note 81 for
complete description of calculation
of OBS-3+ calibration coefficients.

e You can interface to two OBS-3+
sensors, or to both the 1X and 4X
ranges on one OBS-3+ sensor,
providing two channels of
OBS-3+ data.

Methane Sensor Calibration Coefficients

The Franatech(formerly Capsum) METS sensor requires two channels — one
for methane concentration and the other for temperature measured by the
sensor. Make sure to select both when configuring the instrument.

For the concentration channel, enter D, A0, A1, BO, B1, and B2.

Methane concentration

—exp {DIn[BO+Blexp Y )+ L -1 1y [umol/1]
B2 Vm A0-Al*Vt
where
Vt = temperature voltage Vm = methane concentration voltage

For the temperature channel, enter T1 and T2.
Gas temperature = (Vt * T1) + T2 [°C]

OBS/Nephelometer/Turbidity Calibration Coefficients

In general, turbidity sensors are calibrated to a standard (formazin). However,
particle size, shape, refraction, etc. in seawater varies. These variations affect
the results unless field calibrations are performed on typical water samples.

e Downing & Associates [D&A] OBS-3 Backscatterance
Enter gain and offset.
output = (volts * gain) + offset
where
gain = range/5; see calibration sheet for range
Note: SBE Data Processing can process data for an instrument interfacing
with up to two OBS-3 sensors.

e Downing & Associates [D & A] OBS-3+
Enter AO, Al, and A2.
output = A0 + (Al * V) + (A2 * V?)
where
V = voltage from sensor (milliVolts)
A0, A1, and A2 = calibration coefficients from D & A calibration sheet
Note: SBE Data Processing can process data for an instrument interfacing
with up to two OBS-3+ sensors.

e Chelsea
Enter clear water value and scale factor.
turbidity [F.T.U.] = (10.0Y — C) / scale factor
where
V = voltage from sensor
See calibration sheet for C (clear water value) and scale factor.

e Dr. Haardt Turbidity

Enter A0, A1, B0, and B1. Select the gain range switch:

»  Output Voltage Level if the instrument indicates gain by output voltage
level (< 2.5 volts is low gain, > 2.5 volts is high gain)
Low gain: value = A0 + (Al * V)
High gain: value = B0 + (B1 * V)

»  Modulo Bit if the instrument has control lines custom-wired to bits in
the SBE 9plus modulo word
Bit not set: value = A0 + (A1 * V)
Bit set: value = B0 + (B1 * V)

»  None if the instrument does not change gain
value = A0 + (Al *V)

where

V = voltage from sensor
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Note:

See Application Note 48 for complete
description of calculation of Seapoint
Turbidity calibration coefficients.

Notes:

e To enable entry of the mx, my,
and b coefficients for the
SCUFA fluorometer, you must
first select the Turner SCUFA
(OBS/Nephelometer/Turbidity).

e See Application Note 63 for
complete description of calculation
of Turner SCUFA calibration
coefficients.

Note:
See Application Note 87 for complete
description of calculation of WET

Labs ECO-BB calibration coefficients.

Note:

See Application Note 62 for complete
description of calculation of WET
Labs ECO-NTU calibration
coefficients.

Note:

See Application Note 19 for complete
description of calculation of ORP
calibration coefficients.

IFREMER
This sensor requires two channels - one for direct voltage and the other for
measured voltage. Make sure to select both when configuring the CTD.
For the direct voltage channel, enter vm0, vd0, d0, and k.

diffusion = [k * (vim — vm0) / (vd — vd0)] — d0

where

k = scale factor

vm0 = measured voltage offset
vd0 = direct voltage offset

vm = measured voltage
vd = direct voltage
dO0 = diffusion offset

Seapoint Turbidity

Enter gain setting and scale factor.

output = (volts * 500 * scale factor)/gain

where

Scale factor is from calibration sheet

Gain is dependent on cable used (see cable drawing)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seapoint Turbidity sensors.

Seatech LS6000 and WET Labs LBSS

Enter gain setting, slope, and offset.

Output = [volts * (range / 5) * slope] + offset

where

Slope is from calibration sheet.

Range is based on sensor ordered (see calibration sheet) and cable-
dependent gain (see cable drawing to determine if low or high gain):
High Gain: 2.25, 7.5, 75, 225, 33; Low Gain: 7.5, 25, 250, 750, 100
Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seatech LS6000 or WET Labs LBSS sensors.

Turner SCUFA

Enter scale factor and offset.

NTU = (scale factor * voltage) + offset

corrected chlorophyll = (mx * chlorophyll) + (my * NTU) + b

where

mx, my, and b = coefficients entered for Turner SCUFA fluorometer
chlorophyll = results from fluorometer channel in SCUFA (see Turner
SCUFA in fluorometer equations above)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Turner SCUFA sensors.

WET Labs ECO-BB

Enter Scale Factor and Dark Output.

B(®©c) [m Tsr = (V - Dark Output) * Scale Factor

where

V = voltage from sensor

Scale Factor and Dark Output are from calibration sheet.

Note: SBE Data Processing can process data for an instrument interfacing
with up to five WET Labs ECO-BB sensors.

WET Labs ECO-NTU

Enter scale factor and Dark Output.

NTU = (V — Dark Output) * Scale Factor

where

V = voltage from sensor

Scale Factor and Dark Output are from calibration sheet.

Note: SBE Data Processing can process data for an instrument interfacing
with up to five WET Labs ECO-NTU sensors.

Oxidation Reduction Potential (ORP) Calibration Coefficients

Enter M, B, and offset (mV).
Oxidation reduction potential = [(M * voltage) + B] + offset
Enter M and B from calibration sheet.
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Notes:

e See Application Notes 13-1 and 13-3
for complete description of
calibration coefficients for Beckman-
or YSI-type sensors.

e See Application Notes 64 and 64-2
for complete description of SBE 43
calibration coefficients.

e The Tau correction ([tau(T,P) * 8V/t]
in the SBE 43 or [tau * doc/dt] in the
SBE 13 or 23) improves response of
the measured signal in regions of
large oxygen gradients. However,
this term also amplifies residual
noise in the signal (especially in
deep water), and in some situations
this negative consequence
overshadows the gains in signal
responsiveness. To perform this
correction, select Apply Tau
correction on Data Conversion’s or
Derive’s Miscellaneous tab.

¢ |f the Tau correction is enabled,
oxygen computed by Seasave and
Data Conversion differ from values
computed by Derive. Both
algorithms compute the derivative of
the oxygen signal with respect to
time, and require a user-input
window size:

» Quick estimate -
Seasave and Data Conversion
compute the derivative looking
back in time, because they share
common code and Seasave
cannot use future values while
acquiring real-time data.
» Most accurate results -
Derive uses a centered window
(equal number of points before
and after scan) to compute
the derivative.
In Data Conversion or Derive, the
window size is input on the
Miscellaneous tab.

¢ A hysteresis correction can be
applied in Data Conversion for the
SBE 43. To perform this correction,
select Apply hysteresis correction on
Data Conversion’s Miscellaneous
tab. H1, H2, and H3 coefficients for
hysteresis correction (entered in the
.con or .xmlcon file) are available on
calibration sheets for SBE 43s
calibrated after October 2008.

e See Calibration Coefficients for
RS-232 Sensors below for the
SBE 63 Optical Dissolved Oxygen
Sensor and Aanderaa Optode
Oxygen sensor.

Oxygen Calibration Coefficients

Enter the coefficients, which vary depending on the type of oxygen sensor,
from the calibration sheet:

Beckman- or YSI-type sensor (manufactured by Sea-Bird or other
manufacturer) - These sensors require two channels - one for oxygen
current (enter m, b, soc, boc, tcor, pcor, tau, and wt) and the other for
oxygen temperature (enter k and c). Make sure to select both when
configuring the instrument.

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Beckman- or YSI-type oxygen sensors.

IOW sensor - These sensors require two channels - one for oxygen current
(enter b0 and bl) and the other for oxygen temperature (enter a0, al, a2,
and a3). Make sure to select both when configuring the instrument.
Value =b0 + [bl * (a0 +al * T+a2 * T>+a3 * T°) * C]

where T is oxygen temperature voltage, C is oxygen current voltage
Sea-Bird sensor (SBE 43) - This sensor requires only one channel.

In Spring of 2008, Sea-Bird began using a new equation, the Sea-Bird
equation, for calibrating the SBE 43. Calibration sheets for SBE 43s
calibrated after this date will only include coefficients for the Sea-Bird
equation, but our software (Seasave-Win32, Seasave V7, and SBE Data
Processing) supports both equations. We recommend that you use the
Sea-Bird equation for best results.

Sea-Bird: Enter Soc, Voffset, A, B, C, E, Tau20, D1, D2, H1, H2, and H3.
OX =

Soc * [V + Voffset + tau(T,P) * §V/dt] * OxSOL(T,S) *

1.0 + A*T + B*T? + C*T°) * ¢ ®7/K)
where
- OX = dissolved oxygen concentration (ml/l)
- T, P = measured temperature (°C) and pressure (decibars) from CTD
- S = calculated salinity from CTD (PSU)
- V = temperature-compensated oxygen signal (volts)
- Soc = linear scaling calibration coefficient
- Voffset = voltage at zero oxygen signal
- tau(T,P) = sensor time constant at temperature and pressure
- tau20 = sensor time constant tau(T,P) at 20 C, 1 atmosphere, 0 PSU;
slope term in calculation of tau(T,P)
- D1, D2 = calibration terms used in calculation of tau(T,P)
- 0V/dt = time derivative of oxygen signal (volts/sec)
- H1, H2, H3 = calibration terms used for hysteresis correction
- K = absolute temperature (Kelvin)
- Oxsol(T,S) = oxygen saturation (ml/l); a parameterization from Garcia
and Gordon (1992)

OR

Owens-Millard: Enter Soc, Boc, Voffset, tcor, pcor, and tau.
OX-=
[Soc*{(V+Voffset)+(tau* dV/dt)}+Boc*exp(-0.03T)]*exp(tcor* T+pcor*P)*Oxsat(T,S)
where
OX = dissolved oxygen concentration (ml/1)
T = measured temperature from CTD (°C)
P = measured pressure from CTD (decibars)
S = calculated salinity from CTD (PSU)
V = temperature-compensated oxygen signal (volts)
dV/dt = derivative of oxygen signal (volts/sec)
Oxsat(T,S) = oxygen saturation (ml/I)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two SBE 43 oxygen sensors.
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Notes:

e See Application Note 11General
for multiplier values for output units
other than pEinsteins/m2 sec.

e See Application Notes 11QSP-L
(Biospherical sensor with built-in
log amplifier), 11QSP-PD
(Biospherical sensor without built-
in log amplifier), 11Licor (LI-COR
sensor), and 11Chelsea for
complete description of calculation
of calibration coefficients for
underwater PAR sensors.

e Selection of Par/ Irradiance,
Biospherical / Licor as the voltage
sensor is also applicable to the
Chelsea PAR sensor.

e For complete description of
calculation of calibration
coefficients for surface PAR,
see Application Note 11S
(SBE 11plus Deck Unit) or
47 (SBE 33 or 36 Deck Unit).

Notes:

e See Application Notes 18-1, 18-2,
and 18-4 for complete description
of calculation of pH calibration
coefficients.

¢ Seasoft-DOS < version 4.008
ignored temperature compensation
of a pH electrode. The relationship
between the two methods is:
pH = pH old + (7 — 2087/°K)

For older sensors, run pHfit version
2.0 (in Seasoft-DOS) using Vout,
pH, and temperature values from
the original calibration sheet to
compute the new values for offset
and slope.

PAR/Irradiance Calibration Coefficients

Underwater PAR Sensor
Enter M, B, calibration constant, multiplier, and offset.
PAR = [multiplier * (10° * 10(V-B)/M) / calibration constant] + offset
where
Calibration constant, M, and B are dependent on sensor type;
multiplier = 1.0 for output units of pEinsteins/m’ sec
e Biospherical PAR sensor
- PAR sensor with built-in log amplifier (QSP-200L, QSP-2300L,
QCP-2300L, or MCP-2300)]:
Typically, M = 1.0 and B = 0.0.
Calibration constant
=10 / wet calibration factor from Biospherical calibration sheet.
- PAR sensor without built-in log amplifier (QSP-200PD, QSP-2200 (PD),
or QCP 2200 (PD)):
M and B are taken from Sea-Bird calibration sheet.
Calibration constant
= Cg calibration coefficient from Sea-Bird calibration sheet
=10 ?/ calibration coefficient from Biospherical calibration sheet
e LI-COR PAR sensor
Calibration constant is LI-COR in water calibration constant.
Enter calibration constant, M, and B from calibration sheet.
e  Chelsea PAR sensor
Calibration constant
=10°/0.01 (for units of microEinsteins/sec—m?) or
=10 9/0.04234 (for units of quanta/sec—m?)
M=1.0/(loge* Al * 1000) = 1.0/ (0.43429448 * A1 * 1000)
B=-M*loge* A0=-M *0.43429448 * A0
where A0 and A1 are constants from Chelsea calibration sheet with an
equation of form: PAR = A0 + (Al * mV)
Multiplier can be used to scale output, and is typically set to 1.0.
Note: SBE Data Processing can process data for an instrument interfacing with
up to two PAR/irradiance sensors.

Biospherical Surface PAR Sensor
A surface PAR sensor is selected by clicking Surface PAR voltage added in the
Configure dialog box. Enter conversion factor and ratio multiplier.

pH Calibration Coefficients

Enter the slope and offset from the calibration sheet:
pH =7+ (Vout — offset) / (°K * 1.98416e-4 * slope)
where

°K = temperature in degrees Kelvin

Pressure/FGP (voltage output) Calibration Coefficients

Enter scale factor and offset.

output [Kpa] = (volts * scale factor) + offset

where:

scale factor = 100 * pressure sensor range [bar] / voltage range [volts]

Note: SBE Data Processing can process data for an instrument interfacing with
up to eight pressure/fgp sensors.
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Note:

See Application Note 7 for
complete description of
computation of M and B.

Suspended Sediment Calibration Coefficients

The Sequoia LISST-25 sensor requires two channels — one for scattering
output and the other for transmission output. Make sure to select both when
configuring the instrument.

For the scattering channel, enter Total volume concentration constant (Cal),
Sauter mean diameter calibration (o), Clean H,O scattering output (Vg), and
Clean H,O transmission output (Vo) from the calibration sheet. For the
transmission channel, no additional coefficients are required; they are all
defined for the scattering channel.

Optical transmission =t = V1 / Vg

Beam C=-1n(t)/0.025 [1/meters]

Total Volume Concentration =TV =Cal * [ ( Vs/1)- Vg ] [uliters / liter]
Sauter Mean Diameter=SMD =a * [ TV/(-In(t)] [microns]

where

V1 = transmission channel voltage output

Vg = scattering channel voltage output

The calibration coefficients supplied by Sequoia are based on water containing
spherical particles. Perform calibrations using seawater with particle shapes
that are similar to what is expected in situ.

Transmissometer Calibration Coefficients

e Sea Tech and Chelsea (Alphatracka)
Enter M, B, and path length (in meters)
Path length (distance between lenses) is based on sensor size
(for example, 25 cm transmissometer = 0.25m path length, etc.).
light transmission (%) = M * volts + B
beam attenuation coefficient (c) = - (1/z) * In (light transmission [decimal])
where
M=(Tw/[W0-Y0])(A0O-Y0)/(A1-Y1) B=-M*Yl1
A0 = factory voltage output in air (manufacturer factory calibration)
Al = current (most recent) voltage output in air
YO0 = factory dark or zero (blocked path) voltage (manufacturer factory
calibration)
Y1 = current (most recent) dark or zero (blocked path) voltage
WO = factory voltage output in pure water (manufacturer factory calibration)
Tw = % transmission in pure water
(for transmission relative to water, Tw = 100%; or
for transmission relative to air, Tw is defined by table below.

Tw = % Transmission in Pure Water (relative to AIR)
Wavelength 10 cm Path Length 25 cm Path Length
488 nm (blue) 99.8% 99.6%
532 nm (green) 99.5% 98.8%
660 nm (red) 96.0 - 96.4% 90.2 -91.3%

Transmissometer Example

(from calibration sheet) A0 =4.743 V, Y0 = 0.002 V, W0 =4.565 Volts
Tw = 100% (for transmission relative to water)

(from current calibration) A1 =4.719 volts and Y1 = 0.006 volts

M =22.046 B=-0.132

Note: SBE Data Processing can process data for an instrument interfacing
with up to two transmissometers in any combination of Sea Tech and
Chelsea Alphatracka,
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WET Labs AC3

This sensor requires two channels - one for fluorometer voltage (listed
under fluorometers in the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.

Enter Ch20, Vh20, VDark, and X from calibration sheet.

Beam attenuation = {[log (Vh2o0 - VDark) - log (V - VDark)] /X} + Ch2o0
Beam transmission (%) = exp ( -beam attenuation * X) * 100

WET Labs C-Star

Enter M, B, and path length (in meters)

Path length (distance between lenses) is based on sensor size

(for example, 25 cm transmissometer = 0.25m path length, etc.).

light transmission (%) = M * volts + B

beam attenuation coefficient (c) = - (1/z) * In (light transmission [decimal])
where

M=(Tw/[W0-Y0])(A0O-Y0)/(Al-Y1) =-M*YlI
A0 = Vair = factory voltage output in air (manufacturer factory calibration)
A1 = current (most recent) voltage output in air

Y0 = Vd = factory dark or zero (blocked path) voltage (manufacturer
factory calibration)

Y1 = current (most recent) dark or zero (blocked path) voltage

WO = Vref = factory voltage output in pure water (manufacturer factory
calibration)

Tw = % transmission in pure water

(for transmission relative to water, Tw = 100%; or

for transmission relative to air, Tw is defined by table below.

Tw = % Transmission in Pure Water (relative to AIR)
Wavelength 10 cm Path Length 25 cm Path Length
488 nm (blue) 99.8% 99.6%
532 nm (green) 99.5% 98.8%
660 nm (red) 96.0 - 96.4% 90.2-91.3%

Transmissometer Example

(from calibration sheet) Vair =4.743 V, Vd = 0.002 V, Vref =4.565 V
Tw = 100% (for transmission relative to water)

(from current calibration) A1 =4.719 volts and Y1 = 0.006 volts

M =22.046 B=-0.132

Note: SBE Data Processing can process data for an instrument interfacing
with up to six WET Labs C-Stars.

67



Manual revision 7.23.2 Section 4: Configuring Instrument (Configure) SBE Data Processing

User Polynomial (for user-defined sensor)
Calibration Coefficients

The user polynomial allows you to define an equation to relate the sensor
output voltage to calculated engineering units, if your sensor is not pre-defined
in Sea-Bird software.

Enter a0, al, a2, and a3.

Val=2a0 + (al * V) + (a2 * V2) + (a3 * V3)

where:

V = voltage from sensor

a0, al, a2, and a3 = user-defined sensor polynomial coefficients

If desired, enter the sensor name. This name will appear in the data file header.
Note: SBE Data Processing can process data for an instrument interfacing with
up to three sensors defined with user polynomials.

Example

A manufacturer defines the output of their sensor as:

NTU = (Vsample — Vblank) * scale factor

Set this equal to user polynomial equation and calculate a0, al, a2, and a3.
(Vsample — Vblank) * scale factor = a0 + (al * V) + (a2 * V?) + (a3 * V?)
Expanding left side of equation and using consistent notation (Vsample = V):
scale factor * V — scale factor * Vblank = a0 + (al * V) + (a2 * V?) + (a3 * V?)
Left side of equation has no V2 or V3 terms, so a2 and a3 are 0; rearranging:

(— scale factor * Vblank) + (scale factor * V) =a0 + (al * V)

a0 = — scale factor * Vblank al = scale factor a2=a3=0

Zaps Calibration Coefficients

Enter M and B from calibration sheet.
z = (M * volts) + B [nmoles]
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Calibration Coefficients for RS-232 Sensors

Notes:

e The SBE 38 is compatible only with
the SBE 16plus V2, 16plus-IM V2,
19plus V2, and 25plus.

e The SBE 50 is compatible only with
the SBE 16plus V2, 16plus-IM V2,
and 25plus.

See the CTD manual for required

setup for the SBE 38 and SBE 50.

Note:

The SBE 63 is compatible only with
the SBE 16plus V2, 19plus V2, and
ODO MicroCATs (37-SMP-ODO,
SIP-ODO, IMP-ODO). See the CTD
manual for required setup for the
SBE 63.

Note:

WET Labs RS-232 sensors are
compatible only with the

SBE 16plus V2, 16plus-IM V2, 19plus
V2, and 25plus. See the CTD manual
for required setup for the WET Labs
RS-232 sensor.

Unless otherwise noted, SBE Data Processing supports only one of each auxiliary
sensor model (for example, you cannot specify two Aanderaa Optodes).

SBE 38 Temperature Sensor and
SBE 50 Pressure Sensor Calibration Coefficients

The SBE 38 must be set up to output converted data (°C) when integrated with
a CTD. The SBE 50 must be set up to output converted data (psia) when
integrated with a CTD. Therefore, calibration coefficients are not required in
SBE Data Processing; just enter the serial number and calibration date.

Note: SBE Data Processing can process data for an SBE 25p/us interfacing
with up to two SBE 38s or two SBE 50s.

SBE 63 Optical Dissolved Oxygen Sensor Calibration
Coefficients

The SBE 63 must be set up to output data in a format compatible with Sea-Bird
CTDs (SetFormat=1). The SBE 63 manual lists the equation for calculating
dissolved oxygen and the calibration coefficients (see the manual on our
website). Enter the serial number, calibration date, and calibration coefficients.

WET Labs Sensor Calibration Coefficients

If you select the WET Labs RS-232 sensor, SBE Data Processing adds three
lines to the Channel/Sensor table. If integrating an ECO Triplet, select sensors
for all three channels. If integrating a dual ECO sensor (such as the FLNTU),
select sensors for the first two channels, and leave the third channel Free. If
integrating a single sensor, select the sensor for the first channel, and leave the
second and third channels Free.

The following WET Labs sensors are available as RS-232 output sensors:
e  Fluorometers — ECO CDOM, ECO-AFL/FL, and WETStar

e Transmissometers — C-Star

e  Turbidity Meters — ECO-BB and ECO NTU

These sensors are also available as voltage sensors; calibration coefficient
information for these sensors is detailed above in Calibration Coefficients for
Voltage Sensors. Values for the calibration coefficients are listed on the WET
Labs calibration sheets in terms of both analog output (voltage) and digital
output (counts); use the digital output values when calculating / entering
calibration coefficients for the RS-232 sensors. SBE Data Processing calculates
the converted sensor output based on the counts output (instead of the voltage
output) by the sensor. For all sensors, enter the serial number, calibration date,
and calibration coefficients.

Note: SBE Data Processing can process data for an SBE 25p/us interfacing
with up to two RS-232 WET Labs sensors.
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Notes:

e The GTD is compatible only with the
SBE 16plus V2, 16plus-IM V2, and
19plus V2. See the CTD manual for
required setup for the GTD.

e SBE Data Processing supports
single or dual GTDs.

Notes:

e The Optode is compatible only with
the SBE 16plus V2, 16plus-IM V2,
and 19plus V2. See the CTD manual
for required setup for the Optode.

e See Calibration Coefficients for
Voltage Sensors above for voltage-
output Oxygen sensors, including
the SBE 43.

GTD Calibration Coefficients

The GTD must be set up to output converted data (millibars) when integrated
with a CTD. Therefore, calibration coefficients are not required in SBE Data
Processing; just enter the serial number and calibration date.

Aanderaa Oxygen Optode Calibration Coefficients

Enter the serial number, calibration date, and information required for salinity
and depth corrections. The internal salinity must match the value you
programmed into the Optode (the value is ignored if you do not enable the
Salinity correction). If you enable Salinity correction, SBE Data Processing
corrects the oxygen output from the Optode based on the actual salinity
(calculated from the CTD data). If you enable Depth correction, SBE Data
Processing corrects the oxygen output from the Optode based on the depth
(calculated from the CTD data).
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Section 5: Raw Data Conversion Modules

Module Name

Module Description

Data
Conversion

Convert raw data from CTD (.hex, .dat, or .xml file) to
engineering units, storing the converted data in

.cnv file (all data) and/or .ros file (water bottle data).
Note:

.xml file conversion only applicable to SBE 25p/us.

Bottle
Summary

Summarize data from water sampler bottle .ros file,
storing the results in .btl file.

Mark Scan

Create .bsr bottle scan range file from .mrk data file.
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SBE Data Processing

Data Conversion

Notes:

equations.

Algorithms used for calculation of
derived parameters in Data
Conversion, Derive, Sea Plot,
SeaCalc Il [EOS-80 (Practical
Salinity) tab], and Seasave are
identical, except as noted in
Appendix V: Derived Parameter
Formulas (EOS-80; Practical
Salinity), and are based on EOS-80

Location to store all information
input in File Setup and Data
Setup tabs. Open to select
different .psa file, Save or
Save As to save current
settings, or Restore to reset
all settings to match last saved

2% Data Conversion

File Cptions

File: Setup | Data Setupl Miscellaneousl Header Viewl

Data Conversion:

Converts raw data to engineering units from:

.dat file from SBE 911plus, acquired with Seasave versions < 6.0, or
.hex file from SBE 91 1plus, acquired with Seasave versions > 7.0, or
hex file from other CTDs, acquired with any version of Seasave or by
uploading data from memory (if applicable), or

.xml file uploaded from SBE 25plus.

Stores the converted data in a .cnv file and (optional) .ros file.

The File Setup tab in the dialog box looks like this:

Help

e Select to have program find .con or .xmlcon
file with same name and in same directory
as data file. For example, if processing
test.dat and this option is selected, program
searches for test.xmlcon (same directory as
test.dat); if it does not find test.xmlcon, it
searches for test.con.

Program setup file

o Also select if more than 1 data file is to be
processed, and data files have different

processing test.dat and test1.dat, and this
option is selected, program searches for

directory as test.dat and test1.dat); if it does
not find .xmicon files, it searches for .con

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

Output file

Mame append

test oy

Mat proceszing

Directory and file names for converted output (.cnv) data.

version. See note above. I~
|K:\datahDehbie\DatEnv.psa configuration files. For example, if
Instrument configuration file Open., Bt | Er | Bestor
chatlon. Select to pick a _ test.xmlcon and test1.xmlcon (same
different .con or .xmicon file, or
Modify to view and/or modify I~ Inztiument configuration file
instrument configuration. ; 2 files
See Section 4: Configuring |K.\data\Debble\test.cun / .
Instrument (Configure). Select Madify... | [=Tatch instrument configuration ko input file
Directory and file names for Imput directony
raw data (.hex, .dat, or .xml). :
Select to pick a different file. |Ki'\data"~Debble
To process multiple raw data e s e
files from same directory: N P g
1. Click Select. test dat - Select...
2. In Select dialog box, hold I J —I
down Ctrl key while clicking -
on each desired file. Dutput directary
[ \data\Debbie '

If more than 1 data file is to be processed, Output file field
disappears and output file name is set to match input file
name. For example, if processing test.dat and test1.dat,
output files will be named test.cnv and test1.cnv.

SBE Data Processing adds Name append to (each) output
file name, before .cnv extension. For example, if processing
test.dat and test1.dat with a Name append of 06-20-00,
output files will be test06-20-00.cnv and test106-20-00.cnv.

N\
Start Process

Cancel |

/ Exit
/

VA

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Program skips first scans to skip

over scans.

o If Process scans to end of file
selected: process all
remaining scans (upcast
and downcast scans if Upcast
and downcast selected;
downcast scans only if
downcast selected).

e If Process scans to end of file
not selected: process next
scans to process.

Select to replace existing header
in input file with header in .hdr file.
Program looks for a file with a
matching name (but .hdr
extension) in same directory as
input file.

\I‘_ tterge separate header file

Select which variables to convert
and output (see dialog box below).

Select start time source for header:

e Instrument’s time stamp —
instrument’s time stamp in first
data scan (if available) or in
header of input raw data file.

o NMEA time — time from a NMEA
device that was integrated with
system; time in first data scan (if
available) or in header of input
raw data file.

e System UTC — computer time in
first data scan (if available) or in
header of input raw data file.

e Upload time — time that data was
uploaded from instrument’s
memory.

The Data Setup tab in the dialog box looks like this:

i

File Setup  [ata Setup ‘ Miscellanenus | Header

v Process scans to end of file

Seans bo skip over |
li

ASCH output =

Scans bo process

Cutput format

a@@_‘

e Binary - smaller file, processed faster than ASCII
file by other SBE Data Processing modules.
o ASCII - larger file, can be viewed with a text editor.
Translate can translate converted data file from
binary to ASCII or vice versa.
1

Convert downcast data, or upcast and downcast data.

Create converted data file only,
bottle file only (for subsequent

Corrvert data from |L||:ucasl and downcast j

processing by Bottle Summary),
or both.

Create file types

|Ereate both data and battle file

= I

Source of data for creating bottle

Source of scan range data |Scans marked with battle confim bit ZI_ file:

¢ In same directory as input data

Scan range offzet [z]

Stcan range duration [z]

ID_ Define scans from CTD data
file to be included in bottle
|2_ file. See Data Conversion:
Creating Water Bottle (.ros)
Files below. *

file, with same file name - auto
fire module or ECO .afm file,
bottle log .bl file, or bottle scan
range .bsr file, or

Scans marked with bottle

T~ Select Output Yariables... ‘

Source for ztart time in output . cry header

" Instrumnent's time stamp

¢ MMEA time

confirm bit in input data file
See Data Conversion: Creating
Water Bottle (.ros) Files below.

(" System UTC
™ Upload time

[ Prarpt for start tirme and/or iote™

Select to have software prompt you to modify start time to put
in output .cnv header (instead of using one of sources for start
time listed above), or to add a note to output .cnv header.

Start Pro cess\l\

\E:-:it Cancel
\

AN

Begin processing data.
Status field on File Setup
tab shows Processing
complete when done.

Return to SBE Data Processing window.

If Confirm Program Setup Change was selected in Options
menu - If you made changes and did not Save or Save As,
program asks if you want to save changes.

If Confirm Program Setup Change was not selected in Options
menu - Button says Save & Exit. If you do not want to save
changes, use Cancel button to exit.
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The Select Output Variables dialog box (which appears when you click
Select Output Variables on the Data Setup tab) looks like this:

Select Dutput Yariables E2

Seq & Variable Mame [unit]

|
|-

1 Pressure, Digiguartz [db]

2 Temperature [IT5-30, deg C]

a Conductivity [S/m]

[ Awerage Sound Yelozity

o Add variable: click blank field in Variable Name column, click desired
variable in list, click Add.

e Change variable: click existing variable in Variable Name column,
click desired variable in list, click Change.

o Insert variable: click existing variable below desired sequence # in
Variable Name column, click desired variable in list, click Insert.

If Data Conversion requires additional information to compute a variable,

a dialog box appears after variable is selected, with fields for required

user-input parameters.

|

Click Data to view/modify user-input parameters for selected variable (if

applicable). Some variables share a user-input parameter, so changing a

parameter for one variable automatically changes it for the other:

e Depth and average sound velocity use same latitude (if NMEA data
unavailable).

o Descent rate and acceleration use same time window size.

e All SBE 13, 23, and 43 oxygen sensors use same time window size, Tau
correction, and (SBE 43 only) hysteresis correction.

Note: An alternate method of entering these parameters is on

Miscellaneous tab in Data Conversion dialog box.

i-- Bottles Fired
Charge | - Bitharn Cantact
- Byte Count
Delete | (=1 Conductivity
L8
Ingert | P
sl | 1 SouSdem
M I?‘ Cotiductivity, 2

[ Conductivity Differerice,

[#- Density, 2

I:‘ Denzity Difference, 2 -1
Ii‘ Depth

I?‘ Descent Rate

I?‘ Frequency Channel

| i+ Modulo Erar Count

Al ghinka |
Evpand Al |
Ezpand |

2-1

List includes all variables
that can be converted from
input data file or derived
from variables in input

data file.
En

The Miscellaneous tab in the Data Conversion dialog box looks like this:

5% Data Conversion

File Options Help

Note:

Values for these parameters can be
changed on the Miscellaneous tab
or by double clicking on the output

File Setup] Data Setup  Mizcellaneous Headel‘v"iewl

Thiz tab configures mizcellaneous data for calculations.
Mote: Values entered only affect indicated calculations.

Depth and Average Sound Yelocity

variable in the Select Output Latitude when MMEA is not avallable  |p
Variables dialog box (above);
changes made in one location are Average Sound Velocity Plurne Anomaly
automatically made in the other AT SR P it
location. Miriimurn zalinity [pzu] 20| SalinipB
Preszure window size [db] |20 Theta< / Salinity-2
Time window size [5] B0 Reference pressure [db]
Potential Temperature Anomaly
a0 ||j a1 |D A1 Mulliplier | ey
Oxygen selections apply to ||~ Davgen
SBE 43 and Beckman/YSI Window zize [s] 2

sensors. They do not apply
to SBE 63 or Aanderaa
Oxygen Optode.

¥ Apply Tau corection

Window zize [z]

Descent and Acceleration

4

Apply hysteresiz comection to SBE 43 when Sea-Bird equation selected in
instrument configuration file

Set to Defaults

-

Start Process

E it |

Cancel |

The Miscellaneous tab defines parameters required for output of specific
variables (depth, average sound velocity, plume anomaly, potential
temperature anomaly, oxygen, descent rate, and acceleration). Entries are used
only if you are calculating and outputting the associated variable to the .cnv
file. For example, if you do not select Oxygen in the Select Output Variables
dialog box, Data Conversion ignores the Oxygen window size and the
enabling of hysteresis and Tau corrections on the Miscellaneous tab.
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Notes:

e You may have more than one
source of scan range data
available. For example, if Seasave
is used with an SBE 911plus and
SBE 32 Carousel Water Sampler,
a bottle log (.bl) file is created.
Additionally, if you used the Mark
Scan feature in Seasave, a .mrk
file is created.

o If scan range data is defined by a
.afm file, Data Conversion creates
a .bl file (same name as input data
file, with .bl extension). The .bl file
is used when processing the
water bottle data in Bottle
Summary.

e You can create a .bsr file in a text
editor if scan range data is not
available in any of these forms.

Data Conversion: Creating Water Bottle (.ros) Files

A .ros water bottle file contains:
e data for each scan associated with a bottle firing, and
e data for user-selected range of scans before and after each bottle firing

Scan range data for creation of a water bottle file can come from:

o Scans marked with bottle confirm bit in input data file - if used
- SBE 9plus with an SBE 11plus Deck Unit and G.O. 1015 Rosette, or
- SBE 9plus with an SBE 17plus Searam and SBE 32 Carousel
Water Sampler.

For these systems, the bottle confirm bit in the input (.hex or .dat) data file
is set for all scans within a 1.5-second duration after a bottle firing
confirmation is received from the water sampler.

e Bottle log (.bl) file - if used Seasave to interface with
- SBE 9plus with SBE 11plus Deck Unit and G.O. 1016 Rosette or
SBE 32 Carousel Water Sampler, or
- SBE 19, 19plus, 19plus V2, 25, or 49 with SBE 33 Deck Unit and
SBE 32 Carousel Water Sampler, or
- SBE 19, 19plus, 19plus V2, 25, or 49 with SBE 33 Deck Unit and SBE
55 ECO Water Sampler.

For these systems, Seasave creates the .bl file. Each time a bottle fire
confirmation is received, the bottle sequence number, position, date, time,
and beginning and ending scan numbers (1.5-second duration for each
bottle) are written to the .bl file.

o Auto Fire Module or ECO (.afm) file - if used
- Carousel Auto Fire Module (AFM) with SBE 19, 19plus, 19plus V2,
25, or 50 and SBE 32 Carousel Water Sampler, or
- SBE 19, 19plus, 19plus V2, 25, or 50 and SBE 55 ECO Water Sampler
(autonomous operation).

For these systems, the .afm file contains five scans of data recorded by the
AFM or SBE 55 ECO Water Sampler for each bottle firing.

e Bottle scan range (.bsr) file - if used Mark Scan feature in Seasave during
data acquisition to create a .mrk file; use Mark Scan to convert the .mrk
file to a .bsr file before running Data Conversion. The format for the .bsr
file is:
beginning scan # for bottle #1, ending scan # for bottle #1

beginning scan # for last bottle, ending scan # for last bottle
Example: test.bsr contains -
1000, 1020
2000, 2020
4000, 4020
The .ros file created using test.bsr would contain scans 1000 - 1020 for
bottle #1, 2000 - 2020 for bottle #2, and 4000 - 4020 for bottle #3.

The amount of data written to the .ros file is based on:

e Scan range offset - determines the first scan output to the .ros file for
each bottle, relative to the first scan with a confirmation bit set or written
to a .afm, .bsr, or .bl file.

e  Scan range duration - determines the number of scans output to the .ros
file for each bottle.

Example: A bottle confirmation for an SBE 911plus is received at scan 10,000
(scan 10,000 and subsequent scans for 1.5 seconds have confirmation bit set).
In Data Conversion, Scan range offset is set to -2 seconds, and Scan range
duration is set to 5 seconds. If the scan rate is 24 scans/second,

10,000 - 2 second offset (24 scans/second) = 9,952

9,952 + 5 second duration (24 scans/second) = 10,072

Therefore, scans 9,952 through 10,072 will be written to the .ros file.
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Note:

If you choose to compute derived
parameters in Data Conversion,
note that the algorithms are the
same as used in Derive (with the
exception of the oxygen, descent
rate, and acceleration calculations);
see Appendix V: Derived
Parameter Formulas for
algorithms for derived variables.

Data Conversion: Notes and General Information

Data Conversion was written to accommodate most sensors that have been
installed on Sea-Bird products. See the configuration page at the beginning of
your instrument manual for the sensors that were installed on your system.

e Ifyou plan to process the data with other modules, select only the primary
variables to be converted, and then use Derive to compute derived
parameters such as salinity, density, sound velocity, and oxygen.

e If desired, you can select the same variable multiple times for the output
.cnv file. If you do, data processing operations on that variable in other
modules will use the last occurrence of the variable in the file.

Example: Select Primary Conductivity, Primary Temperature, Pressure,
and Primary Conductivity (again) for output variables (columns 1, 2, 3,
and 4 respectively). Then, if you run Cell Thermal Mass, it will correct the
conductivity in column 4 only, leaving column 1 uncorrected; you could
plot the corrected and uncorrected conductivity to see the changes. If you
then run Derive to calculate salinity, it will use the corrected conductivity
in column 4 in the salinity calculation.

e If you will use Derive to compute:

»  Salinity, density, or other parameters that depend on salinity -
include pressure, temperature, and conductivity in the output file.
For a moored instrument without optional pressure sensor (SBE 16,
16plus, 16plus-IM, 16plus V2, or 16plus-IM V2), if you select
pressure as an output variable, Data Conversion inserts a column with
the moored pressure (entered in the configuration file Data dialog) in
the output .cnv file. For a thermosalinograph (SBE 21 or 45), if you
select pressure as an output variable, Data Conversion inserts a
column of 0’s for the pressure in the output .cnv file. The pressure
column is needed for Derive to calculate salinity, density, etc.

» Oxygen - include in the output file (along with pressure, temperature,
and conductivity)
For SBE 13 or 23 - oxygen current and oxygen temperature
For SBE 43 - oxygen value

e If you will use Bin Average:
»  With depth bins - include depth in the output file
»  With pressure bins - include pressure in the output file

e  Pressure temperature is computed using a backward-looking, 30-second
running average, to prevent bit transitions in pressure temperature from
causing small jumps in computed pressure. Because the heavily insulated
pressure sensor has a thermal time constant on the order of one hour,
the 30-second average does not significantly alter the computed
pressure temperature.

e Oxygen, descent rate, and acceleration computed by Seasave and Data
Conversion are somewhat different from values computed by Derive,
because the algorithms calculate the derivative of the signal (oxygen
signal for oxygen, pressure signal for descent rate and acceleration) with
respect to time, using a linear regression to determine the slope. Seasave
and Data Conversion compute the derivative looking backward in time,
since they share common code and Seasave cannot use future values while
acquiring data in real time. Derive uses a centered window (equal number
of points before and after the scan; time window size is user input) to
obtain a better estimate of the derivative. Use Seasave and Data
Conversion to obtain a quick look at oxygen, descent rate, and
acceleration; use Derive to obtain the most accurate values.

e Foran SBE 21 or 45 with a remote temperature sensor, Seasave,
Data Conversion, Derive, and Derive TEOS-10 all use the remote
temperature data when calculating density and sound velocity.
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Notes:

e Each SBE Data Processing
module that modifies a .cnv
file adds information to the
header and updates nquan,
nvalues, name n, span n,
interval, and file_type, as
applicable.

e Calibration coefficients were
added to the file header for a
.cnv file and for a .ros water
bottle file in SBE Data
Processing version 7.19.

Data Conversion has the following /x parameters when run from the Command
Line Options dialog box, from the command line, or with batch file processing:

/x Parameter

Description

/xdatenv:skipN

N = number of scans to skip.

/xdatcnv:pump

For SBE 911plus, do not output scans if
pump status = off.

/xdatcnv:nomatch

Disable matching of header information to .con or .xmlcon
configuration file - program continues to run even if there is
a discrepancy in header information.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

Data Conversion adds the following to the data file header for a
.cnv converted data file:

Label Description
Number of columns (fields) of converted data.
Note: Data Conversion automatically adds 1 field to number
Nquan selected by user (i.e., if user selects 3 variables to convert,
then nquan=4). This added field, initially set to 0, is used by
Loop Edit to mark bad scans.
Nvalues Number of scans converted.
. Specified (indicates units are specified separately for each
Units .
variable).
Name n Sensor (and units) associated with data in column n.
Span n Span (highest - lowest value) of data in column n.
Interval Scan rate (seconds).
Start time Data start time.
Bad_flag Fgr information only; value that Loop Edit and Wild Edit
- will use to mark bad scans and bad data values.
Sensors Sensor description, serial number, and calibration date and

coefficients, all in XML format.

Datcnv_date

Date and time that module was run. Also shows how many
columns of data output (not including flag column).

Datenv_in

Input .hex (or .dat) data file and .con or .xmlcon
configuration file.

Datcnv_skipover

Number of scans to skip over in processing.

Datcnv_ox_
hysteresis_correction

Whether hysteresis correction was performed on oxygen
data.

Datenv_ox_tau
correction

Whether tau correction was performed on oxygen data.

File type

Selected output file type - ASCII or binary.

Data Conversion adds the following to the data file header for a

.ros water bottle file:

Label Description
Number of columns (fields) of converted data.
Note: Data Conversion automatically adds 1 field to number
Nquan selected by user (i.e., if user selects 3 variables to convert,
then nquan=4). This added field, initially set to 0, is used by
Loop Edit to mark bad scans.
Nvalues Number of scans converted.
. Specified (indicates units are specified separately for each
Units .
variable).
Name n Sensor (and units) associated with data in column n.
Interval Scan rate (seconds).
Start time Data start time.
Sensors Sensorldescriptign, serial number, and calibration date and
coefficients, all in XML format.
Datcnv_date Date and time that module was run.
. Input .hex (or .dat) data file and .con or .xmlcon
Datcenv_in .
- configuration file.
Datcenv_bottle Source of data for creating bottle file, and scan range offset
scan_range source | and duration.
Datenv_scans_ Number of data scans/bottle in .ros file; based on scan range
per bottle offset and duration, and CTD sampling rate

71




Manual revision 7.23.2

Section 5: Raw Data Conversion Modules SBE Data Processing

Bottle Summary

Note:
Bottle Summary was previously
called Rosette Summary.

Note:

A .bl file is created by:

e Seasave, during real-time data
acquisition, or

e Data Conversion, if the source of
scan rage data was a .afm file.

Note:
You can create a .sn file in a text
editor.

Bottle Summary reads a .ros file created by Data Conversion and writes a
bottle data summary to a .btl file. The .ros file must contain (as a minimum)
temperature, pressure, and conductivity (or salinity).

The output .btl file includes:

e Bottle position, optional bottle serial number, and date/time

e User-selected derived variables - computed for each bottle from mean
values of input variables (temperature, pressure, conductivity, etc.)

e  User-selected averaged variables - computed for each bottle from
input variables

The maximum number of scans processed per bottle is 1440.
In addition to the .ros input file:

e Ifa bl file (same name as input data file, with .bl extension) is found in
the input file directory, Bottle Summary uses bottle position data from the
.bl file. The bottle position data defines the bottle firing sequence - the .bl
file contains the bottle firing sequence number, bottle position, date and
time, and beginning and ending scan number for each bottle.

e Ifa .sn file (same name as input data file, with .sn extension) is found in
the input file directory, bottle serial numbers are inserted between the
bottle position and date/time columns in the .btl file output. The format
for the .sn file is:

Bottle position, serial number (with a comma separating the two fields)
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The Data Setup tab in the dialog box looks like this:

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

E% Hottle Summary

File Options Help

File Setyp  Data Setup | Header View

[ Dutput mindmax values foraveraged variables

Select input variables to be averaged. Mean and
standard deviation will be calculated and output for
each bottle.

o If Output min/max values for averaged variables

Select Averaged Variables. .

Ignored if not computing oxygen in derived
variables:

Tau correction ([tau(T,P) * 8V/&t] in SBE 43 or
[tau * doc/dt] in SBE 13 or 23) improves
response of measured signal in regions of large
oxygen gradients. However, this term also
amplifies residual noise in signal (especially in
deep water), and in some situations this
negative consequence overshadows gains in
signal responsiveness.

is selected, minimum and maximum values will

Select Derived VWariables. .
\I also be output for each bottle.

Orygen
T Apply Tau comection

\ 1

Select variables to derive from input data. Derived
variables are computed from mean values of input
variables (temperature, conductivity, pressure, etc.)
for each bottle.

Oxygen can be derived if oxygen data (oxygen
current and temperature for SBE 13 or 23; oxygen
signal for SBE 43) is in the .ros file.

Bottle Summary calculates derivative of oxygen
current (or signal), using a least squares fit to all
the oxygen data for each bottle. Oxygen is
calculated using mean values for temperature,
pressure, and salinity, derivative, and scan-by-
scan values of oxygen current and temperature (or
signal).

Return to SBE Data Processing window.

If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
If Confirm Program Setup Change was not selected in Options menu - Button says

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

——Start Process

Save & Exit. If you do not want to save changes, use Cancel button to exit.

N\
Cancel I

E it |

Bottle Summary adds the following to the data file header:

Label* Description

Bottlesum date | Date and time that module was run.

Input .ros bottle data file and .con or .xmlcon

Bottlesum_in configuration file.

Bottlesum ox | Tau correction applied to oxygen data? Only appears if
tau_correction | oxygen is derived.

*Labels were previously rossum_date and rossum_in.
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Mark Scan

Note:

Alternatively, an ASCII text editor can
be used to create the .bsr file. The
format for the output .bsr file is:

Beginning scan for bottle 1, ending scan for
bottle 1
Beginning scan for bottle 2, ending scan for
bottle 2

Beginning scan for last bottle, ending scan
for last bottle

Note that a comma must separate the
beginning and ending scan numbers.

Note:

The File Setup tab is similar
for all modules; see Section 2:
Installation and Use.

Mark Scan creates a bottle scan range (.bsr) file from a .mrk data file created
in Seasave. The data in the .bsr file can be used by Data Conversion to create a
.ros file, and the .ros file can be used by Bottle Summary to create a bottle data
summary .btl file.

The input .mrk file contains one scan with the mark number, system time,
and scan number for each time Mark Scan was clicked while in Seasave’s
Mark Scan Control dialog box (accessed by selecting Mark Scan Control in
Seasave’s Real-Time Control menu). Mark Scan’s output .bsr file points to a
user-defined range of adjacent scans for each marked scan. Note that the
output .bsr file only contains the pointers to the scans, and does not contain
the data.

The Data Setup tab in the dialog box looks like this:

& Mark Scan

Eie Dptions - Help

i [=] E3

File Setup  DataSetup l
|

|E > Define the range of scans around each scan in

the .mrk file to include in the .bsr file.
Duration [scats] |1D

o offset - number of scans before or after scan
in .bsr file for starter pointer

e duration - number of scans to include in .bsr
file for each scan in .mrk file

Example: Offset is -5 scans and duration is

10 scans. If .mrk file contains scans 16 and

128, .bsr file will look like this:

11, 21 (16-5=11; 11+10=21)

123, 133 (128-5=123; 123+10=133)

Dffeet [snang]

Return to SBE Data Processing window.
o If Confirm Program Setup Change was selected in Options menu - If you made

o If Confirm Program Setup Change was not selected in Options menu - Button says

changes and did not Save or Save As, program asks if you want to save changes.

Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows
Processing complete when done.

Begin processing data. Status field

N\ |

Exit I Cancel I

Start Process

Mark Scan’s output .bsr file does not have a header.
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Section 6: Data Processing Modules

All data processing is performed on converted data from a .cnv file.

Module Name Module Description
Align CTD Align de}tg relative to pressure (typically used for
conductivity, temperature, and oxygen).
Bin Average Average data}, basing bins on pressure, depth, scan
number, or time range.
Buovanc Compute Brunt Viisild buoyancy and
yancy stability frequency.
CellI\T/Il;::mal Perform conductivity thermal mass correction.
Calculate salinity, density, sound velocity, oxygen,
Derive potential temperature, dynamic height, etc. based on
EOS-80 (Practical Salinity) equations.
Derive Calculate thermodynamic properties based on TEOS-10
TEOS-10 (Absolute Salinity).
Filter Low-pass filter columns of data.
Loop Edit Mgrk a scan w1th badflag if scan fails pressure reversal or
minimum velocity tests.
Wild Edit Mark a data value with badflag to eliminate wild points.
Window Filter data with triangle, cosine, boxcar, Gaussian, or
Filter median window.
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Align CTD
Align CTD aligns parameter data in time, relative to pressure. This ensures

Note: that calculations of salinity, dissolved oxygen concentration, and other
Align CTD cannot be run on files that parameters are made using measurements from the same parcel of water.
have been averaged into pressure or Typically, Align CTD is used to align temperature, conductivity, and oxygen
depth bins in Bin Average. If measurements relative to pressure.
alignment is necessary, run Align
CTD before running Bin Average. There are three principal causes of misalignment of CTD measurements:

e physical misalignment of the sensors in depth

e inherent time delay (time constants) of the sensor responses

profiling speed)

to pressure

Pressure

EE Align CTD

Upcast and Downcast mismatch with . o
File' Dptions  Help

Respect to Pressure
Fie Setup DataSetup | HeaderView |

e water transit time delay in the pumped plumbing line - the time it takes
the parcel of water to go through the plumbing to each sensor (or, for free-
flushing sensors, the corresponding flushing delay, which depends on

When measurements are properly aligned, salinity spiking (and density) errors
\ are minimized, and oxygen data corresponds to the proper pressure (e.g.,
Aligned relative \ temperature vs. oxygen plots agree between down and up profiles).

Downcast * The Data Setup tab in the dialog box looks like this:

1

= E3

Define alignment times for all data.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field

\

on File Setup tab shows

Processing complete when done. Start Process |

Exit\ l

Cangel

The Enter Advance Values dialog box looks like this:

Enter Advance Values

Variable Name uni]

Advance (zec)

+ Advance - Advance | Tempetature TS0 deg O]

<+ (delay) —» Candyctivity [5/m]

> Dypen Curren, Beckman/ YS! [ud]

Time i
Dipaen Ternperatire, Beckian/Y5! {deg C]

Dwyiger, BeckmanS! [mi/)

ol oo oo

oK | Cancel
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Define alignment times.
Diagram shows sign
convention for Advance. If
0 seconds is entered,
alignment relative to
pressure (and time) remains
unchanged for that variable.
See discussion below to
determine appropriate
alignment times for
conductivity, temperature,
and oxygen.
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Align CTD: Conductivity and Temperature

Temperature and conductivity are often misaligned with respect to pressure.

Shifting temperature and conductivity relative to pressure can compensate.

As shown in the figures, indications of misalignment include:

e  Depth mismatch between downcast and upcast data

e Spikes in the calculated salinity (which is dependent on temperature,
conductivity, and pressure) - caused by misalignment of temperature and
conductivity with each other

The best diagnostic of proper alignment is the elimination of salinity spikes
that coincide with very sharp temperature steps. To determine the best
alignment, plot 10 meters of temperature and salinity data at a depth that
contains a very sharp temperature step. For the downcast, when temperature
and salinity decrease with increasing pressure:

e A negative salinity spike at the conductivity step means that conductivity
leads temperature (conductivity sensor sees step before temperature sensor
does). Advance conductivity relative to temperature a negative number
of seconds.

o Conversely, if the salinity spike is positive, advance conductivity relative
to temperature a positive number of seconds.

0 dbf T 0 dbf Odbpr— T

Negative E
E spike ... = No
; ':/:{-, -------- E Spike an®

] F " ol L] E e

S : SF 5 i

o H A orF [

of : Salinity St oF ! Salinity

ot T ot oE
Downcast, Conductivity leads Temperature Downcast, Conductivity lags Temperature Downcast, C and T Aligned

The best alignment of conductivity with respect to temperature is obtained
when the salinity spikes are minimized. Some experimentation with different
advances is required to find the best alignment.

Typical Temperature Alignment
The SBE 19, 19plus, and 19plus V2 use a temperature sensor with a relatively

slow time response, while the SBE 9plus, 25, 25plus, and 49 use a temperature
sensor with a faster time response. Typical advances are:

Instrument Advance of Temperature Relative to Pressure (seconds)
Iplus 0
19, 19plus, or
19plus V2 0.5
25 or 25plus 0
49 * +0.0625

*The SBE 49 can be programmed to advance temperature relative to pressure
in real-time, eliminating the need to run Align CTD. See the SBE 49 manual
for details.
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Note:

All SBE 11 series deck units can
advance primary conductivity, which
may eliminate the need to use Align
CTD for conductivity. The SBE 11plus
does not advance secondary
conductivity. The SBE 11plus V2 can
advance secondary conductivity and
all voltage channels; the advance time
is user-programmable.

Advance C relative to T +0.073 seconds

(use SBE 11 series deck unit and/or ALIGN CTD)

e

T
i J |

l— ClagsTby —» Time

0.073 seconds

Typical Conductivity Alignment

SBE 9plus - For an SBE 9plus with TC-ducted temperature and
conductivity sensors and a 3000-rpm pump, the typical lag of conductivity
relative to temperature is 0.073 seconds. The Deck Unit can be
programmed to advance conductivity relative to pressure, eliminating the
need to run Align CTD.

Following is an example of determining the value to enter in Align CTD:
Example: The SBE 11plus is factory-set to advance the primary
conductivity +1.75 scans (at 24 Hz, this is 1.75 / 24 = 0.073 seconds).
Advance conductivity relative to temperature in Align CTD:

0.073 - 1.75/24 = 0.0 seconds (enter 0 seconds for conductivity).

SBE 19plus or 19plus V2 — For an SBE 19plus or 19plus V2 with a
standard 2000-rpm pump, do not advance conductivity.

SBE 19 (not plus) — For an unpumped SBE 19, the conductivity
measurement may lead or lag that of temperature, because the flushing
rate of the conductivity cell depends on drop speed. If the SBE 19 is
lowered very slowly (< 20 cm/second, typically from a fixed platform or
ice), conductivity lags temperature. If the SBE 19 is lowered fast,
conductivity leads temperature. Typical advances of conductivity relative
to temperature range from 0 seconds at a lowering rate of

0.75 meters/second to -0.6 seconds for 2 meters/second (if temperature
was advanced +0.5 seconds, these correspond to conductivity advances of
+0.5 seconds and -0.1 seconds respectively).

SBE 25 or 25plus - For an SBE 25 or 25plus with a standard 2000-rpm
pump, a typical advance of conductivity relative to temperature is
+0.1 seconds.

SBE 49 — For a typical SBE 49 with TC duct and 3000 rpm pump, do not
advance conductivity.

If temperature is advanced relative to pressure and you do not want to
change the relative timing of temperature and conductivity, you must add
the same advance to conductivity.

Example (typical of an unpumped SBE 19):

Advance temperature relative to pressure +0.5 seconds to compensate for slow
response time of sensor.

If the CTD is lowered at 0.75 m/s, advance conductivity relative to
temperature 0 seconds. Calculate advance of conductivity relative to
pressure to enter in Align CTD: +0.5 + 0 =+0.5 seconds

If the CTD is lowered at 2 m/s, advance conductivity relative to
temperature -0.6 seconds. Calculate advance of conductivity relative to
pressure to enter in Align CTD: +0.5 + (-0.6) =-0.1 seconds
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Align CTD: Oxygen

Oxygen data is also systematically delayed with respect to pressure. The two
primary causes are the long time constant of the oxygen sensor (for the

SBE 43, ranging from 2 seconds at 25 °C to approximately 5 seconds at 0 °C)
and an additional delay from the transit time of water in the pumped plumbing
line. As with temperature and conductivity, you can compensate for this delay
by shifting oxygen data relative to pressure. Typical advances for the SBE 43,
13, or 23 are:

Instrument Advance of Oxygen Relative to Pressure (seconds)
Iplus +2 to +5
19plus or
+ +
19plus V2 3to+7
19 (not plus) +3 to +7 (pumped), +1 to +5 (unpumped)
25 or 25plus +3 to +7

Align CTD adds the following to the data file header:

Label Description

Alignctd date | Date and time that module was run.

Alignctd in Input .cnv converted data file.

Alignctd adv | Variables aligned and their respective alignment times.
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Bin Average

Note: Bin Average averages data, using averaging intervals based on:
Align CTD, which aligns parameter

data in time, relative to pressure, e  pressure range,

cannot be run on files that have been

averaged into pressure or depth bins e depth range,

in Bin Average. If alignment is

necessary, run Align CTD before

running Bin Average. e scan number range, or

e time range

Note: The Data Setup tab in the dialog box looks like this:

The File Setup tab and Header View

tab are similar for all modules; see B% Bin Average ISl B¥2

i . i : e o Average by:
Section 2: Installation and Use. File  Options  Help . pregsuré/ (with or without interpolation)

o depth (with or without interpolation)
e scan number
e ¢ time (seconds or hours)
Bin type: |PFESSUIE _:I If pressure (or depth) is not included in input
file, it will not appear on list of bin types.

File Setup  DataSelup | Haader View |

If selected, a column containing number of W
scans in each bin will be added to output data. Birvsize: l-ﬂl

Bin size is range of data for each bin (i.e.,
X pressure range, scan number range, etc.).
Iviclade rumber of scars per bin
If selected, data from scans marked with
badflag in Loop Edit will not be used in H‘J ‘Exchide séatis markied bad
calculating average. Note that values marked : Skip first n scans of data before
with badflag by Wild Edit are never included ; : beginning processing.
in calculating average. Spang to skip over iEI ~ 2 9P ’

; : [
Cast to pracess ILI|:u:ast and downcast j | Process downcast, upcast, or both.

If selected, include surface bin (applicable only if v rElide surfane bin
averaging by pressure or depth). Input: ¥R

e minimum and maximum values - minimum and | §yface bif minimm Yalue r_‘u
maximum (pressure or depth, as applicable) to e

be used in calculating surface bin Surface bih masimum value |D
* value - target value (pressure or depth) to be :
associated with averages Surtace bin walus Iu

Note that surface bin minimum, maximum,
and value do not affect minimum, maximum,
and center of first or subsequent bins.

Begin processing data. Status field

on File Setup tab shows INC St Provans | Bt/ I B
Processing complete when done. v :
/

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Note:

If Exclude scans marked bad is
selected in the dialog box, data from
scans marked with badflag in Loop
Edit are not used in calculating
average. Values marked with badflag
by Wild Edit are never included in
calculating the average. If the
number of points included in the
average is 0 (all data and/or scans in
the bin are marked with badflag), the
average value is set to badflag.

Bin Average: Formulas

The center value of the first (not surface) bin is set equal to the bin size. The
surface bin, if included, cannot overlap the first bin.

Example (pressure bin, surface bin not included):
Bin size is 10 db. The first bin is defined as follows:

surface = 0 db

Minimum first bin = BinMin =

4 bin size - (bin size/2) = 5 db
First bin Center (target) first bin =
Bin size=10 db bin size=10 db

A 4 Maximum first bin = BinMax =

bin size + (bin size/2) = 15 db

Example (pressure bin, surface bin included):
Bin size is 10 db. Surface bin is included, and surface bin parameters are 0 db
minimum, 3 db maximum, and 0 db value. The bins are defined as follows:

minimum surface bin = 0 db

'y target surface bin = 0 db
Surface bin

v Bin size=3 db maximum surface bin = 3 db

A Minimum first bin = BinMin =
bin size - (bin size/2) =5 db

First bin Center (target) first bin =
Bin size=10 db bin size=10 db
v Maximum first bin = BinMax =

bin size + (bin size/2) = 15 db

Note that for this example, the surface bin could have a maximum of up to
5 db (the minimum value for the first bin).

The algorithms used for each type of averaging follow.

Pressure Bins (no interpolation)

For each bin:

BinMin = center value - (bin size / 2)
BinMax = center value + (bin size / 2)

1. Add together valid data for scans with BinMin < pressure < BinMax.
Divide the sum by the number of valid data points to obtain the average,
and write the average to the output file.

Repeat Steps 1 through 2 for each variable.

4. For the next bin, compute the center value and repeat Steps 1 through 3.

W
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Pressure Bins (with interpolation)
For each bin:
BinMin = center value - (bin size / 2)
BinMax = center value + (bin size / 2)
1. Add together valid data for scans with BinMin < pressure < BinMax.
2. Divide the sum by the number of valid data points to obtain the average.
3. Interpolate as follows, and write the interpolated value to the output file:
P, =average pressure of previous bin
X, =average value of variable in previous bin
P. =average pressure of current bin
X, =average value of variable in current bin
P; = center value for pressure in current bin
X, =interpolated value of variable (value at center pressure P;)
=((Xe-Xp) * (Pi-Py) /(P -Pp) ) + X,
4. Repeat Steps 1 through 3 for each variable.
5. Compute the center value and Repeat Steps 1 through 4 for the next bin.
Values for the first bin are interpolated after averages for the second bin are
calculated; values from the next (second) bin instead of the previous bin are
used in the equations.

Depth Bins (with or without interpolation)
Depth bin processing is similar to processing pressure bins, but bin size and
center values are based on depth.

Scan Number Bins

Scan number bin processing is similar to processing pressure bins without
interpolation. If exclude scans marked bad is selected, Bin Average averages
bin size good scans (not marked with badflag in Loop Edit).

Example: Bin size is 100. First bin should include scans 50 - 149. However,
scans 93, 94, and 126 are marked with badflag in Loop Edit, and the user
selected exclude scans marked bad. To include 100 valid scans in the average,
Bin Average includes scans 50 - 152 in the first bin.

Time Bins
Time bin processing is similar to processing pressure bins without
interpolation. Bin Average determines the number of scans to include based on
the input bin size and the data sampling interval:

Number of scans = bin size [seconds] / interval or

Number of scans = (bin size [hours] x 3600 seconds/hour) / interval

Bin Average has the following /x parameter when run from the Command Line
Options dialog box, from the command line, or with batch file processing:

/x Parameter Description

/xbinavg:cN N = center value for first bin.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

Bin Average adds the following to the data file header:

Label Description
Binavg date Date and time that module was run.
Binavg in Input .cnv converted data file.

Binavg bintype

Bin type (pressure, depth, scan time in seconds or hours).

Binavg binsize

Bin size.

Binavg_excl
bad scans

If yes, values from scans marked with badflag in Loop
Edit are not included in average.

Binavg_skipover

Number of scans skipped over.

Binavg_surface
bin

Surface bin included? Minimum and maximum values
for surface bin.
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Buoyancy

Note:

The input .cnv file for Buoyancy must
have been processed with Bin
Average on pressure bins (with or
without interpolation) and must
contain pressure, temperature, and
either salinity or conductivity.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Select buoyancy
variables to be
computed and added
to.cnvfile-1, 2, 3,
or 4 variables can be
computed.

& Buoyancy Hi=]

Fle Dptions  Help

File Setup DataSetup | HeaderView

Buoyancy calculates buoyancy (Brunt-Viiséld) frequency (N) and stability (E)
using the Fofonoff adiabatic leveling method (Bray N. A. and N. P. Fofonoff
(1981) Available potential energy for MODE eddies. Journal of Physical
Oceanography, 11, 30-46.).

The Data Setup tab in the dialog box looks like this:

Select variable used in buoyancy computation:

o Latitude - Buoyancy uses algorithm in
UNESCO Technical Papers in Marine Science 44
to estimate local gravity from user-input latitude

e Gravity

Calculate buoyancy variables for pressure values
centered in window. Buoyancy converts window
o e size from decibars to scans based on pressure
Winrion 38 ido] |-IEI interval between scans in input file. If window size
is less than 3 scans, Buoyancy sets it to 3 scans.
If window size is an even number of scans,
Buoyancy adds 1 scan to window size. (see
example below)
Note: As used here, a scan is one row of output
data from Bin Average, which is an average of
many scans of original data.

Buayancy Yariable

Latitoide:

Grawity [mds"2]

[~ Stability, E [rad"*2/m]
I~ SGtability, E [10°8 rad”2/m]
Bunyancy frequenicy (N2 1ad°245°2]

Bucpancy frequency [N, coclesdhowr]

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

N\ |

Start Process

SavelEdt | Cancel |

Example: For an interval of 10 db between scans, buoyancy window sizes of
5, 10, or 20 db result in a window size of 3 scans. Window sizes of
30 or 40 db result in a window size of 5 scans.

10 db 20 db 30db 40 db 50 db
< 5 db window = 3 scan minimum >

10 db window = 3 scan minimum

:20 db window = 3 scans (10, 20, 30 db)>

A 4

30 db window = 4 scans (10, 20, 30, 40 db) + 1 scan to’take odd number

A 4

< 40 db window = 5 scans (10, 20, 30, 40, 50 db)
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Buoyancy: Formulas

The relationship between frequency N and stability E is:
N?=gE [rad’/s’]

where g = gravity [m / s%]

The algorithm used to compute N? for the pressure value centered in the
buoyancy window is:

1. Compute averages:
p_bar = average pressure in the buoyancy window [decibars]
t_bar = average temperature in the buoyancy window [deg C]
s_bar = average salinity in the buoyancy window [PSU]
rho_bar = density (s_bar, t_bar, p_bar) [Kg/m’]
2. Compute the vertical gradient:
theta = potential temperature (s, t, p, p_bar)
v =1/ density(s, theta, p_bar)
where s, t, and p are the averaged values for salinity, temperature, and
pressure calculated in Bin Average

Use a least squares fit to compute the linear gradient dv/dp in the
buoyancy window.

3. Compute N> N, E, and 10 *E:

N?=-1.0¢"rho_bar’g’ 2’— [rad?/s’]

3600
N="n \/ N? [eycles/hour)

2
E- _zgv [rad*/m]
NZ
E=10" R [10°% rad?*/m]

Buoyancy adds the following to the data file header:

Label Description

Buoyancy date | Date and time that module was run.

Buoyancy in Input .cnv converted data file.

Gravity value (input value or value based on input
Buoyancy vars | latitude) and buoyancy window size (adjusted to provide
a minimum of three scans and an odd number of scans).
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Cell Thermal Mass

Note:

Cell thermal mass corrections should
not be applied to freshwater data.
It can give bad results, due to the
way the derivative dC/dT is
calculated in regions where
conductivity changes are very small.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Cell Thermal Mass uses a recursive filter to remove conductivity cell thermal
mass effects from the measured conductivity. Typical values for alpha and

1/beta are:
Instrument alpha | 1/beta

SBE 9plus with TC duct and 3000 rpm pump 0.03 7.0
SBE 19plus or 19plus V2 0.04 3.0
with TC duct and 2000 rpm pump ) '

SBE 19 (not plus) with TC duct and 2000 rpm pump 0.04 8.0
SBE 19 (not plus) with no pump, moving at 1 m/sec 0.042 10.0
SBE 25 or 25plus with TC duct and 2000 rpm pump 0.04 8.0
SBE 49 with TC duct and 3000 rpm pump * 0.03 7.0

*The SBE 49 can be programmed to correct for conductivity cell thermal mass

effects in real-time, eliminating the need to run Cell Thermal Mass. See the

SBE 49 manual for details.

The Data Setup tab in the dialog box looks like this:
&% Cell Thermal Mass
File Options  Help
File Getup  Data Setup | Header View |

v Chmect priman corductivits walues

E[=l E3

Temperatute sensor o use

Thermal shomaly amplitude [alpha] 00z

Filter primary and/or
secondary conductivity
values.

Thermal aramal time constant [1/heta] i;-'

Use primary or secondary
temperature sensor data for
filtering the conductivity data.

¥ oot secondary conduchivity valies

Tempetature senzor to bse Secondary =

Thermal anomaly ampltude [alphal 00z

Thermal anormaly time constant [1/beta] !?

Return to SBE Data Processing window.
o If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

™ stant Process |

\

(| e
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Cell Thermal Mass: Formulas
The algorithm used is:

a =2 * alpha / (sample interval * beta + 2)
b=1-(2*a/alpha)

dc/dT =0.1 * (1 + 0.006 * [temperature - 20])

dT = temperature - previous temperature

ctm [S/m] =-1.0 * b * previous ctm + a * (dc/dT) * dT

where
sample interval is measured in seconds and temperature in °C
ctm is calculated in S/m

If the input file contains conductivity in units other than S/m, Cell Thermal
Mass applies the following scale factors to the calculated ctm:

ctm [mS/cm] = ctm [S/m] * 10.0

ctm [uS/cm] = ctm [S/m] * 10000.0

corrected conductivity = ¢ + ctm

To determine the values for alpha and beta, see:
Lueck, R.G., 1990: Thermal Inertia of Conductivity Cells: Theory., American
Meteorological Society Oct 1990, 741-755.

Cell Thermal Mass adds the following to the data file header:

Label Description
Celltm_date Date and time that module was run.
Celltm in Input .cnv converted data file.
Celltm_alpha Value used for alpha.
Celltm_tau Value used for 1/beta.
Celltm_temp_sensor | Temperature sensor for primary conductivity filter,
use for cond temperature sensor for secondary conductivity filter.
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Derive (EOS-80; Practical Salinity)

Notes:

¢ Derive’s File Setup tab requires
selection of an input data file and
instrument configuration (.con or
.xmlcon) file. SBE 37 stores
calibration coefficients internally, and
does not have a .con or .xmlcon file
provided by Sea-Bird.
- If you used SeatermV2 version 1.1
or later to upload SBE 37 data, the
software created a .xmlcon file when
it created the .hex file.
- If you used an earlier version of

SeatermV2 or any version of Seaterm

to upload SBE 37 data, use a .con or
.xmlcon file from any other Sea-Bird

instrument; the contents will not affect

the results. If you do not have a .con
or .xmlcon file for another instrument,
create one in SBE Data Processing’s
Configure menu (select any
instrument in the Configure menu,
then click Save As in the
Configuration dialog box).

o Algorithms used for calculation of
derived parameters in Data
Conversion, Derive, Sea Plot,
SeaCalc Il [EOS-80 (Practical
Salinity) tab], and Seasave are

identical, except as noted in Appendix

V: Derived Parameter Formulas
(EOS-80; Practical Salinity), and are
based on EOS-80 equations.

¢ Derive is not compatible with a .cnv
file from an SBE 39, 39-IM, 39plus,
or 48.

e For an SBE 21 or 45 with a remote
temperature sensor, Seasave, Data
Conversion, Derive, and Derive
TEOS-10 all use the remote
temperature data when calculating
density and sound velocity.

Note:

The File Setup tab and Header View
tab are similar for all modules; see
Section 2: Installation and Use.

Derive uses pressure, temperature, and conductivity from the input .cnv file to
compute the following oceanographic parameters:

density (density, sigma-theta, sigma-1, sigma-2, sigma-4, sigma-t)
thermosteric anomaly

specific volume

specific volume anomaly

geopotential anomaly

dynamic meters

depth (salt water, fresh water)

salinity

sound velocity (Chen-Millero, DelGrosso, Wilson)

average sound velocity

potential temperature (reference pressure = 0.0 decibars)

potential temperature anomaly

specific conductivity

derivative variables (descent rate and acceleration) - if input file has not
been averaged into pressure or depth bins

oxygen (if input file contains pressure, temperature, and either
conductivity or salinity, and has not been averaged into pressure or
depth bins) - also requires oxygen current and oxygen temperature
(SBE 13 or 23) or oxygen signal (SBE 43)

corrected irradiance (CPAR)

See Appendix V: Derived Parameter Formulas for the formulas used to
calculate these parameters.

See Derive TEOS-10 after this module to calculate TEOS-10 (Absolute
Salinity) parameters.

The Data Setup tab in the dialog box looks like this:

File Cptions Help

File Setup  Diata Setup | Miscellaneousl HeaderViewI

=131

Select variables to

Select Derived Variables... 1/ be calculated.

The thermodynamic properties computed by thiz module are based on EOS-80.

Usge the Derive TEODS-10 module to compute variables baged on TEOS-10.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows

Begin processing data. Status field

Processing complete when done.

\

Eat \ |

Cancel

\Start Process |
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The Select Derived Variables dialog box looks like this:

b

Shiink Al |
Evpand Al |
Shrirk. |
Expand |

List includes all variables
that can be derived from
variables in input data file.

Seq Wanabla Mame [Lnit] =
1 Drersity [dersity, Kagdm™3] [#- Average Sound Yelocity
2 Drepth [salt water, m] Change | '%j D:er?;itg S
3 Sound Yelocity [Chen-Millera, mds] i bl AT N
4 [SammpPsU] e | L i:z:zth:;r:?;m 3
< Add variable: olick blank field in Variable Name column, 1 M g
click desired sensor in sensor list, click Add. ] Dotz Al | P Sigma_4: Kg g
e Change variable: click existing sensor in Variable Name - Depth
column, click desired sensor in sensor list, click Change. [ | - Descent Rate
¢ Insert variable: click existing sensor below desired ] -+ Dynamic Meters [10. /K]
sequence # in Variable Name column, click desired ¢+ Gieopotential Anomaly [1/Kd]
sensor in sensor list, click Insert. | :z g;f;?als;;‘;a:;we
If Derive requires additional information to compute a : 1 Potertial Temse[atwe i
variable, a dialog box appears after variable is selected, .. Salinity [PSL]
with fields for required user-input parameters. R | - Sourd Yelacity

ok |

#

Cangel

Click Data to view/modify user-input parameters for selected variable (if applicable). Some variables share a user-input parameter,

so changing a parameter for one variable automatically changes it for the other:
o Depth and average sound velocity use same latitude (if NMEA data not available).

e Descent rate and acceleration use same time window size.

o All SBE 13, 23, and 43 oxygen sensors use same time window size, Tau correction, and (SBE 43 only) hysteresis correction.

Note: An alternate method of entering these parameters is on Miscellaneous tab in Derive dialog box.

The Miscellaneous tab in the Derive dialog box looks like this:

Note:

Values for these parameters can be
changed on the Miscellaneous tab
or by double clicking on the output
variable in the Select Derived
Variables dialog box (above);
changes made in one location are
automatically made in the other
location.

File Options

Help

File Setup | Data Setup  Miscellaneous l Header View

Thiz tab configures miscellaneous data for calculations.
Mate: ¥alues entered only affect indicated calculations.

Depth and Average Sound Yelociy
Latitude when NMEA iz not available

—

Average Sound Yelocity

Minimum pressure [db] o0
Minimum zalinity [psu] a0

Potential Temperature dnomaly

Oxygen selections apply to
SBE 43 and Beckman/YSI
sensors. They do not apply
to SBE 63 or Aanderaa
Oxygen Optode.

Al |u a1 |D A7 Multiplhier
Orpaen
Window size [s] 2

v Apply Taw comrection

Descent and Acceleration
“window size [g]

—

Salinity

Set to Defaults

Start Process

Exit | Cancel |

The Miscellaneous tab defines parameters required for output of specific
variables (depth, average sound velocity, potential temperature anomaly,
oxygen, descent rate, and acceleration). Entries on this tab are used only if you
are calculating and outputting the associated variable to the .cnv file. For
example, if you do not select Oxygen in the Select Derived Variables dialog
box, Derive ignores the value entered for Oxygen window size and the
enabling of the Tau correction on the Miscellaneous tab.
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In Derive, derivative variables (oxygen, descent rate, and acceleration) are
computed by looking at data centered around the current data point with a time
span equal to the user-input time window size and using a linear regression to
determine the slope. This differs from how the calculation is done in Seasave
and Data Conversion, which compute the derivative looking backward in time,
since they share common code and Seasave cannot use future values while
acquiring data in real-time.

Derive has the following /x parameter when run from the Command Line
Options dialog box, from the command line, or with batch file processing:

/x Parameter Description
For SBE 911plus, do not output scans if
pump status = off.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

/xderive:pump

Derive adds the following to the data file header:

Label Description
Date and time that module was run. Also
Derive date shows how many columns of data (how

many variables) were derived.

Input .cnv converted data file and .con or

Derive in .
- .xmlcon configuration file.

Window size for oxygen derivative

Derive time window_docdt .
- = - calculation (seconds).

Window size for descent rate and

Derive time window_dzdt . .
- = - acceleration calculation (seconds).

Derive _ox_tau Whether tau correction was performed on

correction oxygen data.
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Derive TEOS-10

Notes:

« Algorithms used in Derive TEOS-10
are based on the TEOS-10 website:
www.TEOS-10.0rg.

e Derive TEOS-10 is not compatible
with a .cnv file from an SBE 39,
39-IM, 39plus, or 48.

e For an SBE 21 or 45 with a remote
temperature sensor, Seasave,

Data Conversion, Derive, and
Derive TEOS-10 all use the remote
temperature data when calculating
density and sound velocity.

Notes:

e The File Setup tab and Header View
tab are similar for all modules; see
Section 2: Installation and Use.

o (if used) Values for longitude,
latitude, and pressure in .txt files are
not limited to the number of digits
shown in the examples.

txt file format is:

Derive TEOS-10 uses temperature, conductivity or salinity (Practical,
EOS-80), pressure, latitude, and longitude to compute the following

thermodynamic parameters using TEOS-10 equations:
Absolute Salinity

Absolute Salinity Anomaly
adiabatic lapse rate
Conservative Temperature
Conservative Temperature freezing
density

dynamic enthalpy

enthalpy

entropy

gravity

internal energy

isentropic compressibility
latent head of evaporation
latent heat of melting
potential temperature
Preformed Salinity
Reference Salinity

saline contraction coefficient
sound speed

specific volume

specific volume anomaly
temperature freezing

thermal expansion coefficient

The Data Setup tab in the dialog box looks like this:

BE Derive TEOS-10 i

I

File ©ptions Help

File Setup  Data Setup | Header iew |

Select instrument: SBE 21 or

SBE 45 Thermosalinograph,
/ or Other (anything else).

Instrument type:

Other i

Source for Latitude / Longitude data when MMEA data is not present

/lcomment line starts with two //
Longitude: xxx.xx
Latitude: xxx.xx

xt file format is:
/lcomment line starts with two //
Pressure: Xxxxx.xx

Select variables to be
calculated (see below).

(¢ \alues entered below  © Text file [*tst]

| Latitude ID Longitude

—

ingtuments]

¥ alue entered below € Text file [*tat)

r—

Pressure, decibars

Source for pressure data when pressure column is not prezent [zome moored

Select TEOS-10Variables.. |

Mote: ket file must be in same directory as .cnv data file, and must have same file

‘ name [excluding extension).

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

Start Process | Exit I

Cancel
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The Select TEOS-10 Variables dialog box looks like this:

2
: Delete
4

e Add variable: click blank field in Variable Name column, Inset
click desired sensor in sensor list, click Add. Delete Al

e Change variable: click existing sensor in Variable Name
column, click desired sensor in sensor list, click Change.

o Insert variable: click existing sensor below desired
sequence # in Variable Name column, click desired
sensor in sensor list, click Insert.

1]
14

T LI Data...

HU

i
Seq # “ariable Marne [unit] - Add - Abszalute Salinity [g/kg] A1 Shiink &l |
1 Abzolute Salinity [9/kg] - dbzolute Salinity Anomaly [9/kg]
density, TEOS-10 [demsity, kg/m™3] Change - adiabatic lapse rate [K./Pa] Expand All |

- Conzervative Temperature [IT5-30, deg C]

- Congervative Temperature Freezing [IT5-90, Shiink |
= density, TEOS-10
z ] Expand |

- gigma-, kg/m”
- gigma-1, kasm™3
- gigma-2, ka/m™3
o sigma-3, kgdm”™3
- sigma-4, kg/m™3
- dynanic enthalpy [J/kag]
- enthalpy [J/kg]
- entropy [JAkgfK]
o gravity [mds"2]

- internal energy [J/kg] i
1| | 3

List of available
TEOS-10 variables.

Derive TEOS-10 adds the following to the data file header:

Label

Description

DeriveTEOS 10 date

Date and time that module was run. Also
shows how many columns of data (how
many variables) were derived.

DeriveTEOS 10 in

Input .cnv converted data file

DeriveTEOS 10
latitude source

Source of latitude data.

DeriveTEOS 10
longitude source

Source of longitude data.

Using the GSW Toolkit
version Xx.XX

Source and version of equations used in
TEOS-10 calculations.
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TEOS-10 Formulas

The following table references the C functions from www.TEOS-10.org that

are implemented in Derive TEOS-10:

SBE Data Processing
variable name
(in Select TEOS-10 Variables
dialog and in output .cnv file)

C function from
www.TEOS-10.0rg code

Absolute Salinity

gsw

sa_from sp

Absolute Salinity Anomaly

gsw

deltasa from sp

adiabatic lapse rate

gsw

adiabatic lapse rate from ct

Conservative Temperature

gsw

ct from t

Conservative Temperature freezing

gsw

ct freezing

density, TEOS-10

gsw_rho
(use gsw_rho with reference
pressure for the sigmas)

dynamic enthalpy

gsw_dynamic_enthalpy

enthalpy gsw_enthalpy
entropy gsw_entropy from t
gravity gsw_grav

internal energy gsw_internal energy
isentropic compressibility gsw_kappa

latent heat of evaporation

gsw_latentheat evap ct

latent heat of melting

gsw_latentheat melting

potential temperature

gsw pt0 from t

Preformed Salinity

gsw_sstar from sa

Reference Salinity

gsw_sr from sp

saline contraction coefficient

gsw_beta

sound speed

gsw_sound speed

specific volume

gsw_specvol

specific volume anomaly

gsw_specvol anom

temperature freezing

gsw t freezing

thermal expansion coefficient

gsw_alpha
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Filter

Filtered ‘,]
Data 4

i I \\ Original
/_l Data

Time

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Filter runs a low-pass filter on one or more columns of data. A low-pass filter
smoothes high frequency (rapidly changing) data. To produce zero phase

(no time shift), the filter is first run forward through the data and then run
backward through the forward-filtered data. This removes any delays caused

by the filter.

Pressure data is typically filtered with a time constant equal to four times the
CTD scan rate. Conductivity and temperature are typically filtered for some
CTDs. Two time constants can be specified, so different parameters can be
filtered with different time constants in one run of Filter. Typical time

constants are:

Instrument

Temperature
(seconds)

Conductivity
(seconds)

Pressure
(seconds)

SBE 9plus

0.15

SBE 19plus or 19plus V2

0.5

0.5

1.0

SBE 19 (not plus) with or
without TC duct and pump

0.5

0.5

2.0

0.1

0.5

SBE 25 or 25plus 0.1

SBE 49 with TC duct and 0.085

3000 rpm pump * 0.085 0.25

*The SBE 49 can be programmed to filter the data in real-time with a cosine
window filter (see WFilter), eliminating the need to run Filter on temperature
and conductivity data. See the SBE 49 manual for details.

The Data Setup tab in the dialog box looks like this:

= e

EZ Filter

Eie Options Help

FieSetup DataSetup | Header View |

Low pass filler &, lime constant [s] 1&1[‘

Desired filter time constants
Low pass fiter B. tirme canstant [] !ﬁ

Specify Hllers‘.k |

Select which variables to apply
filter to, and which time constant
to use for each variable.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows

Begin processing data. Status field \

Processing complete when done.

E xif I

Cancel

Start Process |
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The Specify Filters dialog box looks like this:

Specify Filters

Yariahle hame [unit]

 Tempetature [|T5-80 deg ]

Conductivity [5¢/m]

Dioen Current, Beckman/vS] [ub]

Dwygen Temperatie, ErE:ckfﬁaTu"‘fSl [dea C]

Dwyger, Beckman/rS! ]

Pressure; Digiquartz [dhb]

Filter Tupe:
P ome _7_]
Name -
= Select None, Filter A, or
Nane = Filter B for each
Maote - variable.
Mone =
Naone j

ok | caneer |

Filter: Formulas

For a low-pass filter with time constant I':

I'=1l/o o =2nf
T = sample interval (seconds)
SO =1/T

Laplace transform of the transfer function of a low-pass filter (single pole)
with a time constant of I" seconds is:

HO= sy

Using the bilinear transform:

A 2(1-z7h 2(z-1)
$-f2) = Tazz7 T+
1 -1
H(z) = L 26D 1-2/TS,
T(z+1)S, TS {1+ 1+2/TSO) }
2
1 b s
Iff A= B= 0
2 2
1+ 1+
TS, TSo
-1
Then: H(z)= Y(z) Al Hl)
X(z) (1+Bz™)

Where z ' is the unit delay (one scan behind).

y[N] = current output
y[N-1] = previous output
x[N] = input data (current scan)

x[N-1] = previous input data (from previous scan)

Yz (1+Bz)=X@2)A@z'+1)
yIN] + By[N-1] = Ax[N-1] + Ax[N]
yIN] = A(x[N] + x[N-1]) - By[N-1]
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Example: Time constant = 0.5 second, sample interval = 1/24 second
1

A= @72%05%28)  (1+24) 004
1-24

B=(1-2%05%24)A= — =092
1+ 24

Filter adds the following to the data file header:

Label Description
Filter date Date and time that module was run.
Filter in Input .cnv converted data file.
Filter low pass tc A Time constant for filter A.
Filter low-Pass tc B Time constant for filter B.
Filter low pass A vars | List of variables filtered with time constant A.
Filter low pass B vars | List of variables filtered with time constant B.
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Loop Edit

Note:

Data Conversion calculates
velocity with a 2-second
window (e.g., 48 scans for an
SBE 9plus), giving a much
smoother measure of velocity.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Loop Edit marks scans bad by setting the flag value associated with the scan to
badflag in input .cnv files that have pressure slowdowns or reversals (typically
caused by ship heave). Optionally, Loop Edit can also mark scans associated
with an initial surface soak with badflag. The badflag value is documented in
the input .cnv header.

Loop Edit operates on three successive scans to determine velocity. This is
such a fine scale that noise in the pressure channel from counting jitter or other
unknown sources can cause Loop Edit to mark scans with badflag in error.
Therefore, you must run Filter on the pressure data to reduce noise
before you run Loop Edit. See Filter for pressure filter recommendations for
each instrument.

The Data Setup tab in the dialog box looks like this:

EE Loop Edit

File ©Options Help

_ 1o x|
Minimum velocity type:
Fixed minimum velocity - If CTD velocity <
specified Minimum CTD Velocity, or
pressure < previous maximum pressure,
scan is marked with badflag.
Percent of mean speed - For each scan,
mean speed over last Window Size seconds
is computed. If CTD velocity < specified
Percent of Mean Speed, or pressure <
previous maximum pressure, scan is marked
with badflag. Minimum CTD Velocity is used
to evaluate data points in first time window.

Filz Setup  Data Setup |

inimum velocity twpe

Fixed minimum veloci

Minimum CTD velocity [mds]  [0.25

Window size [z] 300

—

Percent of mean speed

If selected, scans related to surface

soak are marked with badflag,
based on Minimum soak depth and
Maximum soak depth (note that
Surface soak depth is not actually
used in calculation of surface

soak scans). See drawing below
for details.

o |f selected, scans previously
marked with badflag (for example,
in a previous run of Loop Edit) will
not be evaluated.

If not selected, scans previously
marked with badflag will be
reevaluated, and scan’s flag will
be reset accordingly.

Begin processing data. Status field

¥ Femove surface soak

Surface zoak depth [m]

T
—
T

¥ Usze deck pressure as pressure offset

Minirurm soak depth [m]
[default = soak depth / 2]

M awirum zoak depth [m]
[default = zoak depth * 2)

If selected, pressure from first scan in file is used
as a pressure offset in determining scans related
to surface soak. See drawing below for details.
Note: This affects only marking of surface soak
scans, and has no effect on pressure data in file.

I ¥ Exclude scans marked bad

E it I

Cancel

/Start Process |

on File Setup tab shows Processing
complete when done.

Depth

Algorithm
for removal
of surface
soak data

Return to SBE Data Processing window.

o |f Confirm Program Setup Change was selected in Options menu - If you made changes
and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says Save
& Exit. If you do not want to save changes, use Cancel button to exit.

\Deck pressure

Minimum
.soak depth
reached

= 5cans marked with badflag
Time

—— Minimum pressure between
when minimum soak depth was
reached and maximum soak
depth was reached (First scan
not automatically marked
with badflag)

Surface soak depth

Maximum
— -soak depth
reached
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Loop Edit adds the following to the data file header:

Label

Description

Loopedit date

Date and time that module was run.

Loopedit in

Input .cnv converted data file.

Loopedit_minVelocity

If Fixed Minimum Velocity was selected -
minimum CTD velocity for good scans;
scans with velocity less than this are marked
with badflag.

Loopedit_percentMeanSpeed

If Percent of Mean Speed was selected -
minimum CTD velocity for first time
window, window size, and percent of mean
speed for good scans; scans that do not meet
this criteria are marked with badflag.

Loopedit_surfaceSoak

If Remove surface soak was selected —
minimum soak depth, maximum soak depth,
and whether to use deck pressure as a
pressure offset (1 = yes, 0 = no).

Loopedit_excl bad scans

If yes, do not evaluate scans marked with
badflag in a previous run of Loop Edit.
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Wild Edit

Note:

Wild Edit marks individual data (for
example, a conductivity value) with
badflag, but does not mark the entire

scan (which may inclu

that is valid, such as temperature,

pressure, etc.).

de other data

Note:

The File Setup tab and Header View
tab are similar for all modules; see

Section 2: Installation

and Use.

The Data Setup tab in the dialog box looks like this:

Wild Edit marks wild points in the data by replacing the data value with
badflag. The badflag value is documented in the input .cnv header.

Wild Edit’s algorithm requires two passes through the data: the first pass
obtains an accurate estimate of the data’s true standard deviation, while the
second pass replaces the appropriate data with badflag.

BE Wwild Edit = O] = iWiId Edit operates

Eile Options  Help

File Setup  Date Setup | Header View |

Standard deviafions for pass one

If selected, data from
scans marked with
badflag in Loop Edit
will not be used in
calculating mean and
standard deviation.

'E;!éndard deviations far pazs twa

5 cans per block

W Esclude scans marked bad

Select which variables
to run Wild Edit on.

[ SelectWid Edt Varables... |

Begin processing
data. Status field on
File Setup tab shows
Processing complete
when done.

—
e
T

Keep data within this distance of the meah in

Do not flag data within this distance of mean,
even if it falls outside specified standard
deviation. Set to a value where difference
between data and mean would indicate a wild
point. May need to use if data is very quiet (for
example, a single bit change in voltage may
cause data to fall outside specified standard
deviation and be marked bad). A typical
sequence for using parameter follows:

1. Run Wild Edit for all desired variables, with
parameter set to 0.

2. Compare output to input data. If a variable’s
data points that are very close to mean were
set to badflag:

A. Rerun Wild Edit for all other variables,
leaving parameter at 0 and overwriting
output file from Step 1.

B. Rerun Wild Edit for quiet variable only,
setting parameter to desired value to
prevent flagging of data close to mean.

as follows:

1. Compute mean and
standard deviation of
data in block
(specified by Scans
per Block) for each
selected variable.
Temporarily flag
values that differ from
mean by more than
standard deviations
specified for pass 1.

2. Recompute mean and
standard deviation,
excluding temporarily
flagged values. Mark
values that differ from
mean by more than
standard deviations
specified for pass 2 by
replacing data value
with badflag.

3. Repeat Steps 1 and 2
for next block of
scans.

o If last block of data
in input file has less
than specified
number of scans,
use data from
previous block to fill
in block.

Start Process

Cancel

/

/

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

104




Manual revision 7.23.2

Section 6: Data Processing Modules SBE Data Processing

If the data file is particularly corrupted, you may need to run Wild Edit more
than once, with different block sizes and number of standard deviations.

If the input file has some variables with large values and some with relatively
smaller values, it may be necessary to run Wild Edit more than once, varying
the value for Keep data within this distance of mean so that it is meaningful
for each variable. Better results may also be obtained by increasing Scans per
block from 100 to around 500.

Example

Sensor A’s range is approximately 1000 and Sensor B’s range is
approximately 10. Run Wild Edit on Sensor A, using Keep data
within this distance of mean = 10. Then run Wild Edit on
Sensor B, using Keep data within this distance of mean = 0.1

Wild Edit adds the following to the data file header:

Label Description
Wildedit date Date and time that module was run.
Wildedit in Input .cnv converted data file.

Wildedit passl nstd Number of standard deviations for pass 1 test.

Wildedit pass2 nstd Number of standard deviations for pass 2 test.

Wildedit pass2 mindelta | Keep data within this distance of mean.

Wildedit npoint Number of points to include in each test.

Wildedit vars List of the variables tested for wild points.

If yes, values in scans marked with badflag
Wildedit_excl bad scans | (in Loop Edit) will not be used to determine

standard deviation.
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Window Filter

Window Filter provides four types of window filters and a median filter for
data smoothing of .cnv files:

e  Window filters calculate a weighted average of data values about a center
point and replace the data value at the center point with this average.

e The median filter calculates a median for data values about a center point
and replaces the data value at the center point with the median.

Note: . . . .
Tt?eeFile Setup tab and The Data Setup tab in the dialog box looks like this:
Header View tab are similar % Window Filter HE‘

for all modules; see Section 2:

Installation and Use. Fies elonsben

Fie Setup Data Setup | Header View |

Interval betieen seans, secands = 00416667

If selected, data 7 Ektiiide it
from scans marked | R S e

with badflag in Loop _
Edit will not be used. 'Specify\)\ﬁndgw Filters:.

/

Select which variables to run
Window Filter on, and specify the
filters.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Start Process I Esit | cancel

The Specify Window Filters dialog box looks like this:

Specify Window Filters
Wariable Name funt] Filter Typa- Farameters Clear Al l
Pressure; Digiquartz @31 | Gaussian | = 5,1.000, 0.000
_T_ETE‘?LE'FHEM_E@!]:EE.QQ Nore = Select none, boxcar, cosine,
Temperature, 2{1T5-80, deg T h E‘Une - Gaussian, median, or triangle filter.
Conductivity [5/m] DO A dialog box appears to enter
_E- _d_tl_[ESJ ] 'rmz applicable filter parameters, which
i " Gaussian 2 then display in Parameters column.
Densiy fsigma theta, Kg/n'3) et ,
Saliity [P5L] Nare =] |

ok I Eanhglj
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Window Filters: Descriptions and Formulas

Shape and length define filter windows:

e  Window Filter provides four window shapes: boxcar, cosine, triangle,
and Gaussian.

e  The minimum window length is 1 scan, and the maximum is 511 scans.
Window length must be an odd number, so that the window has a center
point. If a window length is specified as an even number, Window Filter
automatically adds 1 to make the length odd.

The window filter calculates a weighted average of data values about a center
point, using the following transfer function:

L/2

ym) = 2 w(k)x(n-k)

The figure below shows the impulse response of each of the four filter types
for a filter of length 17 scans. The impulse response of a filter is obtained by
filtering a data set that has zeros everywhere except one data value that is set
to 1.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

Boxcar Cosine

Maghnitude

Triangle Gaussian

Time
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Note:

In the window filter equations:

¢ L = window length in scans,
(always an odd number)

e n = window index, -L/2 to +L/2,
with 0 the center point of
the window

¢ w(n) = set of window weights

The window filtering process is similar for all filter types:
1. Filter weights are calculated (see the equations below).
2. Filter weights are normalized to sum to 1.

e  When a bad data point is encountered (scan marked with badflag if
exclude scans marked bad was selected or data value marked with
badflag), the weights are renormalized, excluding the filter element
that would operate on the bad data point.

Boxcar Filter
1 L-1 L-1
wh)= —__ forn= - ..
L 2 2
Cosine Filter
wn)=1 forn=0
L-1 L-1
W) = cos " forn= - ALl
L+1 2 2
Triangle Filter
wmn)=1 forn=0
n] L-1 L-1
wn) =————  forn= - RS T R
2 2
L-1
where K = +1
2

Gaussian Filter

offset (sec)

sample interval (sec)

sample rate 2
scale =log(2) x f 2 x
half width (scans)

W(l’l) =e -phase x phase x scale fOV n=0

phase =

L-1 L-1

w(n) =e -(n-phase)z x scale fOl" n= -

5 . oy

The Gaussian window has parameters of halfwidth (in scans) and offset (in
time), in addition to window length (in scans). These extra parameters allow
data to be filtered and shifted in time in one operation. Halfwidth determines
the width of the Gaussian curve. A window length of 9 and halfwidth of 4
produces a set of filter weights that fills the window. A window length of 17
and halfwidth of 4 produces a set of filter weights that fills only half the
window. If the filter weights do not fill the window, the offset parameter may
be used to shift the weights within the window without clipping the edge of the
Gaussian curve.
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Pressure

Example: Window length is 33 scans and halfwidth is 4 scans. Offset is
-3 seconds in left curve, 0 in middle curve, and +3 seconds in right curve.

Shifted 0 seconds

Magnitude

| |
| 1 I I 1 I I I n
3 6 9 12 15 18 21 24 27 Time

Note that the window length in the example is larger than the halfwidth. This
allows the complete Gaussian curve to be expressed in the window when the
offset parameter shifts the curve forward or backward in time. If the halfwidth
was larger, the trailing edge of the -3 second offset curve would be truncated
and the leading edge of the +3 second curve would be truncated. The offset
parameter moves the Gaussian shape of the window weights forward or
backward in time. Since the weighted average is calculated for a data value in
the center of the window, this has the effect of shifting the data that the filter is
operating on forward or backward in time relative to the other data in the file.
This capability allows filtering and time shifting to be done in one step.

Median Filter: Description

The median filter is not a smoothing filter in the same sense as the window
filters described above. Median filtering is most useful in spike removal.

A median value is determined for a specified window, and the data value at the
window’s center point is replaced by the median value.

s
T

j’
Fd 4 “Median-Filtered Data,
i T i window length 17

I | (- il Il Il I L L - | | - Il I (- Il

Tt r tr r + &ttt &t & &°T

Salinity
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Window Filter has the following /x parameter when run from the Command
Line Options dialog box, from the command line, or with batch file processing:

/x Parameter Description
Jxwhilter-diff Output difference between original and filtered value

instead of outputting filtered value.
See Appendix 1: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

Window Filter adds the following to the data file header:

Label Description
Wifilter date | Date and time that module was run.
Wifilter in Input .cnv converted data file.

Wrfilter_excl | If yes, values in scans marked with badflag in
bad scans Loop Edit will not be used.
Wfilter action | Data channel identifier, filter type, filter parameters.
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Section 7: File Manipulation Modules

Module Name

Module Description

ASCII In

Add header information to a .asc file containing rows
and columns of ASCII data.

ASCII Out

Output data portion and/or header portion from .cnv
converted data file to an ASCII file (.asc for data, .hdr
for header). Useful for exporting converted data for
processing by other (non-Sea-Bird) software.

Section

Extract rows of data from .cnv converted data file.

Split

Split data in .cnv converted data file into upcast and
downcast files.

Strip

Extract columns of data from .cnv converted data file.

Translate

Convert data format in .cnv converted data file from
ASCII to binary, or vice versa.
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ASCIl In

ASCII In adds a header to a .asc file that contains rows of ASCII data. The
data can be separated by spaces, commas, or tabs (or any combination of
spaces, commas, and tabs). The output file, which contains both the header and
the data, is a .cnv file. ASCII In can be used to add a header to data that was
generated by a non-Seasoft program.

Note: The Data Setup tab in the dialog box looks like this:

o e e e
for all modules; see Section 2: =l o

Ele Options  Help

Installation and Use. Select whether interval between

scans is based on time,
pressure, or depth, and indicate
the interval value (time, pressure,
or depth between scans). This
information is put in header.

FileSetup  Data Getup i

Soan interyal varable 5
Sean Interval valus IU_5

Selact Colurir Names... I

Select variable name associated
with each column of data, to be
put in header. Selection list
includes all variables that can be
output by Data Conversion and
Derive, as well as user-defined
variable names.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \ |

on File Setup tab shows S AP | ’ﬁk—l Caricel |
Processing complete when done. 2 d

ASCII In creates a data file header containing the following information:

Label Description

Number of columns (fields) of data.

NOTE: ASCII In automatically adds 1 field to number of fields
Nquan in input .asc file (i.e., if the .asc file contains 3 columns of data,

then nquan=4). This field, initially set to 0, is used by Loop Edit
to mark bad scans.

Nvalues | Number of scans converted.

Specified (indicates units are specified separately for each

Units variable).

Name n | Sensor (and units) associated with data in column n.

Span n Span (highest - lowest value) of data in column n.

Interval | Scan rate (seconds).

Start time | Start time for when ASCII In was run.

Provided for information only; value that Loop Edit will
Bad flag | use to mark bad scans and Wild Edit will use to mark
bad data values.

Asciiin_in | Input .asc data file.

File type | Selected output file type - ASCII data.
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ASCII Out

ASCII Out outputs the header portion and/or the data portion of a converted

data file (.cnv).

e  The data portion is written in ASCII engineering units to a .asc file, and
may be useful if you are planning to export converted data for processing
by other (non-Sea-Bird) software.

e  The header portion is written to a .hdr file.

Note:
The File Setup tab and The Data Setup tab in the dialog box looks like this:

Header View tab are similar
for all modules; see Section 2:
Installation and Use.

EE ASCII Out g@g|

File Cptions Help If columns are labeled at top of each
page, form feed character is inserted
after selected number of lines/page.

File Setup  Data Setup HeaderView]

W Output header file Lines per page |5|:|
If selected, scans marked ¥ Outout data fil
with badflag in Loop Edit will [~ il Column label for output data file: Top of file,
not be output in data file. " Esclude scans marked bad Top of each page, or No column labels.
Labe! calumns |N0 colurrTabels ﬂ L1

Column separator for output data file:

Column separator Space E/ space, tab, semi-colon, or colon.

Select Time Conversion Formats.= - 1
Date and time formats for output
—1 Add first column data file (applicable if date

T

If selected, 1 column is

inserted before first column of Eey selected as output variable).
data, with specified column IS DR |
name and data value. Eireles Bl roalie |
I Replace bad flag —————|f selected, all occurrences of badflag in input file
(occurrences in flag column as well as in data columns)
PR R0 7524029 are replaced with specified value in output file. This
Select which variables to may be useful for plotting purposes, as SBE Data
include in output data file. ™S select Dutput ¥ ariables. . | Processing uses a very small number (-9.990e-29) for
badflag, which looks like 0 in a plot.

Begin processing data. Status field

on File Setup tab shows N Eui C |

Processing complete when done. Start Process ”'t\\ | ance J
\

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

ASCII Out has the following /x parameter when run from the Command Line
Options dialog box, from the command line, or with batch file processing:

/x Parameter Description

string = value (maximum of 11 characters) placed in
each row of column inserted before first column
of data.

/xascii_out:first
column_value=string

/xascii_out:label
format=mon/day/yr
hh:mm

mon/day/yr is heading for date column;
hh:mm is heading for time column.

See Appendix 1: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

ASCII Out does not add anything to the data file header. The output header
(-hdr) file contains the header from the input (.cnv) file.
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Section

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Section extracts rows of data from the input .cnv file, based on a pressure
range or scan number range, and writes the rows to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

= Section B=]

Fie Optiors Help

Fite Setup Data Sefup | Header View | Section based on a pressure range or

Sectioh based on

Select Upcast or Downcast if
section is based on pressure.

|~ Prezsire sechion cast IDDwncaSt ‘r!

Wi valuz |
: o > Section writes to output file all rows

M amimuir walis: I':' of data that fall within this range of

a scan range.

pressure or scan number.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

N\ |

Start Process I

’ﬁﬁ Canoe| |

Section adds the following to the data file header:

Label Description
Section date Date and time that module was run.
Section_in Input .cnv converted data file.

Section_type

Evaluate data based on pressure or scan range.

Section_range

Range of (pressure or scan count) data to keep.
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Split

Note:

Bin Average provides the option of
processing upcast, downcast, or
both, possibly removing the need to
run Split.

Note:

The File Setup tab and Header View
tab are similar for all modules; see
Section 2: Installation and Use.

Split separates the data from an input .cnv file into upcast (pressure
decreasing) and downcast (pressure increasing) files. Split writes the data to an
output .cnv file(s). The upcast output file name is the input file name prefixed
by u. The downcast output file name is the input file name prefixed by d.

The Data Setup tab in the dialog box looks like this:

B Split =]

File Options Help

File Setup DiataSetup l Headsr Ik"ié'-'\'i Output an upcast file (prefix u) and

_— downcast (prefix d) file, or just a
downcast (prefix d) file.

pcast and downcast

Ouput fils

WV Exclude scans marked bad

If selected, scans marked with badflag (in
Loop Edit) will not be used to identify
maximum pressure. Maximum pressure
defines when downcast ends and upcast
begins.

Note: Pressure values marked with
badflag in Wild Edit are never used to
determine maximum pressure.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows

Begin processing data. Status field

Processing complete when done.

N\ l
Exit I Cancel |

Start Process

Split adds the following to the data file header:

Label Description

Split date Date and time that module was run.

Split_in Input .cnv converted data file.

If Yes, pressure from scans marked with badflag
(in Loop Edit) were not used to determine
maximum pressure (for determining when
downcast ends and upcast begins).

Split_excl bad scans

115



Manual revision 7.23.2

Section 7: File Mani

pulation Modules SBE Data Processing

Strip

Note:

The File Setup tab and Header View
tab are similar for all modules; see
Section 2: Installation and Use.

Strip outputs selected columns of data from the input .cnv file. Strip writes the
data to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

BE Strip
Ele Opions Help

File Setup  Data Setup | Header View |

= E

i Select Included Yan

i} . -
\ Select which variables (columns
of data) to output.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

e |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

N\ |

= -\ -
Start Process | Eit | Cancel |

Strip adds the following to the data file header:

Label Description
Strip _date | Date and time that module was run.
Strip_in Input .cnv converted data file.
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Translate
Translate changes the converted data file format from binary to ASCII or vice
versa, and writes the data to an output .cnv file.
Note: The Data Setup tab in the dialog box looks like this:
The File Setup tab and Header View BT Translate E=E

tab are similar for all modules; see

Section 2: Installation and Use. fieihiass e

File Setup DataSetup | Header iew |

Transtation [pr - -
' ' Bmary At ‘J \ Switch from:

e Binary to ASCII,

. e ASCII to binary, or
Tiahaiaiato oooe e e Binary to ASCII or ASCII to binary,
as applicable

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

e |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field / I

on File Setup tab shows - ’—ﬁ -
Processing complete when done. Start Process I i Cancel |

Translate changes the following in the data file header:

Label Description

File type File type - changes to ASCII or binary, as applicable.
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Section 8: Data Plotting Module — Sea Plot

Notes:

¢ Converted data (.cnv) files are
typically created in Data Conversion
and manipulated in other SBE Data
Processing modules. Sea Plot can
plot data at any point after Data
Conversion has been run.
- For SBE 37 (firmware < 3.0), 39,
39-IM, and 48, a converted (.cnv)
data file is created from an uploaded
.asc file using the Convert button in
Seaterm’s Toolbar.
- For SBE 39plus, a converted (.cnv)
data file is created from an uploaded
xml file using Convert . XML data file
in SeatermV2’s Tools menu.

¢ Algorithms for calculation of derived
parameters in Data Conversion,
Derive, Sea Plot, SeaCalc Ill [EOS-
80 (Practical Salinity) tab], and
Seasave are identical, except as
noted in Appendix V: Derived
Parameter Formulas (EOS-80;
Practical Salinity), and are based on
EOS-80 equations.

¢ Calculation of Absolute Salinity and
associated parameters
(TEOS-10) is available in
Derive TEOS-10 and SeaCalc Il
[TEOS-10 (Absolute Salinity) tab].
Once they are calculated in Derive
TEOS-10, they can be plotted in
Sea Plot. See Section 6: Data
Processing Modules and
Section 9: Miscellaneous Module —
SeaCalc Ill.

Sea Plot can be used to plot C, T, and P, as well as derived variables and data
from auxiliary sensors, from any converted .cnv data file. Sea Plot can:

e Plot up to 5 variables on one plot, with a single X axis and up to four
Y axes or a single Y axis and up to four X axes.

e Plot any variable on a linear or logarithmic scale (logarithmic scale not
applicable to TS plots).

e Derive and plot derived salinity and/or derived density, if conductivity,
temperature, and pressure data are in the input file. This allows you to
skip running Derive if salinity and density are the only derived parameters
you are interested in. Alternatively, you can calculate and plot derived
salinity and/or derived density even if salinity and density are already in
the input file; the values may differ because of processing steps performed
on C, T, or P after Derive was run. Note that the calculations for derived
salinity and derived density are based on EOS-80 equations (Practical
Salinity). For TEOS-10 (Absolute Salinity), you must calculate the
parameters in Derive TEOS-10 before plotting with Sea Plot.

e Plot time series data; the time scale selections include Julian Days,
elapsed time in hours, minutes, or seconds, or date and time.

e Create contour plots, generating density (sigma-t or sigma-theta) or
thermosteric anomaly contours on temperature-salinity (TS) plots.

Note:

When plotting date and time, the

following restrictions apply:

o On the Plot Setup tab, select Single
X — Multiple Y or
Single X — Multiple Y, Overlay
for plot type

e On the X Axis tab, select Julian days
or Elapsed time for the variable, and
select Show as Date/Time.

e On the X Axis tab, do not select
Reverse scale direction.

e  Process and plot multiple input files that contain the same variables and
with the same setup parameters, each on their own plot, allowing the user
to quickly switch the view from one file to the next.

e Process and plot multiple input files that contain the same variables on an
overlay plot, allowing the user to view multiple sets of data at the
same time. If desired, the user can offset each file on the plot to create a
waterfall plot.

e Zoom in on plot features.

e Send plots to a printer, save plots to the clipboard for insertion in another
program (such as Microsoft Word), or save plots as graphic files in
bitmap, metafile, or JPEG format.

¢ Run in batch processing mode. See Appendix I: Command Line Options,
Command Line Operation, and Batch File Processing.

The Sea Plot dialog box differs somewhat from the other SBE Data Processing
modules. Each tab of the Sea Plot dialog box is described below, as well as
options for viewing, printing, and saving a plot.
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Sea Plot File Setup Tab

Input data directory and file names.

Select to pick a different file.

To process multiple files from

same directory:

1. Click Select.

2. In Select dialog box, hold down
Ctrl key while clicking on each
desired file.

If multiple files selected, header in each

file must contain same set of sensors

and variables.

For overlay plots:

o If Sort Input Files selected in Options
menu: Sea Plot sorts input files in
alphabetical order.

o If Sort Input Files not selected in
Options menu: Sea Plot maintains
order of files as you selected them
using Ctrl key. Use this feature if
there is a particular data set you
want to use as base on a waterfall
overlay plot. Note that using Shift
key to select files will not maintain
selected order.

File

The File Setup tab defines the Program Setup file; input data file(s); and

output type, orientation, and (if applicable) file name. The File Setup tab looks

like this:

SBE Data Processing

File to store all information input in File, Plot, and Axis Setup tabs. Open to select a
different .psa file, Save or Save As to save current settings, or Restore to reset all
settings to match last saved version.

%= Sea Plob O3

Optians

File Setup | Plot Setup | Temperature | Salinty | Header View |

=101 x|

Help

Program zetup file

/

[H:\data'\Debbie\SeaPlot psa !
Open... Save Save fz.. Feztore I
Input directory

|7 |H:\data\Debbie

Input filez, 1 selected

| 233al alignderivealigndenve. crv

j Select... |

Output Information is default, and is
only used automatically for batch
processing or when running with Auto
start command line option. For all other
cases, Sea Plot does not automatically
print or output plot to file when you click
Start Process. You can choose to print
or output plot to file while viewing a
plot; output destination and parameters
can be easily changed at that time.

e Output to: Printer, Metafile (.wmf),
JPEG (.jpg), or Bitmap (.bmp). When
viewing plot, you can also output to
clipboard; from clipboard, you can
paste plot into another application
(such as Microsoft Word).

o Orientation: if outputting to printer.
Driver default, Landscape, or
Portrait. If Driver default selected,
orientation determined by default for
printer you select.

o Print full page: Applicable for
outputting to printer. If selected, Sea
Plot sizes plot to fit 8'/2 x 11 inch
paper. If not selected, input desired
plot size (Units, Width, and Height).

o Units, Width, and Height: Plot size.
Applicable when outputting to printer
(if Print full page was not selected),
or graphics file.

Cutput to IF'rinter vI Orightation ILandacape vl [ Pririt full page
I pits IMillimeters vI Wwidth |15|:| Height 120

Output directony

[H:\datatDebbie

Select... |

Default directory and file name (can be easily changed while

Name append I— viewing plot) for outputting .wmf, .jpg, or .bmp graphic file.

o If more than 1 file to be processed, Output file field disappears

Dutput file IW; and output file names are set to match input file names. For
example, if processing test.cnv and test1.cnv, and outputting
.jpg files, output files will be test.jpg and test1.jpg.

Mot processing o Sea Plot adds Name append to (each) output file name,

\ before extension. For example, if processing test.cnv and

test1.cnv with a Name append of CTDpH, and outputting .jpg
files, output files will be testCTDpH.jpg and test1CTDpH.jpg.

Exit Cancel |

\
Start Process \I\\
N

Return to SBE Data Processing window.

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

o If Confirm Program Setup Change selected in Options
menu - If you made changes and did not Save or Save
As, program asks if you want to save changes.

o If Confirm Program Setup Change not selected in

Options menu - Button says Save & Exit. If you do not
want to save changes, use Cancel button to exit.
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Sea Plot Plot Setup Tab

The Plot Setup tab defines the plot type, scans to be included, and plot layout
(title, color, font grid lines, etc.). The Plot Setup tab looks like this:

e Single X - Multiple Y: 1 X axis and up to 4 Y axes

e Single X - Multiple Y, Overlay: 1 X axis and up to 4 Y axes, overlaying data from
multiple files on 1 plot

e Single Y - Multiple X: 1Y axis and up to 4 X axes

¢ Single Y - Multiple X, Overlay: 1Y axis and up to 4 X axes, overlaying data from
multiple files on 1 plot

e TS Plot: temperature vs. salinity, with density or thermosteric anomaly contours

e R AR R Y o TS Plot, Overlay: TS plot, overlaying data from multiple files on 1 plot

Plot Title and Title color. Select
Add file name to title to add

input data (.cnv) file name to title File Options Help 1

(for overlay plots, it adds first file Enapled if TS plot
name Fo title). For example, if you Fila Setup  Plot Setup |W—".:-:is | % A 1 | % i 2' % A 3' % fuia 4| type is selected.
enter title as P vs T, select Add See below.
file name to title, and data file Plat b 3 : e o
name is October1.cnv, title will SRR |5'”9|EY - Multiple & :l Wherlay b":"-'l’\\l 5 Flat Senm,. | | |
be P vs T, October 1.cnv.

\T'I Enabled if overlay plot type is

tle fpys T selected. See below.

Plot Font type and Font size

(small, medium, or large). Sea Title Colar... | . Iv &dd file name ta title

Plot displays example of font
type to right of selection. List of

fonts depends on what fonts are [T—Fantiype [uy =] |ﬂaBbCCDdEeFf—O’1 2345
installed on your computer.

. Grid lines (none, horizontal and vertical, horizontal, or
Fart size iSmaII *i vertical), Grid style (solid, dotted, or dashed line), and
Inside Background Color whether to place Grid in front of plotted data.
defines color within axes. Grid lines . : ——
Outside Background Color |Hnr|znntal and Yertical j %yg&ﬂsalggﬁgef;?q;in;);st
defines color outside axes. Girid style |Thin Salid Line v| I™ Gridin front frequent), if Monochrome
plot selected. If too frequent,
Size (small, mediur’q, or Ia.rge) of symbols create illusion of
symbol for each variable, if Inside Background Color... | D Outside Background Colar... I D very thick line, making details
Monochrome plot or Plot difficult to see.
symbols only selected. \S ol Sumbal T
yrbal size |u; ol v| ymbal frequency |5 — -
- ik I_-_-I e Mark data points: Mark
* Monochrome plot: Substitute |J_ IL }_ individual data points with
black lines with symbols for Monochrome plat Plot symbols only v Show line legends a dot, and connect dots. If
colors (Colors anq symbols not selected, Sea Plot just
are defined on Axis setup tabs I Mark data paints I Show plt shadow I Black test anes draws a continuous line
for non-overlay plots. For between data points.
overlay plots, click Overlay i  Show plot shadow:
Setup button to define). Auto range padding % IE_:_' Process Optiong... Create shadow effect to

Enables you to set up axes

with colors for viewiqg on o Black text axes — Create
screen, and then switch to labels for all axes in black.

black lines with symbols for If not selected:

black and white printing. - Axis label color matches
e Plot s_yn_\b_ols only: Mgrk _ Start Process | \ selected plot color for

each individual data point with =1 each variable.

a symbol, and do not connect \

c ¢ - For overlay files, colors
symbol_s with & I|n_e (Symbols Define space between axes and maximum and match colors for variables
are defined on Axis setup tabs

minimum plotted values, if Auto range selected in first file.
for non-overlay plots. For ) o .
; on Axis setup tabs. For 0%, maximum and
overlay plots, click Overlay L
) minimum values plot on axes.
Setup button to define).

e Show line legends: Show line
legends below plot title.
Legend indicates line color
and type (for color plots) or
line symbol and type (for
monochrome plots). For
overlay plots, legend indicates
line color or symbol only for
first file.

bottom and right of axes.
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Process Options

If the Process Options button is clicked on the Plot Setup tab, the following
dialog box appears:

Plot all scans in file. If not Process Dptions EI
selected, plot Scans to process.
\F Frocess scans to end of file

Skip these scans at beginning of cast, and then plot Scans ho process 100 Total number of scans to process.
remaining scans or number of scans designated by I

Scans to process. Example: If Scans to process I i Skip this number of scans between
is 100 and Scans to skip at start is 10, Soans to Sklp &t start IEI eal:% s<l:an 1:0 plot. W
Sea Plot processes scans 10 through 109. Sans to skip hetween paints ID— Example: If Scans to process is 10 and
Scans to skip at start is 2, Sea Plot
- - plots every other scan (scans 0, 2, 4, 6,
Plot scans that were marked with bad flag in —F  Plot scans marked bad by loop edit and 8).
Loop Edit. If not selected, Sea Plot omits those I
data points from plot. See illustration below. [~ Lift pen over bad data———o | Create a discontinuous line:

o Lift pen over data marked with bad
flag in Wild Edit, and
Help | ak. Cancel | o Lift pen over scans marked with
bad flag in Loop Edit (if Plot scans
marked bad by loop edit was
not selected).
See illustration below.

Plot scans marked bad by loop edit selected. Plot scans marked bad by loop edit not selected.
Lift pen over bad data not selected. Lift pen over bad data not selected.

badflag from

LOOP EDIT

(not plotted)
o

badflag from
LOOP EDIT

badflag from
o WILD EDIT
(not plotted)

badflag from
OWILD EDIT
(not plotted)

Plot scans marked bad by loop edit selected.

Lift pen over bad data selected. Plot scans marked bad by loop edit not selected.

Lift pen over bad data selected.

badflag from

fgcg/ggEf[rﬁrTn LOOP EDIT

(not plotted)

~ ?
safgag g:)_lfn badflag from -
o WILD EDIT
o

(not plotted) (not plotted)
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Overlay Setup

If an overlay plot type is selected

on the Plot Setup tab, the Overlay Setup

button is enabled. If clicked, the following dialog box appears:

Axis offsets define distance to separate plot from
each file, for each axis. Offset units match axis
units. For example, if Axis 1 is temperature in °C, a
0.2 offset means that file 1 plots at actual data
points, file 2 plots at 0.2 °C more than actual data
points, file 3 plots at 0.4 °C more than actual data
points, etc. This creates a waterfall effect and allows
user to see changes in shape that would be difficult
to see if plots were not offset from each other.

Note: Axis offsets are not applicable for TS plots.

Select line symbols for each axis, for each file.
Applicable if Monochrome Plot or Plot symbols
only selected on Plot Setup tab. See below.

Line Colors

X

Owverlay Setup

Az 1 offset Igz—
Bxis 2 offset IF
Buig 3 offset |-|—
Az 4 offset Ih_

Select line colors for each

axis, for each file. See below.

Line Spmbolz... | |

for each file. See below.

Select line types for each axis,

Help | Ok I Cancel | |

Double click on an axis heading to select a range of colors for that
_ axis, for all files. Color wheel dialog box appears (see below).

Double click on
a file heading to File
select a range of 1
colors for that
file, for all axes.
Color wheel
dialog box
appears

(see below).

|
X awis K Az 2 Kawis3d | XKazisd

Double click on a box to pick a
color for selected axis in
selected file. Color dialog box
appears; select desired color

Note:

If more than 10 files
were selected on the
File Setup tab, Sea
Plot repeats the colors
defined for files 1-10.
For example, if 20 files
were selected, files 1
and 11 have the same
color, 2 and 12 have
the same color, etc.

f T S I R 0 R R R )

25
=

Defaultz Help

Color Wheel, X Axis 1 )

Select Starting Color I |D.DD .
Select Ending Color | [30.00 L]

/Bightness |-|2 -I [ Advance clockwise

Select desired color

15 = brightest).

brightness (1 = least bright;

Click Select Starting Color and click desired
color in color wheel; then click Select Ending
Color and click desired color in color wheel.
Sea Plot calculates evenly spaced colors

(10 evenly spaced colors if you selected an

axis or 4 evenly spaced colors if you selected

a file).

» Advance clockwise not selected: Sea Plot
calculates colors moving counterclockwise
around circle from starting to ending color.

¢ Advance clockwise selected: Sea Plot
calculates colors moving clockwise around
circle from starting to ending color.

To set 1 color for all selected lines, click Select
Starting Color and enter desired color value in
box; then tab to Select Ending Color box and
enter same value again.

Help |

ak. | Cancell
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Line Symbols

Double click on axis heading to select same line symbol for that axis, for all
files. Line symbol dialog appears; make desired selection and click OK.

Double click on file
heading to select same
line symbol for that file,
for all axes. Line symbol
dialog appears; make
desired selection and
click OK.

Note:

If more than 10 files were
selected on the File Setup
tab, Sea Plot repeats the line
symbols and types defined for
files 1-10. For example, if

20 files were selected, files 1
and 11 have the same line
symbol and type, 2 and 12
have the same line symbol
and type, etc.

File: Az
1 Solid Circle
2 SolidCicle
i Solid Circle
4 Solid Circle
5 Solid Circle
§  SolidCicle
7 Solid Circle
g Solid Circle
9 Solid Circle
10 | Solid Circle
<]
Defaultz | Help |

¥ Az 2
Solid Upward Trangle
Solid Upward Triangle
Salid Upward Trangle
Solid Upward Triqngle
Salid Upward Trangle
Solid Upward Triangle
Salid Upward Triangle
Solid Upward Triqngle
Salid Upward Trangle
Solid Upward Triar_‘uglg

(] | Cancel ‘

i

Pull down on box to
pick line symbol for
selected axis in
selected file.

Line Types

Double click on axis heading to select same line type for that axis, for all
files. Line type dialog appears; make desired selection and click OK.

¥ Az 1

- - 1 i Thin Sold * | Thin S olid

Double click on file : : - -
heading to select same e Thin Solid * | Thin Solid
line type for that file, for 3 Thin Solid * | Thin Solid
3!' axes. Line type ) 4 | Thin Solid = | Thin Salid

ialog appears; make - - T
desired selection and A Thin Solid * | Thin Solid
click OK. g Thin Solid * | Thin Salid
7 Thin Salid * | Thin Salid
g Thin Salid ~ | Thin Solid
g Thin Salid * | Thin Solid
10 Thin Solid * | Thin Solid

< |
Defaults | Help |

ak. | Canicel |

H Az 2

Pull down on box to
pick line type for

selected axis in
selected file.
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TS Plot Setup

If a TS plot type is selected on the Plot Setup tab, the TS Plot Setup button is
enabled. The TS Plot Setup defines the contour lines for the plot; the user

selects from the following contour types:

e Density contours — Sea Plot calculates and plots sigma-t contours
if temperature is plotted, or sigma-theta contours if potential
temperature is plotted (see Axis Setup Tabs below for selection of

temperature parameter).
e  Thermosteric anomaly contours

The units for the parameters in the input data file do not affect the contour
calculations. For example, temperature could be in °C or °F, ITS-90 or
IPTS-68; Sea Plot performs the required conversions to calculate the contours.

The following table defines the required input parameters for various

combinations of temperature, salinity, and contours:

To plot:

Input .cnv file must
include:

temperature, salinity, density sigma-t or
temperature, salinity, thermosteric anomaly

temperature, salinity

temperature, derived salinity, density sigma-t or
temperature, derived salinity, thermosteric anomaly

temperature,
conductivity, pressure

potential temperature, salinity, density sigma-theta or

potential temperature, salinity, thermosteric anomaly

potential temperature,
salinity

potential temperature, derived salinity, density sigma-t or
potential temperature, derived salinity, thermosteric anomaly

potential temperature,
temperature *,
conductivity, pressure

*Derived salinity requires actual temperature in the input file. Potential
temperature cannot be used in calculation of derived salinity.

If the TS Plot Setup button is clicked, the following dialog box appears:

Variable to be calculated and plotted on
contour lines — density (sigma-t or sigma-theta)
or thermosteric anomaly. These variables are
calculated by Sea Plot from data in input file,
and do not need to be in input file.

TS Plot Setup X

x|

Contovr variable Denmt_l,l [K.gém™3]

=

Significant digits to right of decimal
point for contour line labels.

Define contour line smoothness

Type size of contour line labels
(1 = smallest, 10 = largest).

Button is not enabled if monochrome plot was
selected on Plot Setup tab.

(10 = least smooth, 200 = smoothest). | Bt :
per line [10 - 200] |4|:|

Starting contour value

Starting contour value is lowest value
of contour variable to be plotted. First

Contaur interval | ; contour line is plotted at this value;

subsequent lines are plotted at every

Sigrificant digitz [0 - 10] 2 Contour Interval.

Distance of contour line labels from

Ll SR Y axis as a % of X axis size
abel posibion 2 IE —— | (0% = label contour lines on Y axis,

100% = label contour lines at far

[ Label zize [1 - 10) [@ right of plot).

Contour line ype I Medium\"J\
Select contour line thickness.

Select contour line color for color plots. |l — Contour line color... I .

Help | k. I Eanu:ell
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Sea Plot Axis Setup Tabs

Each Axis Setup tab defines a plot variable, scale, and line type.

e  Axis tabs are labeled X Axis and Y Axis if an X-Y plot was selected on
the Plot Setup tab.

e Axis tabs are labeled Temperature and Salinity if a TS plot was selected
on the Plot Setup tab.

X-Y Axis Setup Tabs

An Axis Setup tab looks like this for X-Y plots (X Axis 2 tab shown;
other axis tabs are similar):

Drop down list includes all variables in data (.cnv) file. Sea Plot indicates range of data for selected variable, to assist setup of plot scale.
Range is full range of data in file(s), and does not reflect your selection of Scans to process, Scans to skip at start, Scans to skip
between points, etc. in Process Options dialog box. If file contains data collected while instrument was in air, range reflects these values. If
multiple files were selected on File Setup tab, range is lowest value in all files to highest value in all files. If selected variable is derived
salinity or derived density, variable range shown is 0 to 0, because Sea Plot does not know derived salinity or density values until you click
Start Process and it begins to calculate derived values.

Order in drop down list reflects order of variables in file. If file contains multiple occurrences of a variable (for example, you calculated
salinity in Data Conversion and then again in Derive, after aligning and filtering data), list adds a suffix (1%, 2", 3", etc.) to variable name;
do not confuse this with labeling for data from duplicate sensors (for example, Salinity, 2 [PSU] 1% is first occurrence in file of salinity
calculated from secondary temperature and conductivity sensor data). Make sure to select desired variable for plotting.

=101 =]

Include this axis in plot. Sea Plot [Eakt==Na 1A= E 1 B
can plot up to 5 variables (1Y File Cptions Help
and 4 X, or 1 X and 4Y). At least
1 X'and 1Y variable is required,
so this selection is available only
on Axis Setup tab for third,
fourth, and fifth axis. — ¥ Include asis
Note: If you deselect an axis, all
axes numbered above that axis "ariable

File Setup | Plot Setup | v dwis | % s 7 | ¢ s 3| % Awis 4 | Header View |

Conductivity [S4m]

are automatically deselected. Select desired Line tvoe. color
ariable range is from 2837419 to 3 666365, ype, ’

and symbol.
— - e Selection of color or monochrome
Select to label axis with variable | [ | Jbel auis with variable name plot, and inclusion of symbols in plot,
name as I_|sted in drop down is made on Plot Setup tab, and
Variable list, or enter a Custom Cusztorn label I applies to all axes.
label for axis.

e |f an overlay plot was selected on

Plot Setup tab, line type, color, and
Line type : " = / symbol are grayed out — select these
|Th|n Sald J for all files using Overlay Setup

Line Col . Line symbol [ T - button on Plot Setup tab.
« Auto range: Sea Plot selects —ImE AT | >0iid Upiard Trianale

axis Minimum and Maximum L1
values, number of Major Plot this axis on linear or logarithmic scale.
divisions on axis, and number

Scale lype: % Linear  Log

of Minor divisions between
major divisions. v Auto range Mirirnurn [ o000 M axirnurm |1 00000
e Auto divisions: Sea Plot
selects number of major ¥ futo divisions P ajor Iq_ kdirior I,_
divisions on axis, and number
of minor divisions between Reverze scale direction
major divisions. User
selects axis Minimum and Plot axis from highest to lowest value. Typically
Maximum values. used when pressure or depth is plotted on Y axis,
Any values that fall outside user- so pressure / depth starts at 0 at top of plot and
selected Minimum to Maximum increases as you move down vertically.
range will plot at minimum or
maximum, as applicable.

Start Process Exit | Cancel
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An Axis Setup tab looks like this for TS plots (Temperature axis tab shown;
Salinity axis tab is similar):

Drop down list includes all applicable variables in data (.cnv) file - temperature and potential temperature (for Temperature tab) and salinity
(for Salinity tab), as well as derived salinity (for Salinity tab). Sea Plot indicates range of data for selected variable, to assist you in setup of
plot scale. Range is full range of data in .cnv file(s), and does not reflect your selection of Scans to process, Scans to skip at start,
Scans to skip between points, etc. in Process Options dialog box. If file contains data collected while instrument was in air, range reflects
these values. If multiple files were selected on File Setup tab, range is lowest value in all files to highest value in all files. If selected
variable (on Salinity tab) is derived salinity, variable range shown is 0 to 0, because Sea Plot does not know derived salinity values until
you click Start Process and it begins to calculate derived values.

Order in drop down list reflects order of variables in file. If file contains multiple occurrences of a variable (for example, you calculated
salinity in Data Conversion and then again in Derive, after aligning and filtering data), list adds a suffix (1%, 2", 3", etc.) to variable name;
do not confuse this with labeling for data from duplicate sensors (for example, Salinity, 2 [PSU] 1* is first occurrence in file of salinity
calculated from secondary temperature and conductivity sensor data). Make sure to select desired variable for plotting.

B Sea Plot, Beta 1.2a
File Options Help

=10l x|

File Setupl Plot Setup  Temperature LS slinity Header‘-«fiewl

Variable  [Temperature (I15-92 deg C] [

W ariable range ig from 09566 to 11.7613. Select desired Line type, color,

Select to label axis with variable and symbol.

name as listed in drop down v Label suswithowarahl ¢ Selection of color or monochrome

Variable list, or enter a Custom Gl R el plot, and inclusion of symbols in plot,
\Custnm label I

label for axis. is made on Plot Setup tab, and
applies to all axes.
e [f an overlay plot was selected on

: Plot Setup tab, line type, color, and
Lire type |Thin S alid j / symbol are grayed out — select these

for all files using Overlay Setup

: : button on Plot Setup tab.
Line Color.. | [ Uinesmbol [So T P

Scaletype: % Linear ) Log

« Auto range: Sea Plot selects 47 At range Minimum ||j|_|_'||j||_'|!'_| b i |1|;| oooo

axis Minimum and Maximum
values, number of Major ¥ futo divisions b ajor I_nr_ kinar |-|_
divisions on axis, and number

of Minor divisions between
major divisions.

e Auto divisions: Sea Plot
selects number of major
divisions on axis, and humber
of minor divisions between
major divisions. User
selects axis Minimum and
Maximum values.

Any values that fall outside user-

selected Minimum to Maximum

range will plot at minimum or
maximum, as applicable.

[T | Beverse seale drection

Stant Process Exit | Cancel
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Sea Plot Header View Tab

The Header View tab allows you to view the existing header in the input
file(s). The Header View tab looks like this:

-5 x|

File Options Help
File Setup | Plot Setup | ¥ Awis | Stwis 1 | uis 2] % duie 3| Kibwin 8 Header View |
1

View existing header in input file(s). If multiple input files are to be processed,

e it
LR | iz switch between input file headers by using Prior and Next buttons.

* Sea-Bird SBE 25 Data File: -
*FileM ame = \CTD25MB00.HE

* Software Verzion 4. 246

* Temperature SH =2339

* Conductivity S = 1897

*Syztem Upload Time = Sep 27 2000-22:06:04

= Ship:

= Cruize: - — - -

# Shation: e Header lines beginning with * contain header

= ahitiide: information copied from raw input data file.

= |_ongitide: e Header lines beginning with # contain header

“ds information describing input converted data (.cnv) file

*SBE25CTD W 4.0b5SH (not applicable to example shown). As each module is
* external pressure sensol  run, it adds information to the header, such as the input
*wtal = 3437333 clk = 3]  file name for the module, date and time the module
*hoaste=2 samples =4 was run, and input parameters. Thus, the header

: ) . contains a complete record of how the data has been
*CTD configuratior; converted, edited, and manipulated.

“number of seans avelad,  ASCHl string *END* flags end of header information.
* real time data tranemitte

* mirimum conductivity fregquency far prump turnon =10
* pump delay = 45 zeconds

* battery type = ALKALINE

* 4 gxternal voltaoes zampled

*ztared voltage # 0 = external volkage 0 _lll
1| | b

Start Process | Euit | Caheel |
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Viewing Sea Plot Plots

Shown below are three examples:

e  Multiple X-Y plots, no overlay
e  Multiple TS plots, no overlay
e X-Y overlay plot

Following the examples is a detailed description of the plot’s menus.

Multiple X-Y Plots, No Overlay

B Gea Plot View, 1/3 18] =|
Qutput  Options  Wiew
Test Plot, KBOO1 .CNV‘
oot . — .
- If plotting multiple files, title bar indicates which file number is
L shown and total number of files plotted. Use View menu or
= keyboard Arrow, Home, or End keys to switch between files. Double click on plot title, and Plot
25 Setup tab appears, allowing you to
L make changes and reprocess data.
504
L Zoom in to enlarge details by clicking and dragging
= to select a rectangular area. You can zoom in
?-5': several times before reaching program limits. Undo
_ = zoom by selecting Undo Zoom in View menu.
= [
210.0+
5 L
§T
D_ -
12,54
1504 Double click on axis or axis label (temperature,
F pressure, etc.), and appropriate Axis Setup tab
L appears, allowing you to make changes and
s reprocess data with new plotting parameters.
2004
295 L 1 I L1 L1 I 1 L1 1 I L1 1 I 1 L1 1 I L1 L1 I 1 1 L1 I 1 L1 1 I L1 L1 I
8.0 9.8 100 10.8 1.0 1.8 12.0 12.8 13.0

Temperature [ITS-BB, deg C]
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Multiple TS Plots, No Overlay

If plotting multiple files, title bar indicates which file number is
shown and total number of files plotted. Use View menu or
keyboard Arrow, Home, or End keys to switch between files.

£ Sea Plot View, 1/14 =18

Qutput  Options  View

DI10011.cnv w

Contour lines — example reflects following
choices in TS Plot Setup dialog box:

o Contour variable - density (so Sea Plot Double click on plot title, and Plot
calculated and plotted sigma-t). | ———"|Setup tab appears, allowing you to
e Contour interval - 0.2 make changes and reprocess data. |—— ]

o Significant digits — 2
e Label position — 5%

26.80

Zoom in to enlarge details by clicking and dragging
to select a rectangular area. You can zoom in

several times before reaching program limits. Undo
zoom by selecting Undo Zoom in View menu. I

Temperature [IT3-90, deg ]

; Double click on axis or axis label (temperature or
2 salinity), and appropriate Axis Setup tab appears,
-2 allowing you to make changes and reprocess data
with new plotting parameters.

S

7.40

i

| I | | I | I I I
34.35 3440 3445 34.50 \44.55 34,50 34,85 34,70 34.75 34.80
Salinity [PSU]
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X-Y Overlay Plot

In View menu, select Show Plot Legends to view complete list of
file names and plot colors or plot symbols (if monochrome plot was
selected on Plot Setup tab). You can highlight 1 line, all lines in

1 file, or 1 line in all files with color or line symbol. See below.

Double click on plot title, and
Plot Setup tab appears,
allowing you to make
changes and reprocess data.

Legend shows line color and
type for each axis in first file
if Show line legends selected
on Plot Setup tab.

EZ Sea Plot Yiew, Overlay

=8|

Cutpuk  Options  View

Creygen Current, Beckman/'S1 [ud)

Croygen Current, Beckman'S1 [ud)
20 7 E

0.5 1.0 14 3 ) 4.0 44
_IIIIII\IIIIIIIIIIIIIIIIIIIIIIIIIIIIII\IIIIIIIIII
i Base lines (from first file) plotted at actual
L data points. Other lines are offset from base
10004 line by amounts defined in Overlay Setup
L dialog box (access from Plot Setup tab).
1500+
_ Zoom in to enlarge details by clicking and dragging
= to select a rectangular area. You can zoom in
s several times before reaching program limits. Undo
2 2000+ zoom by selecting Undo Zoom in View menu.
i
e
[}
i
(ol
o
W 25089
r
E
'_
3000 ' —EﬁL
L Double click on axis or axis label :
L (temperature, time, etc.), and L,
= appropriate Axis Setup tab i
3800+ appears, allowing you to make 1
r changes and reprocess data with ;
r new plotting parameters. St 5
_IIII}IIIIIIIIIIII\IIIIIIIIIII\IIIIIIIIIIII\IIII
20 5 100 1258 15.0 1758 200 225 250
Temperature [IT3-90, deg C]
Not If you select Show Plot Legend in the View menu, the Plot Legend dialog box
ote:

shows the color for each line in each file, and allows you to apply a highlight

If Monochrome plot or color to a selected line or lines. The dialog box looks like this:

Plot symbols only were

selected on the Plot
Setup tab, the Plot
Legend dialog box shows

Double click on axis heading, and all
files for selected axis change to
/ highlight color.

it
™ Highlight Color.. |.

Click to select
desired highlight
color. Color dialog

each line symbol instead

box appears;

of each line color, and make selection

Double click on color, and selected

provides for user and click OK. File Hhwiz1 | H Az 2 axis in selected file changes to

selection of a highlight 2a34Ed crv highlight color.

symbol instead of a 2a340d chy

highlight color. Double clickon [ Note that if you print, save, or copy
file name, and all La- A GHY plot to clipboard, it does not include

2a3Add.cnv - |_l|legend. To save legend information,

lines (all axes) for
selected file
change to

click Copy. Legend can then be
pasted into another application, such

highlight color.

Help | Copy m

as Microsoft Word, and saved.

With the highlight color applied, you can view the plot on screen and output to
the printer, file, or clipboard. When you click Cancel in the Plot Legend dialog
box, the colors return to what they were before you applied the highlight.
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Note:

If you print, save, or copy
the plot to the clipboard,
it does not include the
legend. To save legend
information, click Copy in
the Plot Legend dialog
box. The legend can then
be pasted into another
application, such as
Microsoft Word, and
saved.

Plot Menus
The Sea Plot View window’s menus are described below:

Output - Directs Sea Plot to output plot now to printer, clipboard, or a file. If
multiple files are plotted (but not as an overlay), you can output plot shown on
screen or plots for all files. How plot is output (size, file type, etc.) is
controlled by Options menu.

Options - Sets up how plot is output to printer, clipboard, or a file.
e Print-
» Orientation — landscape, portrait, or print driver default
»  Print full page - scale plot to fit 8 1/2 x 11 inch page. If not selected,
Size determined by -
Sea Plot View Dimensions - dimensions of plot as shown on screen
File Setup tab entries - entries on File Setup tab for Width and Height
Values Entered Below - dimensions entered in dialog box (in mm)
e File-
» Data format - Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp)
»  Size determined by
Sea Plot View Dimensions - dimensions of plot as shown on screen
File Setup tab entries - entries on File Setup tab for Width and Height
Values Entered Below - dimensions entered in dialog box (in mm)
o  Clipboard -
» Data format - Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp)
» Size determined by -
Sea Plot View Dimensions - dimensions of plot as shown on screen
File Setup tab entries - entries on File Setup tab for Width and Height
Values Entered Below - dimensions entered in dialog box (in mm)

View — Sets up viewing options.

e Show cursor position — Directs Sea Plot to show the coordinates of the
cursor as you move the cursor around when viewing a plot.

e  Next Plot, Prior Plot — Directs Sea Plot to switch between plots, if you
selected multiple files on File Setup tab but are not doing an overlay plot.

e  File name — Lists, and allows you to select from, all input files, if you
selected multiple files on File Setup tab but are not doing an overlay plot.

o Show plot legends — For overlay plots only, allows you to view a complete
list of file names and plot colors or plot symbols (if monochrome plot was
selected on Plot Setup tab).

e Undo Zoom — Directs Sea Plot to return plot to original ranges specified
on Axis Setup tabs. Undo Zoom is grayed out unless you have zoomed in
(by clicking and dragging to select a rectangular area) to enlarge details.

o Set Zoomed Ranges — Directs Sea Plot to substitute current zoomed ranges
of plot for Minimum and Maximum plot ranges on Axis Setup tabs. This
provides ability to save ranges of zoomed view, so you can go to exactly
same view next time you run Sea Plot. Set Zoomed Ranges is grayed out
unless you have zoomed in (by clicking and dragging to select a
rectangular area) to enlarge details.
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Section 9: Miscellaneous Module — SeaCalc Il

Notes:

o Algorithms used for calculation of
derived parameters in Data
Conversion, Derive, Sea Plot,
SeaCalc Il [EOS-80 (Practical
Salinity) tab], and Seasave are
identical, except as noted in
Appendix V: Derived Parameter
Formulas (EOS-80; Practical
Salinity), and are based on EOS-80
equations.

o Algorithms used for calculation of
TEOS-10 parameters in Derive
TEOS-10 and SeaCalc Il [TEOS-10
(Absolute Salinity) tab] are
described in Derive TEOS-10 in
Section 6: Data Processing
Modules.

SeaCalc is a seawater calculator that computes a number of derived variables
from one user-input scan of temperature, pressure, etc. SeaCalc has two tabs:

B SeaCalc 11T ; g ] 3
EQS-80 (Practical Salinity) |TEOS—1 0 (Absolute Salinity) |

Enter temperature in IPTS-68 or

computes other parameter.

automatically computes other parameter.

- meynen saturation, Waiss [ml1™-1] = 5.688
Used to compute sigma-ref. |/ reference pressure [dbar]  [0.00 ranity [m 57-2] = 8780318

Used to compute gravity

ITS-90. SeaCalc automatically ~—temperature [IPTS-68, deg C]  [15.000000 density [sigma-t, kg m™-3] = 2597275
density [sigme-theta, kg m”™-3] = 25.97275

ternperature [ITS-90, deg C] |1 4 996401 density [sigma-ref p, kg m”-3] = 25.97275

potential ternperature [IFT5-68. deg C] = 15.00000

ivi it Conductivity [S -1 l— sound velocity [Chen-kdillara, m s7-1] = 1506 B3

Enter conductivity or salinity. SeaCalc < ty [ 1 4231400 coundelodity [Wilson, m o°-1] - 1807.392
ractical Salinity [PSU] W sound velocity [Delgrosso, m 57-1] = 1506.667

e  The first tab calculates Practical Salinity and associated parameters using
EOS-80 equations. SeaCalc remembers whether you last changed
conductivity or salinity, and calculates other parameters based on this.

For example, if you change conductivity, salinity is recalculated; if you
then change temperature, salinity is recalculated again (based on input

C, P, and t). Conversely, if you change salinity, conductivity is
recalculated; if you then change temperature, conductivity is recalculated
again (based on input S, P, and t).

Use this tab to calculate properties of seawater based on the Equation of Seawater 1980 (EOS-80], which
is a function of Practical Salinity (PSS-78)

pressure [dbar] |D.DDD depth [saltwater, m] = 0.000

depth [fresh water, m] = 0.000

spacificvolume anomaly [107-8*m™3 kg™1] = 202.271

latitucle [deg] |D.D

Click to calculate derived variables.

and salt water depth.

Feport | (Calculatel Exit | Help
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e The second tab calculates Absolute Salinity and associated parameters,
using TEOS-10 equations. SeaCalc automatically populates this tab with
Practical Salinity, temperature [ITS-90, deg C], pressure, reference
pressure, and latitude from the Practical Salinity tab, and requires a
Longitude entry.

=T

EQS-80 (Practical Salinity) TEODS-10 (Absolute Salinity) |

Usze this tab to calculate Absolute Salinity and other properies based the 48-term expression for density as
defined by the intermnational Thermaodynamic Equation of Seawater - 2010 (TEQS-10)

Practical Salinity [FELI] |35.DDDDDD Preformed Salinity [g kg-1] = 35.16484 =

. l— Conservative Temperature [deg C] = 14.9858
(EmERntS (Sl Gl 1 4.996401 potential temperature [deg C] = 14.9964

pressure [dbar] |D_gggggg Ahsolute Salinity Anomaly [g kg™1] = 0.0005775549
density [kg m™-3] = 1025.93

reference pressure [dbar]  [0.000000 potential density [kg m™-3] = 1025.98
latitude [deg]  [0.000000 the_rmal expangion coeffi_cient [K"—1A] = 0000213933
saline contraction coefficient (kg g™-1] = 0.000742401
longitude [deg E]  [0.000000 specificvolume [m”3 kg™-1] = 0.00097468
o " specific volume anomaly [m”3 kg™-1] = 2.0189e-006
sl Sl g |35-155618 Sgund speed [m 5"-1] =)1;5[DB.?1 o
Reference Salinity [g kg™1]  [35.165040 internal energy [J kg™-1] = 6722 B
anthalpy [J kg™-1]= 53821.3

saturation fraction |1.D dynamic enthalpy [J kg ™11 =0 |
Feport | Calculatel Exit | Help |

If you go back to the Practical Salinity tab, SeaCalc automatically populates it
with values from the Absolute Salinity tab.
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Appendix I: Command Line Options,
Command Line Operation, and
Batch File Processing

Command Line Options

Note:

The default program setup (.psa) file is
the last saved .psa file for

the module. PostProcSuite.ini contains
the location and file name of the last
saved .psa file for each module.

- Primary PostProcSuite.ini file default
location, if available, is:
%LOCALAPPDATA%\
Sea-Bird\IniFiles\

(Example
c:\Users\dbresko\AppData\Local\
Sea-Bird\IniFiles\PostProcSuite.ini)

- Secondary PostProcSuite.ini file
default location is:
%APPDATA%\Sea-Bird\IniFiles\
(Example

c:\Documents and Settings\
dbresko.SEABIRD\Application Data\
Sea-Bird\IniFiles\PostProcSuite.ini)

Command line options can be used to assist in automating processing, by
overriding information in an existing program setup (.psa) file or designating a
different .psa file.

Access the Command Line Options dialog box by selecting Command Line
Options in the SBE Data Processing window’s Run menu:

EZX: SBE Data Processing -10O] x|

Run  Configure  Help
1

. Daka Canwversion. ..
. Filker, ..

. Align CTD...

. Cell Thermal Mass. ..
. Loop Edit. ..

, Derive. .,

, Derive TEDS-10..,

. Bin Average. ..

o0 = O N B Ld

9, Bottle Summary. ..
10, Mark Scan...

11, Buowancy...

12, 'wild Edit...

13, Window Filter. ..

14, ASCII In...
15, ASCIT Ouk.,,
16, Section...
17. Split. ..

138, Strip...

19, Translate. ..

20, Sea Plot. ..

21, SeaCalc I1I. ..

Command Ling Options. . .

Ezxit

The Command Line Options dialog box looks like this:

Command Line Options 1[

Optionz ||

[~ Auko start

0k I Cancel
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The option parameters are:

Parameter Description

Use String as instrument configuration (.con or .xmlcon) file.
String must include full path and file name.

Note: If using this parameter, you must also specify input file
name (using /iString).

/cString

Use String as input data file name. String must include full path

and file name.

The /iString option supports standard wildcard expansion:

e ? matches any single character in specified position within
file name or extension.

e * matches any set of characters starting at specified position
within file name or extension and continuing until end of
file name or extension or another specified character.

/iString

/oString |Use String as output directory (not including file name).

/fString  |Use String as output file name (not including directory).

/aString | Append String to output file name (before extension).

Use String as Program Setup (.psa) file. String must include

/pString full path and file name.

Use String to define an additional parameter to pass to
Module. Not all modules have x parameters; see module
descriptions. If specifying multiple x parameters, enclose in
double quotes and separate with a space; do not specify x
/xModule: |parameter more than once.

String  |Example: Run Data Conversion, telling it to skip first
1000 scans, and also run Window Filter, telling it to output
difference between original and filtered value:
/x“datcnv:skip1000 wfilter:diff” Correct

Note:

If you do not select Auto Start,
when you select a module the
module dialog box appears,
allowing you to review the selected
input files and data setup before
beginning processing.

/xdatenv:skip1000 /xwfilter:diff Incorrect

If specifying multiple parameters, insert one or more spaces or tabs
between each parameter in the list.

Example: You set up and saved .psa files for Filter, Loop Edit, Bin Average,
and Derive within each module’s dialog box, and ran each module
successively. The input and output file names in all the .psa files were the
same - c:\Ist\test.cnv (this has the effect of overwriting the module input with
the module output).

You now want to run each process again, using a different input and output
file - c:\2nd\testl.cnv. You enter the following in SBE Data Processing’s
Command Line Options dialog box:

/ic:\2nd\testl.cnv /ftestl.cnv /oc:\2nd

When you pull down on the Run menu and select Filter, you see in the Filter
dialog box that the program substituted c:\2nd\test1.cnv for c:\1st\test.cnv as
the input data and output data path and file. Similarly, testl.cnv is shown as
the input and output data file in all the modules. You can run each process
rapidly in succession, without needing to enter the new path and file name
individually in each module.

Auto Start (for running a module)

Select this and then select the desired module to have SBE Data Processing
automatically run the module with the last saved setup parameters (defined by
the .psa file) and any entered Command Line Options.

e Ifyou select Auto Start, a Run Minimized selection box appears. If
selected, SBE Data Processing minimizes its window while processing the
data, allowing you to do other work on the computer. When processing is
complete, the SBE Data Processing window reappears.
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Command Line Operation

The following modules can be run from the command line (default location for
files is c:\Program Files\Sea-Bird\SBEDataProcessing-Win32):

Module Executable File Name
Align CTD AlignCTDW.exe
ASCII In ASCII InW.exe
ASCII Out ASCII OutW.exe
Bin Average BinAvgW.exe
Bottle Summary BottleSumW.exe *
Buoyancy BuoyancyW.exe
Cell Thermal Mass CellTMW .exe
Data Conversion DatCnvW.exe
Derive DeriveW .exe
Derive TEOS-10 DeriveTEOS 10W.exe
Filter FilterW.exe
Loop Edit LoopEditW.exe
Mark Scan MarkScanW.exe
SeaCalc II1 SeaCalcll.exe
Sea Plot SeaPlotW.exe
Section SectionW.exe
Split SplitW.exe
Strip StripW.exe
Translate TransW.exe
Wild Edit WildEditW .exe
Window Filter W _FilterW.exe

* Bottle Summary’s executable file name was previously RosSumW.exe.

Note:

The default program setup (.psa) file is
the last saved .psa file for

the module. PostProcSuite.ini contains
the location and file name of the last
saved .psa file for each module.

- Primary PostProcSuite.ini file default
location, if available, is:
%LOCALAPPDATA%\
Sea-Bird\IniFiles\

(Example
c:\Users\dbresko\AppData\Local\
Sea-Bird\IniFiles\PostProcSuite.ini)

- Secondary PostProcSuite.ini file
default location is:
%APPDATA%\Sea-Bird\IniFiles\
(Example

c:\Documents and Settings\
dbresko.SEABIRD\Application Data\
Sea-Bird\IniFiles\PostProcSuite.ini)

BottleSumW.exe will run if BottleSumW.exe or RosSumW .exe is typed on

command line.

Command line parameters can be used to override existing information in the
.psa file. The command line parameters are:

Parameter

Description

/cString

Use String as instrument configuration (.con or .xmlcon) file.
String must include full path and file name. Note: If using
/cString, must also specify input file name (using /iString).

/iString

Use String as input data file name. String must include full

path and file name.

This parameter supports standard wildcard expansion:

e 7 matches any single character in specified position within
file name or extension

e * matches any set of characters starting at specified
position within file name or extension and continuing until
end of file name or extension or another specified character

/oString

Use String as output directory (not including file name).

/fString

Use String as output file name (not including directory).

/aString

Append String to output file name (before file name
extension).

/pString

Use String as Program Setup (.psa) file. String must include
full path and file name.

/xModule:
String

Use String to define an additional parameter to pass to
Module. Not all modules have x parameters; see module
descriptions. If specifying multiple x parameters, enclose in
double quotes and separate with a space.

Example: Run Data Conversion from command line, telling it to
skip first 1000 scans: datcnvw.exe /xdatenv:skip1000

/s

Start processing now.

If specifying

multiple parameters, insert one or more spaces or tabs

between each parameter in the list.
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Note:

If you have not modified your
autoexec.bat file to put the .exe
files in the path statement, specify
the full path of the .exe file in the
Run dialog box.

Example: The specified input file directory contains test.dat, testl.dat, and
test2.dat. Select Run in the Windows Start menu. The Run dialog box appears.

Run

=== Tyne the niarme of a progiam, folder, document, of [ntemet
b Tesource; and Windaws will open it far vou,

Dpen: idatcnvw.e:-:e Jitest dat Js

x|

Cocel | Browse.. |

:I

For the command line shown (datcnvw.exe /itest*.dat /s), SBE Data
Processing will process test.dat, testl.dat, and test2.dat using Data Conversion.
If the ? wildcard symbol is used (datcnvw /itest?.dat) instead of the *, Data
Conversion will process only testl.dat and test2.dat.

Batch File Processing

Note:

A duplicate copy of SBEBatch.exe
is placed in the Windows folder
when SBE Data Processing is
installed. This allows the user to run
SBEBatch.exe from anywhere,
without having to specify its path.

Note:

SBEBatch can also launch system
commands, such as copying or
renaming a file, deleting a file from
an intermediate step, etc.
Additionally, it can launch non-
Sea-Bird programs, such as Word
Pad. If you call a program that does
not run and then shut down
automatically, such as Word Pad,
you must manually close the
program before batch processing
will continue to the next step.

Traditional DOS batch file processing cannot be used with the 32-bit
processing modules because the Windows operating system will start the
second process before the first process is finished. The program SBEBatch.exe
(default location c:\Program Files\Sea-Bird\SBEDataProcessing-Win32) or the
Windows Scripting Host can be used to process a batch file to automate data

processing tasks. The format for SBEBatch is:

sbebatch filename parameters

The parameters are referenced in the batch file in the same way as the DOS
batch file, using the percent sign (%) followed by numbers 1 through 9. %1 in
the batch file is replaced by the first command line parameter, %2 in the batch
file is replaced by the second command line parameter, and so on until %9.

Each line in the batch file contains the process name followed by command

line arguments. The process names are:

Module Process Name
Align CTD Alignctd
ASCII In Asciiin
ASCII Out Asciiout
Bin Average Binavg
Bottle Summary Bottlesum *
Buoyancy Buoyancy
Cell Thermal Mass Celltm
Data Conversion Datcnv
Derive Derive
Derive TEOS-10 DeriveTEOS10
Filter Filter
Loop Edit Loopedit
Mark Scan Markscan
Sea Plot Seaplot
Section Section
Split Split
Strip Strip
Translate Trans
Wild Edit Wildedit
Window Filter Wiilter

* Bottle Summary’s process name was previously Rossum. Bottlesum will run if

Bottlesum or Rossum is used in the batch file.
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Note:
The default program setup (.psa) file is
the last saved .psa file for

The batch file can also contain comment lines to document the file purpose.
Any line beginning with @ is a comment line, and does not affect the results.

Parameters specified in the batch file can be used to override existing
information in the .psa file. These parameters are:

the module. PostProcSuite.ini contains Parameter Description
the location and file name of the last Use String as instrument configuration (.con or .xmlcon) file.
sav_ed -psa file for eac.h mo_dyle. . String must include full path and file name.
; Prlr'nary' PostErochlte.|n| file default feString Note: If using /cString, must also specify input file name
location, if available, is: (using /iString).
%LOCALAPPDATA%\ - " : -
Sea-Bird\IniFiles\ Use String as input file name. String must include full path
(Example and file name.
c:\Users\dbresko\AppData\Local\ This parameter supports standard wildcard expansion:
Sea-Bird\IniFiles\PostProcSuite.ini) e 7 matches any single character in specified position within
- Secondary PostProcSuite.ini file /iString file name or extension
default locationis: o *matches any set of characters starting at specified
%APPDATA%\Sea-Bird\IniFiles\ position within file name or extension and continuing
(I.Example ) until the end of file name or extension or another
c:\Documents and Settings\ .
dbresko.SEABIRD\Application Data\ : specified character : :
Sea-Bird\IniFiles\PostProcSuite.ini) /oString  |Use String as output directory (not including file name).
/fString  |Use String as output file name (not including directory).
/aString | Append String to output file name (before extension).
/pString Use String as Program Setup (.psa) file. String must include
full path and file name.
Use String to define an additional parameter to pass to
Module. Not all modules have x parameters; see module
/xModule: |descriptions. If specifying multiple x parameters, enclose in
String double quotes and separate with a space.
Example: Run Data Conversion, telling it to skip first
1000 scans: /xdatcnv:skip1000
Wait for user input at start of Module, allowing user to review
w setup before processing data for a particular Module. After
reviewing setup, user clicks Start Process in Module dialog
box to continue.
Pause processing data at end of Module, allowing user to
/d review output from a particular Module before continuing with

rest of processing.

If specifying multiple parameters, insert one or more spaces or tabs
between each parameter in the list.

Parameters specified on the Run line can also be used to control the process:

#m

Minimize SBE Data Processing window while processing
data, allowing you to do other work on computer.

#w

Wait for user input at start of each Module, allowing user
to review setup before processing data for each Module.
After reviewing setup, user clicks Start Process in Module
dialog box to continue.

#d

Pause processing data at end of each Module, allowing
user to review output from each Module before continuing
with rest of processing.
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Note:

For Sea Plot, enter the desired
choices in the File Setup, Plot
Setup, and Axis Setup tabs.

To process data using a batch file:

1.

Run each software module, entering the desired choices in the File Setup
and Data Setup dialog boxes. Upon completing setup, press Save or Save
As on the File Setup tab. The configuration is stored in the Program Setup
File (.psa).

Create a batch file to process the data.

Following are two examples of typical batch files.

Example 1 — Process Single File, and Save All Intermediate Files

The data file is c:\leg1\cast5.dat, and the .con file is c:\leg1\cast5.con.

1.

Set up each software module, entering desired choices in Setup dialog
boxes. In the File Setup dialog boxes, delete the output file name (this
allows program to base output file name on input file name and any
appended text), and set the output file path as c:\legl.

Create a batch file named preast.txt in c:\legl, which contains:
@ Lines starting with @ are comment lines
@ Comment lines have no effect on the result
datenv /ic:\leg1\%]1.dat /cc:\legl\%1.con /a%?2
wildedit /ic:\leg1\%1%2.cnv /asl
filter /ic:\leg1\%1%?2sl.cnv /as2
loopedit /ic:\leg1\%1%2s1s2.cnv /as3
derive /ic:\legl\%1%2s1s2s3.cnv /cc:\leg1\%1.con /as4
seaplot /ic:\leg1\%1%2s1s2s3s4.cnv
Module names and options are separated by one or more spaces or tabs.

Select Run in the Windows Start menu. The Run dialog box appears.
Type in the program name and parameters as shown:

sbebatch c:\legl\prcast.txt castS testl

(batch filename is c:\leg1\prcast1.txt; parameter %1 is cast5;

parameter %?2 is testl)

The data is processed as follows (all input and output files are in c:\legl):

Module Input File(s) Output File

cast5.dat
castS.con

Data Conversion

(datcnv) castStestl.cnv

Wild Edit (wildedit)

castStestl.cnv

castStestlsl.cnv

Filter (filter)

castStestlsl.cnv

castStestlsls2.cnv

Loop Edit (loopedit)

castStestlsls2.cnv

castStestlsls2s3.cnv

Derive (derive)

castStestlsls2s3.cnv
castS.con

castStestls1s2s3s4.cnv

Sea Plot (seaplot)

castStestls1s2s3s4.cnv

castStest1s1s2s3s4.jpg
(if File Setup tab was
set to output to jpeg)
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Example 2 — Process Several Files, and Overwrite All Intermediate Files

Process all data files in c:\legl. The data files are c:\legl\castl.dat and
c:\legl\cast2.dat, and the .con file is c:\leg1\cast.con.

1. Set up each software module, entering desired choices in Setup dialog
boxes. In the File Setup dialog boxes, delete the output file name (this
allows program to base output file name on input file name and any
appended text). Set the output file path as c:\leg1.

2. Create a batch file named prallcasts.txt in c:\legl, which contains:
@ Lines starting with @ are comment lines
@ Comment lines have no effect on the result
datenv /i%1\*.dat /c%1\cast.con /0%]1
wildedit /i%]1\*.cnv /01%
filter /i%1\*.cnv /01%
loopedit /i%]1\*.cnv /01%
binavg /i%1\*.cnv /aavg /0%l
derive /i%I1\*avg.cnv /c%]1\cast.con /0%l
seaplot /i%]1\*.cnv

Module names and options are separated by one or more spaces or tabs.

3. Select Run in the Windows Start menu. The Run dialog box appears.
4. Type in the program name and parameters as shown:
sbebatch c:\legl\prallcasts.txt c:\legl

(batch filename is c:\legl\prallcasts.txt; parameter %1 is c:\legl)

5. The data is processed as follows (all input and output files are in c:\legl):

Module Input File(s) Output File
castl.dat cast] cnv
Data Conversion (datcnv) cast2.dat ’
cast2.cnv
cast.con
Wild Edit (wildedit) castl.cnv castl.cnv
cast2.cnv cast2.cnv
. castl.cnv castl.cnv
Filter (filter) cast2.cnv cast2.cnv
. . castl.cnv castl.cnv
Loop Edit (loopedit) cast2.cnv cast2.cnv
. . castl.cnv castlavg.cnv
Bin Average (binavg) cast2.cnv cast2avg.cnv
castlavg.cnv cast] cnv
Derive (derive) cast2avg.cnv ’
cast2.cnv
cast.con
castl.jpg
cast2.jpg
Sea Plot (scaplot) castl.env e pile Setup tab
cast2.cnv
was set to output
to jpeg)
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Appendix II:

Configure (.con or .xmicon) File Format

Note:

For an easy-to-read report of .con or
xmlcon file contents, see Appendix lIl:
Generating .con or .xmlcon File
Reports — ConReport.exe.

Modify a .con or .xmlcon configuration file by selecting the instrument in the
Configure menu.

Configuration files (.con or .xmlcon) can also be opened, viewed, and
modified with DisplayConFile.exe, a utility that is installed in the same folder
as SBE Data Processing. Right click on the desired configuration file, select
Open With, and select DisplayConFile. This utility is often used at Sea-Bird to
quickly open and view a configuration file for troubleshooting purposes,
without needing to go through the additional steps of selecting the file in

SBE Data Processing or Seasave.

.xmlcon Configuration File Format

Note:

We recommend that you do not open
xmlcon files with a text editor (i.e.,
Notepad, Wordpad, etc.).

.xmlcon configuration files, written in XML format, were introduced with
SBE Data Processing and Seasave 7.20a. A .xmlcon file uses XML tags to
describe each line in the file. Versions 7.20a and later allow you to open a .con
or a .xmlcon file, and to save the configuration to a .con or a .xmlcon file.
Instruments introduced after 7.20a are compatible only with .xmlcon files.

.con Configuration File Format

Shown below is a line-by-line description of a .con configuration file contents,
which can be viewed in a text editor (i.e., Notepad, Wordpad, etc.).

Line Contents
Conductivity sensor serial number
Conductivity M, A, B, C, D, CPCOR
Conductivity cell const, series r, slope, offset, use GHIJ coefficients?
Temperature sensor serial number
Temperature FO, A, B, C, D, slope, offset, use GHIJ coefficients?

Secondary conductivity sensor serial number

Secondary conductivity M, A, B, C, D, PCOR

Secondary conductivity cell const, series r, slope, offset, use GHIJ coefficients?
Secondary temperature sensor serial number

Secondary temperature FO, A, B, C, D, slope, offset, use GHIJ coefficients?

Pressure sensor serial number

Pressure T1, T2, T3, T4, T5

Pressure Cl1 (Al), C2 (AO), C3, C4 (A2) - parameters in parentheses for strain gauge sensor
Pressure D1, D2, slope, offset, pressure sensor type, AD590 M, AD590 B

Oxygen (Beckman/YSI type) sensor serial number
Oxygen (Beckman/YSI type) M, B, K, C, SOC, TCOR
Oxygen (Beckman/YSI type) WT, PCOR, TAU, BOC

pH sensor serial number

pH slope, offset, VREF

PAR light sensor serial number

PAR cal const, multiplier, M, B, surface cc, surface r, offset

Transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) sensor serial number
Transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) M, B, path length
Fluorometer SeaTech sensor serial number

Fluorometer SeaTech scale factor, offset

Tilt sensor serial number

Tilt XM, XB, YM, YB

ORP sensor serial number

ORP M, B, offset

RIS TN T TN T IS TSI LN I LN N 0 ) [y oy ey iy iy iy ey
olo|o|d|a|o|s|w|N|R|ofe|o|v|la|u|s|w|v|F|o|ClR[T [T =@V

OBS/Nephelometer D&A Backscatterance sensor serial number
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31 OBS/Nephelometer D&A Backscatterance gain, offset

32 Altimeter scale factor, offset, hyst, min pressure, hysteresis

33 Microstructure temperature sensor serial number

34 Microstructure temperature pre m, pre b

35 Microstructure temperature num, denom, A0, Al, A3

36 Microstructure conductivity sensor serial number

37 Microstructure conductivity A0, Al, A2

38 Microstructure conductivity M, B, R

39 Number of external frequencies, number of bytes, number of voltages, instrument type, computer
interface, scan rate, interval, store system time, deck unit or searam?

40 Data format channels 0 - 9

41 Data format channels 10 - 19

42 Data format channels 20 - 39

43 SBE 16: use water temperature?, fixed pressure, fixed pressure temperature

44 Firmware version

45 Miscellaneous: number of frequencies from SBE 9, number of frequencies from SBE 9 to be
suppressed, number of voltages from SBE 9 to be suppressed, voltage range, add surface PAR
voltage?, add NMEA position data?, include IOW sensors? Add NMEA depth data?

46 OBS/Nephelometer IFREMER sensor serial number

47 OBS/Nephelometer IFREMER VMO, VDO, DO, K

48 OBS/Nephelometer Chelsea sensor serial number

49 OBS/Nephelometer Chelsea clear water voltage, scale factor

50 ZAPS sensor serial number

51 ZAPS m, b

52 Conductivity sensor calibration date

53 Temperature sensor calibration date

54 Secondary conductivity sensor calibration date

55 Secondary temperature sensor calibration date

56 Pressure sensor calibration date

57 Oxygen (Beckman/YSI type) sensor calibration date

58 pH sensor calibration date

59 PAR light sensor calibration date

60 Transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) sensor calibration date

61 Fluorometer (SeaTech) sensor calibration date

62 Tilt sensor calibration date

63 ORP sensor calibration date

64 OBS/Nephelometer D&A Backscatterance sensor calibration date

65 Microstructure temperature sensor calibration date

66 Microstructure conductivity sensor calibration date

67 IFREMER OBS/nephelometer sensor calibration date

68 Chelsea OBS/nephelometer sensor calibration date

69 ZAPS sensor calibration date

70 Secondary oxygen (Beckman/YSI type) sensor serial number

71 Secondary oxygen (Beckman/YSI type) sensor calibration date

72 Secondary oxygen (Beckman/YSI type) M, B, K, C, SOC, TCOR

73 Secondary oxygen (Beckman/YSI type) WT, PCOR, TAU, BOC

74 User polynomial 1 sensor serial number

75 User polynomial 1 sensor calibration date

76 User polyl A0, Al, A2, A3

77 User polynomial 2 sensor serial number

78 User polynomial 2 sensor calibration date

79 User polynomial 2 A0, Al, A2, A3

80 User polynomial 3 sensor serial number

81 User polynomial 3 sensor calibration date

82 User polynomial 3 A0, Al, A2, A3

83 Dr. Haardt Chlorophyll fluorometer sensor serial number

84 Dr. Haardt Chlorophyll fluorometer sensor calibration date

85 Dr. Haardt Chlorophyll fluorometer A0, Al, BO, Bl, which modulo bit, gain range switching

86 Dr. Haardt Phycoerythrin fluorometer sensor serial number

87 Dr. Haardt Phycoerythrin fluorometer sensor calibration date

88 Dr. Haardt Phycoerythrin fluorometer AO, Al, BO, Bl, which modulo bit, gain range switching

89 Dr. Haardt Turbidity OBS/nephelometer sensor serial number

90 Dr. Haardt Turbidity OBS/nephelometer sensor calibration date

91 Dr. Haardt Turbidity OBS/nephelometer A0, Al, B0, Bl, which modulo bit, gain range switching

92 IOW oxygen sensor serial number

93 IOW oxygen sensor calibration date

94 IOW oxygen AO, Al, A2, A3, BO, Bl

95 IOW sound velocity sensor serial number

96 IOW sound velocity sensor calibration date

97 IOW sound velocity A0, Al, A2

98 Biospherical natural fluorometer sensor serial number

99 Biospherical natural fluorometer sensor calibration date

100 Biospherical natural fluorometer Cfn, Al, A2, B
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101 Sea tech 1s6000 OBS/nephelometer sensor serial number

102 Sea tech 1s6000 OBS/nephelometer sensor calibration date

103 Sea tech 156000 OBS/nephelometer gain, slope, offset

104 Fluorometer Chelsea Aqua 3 sensor serial number

105 Fluorometer Chelsea Aqua 3 sensor calibration date

106 Fluorometer Chelsea Aqua 3 scale factor, slope, offset, Vacetone, VB (static), Vlug/l
107 Fluorometer Turner sensor serial number

108 Fluorometer Turner sensor calibration date

109 Fluorometer Turner scale factor, offset; or

Turner-10au-005 full scale concentration, full scale voltage, zero point concentration
110 Conductivity G, H, I, J, ctcor, cpcor

111 Temperature FO, G, H, I, J

112 Secondary conductivity G, H, I, J, ctcor, cpcor

113 Secondary temperature FO, G, H, I, J

114 WET Labs AC3 beam transmission transmissometer sensor serial number
115 WET Labs AC3 beam transmission transmissometer sensor calibration date

116 WET Labs AC3 beam transmission transmissometer Ch2o0, Vh2o, Vdark, x, chlorophyll absorption
Kv, Vh20, a"x

117 WET Labs WETStar fluorometer sensor serial number

118 WET Labs WETStar fluorometer sensor calibration date

119 WET Labs WETStar Vblank, scale factor

120 Primary conductivity sensor using g, h, i, j coefficients calibration date
121 Primary temperature sensor using g, h, i, j coefficients calibration date
122 Secondary conductivity sensor using g, h, i, j coefficients calibration date
123 Secondary temperature sensor using g, h, i, j coefficients calibration date
124 FGP pressure sensor #0 serial number

125 FGP pressure sensor #0 calibration date

126 FGP pressure sensor #0 scale factor, offset

127 FGP pressure sensor #1 serial number

128 FGP pressure sensor #1 calibration date

129 FGP pressure sensor #1 scale factor, offset

130 FGP pressure sensor #2 serial number

131 FGP pressure sensor #2 calibration date

132 FGP pressure sensor #2 scale factor, offset

133 FGP pressure sensor #3 serial number

134 FGP pressure sensor #3 calibration date

135 FGP pressure sensor #3 scale factor, offset

136 FGP pressure sensor #4 serial number

137 FGP pressure sensor #4 calibration date

138 FGP pressure sensor #4 scale factor, offset

139 FGP pressure sensor #5 serial number

140 FGP pressure sensor #5 calibration date

141 FGP pressure sensor #5 scale factor, offset

142 FGP pressure sensor #6 serial number

143 FGP pressure sensor #6 calibration date

144 FGP pressure sensor #6 scale factor, offset

145 FGP pressure sensor #7 serial number

146 FGP pressure sensor #7 calibration date

147 FGP pressure sensor #7 scale factor, offset

148 Primary OBS/Nephelometer seapoint turbidity meter sensor serial number

149 Primary OBS/Nephelometer seapoint turbidity meter sensor calibration date
150 Primary OBS/Nephelometer seapoint turbidity meter gain, scale

151 Secondary OBS/Nephelometer seapoint turbidity meter sensor serial number
152 Secondary OBS/Nephelometer seapoint turbidity meter sensor calibration date
153 Secondary OBS/Nephelometer seapoint turbidity meter gain, scale

154 Fluorometer Dr. Haardt Yellow Substance sensor serial number

155 Fluorometer Dr. Haardt Yellow Substance sensor calibration date

156 Fluorometer Dr. Haardt Yellow Substance A0, Al, B0, Bl, which modulo bit, gain range switching
157 Fluorometer Chelsea Minitraka serial number

158 Fluorometer Chelsea Minitraka calibration date

159 Fluorometer Chelsea Minitraka vacetone, vacetonel00, offset
160 Seapoint fluorometer serial number

161 Seapoint fluorometer calibration date

162 Seapoint fluorometer gain, offset

163 Primary Oxygen (SBE 43) serial number

164 Primary Oxygen (SBE 43) calibration date
165 Primary Oxygen (SBE 43) Soc, Tcor, offset
166 Primary Oxygen (SBE 43) Pcor, Tau, Boc

167 Secondary Oxygen (SBE 43) serial number

168 Secondary Oxygen (SBE 43) calibration date
169 Secondary Oxygen (SBE 43) Soc, Tcor, offset
170 Secondary Oxygen (SBE 43) Pcor, Tau, Boc
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171 Secondary sea tech 156000 OBS/nephelometer sensor serial number

172 Secondary sea tech 1s6000 OBS/nephelometer sensor calibration date

173 Secondary sea tech 1s6000 OBS/nephelometer gain, slope, offset

174 Secondary Chelsea Transmissometer sensor serial number

175 Secondary Chelsea Transmissometer calibration date

176 Secondary Chelsea Transmissometer M, B, path length

177 Altimeter serial number

178 Altimeter calibration date

179 WET Labs AC3 serial number

180 WET Labs AC3 calibration date

181 Surface PAR serial number

182 Surface PAR calibration date

183 SEACATplus temperature sensor serial number

184 SEACATplus temperature sensor calibration date

185 SEACATplus temperature sensor A0, Al, A2, A3, slope, offset

186 SEACATplus serial sensor, scans to average, mode

187 Pressure (strain gauge with span TC) serial number

188 Pressure (strain gauge with span TC) calibration date

189 Pressure (strain gauge with span TC) ptempAO, ptempAl, ptempA2, pTCAl, PTCA2

190 Pressure (strain gauge with span TC) pTCBO, pTCB1l, pTCB2, pAO, offset

191 SBE 38 temperature sensor serial number

192 SBE 38 temperature sensor calibration date

193 Turner SCUFA fluorometer serial number

194 Turner SCUFA fluorometer calibration date

195 Turner SCUFA fluorometer scale factor, offset, units, mx, my, b

196 Turner SCUFA OBS serial number

197 Turner SCUFA OBS calibration date

198 Turner SCUFA OBS scale factor, offset

199 WET Labs ECO-AFL fluorometer serial number

200 WET Labs ECO-AFL fluorometer calibration date

201 WET Labs ECO-AFL fluorometer vblank, scale factor

202 Userpoly 0 name

203 Userpoly 1 name

204 Userpoly 2 name

205 Franatech (formerly Capsum) METS serial number

206 Franatech (formerly Capsum) METS calibration date

207 Franatech (formerly Capsum) METS D, A0, Al, BO, B1, B2, Tl, T2

208 Secondary PAR sensor serial number

209 Secondary PAR sensor calibration date

210 Secondary PAR sensor cal const, multiplier, M, B, offset

211 Secondary WET Labs WETStar Fluorometer sensor serial number

212 Secondary WET Labs WETStar Fluorometer sensor calibration date

213 Secondary WET Labs WETStar Fluorometer Vblank, scale factor

214 Secondary Seapoint Fluorometer sensor serial number

215 Secondary Seapoint Fluorometer sensor calibration date

216 Secondary Seapoint Fluorometer gain, offset

217 Secondary Turner SCUFA Fluorometer sensor serial number

218 Secondary Turner SCUFA Fluorometer sensor calibration date

219 Secondary Turner SCUFA Fluorometer scale factor, offset, units, b

220 WET Labs WETStar CDOM sensor serial number

221 WET Labs WETStar CDOM sensor calibration date

222 WET Labs WETStar CDOM Vblank, scale factor

223 Seapoint Rhodamine Fluorometer sensor serial number

224 Seapoint Rhodamine Fluorometer sensor calibration date

225 Seapoint Rhodamine Fluorometer gain, offset

226 Primary Gas Tension Device sensor serial number

227 Primary Gas Tension Device sensor calibration date

228 Primary Gas Tension Device type

229 Secondary Gas Tension Device sensor serial number

230 Secondary Gas Tension Device sensor calibration date

231 Secondary Gas Tension Device type

232 Sequoia LISST-25A sensor serial number

233 Sequoia LISST-25A sensor calibration date

234 Sequoia LISST-25A Total Volume Conc Const, Sauter Mean Diameter Cal, Clean Water Scattering,
Clean Water Trans

235 SBE 45 output conductivity? Output salinity? Output sound velocity? Use 90402 junction box?
SBE 38 remote temperature?

236 SBE 21 remote temperature type

237 SBE 50 serial number

238 SBE 50 calibration date

239 Secondary Chelsea Aqua 3 fluorometer serial number

240 Secondary Chelsea Aqua 3 fluorometer calibration date
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241 Secondary Chelsea Aqua 3 fluorometer scale factor, slope, offset, vacetone, vb, vl

242 Chelsea UV Aquatracka serial number

243 Chelsea UV Aquatracka calibration date

244 Chelsea UV Aquatracka a, b

245 SBE 49 temperature sensor serial number

246 SBE 49 temperature sensor calibration date.

247 SBE 49 temperature sensor A0, Al, A2, A3, slope, and offset.

248 Secondary Turner SCUFA OBS serial number

249 Secondary Turner SCUFA OBS calibration date

250 Secondary Turner SCUFA OBS scale factor, offset

251 OBS D&A 3+ serial number

252 OBS D&A 3+ calibration date

253 OBS D&A 3+ a0, al, a2

254 Secondary OBS D&A 3+ serial number

255 Secondary OBS D&A 3+ calibration date

256 Secondary OBS D&A 3+ a0, al, a2

257 SBE 16, 19, 19plus, 21, 25, or 49 scan time added? NMEA time added? NMEA device connected to
PC?

258 SBE 43 Oxygen sensor: use Sea-Bird equation, Soc2007, A, B, C, E, Voffset, Tau20, DO, D1, D2,
H1, H2, H3

259 Secondary SBE 43 Oxygen sensor: use Sea-Bird equation, Soc2007, A, B, C, E, Voffset, Tau20,
p0, D1, D2, H1, H2, H3

260 File version of SB ConfigCTD.dll which saved the .con file

261 IFREMER OBS/nephelometer sensor serial number

262 Primary Beckman Oxygen Temperature sensor - calibration date

263 Primary Beckman Oxygen Temperature sensor - serial number

264 Secondary Beckman Oxygen Temperature sensor — calibration date

265 Secondary Beckman Oxygen Temperature sensor — serial number

266 IOW Oxygen Temperature sensor - calibration date

267 IOW Oxygen Temperature sensor - serial number

268 Methane Gas Tension, Franatech (formerly Capsum) METS sensor - calibration date

269 Methane Gas Tension, Franatech (formerly Capsum) METS sensor —-serial number

270 Secondary WET Labs ECO-AFL fluorometer serial number

271 Secondary WET Labs ECO-AFL fluorometer calibration date

272 Secondary WET Labs ECO-AFL fluorometer vblank, scale factor

273 Secondary OBS/Nephelometer D&A Backscatterance sensor serial number

274 Secondary OBS/Nephelometer D&A Backscatterance gain, offset

275 Secondary OBS/Nephelometer D&A Backscatterance sensor calibration date

276 Aanderaa Oxygen Optode serial number

277 Aanderaa Oxygen Optode calibration date

278 Aanderaa Oxygen Optode: do salinity correction? do depth correction? internal salinity value
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Appendix lll: Generating .con or .xmlcon
File Reports — ConReport.exe

Note:

You can also run ConReport from a
Run dialog (select Run in the Windows
Start menu). If you have not modified
your autoexec.bat file to put the
ConReport.exe file in the path
statement, specify the full path of the
.exe file in the Run dialog box.

The configuration file report is an ASCII .txt file that shows all parameters in

the .con or .xmlcon file in an easy-to-read form. The .txt report is for viewing

only, and cannot be used to modify parameters in the configuration file for

processing data. The .txt file is generated by:

e Clicking Report in a Configuration dialog box (see Instrument
Configuration in Section 4: Configuring Instrument (Configure)), or

e Using ConReport.exe.

ConReport.exe is run from the command line or from a DOS prompt, and
accepts wildcards for the file names, so multiple reports can be produced
at one time, and reports can be placed into a specified directory.
ConReport is automatically installed when you install SBE Data Processing
(default location c:\Program Files\Sea-Bird\SBEDataProcessing-Win32).

The format for running ConReport is:

Conreport InputFilename OutputDirectory /S

Parameter Description
InputFilename is .con or .xmlcon file for which you want to
generate a report. Must include full path and file name.
This parameter supports standard wildcard expansion
with *:
* matches any set of characters starting at specified
position within file name or extension and continuing
until the end of file name or extension or another
specified character.
(optional) Full path to location to store output .txt file(s).
OutputDirectory |If not specified, defaults to location of input .con or
.xmlcon file(s).
/S (optional) Do not echo messages to screen.
If specifying multiple parameters, insert one or more spaces or tabs
between each parameter in the list.

InputFilename

Example — Generate Reports for All .con Files in Directory, and Save to
Different Directory

The .con files testl.con, test2.con, and test3.con are in c:\legl, and you want to
generate the .txt reports and save them to c:\CruiseSummary.

At the DOS prompt, starting in the directory where ConReport is located
(default c:\Program Files\Sea-Bird\SBEDataProcessing-Win32), type in the
program name and parameters as shown:

conreport c:\legl\*.con c:\CruiseSummary
The program responds:

c:\CruiseSummary\test1.txt

c:\CruiseSummary\test2.txt

c:\CruiseSummary\test3.txt
3 reports written to c:\CruiseSummary
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Appendix IV: Software Problems

Considerable effort has been made to test and check this software before its
release. However, because of the wide range of instruments that Sea-Bird
produces (and interfaces with) and the many applications that these
instruments are used in, there may be software problems that have not been
discovered and corrected. If a problem occurs, please contact us via phone
(425-643-9866), email (seabird@seabird.com), or fax (425-643-9954) with the
following information:

Instrument serial number

Version of the software originally shipped with the instrument
Version of the software you are attempting to run

Complete description of the problem you are having

If the problem involves the configuration or setup of the software, in most
cases a phone call to Sea-Bird will be sufficient to solve the problem. If you
phone, we would appreciate it if you would be ready to run the software
during the phone conversation.

If the problem involves data processing, you may be asked to send a sample of
the data to Sea-Bird for evaluation.
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Appendix V: Derived Parameter Formulas
(EOS-80; Practical Salinity)

Notes:

o Algorithms used for calculation of
derived parameters in Data
Conversion, Derive, Sea Plot,
SeaCalc Il [EOS-80 (Practical
Salinity) tab], and Seasave are
identical, except as noted in this
section, and are based on EOS-80
equations (Practical Salinity).

e Calculation of Absolute Salinity
and associated parameters
(TEOS-10) is available in
Derive TEOS-10 and SeaCalc Il
[TEOS-10 (Absolute Salinity) tab].
Once they are calculated in Derive
TEOS-10, they can be plotted in Sea
Plot. See Section 6: Data Processing
Modules and Section 9:
Miscellaneous Module — SeaCalc Ill.

For formulas for the calculation of conductivity, temperature, and pressure, see
the calibration sheets for your instrument.

Formulas for the computation of salinity, density, potential temperature,
specific volume anomaly, and sound velocity were obtained from "Algorithms
for computation of fundamental properties of seawater", by N.P. Fofonoff and
R.C Millard Jr.; Unesco technical papers in marine science #44, 1983.

e  Temperature used for calculating derived variables is IPTS-68, except as
noted. Following the recommendation of JPOTS, Tgg is assumed to be
1.00024 * Ty (-2 to 35 °C).

e  Salinity is PSS-78 (Practical Salinity) (see Application Note 14: 1978
Practical Salinity Scale). By definition, PSS-78 is valid only in the range
of 2 to 42 psu. Sea-Bird uses the PSS-78 algorithm in our software,
without regard to those limitations on the valid range.

Unesco technical papers in marine science 62 "Salinity and density of
seawater: Tables for high salinities (42 to 50)" provides a method for
calculating salinity in the higher range
(http://unesdoc.unesco.org/images/0009/000964/09645 1 mb.pdf).

Equations / descriptions are provided for the following parameters:

density (density, sigma-theta, sigma-1, sigma-2, sigma-4, sigma-t)
thermosteric anomaly

specific volume

specific volume anomaly

geopotential anomaly

dynamic meters

depth (salt water, fresh water)

seafloor depth (salt water, fresh water)

Practical Salinity (psu)

sound velocity (Chen-Millero, DelGrosso, Wilson)

average sound velocity

potential temperature (reference pressure = 0.0 decibars)

potential temperature anomaly

plume anomaly

specific conductivity

oxygen (if input file contains pressure, temperature, and either
conductivity or salinity, and has not been averaged into pressure or
depth bins) - also requires oxygen signal (for SBE 43), oxygen current and
oxygen temperature (for SBE 13 or 23), or oxygen phase and thermistor
voltage (SBE 63)

oxygen saturation

oxygen percent saturation

nitrogen saturation

derivative variables (descent rate and acceleration) - if input file has not
been averaged into pressure or depth bins

e corrected irradiance (CPAR)
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density=p=p (s, t, p) [kg/m’]
(density of seawater with salinity s, temperature t, and pressure p, based on the
equation of state for seawater (EOS80))

Density calculation:
Using the following constants -

BO = 8.24493e-1, Bl = -4.0899e-3, B2 = 7.6438e-5, B3 = -8.2467e-7, B4 = 5.3875e-9,

CO = -5.72466e-3, Cl = 1.0227e-4, C2 = -1.6546e-6, DO = 4.8314e-4, A0 = 999.842594,

Al = 6.793952e-2, A2 = -9.095290e-3, A3 = 1.001685e-4, A4 = -1.120083e-6, A5 = 6.536332e-9,

FQO = 54.6746, FQL = -0.603459, FQ2 = 1.09987e-2, FQ3 = -6.1670e-5, GO = 7.944e-2, Gl = 1.6483e-2,
G2 = -5.3009e-4, i0 = 2.2838e-3, il = -1.098le-5, i2 = -1.6078e-6, JO =1.91075e-4, MO = -9.9348e-7,
Ml = 2.0816e-8, M2 = 9.1697e-10, EO = 19652.21, E1 = 148.4206, E2 = -2.327105, E3 = 1.360477e-2,

E4 = -5.155288e-5, HO = 3.239908, H1 = 1.43713e-3, H2 = 1.16092e-4, H3 = -5.77905e-7,

KO = 8.50935e-5, K1 =-6.12293e-6, K2 = 5.2787e-8

C Computer Code -

double Density(double s, double t, double p)
// s = salinity PSU, t = temperature deg C ITPS-68, p = pressure in decibars
{

double t2, t3, t4, t5, s32;

double sigma, k, kw, aw, bw;

double val;

t2 t*t;
t3 = t*t2;
td4 = t*t3;
t5 = t*t4;

if (s <= 0.0) s = 0.000001;

s32 = pow(s, 1.5);

p /= 10.0; /* convert decibars to bars */

sigma = A0 + Al*t + A2*t2 + A3*t3 + A4*t4 + AS5*t5 + (BO + Bl*t + B2*t2 + B3*t3 + B4*t4)*s +
(CO + Cl*t + C2*t2)*s32 + DO*s*s;

kw EO + E1*t + E2*t2 + E3*t3 + E4*t4;

aw = HO + Hl*t + H2*t2 + H3*t3;

bw = KO + Kl*t + K2*t2;

k = kw + (FQO + FQl*t + FQ2*t2 + FQ3*t3)*s + (GO + Gl*t + G2*t2)*s32 + (aw + (i0 + il*t +
i2%t2)*s + (J0*s32))*p + (bw + (MO + MI1*t + M2%t2)*s) *p*p;

val =1 - p / k;

if (val) sigma = sigma / val - 1000.0;

return sigma;

Sigma-theta =c¢=0p (s, 0(s, t, p, 0), 0) - 1000 [kg/m 9]
Smmwkﬂn=p&6@QEIMMJMm-mw[@mﬂ
Sigma-2 =o,=p (s, 6(s, t, p, 2000), 2000) - 1000 [kg/m |
Sigma-4 =c4=0p (s, 6(s, t, p, 4000), 4000) - 1000 [kg/m |
Sigma-t=c,=p (s, t, 0) - 1000  [kg/m"]
thermosteric anomaly = 10° ((1000/(1000 + o ()) - 0.97266) [10™* m/kg]
specific volume = V(s, t, p) =1/p  [m/kg]
specific volume anomaly =8 =10*(V(s, t, p) - V(35, 0, p)) [107° m’/kg]
p=p
geopotential anomaly = 10 z G xAp) [Jkgl=[m?’Is’]
Ap,p=0
dynamic meters = geopotential anomaly / 10.0

(1 dynamic meter = 10 J/kg;
(Sverdup, Johnson, Flemming (1946), UNESCO (1991)))
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Note:

You can also enter the latitude on the
Miscellaneous tab in Data Conversion
or Derive, as applicable.

depth=[m]

(When you select salt water depth as a derived variable, SBE Data Processing
prompts you to input the latitude, which is needed to calculate local gravity. It
uses the user-input value, unless latitude is written in the input data file header
[from a NMEA navigation device]. If latitude is in the input file header, SBE
Data Processing uses the header value, and ignores the user-input latitude.).

Depth calculation:

C Computer Code —
// Depth

{
double x, d, gr;

}

return (d) ;

double Depth(int dtype, double p,
// dtype = fresh water or salt water, p = pressure in decibars, latitude in degrees

if (dtype == FRESH WATER)
d=p * 1.019716;

double latitude)

/* fresh water */

else { /* salt water */
X = sin(latitude / 57.29578);
X = X * x;
gr = 9.780318 * (1.0 + (5.2788e-3 + 2.36e-5 * x) * x) + 1.092e-6 * p;
d = (((-1.82e-15 * p + 2.279e-10) * p - 2.2512e-5) * p + 9.72659) * p;
if (gr) d /= gr;

seafloor depth = depth + altimeter reading [m]
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Note:

Absolute Salinity (TEOS-10) is
available in our seawater calculator,
Sea Calc lll. See Section 9:
Miscellaneous Module — SeaCalc lll.
All other SBE Data Processing
modules output only Practical
Salinity, and all parameters derived
from salinity in those modules
(density, sound velocity, etc) are
based on Practical Salinity.

SBE Data Processing

Practical Salinity = [PSU]
(Salinity is PSS-78, valid from 2 to 42 psu.)

Practical Salinity calculation:
Using the following constants -

Al = 2.070e-5, A2 = -6.370e-10, A3
B4 = -3.107e-3, CO = 6.766097e-1,
C4 = 1.0031e-9
C Computer Code —
static double a[6] =

0.0080, -0.1692, 25.3851,

}i
static double b[6]={
0.0005,

-0.0056, -0.0066,

}i
// C =
{

conductivity S/m,

double R, RT,

int 1i;

if (C <= 0.0)
result = 0.0;

RP, temp,

}
return result;

}

C1l

double Salinity(double C, double T,
T = temperature deg C ITPS-68,

suml,

B2 =

3.989%e-15, Bl = 3.426e-2,
= 1.10425%e-4, C3 =

2.00564e-2, C2 =

{ /* constants for salinity calculation */
14.0941,

-7.0261, 2.7081

/* constants for salinity calculation */
-0.0375,

0.0636, -0.0144

double P) /* compute salinity */
P = pressure in decibars
val;

sum2, result,

else {
Cc *= 10.0; /* convert Siemens/meter to mmhos/cm */
R =C / 42.914;
val =1 + Bl *T + B2 * T * T+ B3 * R+ B4 *R * T;
if (val) RP =1+ (P * (Al + P * (A2 + P * A3))) / val;
val = RP * (CO + (T * (CL + T * (C2 + T * (C3 + T * C4)))));
if (val) RT = R / val;
if (RT <= 0.0) RT = 0.000001;
suml = sum2 = 0.0;
for (1 = 0;1 < 6;1i++) {
temp = pow (RT, (double)i/2.0);
suml += a[i] * temp;
sum2 += b[i] * temp;
}
val = 1.0 + 0.0162 * (T - 15.0);
if (val)
result = suml + sum2 * (T - 15.0) / val;
else
result = -99.;

4.464e-4, B3 = 4.215e-1,

-6.9698e-7,
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sound velocity = [m/sec]
(sound velocity can be calculated as Chen-Millero, DelGrosso, or Wilson)

Sound velocity calculation:

C Computer Code —
// Sound Velocity Chen and Millero
double SndVelC (double s, double t, double pO0) /* sound velocity Chen and Millero 1977 */

/* JASA,62,1129-1135 */
// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{
double a, a0, al, a2, a3;
double b, b0, bl;
double ¢, c0, cl, c2, c3;
double p, sr, d, sv;

p =p0 / 10.0; /* scale pressure to bars */
if (s < 0.0) s = 0.0;
sr = sqrt(s);

d=1.727e-3 - 7.9836e-6 * p;

bl = 7.3637e-5 + 1.7945e-7 * t;

b0 = -1.922e-2 - 4.42e-5 * t;

b = b0 + bl * p;

a3 = (-3.389%e-13 * t + 6.64%9e-12) * t + 1.100e-10;

a2 = ((7.988e-12 * t - 1.6002e-10) * t + 9.1041le-9) * t - 3.9064e-7;
al = (((-2.0122e-10 * t + 1.0507e-8) * t - 6.4885e-8) * t - 1.2580e-5) * t + 9.4742e-5;
a0 = (((-3.21e-8 * £t + 2.006e-6) * t + 7.164e-5) * t -1.262e-2) * t + 1.389;

a= ((a3 *p + a2) *p + al) * p + a0;

c3 = (-2.3643e-12 * t + 3.8504e-10) * t - 9.7729%e-9;

c2 (((1.0405e-12 * t -2.5335e-10) * t + 2.5974e-8) * t - 1.7107e-6) * t + 3.1260e-5;

cl (((-6.1185e-10 * t + 1.3621le-7) * t - 8.1788e-6) * t + 6.8982e-4) * t + 0.153563;

cO = ((((3.1464e-9 * t - 1.47800e-6) * t + 3.3420e-4) * t - 5.80852e-2) * t + 5.03711) * t +
1402.388;

c = ((c3 *p+c2) *p+cl) *p + cO;

sv=c+ (a+b*sr+d*s)*s;

return sv;

}

// Sound Velocity Delgrosso
double SndVelD (double s, double t, double p) /* Delgrosso JASA, Oct. 1974, Vol 56, No 4 */
// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{
double c000, dct, dcs, dcp, dcstp, sv;
c000 = 1402.392;
p=p / 9.80665; /* convert pressure from decibars to KG / CM**2 */

dct = (0.501109398873el - (0.550946843172e-1 - 0.22153596924e-3 * t) * t) * t;
decs = (0.132952290781el + 0.128955756844e-3 * s) * s;
dcp = (0.156059257041e0 + (0.244998688441e-4 - 0.83392332513e-8 * p) * p) * p;

decstp = -0.127562783426e-1 * t * s + 0.635191613389%e-2 * t * p + 0.265484716608e-7 * t * t *

p * p - 0.159349479045e-5 * t * p * p + 0.522116437235e-9 * t * p * p * p - 0.438031096213e-6 * t *
t *t *p - 0.161674495909e-8 * s * s * p * p + 0.968403156410e-4 * £t * £t * s + 0.485639620015e-5 *
t *s *s *p - 0.340597039004e-3 * t * s * p;

sv = c000 + dct + dcs + dcp + dcstp;
return sv;

}

// sound velocity Wilson
double SndVelW(double s, double t, double p) /* wilson JASA, 1960, 32, 1357 */
// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{
double pr, sd, a, v0, vl, sv;
pr = 0.1019716 * (p + 10.1325);
sd = s - 35.0;
a = (((7.985le-6 * t - 2.6045e-4) * t - 4.4532e-2) * t + 4.5721) * t + 1449.14;
sv = (7.7711e-7 * t - 1.1244e-2) * t + 1.39799;
v0 = (1.69202e-3 * sd + sv) * sd + a;
a = ((4.5283e-8 * t + 7.4812e-6) * t - 1.8607e-4) * t + 0.16072;
sv = (1.579e-9 * t + 3.158e-8) * t + 7.701l6e-5;
vl = sv * sd + a;
a = (1.8563e-9 * t - 2.5294e-7) * t + 1.0268e-5;
sv = -1.2943e-7 * sd + a;
a = -1.9646e-10 * t + 3.5216e-9;
sv = (((-3.3603e-12 * pr + a) * pr + sv) * pr + vl) * pr + vO0;
return sv;
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Note:

You can also enter the user-input
parameters on the Miscellaneous
tab in Data Conversion or Derive,
as applicable.

> Minimum specified pressure and salinity —g————

Surface

r=p
Ap,p=mi di
average sound velocity = ’ [m/s]
pp
z di / Vi
Ap,p=min

Average sound velocity is the harmonic mean (average) from the surface to
the current CTD depth, and is calculated on the downcast only. The first
window begins when pressure is greater than a minimum specified pressure
and salinity is greater than a minimum specified salinity. Depth is calculated
from pressure based on user-input latitude (regardless of whether latitude data
from a NMEA navigation device is in the data file).
e In Derive, the algorithm is based on the assumption that the data has been
bin averaged already. Average sound velocity is computed scan-by-scan:
d; = depth of current scan — depth of previous scan [meters]
v; = sound velocity of this scan (bin) [m/sec]
e In Seasave and Data Conversion, the algorithm also requires user input of a
pressure window size and time window size. It then calculates:
d; = depth at end of window — depth at start of window [m]
Vi=
(sound velocity at start of window + sound velocity at end of window) / 2 [m/sec]
When you select average sound velocity as a derived variable, SBE Data
Processing prompts you to enter the minimum pressure, minimum salinity, and
if applicable, pressure window size and time window size.

Average

sound velocit
. d; andv; y

A Average

sound velocity
d; and v;

v
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potential temperature [IPTS-68] =0 (s, t, p, pr) [°C]

(Potential temperature is the temperature an element of seawater would have if
raised adiabatically with no change in salinity to reference pressure p;.
Sea-Bird software uses a reference pressure of 0 decibars).

Potential Temperature [IPTS-68] calculation:

C Computer Code -
// ATG (used in potential temperature calculation)
double ATG (double s, double t, double p) /* adiabatic temperature gradient deg C per decibar */

/* ref broyden,h. Deep-Sea Res.,20,401-408 */
// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{

double ds;

ds = s - 35.0;

return((((-2.1687e-16 * t + 1.8676e-14) * t - 4.6206e-13) * p + ((2.7759%9e-12 * t - 1.1351le-
10) * ds + ((-5.448le-14 * t + 8.733e-12) * t - 6.7795e-10) * t + 1.8741e-8)) * p + (-4.2393e-8 * t

+ 1.8932e-6) * ds + ((6.6228e-10 * t - 6.836e-8) * t + 8.5258e-6) * t + 3.5803e-5);

}

// potential temperature

double PoTemp (double s, double t0, double p0O, double pr) /* local potential temperature at pr */
/* using atg procedure for adiabadic lapse rate */
/* Fofonoff,N.,Deep-Sea Res.,24,489-491 */

// s = salinity, tO0 = local temperature deg C ITPS-68, p0 = local pressure in decibars, pr =

reference pressure in decibars

{

double p, t, h, xk, g, temp;

= p0;

= t0;

= pr - p;

xk = h * ATG(s,t,p);

[= e o]

t += 0.5 * xk;
= xk;
+= 0.5 * h;

X T .Q

k =h * ATG(s,t,p);

t += 0.29289322 * (xk-q);

g = 0.58578644 * xk + 0.121320344 * qg;
xk = h * ATG(s,t,p);

t += 1.707106781 * (xk-q9);

g = 3.414213562 * xk - 4.121320344 * qg;
p += 0.5 * h;

xk = h * ATG(s,t,p);

temp = t + (xk - 2.0 * q) / 6.0;

return (temp) ;

potential temperature [ITS-90] =0 (s, t, p, p,) / 1.00024 [°C]

potential temperature anomaly =
potential temperature - a0 - al x salinity

or
Note: potential temperature - a0 - al x Sigma-theta

You can also enter the user-input (When you select potential temperature anomaly as a derived variable,
parameters on the Miscellaneous tab SBE Data Processing prompts you to enter a0, al, and the selection of salinity
in Data Conversion or Derive, as or sigma-theta.)

applicable.
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Notes:
e You can also enter the user-input

parameters on the Miscellaneous
tab in Data Conversion; plume
anomaly is not available as a
derived variable in Derive.
Reference: Baker, E.T., Feely, RA,,
Mottl, M.J., Sansone, F. T., Wheat,
C.G., Resing, J.A,, Lupton, J.E.,
"Hydrothermal plumes along the
East Pacific Rise, 8° 40’ to 11° 50’
N: Plume distribution and
relationship to the apparent
magmatic budget", Earth and
Planetary Science Letters 128
(1994) 1-17.

plume anomaly =

potential temperature (s, t, p, Reference Pressure) — Theta-B

— Theta-Z / Salinity-Z * (salinity — Salinity-B)
(When you select plume anomaly as a derived variable, SBE Data Processing
prompts you to enter Theta-B, Salinity-B, Theta-Z / Salinity-Z, and
Reference Pressure.)

The plume anomaly equation is based on work in hydrothermal vent plumes.
The algorithm used for identifying hydrothermal vent plumes uses potential
temperature, gradient conditions in the region, vent salinity, and ambient
seawater conditions adjacent to the vent. This function is specific to
hydrothermal vent plumes, and more specifically, temperature and potential
density anomalies. It is not a generic function for plume tracking (for example,
not for wastewater plumes). One anomaly for one region and application does
not necessarily apply to another type of anomaly in another region for a
different application. The terms are specific to corrections for hydrothermal
vent salinity and local hydrographic features near vents. They are likely not
relevant to other applications in this exact form.

If looking at wastewater plumes, you need to derive your own anomaly
function that is specific to what it is you are looking for and that is defined to
differentiate between surrounding waters and the wastewater plume waters.

specific conductivity = (C * 10,000) / (1 + A * [T — 25]) [microS/cm]
(C = conductivity (S/m), T = temperature (° C),

A = thermal coefficient of conductivity for a natural salt solution
[0.019 - 0.020]; Sea-Bird software uses 0.020.)
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Note:

Oxygen [ml/l] for the SBE 63 Optical
Dissolved Oxygen Sensor is calculated
as described in its manual. Tau and
hysteresis corrections are not
applicable to the SBE 63.

Note:

You can also enter the oxygen
window size, and enable / disable the
Tau and hysteresis corrections, on the
Miscellaneous tab in Data Conversion
or Derive, as applicable.

Note:

The hysteresis correction can be
performed to calculate and output
oxygen voltage and/or calculated
oxygen (ml/l, etc.) in Data Conversion.
Hysteresis-corrected voltage from
Data Conversion can be further
processed in other modules (such as
Align CTD) before calculating oxygen
values (ml/l, etc.) in Derive.

Oxygen [ml/l] is calculated as described in Application Note 64: SBE 43
Dissolved Oxygen Sensor or Application Note 13-1: SBE 13, 23, 30 Dissolved
Oxygen Sensor Calibration & Deployment.

When you select oxygen as a derived variable, Data Conversion prompts you
to enter the window size (seconds), and asks if you want to apply the Tau
correction and the hysteresis correction:

o  Tau correction — The Tau correction ([tau(T,P)*5V/5t] in SBE 43 or
[tau*doc/dt] in SBE 13 or 23) improves response of the measured signal
in regions of large oxygen gradients. However, this term also amplifies
residual noise in the signal (especially in deep water); in some situations
this negative consequence overshadows gains in signal responsiveness.

If the Tau correction is enabled, oxygen computed by Seasave and Data
Conversion is somewhat different from values computed by Derive. Both
algorithms compute the derivative of the oxygen signal with respect to
time (with a user-input window size for calculating the derivative), using a
linear regression to determine the slope. Seasave and Data Conversion
compute the derivative looking backward in time, since they share
common code and Seasave cannot use future values of oxygen while
acquiring data in real time. Derive uses a centered window (equal number
of points before and after the scan) to obtain a better estimate of the
derivative. Use Seasave and Data Conversion to obtain a quick look at
oxygen values; use Derive to obtain the most accurate values.

e  Hysteresis correction (SBE 43 only, when using Sea-Bird equation) -
Under extreme pressure, changes can occur in gas permeable Teflon
membranes that affect their permeability characteristics. Some of these
changes (plasticization and amorphous/crystalinity ratios) have long time
constants and depend on the sensor’s time-pressure history. These slow
processes result in hysteresis in long, deep casts. The hysteresis correction
algorithm (using H1, H2, and H3 coefficients entered for the SBE 43 in
the .con or .xmlcon file) operates through the entire data profile and
corrects the oxygen voltage values for changes in membrane permeability
as pressure varies. At each measurement, the correction to the membrane
permeability is calculated based on the current pressure and how long the
sensor spent at previous pressures.

Hysteresis responses of membranes on individual SBE 43 sensors are very
similar, and in most cases the default hysteresis parameters provide the
accuracy specification of 2% of true value. For users requiring higher
accuracy (£1 umol/kg), the parameters can be fine-tuned, if a complete
profile (descent and ascent) made preferably to greater than 3000 meters
is available. H1, the effect’s amplitude, has a default of -0.033, but can
range from -0.02 to -0.05 between sensors. H2, the effect’s non-linear
component, has a default of 5000, and is a second-order parameter that
does not require tuning between sensors. H3, the effect’s time constant,
has a default of 1450 seconds, but can range from 1200 to 2000.
Hysteresis can be eliminated by alternately adjusting H1 and H3 in the
.con or .xmlcon file during analysis of the complete profile. Once
established, these parameters should be stable, and can be used without
adjustment on other casts with the same SBE 43.

When you select oxygen as a derived variable, Derive prompts you to enter
the window size (seconds), and asks if you want to apply the Tau correction
(described above for Data Conversion). You cannot apply the hysteresis
correction in Derive, to prevent users from applying the correction to oxygen
voltage in Data Conversion and then applying it again in Derive, providing
erroneous results.

44660
Sigma-theta + 1000

oxygen [umoles/kg| = oxygen [ml/l]
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Notes:

e The oxygen saturation equation
based on work from Garcia and
Gordon (1992) reduces error in the
Weiss (1970) parameterization at
cold temperatures.

e As implemented in Sea-Bird
software, the Garcia and Gordon

equation is valid for -5 < T < 50 and
0 < S < 60. Outside of those ranges,

the software returns a value of -99
for Oxsol.

¢ As implemented in Sea-Bird
software, the Weiss equation is

valid for-2<T<40and 0 < S <42,

Outside of those ranges, the
software returns a value of -99 for
Oxsat.

Note:
The nitrogen saturation equation is
based on work from Weiss (1970).

Oxygen saturation is the theoretical saturation limit of the water at the

local temperature and salinity value, but with local pressure reset to zero

(1 atmosphere). This calculation represents what the local parcel of water
could have absorbed from the atmosphere when it was last at the surface (p=0)
but at the same (T,S) value. Oxygen saturation can be calculated as Garcia and
Gordon, or Weiss —

Garcia and Gordon:

Oxsol(T,S) = exp {A0 + A1(Ts) + A2(Ts) > + A3(Ts) > + A4(Ts) * + A5(Ts) >
+S * [BO + BI(Ts) + B2(Ts) > + B3(Ts) *] + CO(S) %}

where

e Oxsol(T,S) = oxygen saturation value (ml/l)

e S =salinity (psu)
e T =water temperature (ITS-90, °C)
e Ts=In[(298.15-T)/(273.15 +T)]
e A0=2.00907 Al1=3.22014 A2=4.0501
A3 =4.94457 Ad=-0.256847 A5=13.88767
e B0 =-0.00624523 B1=-0.00737614
B2=-0.010341 B3 =-0.00817083

e (C0=-0.000000488682

Weiss:

Oxsat(T,S) = exp {[A]l + A2 * (100/T,) + A3 * In(T,/100) + A4 * ( T,/100)]
+S * [B1 + B2 * (T,/100) + B3 * (T,/100)* ]}

where

e  Oxsat(T,S) = oxygen saturation value (ml/l)

e S =salinity (psu)

e T =water temperature (IPTS-68, °C)

e T, =absolute water temperature (T + 273.15)

o Al=-1734292 A2=249.6339 A3=143.3483 A4=-21.8492
e B1=-0.033096 B2=0.014259 B3 =-0.00170

Oxygen, percent saturation is the ratio of calculated oxygen to oxygen

saturation, in percent:

(Oxygen / Oxygen saturation) * 100%.

The Oxygen Saturation value used in this calculation is the value that was used

in the Oxygen calculation —

e SBE 43 -if you selected the Sea-Bird equation in the .con or .xmlcon file,
the software uses the Garcia and Gordon Oxsol in this ratio; if you
selected the Owens-Millard equation in the .con or .xmlcon file, the
software uses the Weiss Oxsat in this ratio.

e SBE 13, 23, or 30 — the software uses the Weiss Oxsat for this ratio.

Nitrogen saturation is the theoretical saturation limit of the water at the

local temperature and salinity value, but with local pressure reset to zero

(1 atmosphere). This calculation represents what the local parcel of water could

have absorbed from the atmosphere when it was last at the surface (p=0) but at

the same (T,S) value.

N2sat(T,S) =exp {[Al + A2 * (100/T,) + A3 * In(T,/100) + A4 * (T,/100) ]
+S * [B1 + B2 * (T,/100) + B3 * (T,/100)* ]}

where

e N2Sat(T,S) = nitrogen saturation value (ml/l)

e S =salinity (psu)

e T =water temperature (°C)

e T, =absolute water temperature (°C + 273.15)

o Al1=-172.4965 A2=248.4262 A3=143.0738 A4=-21.7120
e BI1=-0.049781 B2=0.025018 B3 =-0.0034861
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Note:

You can also enter the descent rate
and acceleration window size on the
Miscellaneous tab in Data Conversion
or Derive. as applicable.

Note:

For complete description of ratio
multiplier, see Application Note
11S (SBE 11plus Deck Unit) or
47 (SBE 33 or 36 Deck Unit).

Descent rate and acceleration are computed by calculating the derivative of
the pressure signal with respect to time (with a user-input window size for
calculating the derivative), using a linear regression to determine the slope.
Values computed by Seasave and Data Conversion are somewhat different
from values computed by Derive. Seasave and Data Conversion compute the
derivative looking backward in time (with a user-input window size), since
they share common code and Seasave cannot use future values of pressure
while acquiring data in real time. Derive uses a centered window (equal
number of points before and after the scan; user-input window size) to obtain a
better estimate of the derivative. Use Seasave and Data Conversion to obtain a
quick look at descent rate and acceleration; use Derive to obtain the most
accurate values.

(When you select descent rate or acceleration as a derived variable, SBE Data
Processing prompts you to enter the window size (seconds).)

Corrected Irradiance [CPAR] =

100 * ratio multiplier * underwater PAR / surface PAR [%]
(Ratio multiplier = scaling factor used for comparing light fields of disparate
intensity, input in .con or .xmlcon file entry for surface PAR sensor;
Underwater PAR = underwater PAR data;
Surface PAR = surface PAR data)
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Appendix VI: Output Variable Names

Note:

The Notes/Comments column in the
table below indicates 1% sensor, 2™
sensor, etc. For parameters calculated
from multiple sensors (for example,
salinity is a function of temperature,
conductivity, and pressure), 1% refers
to the 1% sensor T-C pair, 2™ refers to
the secondary T-C pair.

This appendix provides a list of output variable names. The names vary,
depending on whether you are viewing header information in a data file or
viewing real-time data in Seasave.
e Headers generated by modules in SBE Data Processing show
‘Short name: Full name’ in header.
Example:
# name 0 = prdM: Pressure, Strain Gauge [db]
(# name 0 indicates that this is the header for the first data column;
prdM is the Short name used in the software coding;
Pressure, Strain Gauge [db] is the more descriptive Full name)
e Seasave’s scrolled display shows a ‘Friendly name’ in heading.
Example:
prM
(this is the Friendly name for Pressure, Strain Gauge [db],;
pr indicates pressure and M indicates metric units)
e Seasave’s fixed display and plot display show 'Full name’.
Example:
Pressure, Strain Gauge [db]
(this is the Full name)

For CTDs that support redundant sensors: Unless noted otherwise, derived
variables are calculated only from primary sensor(s).

Example:

Sound Velocity [Chen-Millero, m/s] can be calculated from both primary and
secondary temperature and conductivity sensors on an SBE 9plus (which
supports secondary temperature and conductivity sensors), as indicated

by the presence of both Sound Velocity [Chen-Millero, m/s] and

Sound Velocity,2 [Chen-Millero, m/s] in the table.

However, Average Sound Velocity [Chen-Millero, m/s] can only be calculated
from the primary temperature and conductivity sensors (there is no entry for
this variable with a 2).

For some parameters, there are multiple entries in the table with the same
meaning for the user (but different meanings for the software).

Example:

Short names of ¢ _S/m, cond0S/m, and c0S/m all have long names of
Conductivity [S/m]; these parameters all provide conductivity in S/m.
However, the short names are different because of differences in the
conductivity equation used by the software in the calculation (equation varies,
depending on the CTD).

All variable selections can be made in Seasave and in SBE Data Processing’s
Derive module, except as noted.

The list is in two parts:

e Practical Salinity and related thermodynamic parameters (EQS-80), and
auxiliary sensor data

e  Absolute Salinity and related thermodynamic parameters (calculated in
and output by SBE Data Processing’s Derive TEOS-10 module)
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Practical Salinity and related Thermodynamic Parameters (EOS-80),
and Auxiliary Sensor Data

Short Name Full Name Friendly Name Units Notes/Comments
accM Acceleration [m/s"2] acc M m/s™2
accF Acceleration [ft/s"2] acc F ft/s"2
altM Altimeter [m] alt M m
altF Altimeter [ft] altF ft
avgsvCM Average Sound Velocity [Chen-Millero, avgsv-C M Chen-Millero,
m/s] m/s
avgsvCF Average Sound Velocity [Chen-Millero, ft/s]|avgsv-C F Chen-Millero,
ft/s
avgsvDM Average Sound Velocity [Delgrosso, m/s]  |avgsv-D M Delgrosso, m/s
avgsvDF Average Sound Velocity [Delgrosso, ft/s] avgsv-D F Delgrosso, ft/s
avgsvWM Average Sound Velocity [Wilson, m/s] avgsv-W M Wilson, m/s
avgsvWF Average Sound Velocity [Wilson, ft/s] avgsv-W F Wilson, ft/s
bat Beam Attenuation, Chelsea/Seatech [1/m]  |bat 1/m 1st sensor
batl Beam Attenuation, Chelsea/Seatech, 2 [1/m] |bat2 1/m 2nd sensor
batdiff Beam Attenuation, Chelsea/Seatech/ WET  |batdiff 1/m 2nd sensor - 1st sensor
Labs CStar, Diff, 2 - 1 [1/m]
wetBAttn Beam Attenuation, WET Labs AC3 [1/m]  |wetBAttn 1/m
CStarAt0 Beam Attenuation, WET Labs C-Star [1/m] |CStarAt 1/m 1st sensor
CStarAtl Beam Attenuation, WET Labs C-Star, 2 CStarAt2 1/m 2nd sensor
[1/m]
CStarAt2 Beam Attenuation, WET Labs C-Star, 3 CStarAt3 1/m 3rd sensor
[1/m]
CStarAt3 Beam Attenuation, WET Labs C-Star, 4 CStarAt4 1/m 4th sensor
[1/m]
CStarAt4 Beam Attenuation, WET Labs C-Star, 5 CStarAt5 1/m 5th sensor
[1/m]
CStarAt5 Beam Attenuation, WET Labs C-Star, 6 CStarAt6 1/m 6th sensor
[1/m]
CStarAtDiff Beam Attenuation, WET Labs C-Star, Diff, |CStarAtDiff 1/m 2nd sensor - 1st sensor
2-1[1/m]
Xmiss Beam Transmission, Chelsea/Seatech [%]  |xmiss % 1st sensor
xmiss 1 Beam Transmission, Chelsea/Seatech, 2 [%] |xmiss2 % 2nd sensor
xmissdiff Beam Transmission, Chelsea/Seatech/ WET  |xmissdiff % 2nd sensor - 1st sensor
Labs CStar, Diff, 2 - 1 [%]
wetBTrans Beam Transmission, WET Labs AC3 [%] wetBTrans %
CStarTr0 Beam Transmission, WET Labs C-Star [%] |CStarTr % 1st sensor
CStarTrl Beam Transmission, WET Labs C-Star, 2 CStarTr2 % 2nd sensor
[%]
CStarTr2 Beam Transmission, WET Labs C-Star, 3 CStarTr3 % 3rd sensor
[%]
CStarTr3 Beam Transmission, WET Labs C-Star, 4 CStarTr4 % 4th sensor
[%]
CStarTrd Beam Transmission, WET Labs C-Star, 5 CStarTr5 % 5th sensor
[%]
CStarTr5 Beam Transmission, WET Labs C-Star, 6 CStarTr6 % 6th sensor
[%]
CStarTrdiff Beam Transmission, WET Labs C-Star, Diff,|CStarTrdiff % 2nd sensor - 1st sensor
2-1[%]
bpos Bottle Position in Carousel bpos
HBBotCls Bottles Closed, HB HBBotCls
nbf Bottles Fired nbf
bct Bottom Contact bct
N Buoyancy [cycles/hour] N cycles/hour Calculated in SBE Data
Processing's Buoyancy
module
N2 Buoyancy [rad"2/s"2] N”2 rad"2/s"2 Calculated in SBE Data
Processing's Buoyancy
module
nbytes Byte Count nbytes

160




Manual revision 7.23.2

Appendix VI: Output Variable Names

SBE Data Processing

Short Name Full Name Friendly Name Units Notes/Comments
cdomflTCO CDOM, Turner Cyclops [ppb QS] cdomfITC ppb QS 1* sensor
cdomflITC1 CDOM, Turner Cyclops, 2 [ppb QS] cdomflITC2 ppb QS 2nd sensor
cdomfITCdiff |CDOM, Turner Cyclops, Diff, 2 - 1 [ppb cdomfITCdiff ppb QS 2nd sensor - 1st sensor
QS]
chloroflTCO Chlorophyll, Turner Cyclops [ug/l] chloroflTC ug/l 1* sensor
chloroflTC1 Chlorophyll, Turner Cyclops, 2 [ug/l] chlorofITC2 ug/l 2nd sensor
chlorofITCdiff |Chlorophyll, Turner Cyclops, Diff, 2 - 1 chlorofITCdiff ug/1 2nd sensor - 1st sensor
[ug/l]
¢ S/m, Conductivity [S/m] ¢ S/m S/m 1* sensor
cond0S/m, or
cond0S/m
¢ mS/cm, Conductivity [mS/cm] ¢ mS/cm mS/cm 1* sensor
condOmS/cm,
or cOmS/cm
¢ uS/cm, Conductivity [uS/cm] cuS/cm uS/cm 1™ sensor
condOuS/cm,
or cond0uS/cm
clS/m Conductivity, 2 [S/m] c2 S/m S/m 2nd sensor
clmS/cm Conductivity, 2 [mS/cm] ¢2 mS/cm mS/cm 2nd sensor
cluS/cm Conductivity, 2 [uS/cm] c2 uS/cm uS/cm 2nd sensor
C2-C1S/m Conductivity Difference, 2 - 1 [S/m] c2-cl S/m S/m 2nd sensor - 1st sensor
C2-ClmS/cm  |Conductivity Difference, 2 - 1 [mS/cm] c2-cl mS/cm mS/cm 2nd sensor - 1st sensor
C2-CluS/cm Conductivity Difference, 2 - 1 [uS/cm] c2-cl uS/cm uS/cm 2nd sensor - 1st sensor
cpar CPAR/Corrected Irradiance [%] cpar %
croilfITCO Crude Oil, Turner Cyclops [ppb QS] croilflITC ppb QS 1™ sensor
croilflITC1 Crude Oil, Turner Cyclops, 2 [ppb QS] croilfITC2 ppb QS 2" sensor
croilflTCdiff Crude Oil, Turner Cyclops, Diff, 2 - 1 [ppb |croilflITCdiff ppb QS 2nd sensor - 1st sensor
QS]
density00 Density [density, kg/m”3] density density, kg/m”3 |1 sensor
sigma-é00 Density [sigma-theta, kg/m”3] sigmath sigma-theta, 1™ sensor
kg/m”3
sigma-t00 Density [sigma-t, kg/m”"3 ] sigmat sigma-t, kg/m"3 |1* sensor
sigma-100 Density [sigma-1, kg/m"3 ] sigmal sigma-1, 1% sensor
kg/m”"3
sigma-200 Density [sigma-2, kg/m”"3 ] sigma2 sigma-2, 1% sensor
kg/m"3
sigma-400 Density [sigma-4, kg/m”3 ] sigma4 sigma-4, 1™ sensor
kg/m”"3
density11 Density, 2 [density, kg/m"3] density 2 density, kg/m”3 |2nd sensor
sigma-¢é11 Density, 2 [sigma-theta, kg/m”3] sigmath 2 sigma-theta, 2nd sensor
kg/m"3
sigma-t11 Density, 2 [sigma-t, kg/m"3 ] sigmat 2 sigma-t, kg/m”"3 |2nd sensor
sigma-111 Density, 2 [sigma-1, kg/m”"3 ] sigmal 2 sigma-1, 2nd sensor
kg/m”"3
sigma-211 Density, 2 [sigma-2, kg/m”3 ] sigma2 2 sigma-2, 2nd sensor
kg/m”"3
sigma-411 Density, 2 [sigma-4, kg/m”3 ] sigma4 2 sigma-4, 2nd sensor
kg/m”3
D2-D1,d Density Difference, 2 - 1 [density, kg/m"3] |D2-D1,d density, kg/m”3 |2nd sensor - 1st sensor
D2-D1 Density Difference, 2 - 1 [sigma-theta, D2-D1,th sigma-theta, 2nd sensor - 1st sensor
kg/m"3] kg/m”"3
D2-DI1,t Density Difference, 2 - 1 [sigma-t, kg/m”3 ] |[D2-DI,t sigma-t, kg/m”"3 |2nd sensor - 1st sensor
D2-D1,1 Density Difference, 2 - 1 [sigma-1, kg/m"3 ] |D2-D1,1 sigma-1, 2nd sensor - 1st sensor
kg/m”3
D2-D1,2 Density Difference, 2 - 1 [sigma-2, kg/m"3 ] |D2-D1,2 sigma-2, 2nd sensor - 1st sensor
kg/m”"3
D2-D1,4 Density Difference, 2 - 1 [sigma-4, kg/m"3 ] |D2-D1,4 sigma-4, 2nd sensor - 1st sensor
kg/m”"3
depSM Depth [salt water, m] depS M salt water, m
depSF Depth [salt water, ft] depS F salt water, ft
depFM Depth [fresh water, m] depF M fresh water, m
depFF Depth [fresh water, ft] depF F fresh water, ft
dNMEA Depth, NMEA [salt water, m] dNMEA salt water, m
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dz/dtM Descent Rate [m/s] dz/dt M m/s
dz/dtF Descent Rate [ft/s] dz/dt F ft/s
dm Dynamic Meters [10 J/kg] dm 10 J/kg Calculated in SBE Data
Processing's Derive module
flag Flag flag
chConctr Fluorescence, Biospherical Chl Con chConctr Concentration
naFluor Fluorescence, Biospherical Natural naFluor Natural fluorescence
product Fluorescence, Biospherical Production product Production
fiC Fluorescence, Chelsea Aqua 3 Chl Con fIC ug/l 1™ sensor
[ug/]
fiIC1 Fluorescence, Chelsea Aqua 3 Chl Con, 2 fic2 ug/l 2nd sensor
[ug/1]
fICdiff Fluorescence, Chelsea Aqua 3 Chl Con, fICdiff ug/1 2nd sensor - 1st sensor
Diff, 2 - 1 [ug/l]
fICM Fluorescence, Chelsea Mini Chl Con [ug/l] |[fICM ug/l
fICUVA Fluorescence, Chelsea UV Aquatracka [ug/l] |[fICUVA ug/l 1* sensor
fICUVALI Fluorescence, Chelsea UV Aquatracka, 2 fICUVA2 ug/l 2nd sensor
[ug/1]
fICUVAJiff Fluorescence, Chelsea UV Aquatracka, Diff, [fICUVAdiff ug/1 2nd sensor - 1st sensor
2 -1 [ug/]
haardtC Fluorescence, Dr. Haardt Chlorophyll a haardtC
haardtP Fluorescence, Dr. Haardt Phycoerythrin haardtP
haardtY Fluorescence, Dr. Haardt Yellow Sub haardtY
fISP Fluorescence, Seapoint fISP 1% sensor
fISP1 Fluorescence, Seapoint, 2 fISP2 2nd sensor
fISPdiff Fluorescence, Seapoint Diff, 2 - 1 fISPdiff 2nd sensor - 1st sensor
fISPR Fluorescence, Seapoint Rhodamine fISPR
fISPuv0 Fluorescence, Seapoint Ultraviolet fISPuv 1% sensor
fISPuvl Fluorescence, Seapoint Ultraviolet, 2 fISPuv2 2nd sensor
fISPuvdiff Fluorescence, Seapoint Ultraviolet, Diff, 2 - |fISPuvdiff 2nd sensor - 1st sensor
1
fS Fluorescence, Seatech fIS Sea Tech fluorometer or WET
Labs Flash Lamp fluorometer
fT Fluorescence, Turner 10-005 fIT
fITAu Fluorescence, Turner 10-Au-005 fITAu
fISCC Fluorescence, Turner Cor Chl [RFU] fISCC RFU S?UFA corrected chlorophyll;
1*" sensor
fISCC1 Fluorescence, Turner Cor Chl, 2 [RFU] fISCC2 RFU SCUFA corrected chlorophyll;
2nd sensor
fISCCdiff Fluorescence, Turner Cor Chl, Diff, 2 - 1 fISCCdiff RFU SCUFA corrected chlorophyll;
2nd sensor - 1st sensor
flScufa Fluorescence, Turner SCUFA [RFU] flScufa SCUFA chlorophyll; 1¥ sensor
flScufal Fluorescence, Turner SCUFA, 2 [RFU] flIScufa2 SCUFA chlorophyll; 2nd sensor
flScufadiff Fluorescence, Turner SCUFA Diff, 2 - 1 flScufadiff SCUFA chlorophyll;
2nd sensor - 1st sensor
wetChAbs Fluorescence, WET Labs AC3 Absorption |wetChAbs 1/m
[1/m]
wetCDOM Fluorescence, WET Labs CDOM [mg/m"3] |wetCDOM mg/m”"3 1™ sensor
wetCDOM 1 Fluorescence, WET Labs CDOM, 2 wetCDOM2 mg/m”"3 2nd sensor
[mg/m"3]
wetCDOM?2 Fluorescence, WET Labs CDOM, 3 wetCDOM3 mg/m”"3 3rd sensor
[mg/m"3]
wetCDOM3 Fluorescence, WET Labs CDOM, 4 wetCDOM4 mg/m"3 4th sensor
[mg/m"3]
wetCDOM4 Fluorescence, WET Labs CDOM, 5 wetCDOMS mg/m”"3 5th sensor
[mg/m"3]
wetCDOMS5 Fluorescence, WET Labs CDOM, 6 wetCDOM6 mg/m”"3 6th sensor
[mg/m"3]
wetCDOMdiff |Fluorescence, WET Labs CDOM, Diff, 2 - 1 |wetCDOMdiff mg/m"3 2nd sensor - 1st sensor
[mg/m"3]
wetChConc Fluorescence, WET Labs Chl Con [mg/m”3] |wetChConc mg/m”"3 WET Labs AC3 chlorophyll
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fIECO-AFL Fluorescence, WET Labs ECO-AFL/FL eco-afl mg/m”"3 1* sensor
[mg/m"3]

fIECO-AFL1 Fluorescence, WET Labs ECO-AFL/FL, 2 |eco-afl2 mg/m"3 2nd sensor
[mg/m"3]

fIECO-AFL2 Fluorescence, WET Labs ECO-AFL/FL, 3 |eco-afl3 mg/m”"3 3rd sensor
[mg/m"3]

fIECO-AFL3 Fluorescence, WET Labs ECO-AFL/FL, 4 |eco-afl4 mg/m”"3 4th sensor
[mg/m"3]

fIECO-AFL4 Fluorescence, WET Labs ECO-AFL/FL, 5 |eco-afl5 mg/m"3 5th sensor
[mg/m"3]

fIECO-AFL5 Fluorescence, WET Labs ECO-AFL/FL, 6 |eco-afl6 mg/m”"3 6th sensor
[mg/m"3]

fIECO-AFLAiff |Fluorescence, WET Labs ECO-AFL/FL, eco-afldiff mg/m”"3 2nd sensor - 1st sensor
Diff, 2 - 1 [mg/m"3]

wetStar Fluorescence, WET Labs WETstar WETstar mg/m”"3 1% sensor
[mg/m"3]

wetStarl Fluorescence, WET Labs WETstar, 2 WETstar2 mg/m”"3 2nd sensor
[mg/m"3]

wetStar2 Fluorescence, WET Labs WETstar, 3 WETstar3 mg/m”"3 3rd sensor
[mg/m"3]

wetStar3 Fluorescence, WET Labs WETstar, 4 WETstar4 mg/m”"3 4th sensor
[mg/m"3]

wetStard Fluorescence, WET Labs WETstar, 5 WETstar5 mg/m”"3 5th sensor
[mg/m"3]

wetStar5 Fluorescence, WET Labs WETstar, 6 WETstar6 mg/m”"3 6th sensor
[mg/m"3]

wetStardiff Fluorescence, WET Labs WETstar, Diff, 2 - |wetStardiff mg/m"3 2nd sensor - 1st sensor
1 [mg/m"3]

fIfITCO Fluorescein, Turner Cyclops [ppb] fIfiITC ppb 1™ sensor

fIfiITC1 Fluorescein, Turner Cyclops, 2 [ppb] fIfITC2 ppb 2nd sensor

fIfITCdiff Fluorescein, Turner Cyclops, Diff, 2 - 1 fIfITCdiff ppb 2nd sensor - 1st sensor
[ppb]

10 Frequency 0 0 Hz 1™ sensor

fl Frequency 1 fl Hz 2nd sensor

2 Frequency 2 2 Hz 3rd sensor

3 Frequency 3 3 Hz 4th sensor

4 Frequency 4 4 Hz Sth sensor

f5 Frequency 5 f5 Hz 6th sensor

o Frequency 6 6 Hz 7th sensor

7 Frequency 7 7 Hz 8th sensor

8 Frequency 8 8 Hz 9th sensor

9 Frequency 9 9 Hz 10th sensor

f10 Frequency 10 f10 Hz 11th sensor

fl1 Frequency 11 fl1 Hz 12th sensor

f12 Frequency 12 f12 Hz 13th sensor

f13 Frequency 13 f13 Hz 14th sensor

f14 Frequency 14 f14 Hz 15th sensor

f15 Frequency 15 f15 Hz 16th sensor

f16 Frequency 16 fl6 Hz 17th sensor

f17 Frequency 17 f17 Hz 18th sensor

f18 Frequency 18 f18 Hz 19™ sensor

f19 Frequency 19 f19 Hz 20™ sensor

20 Frequency 20 20 Hz 21% sensor

21 Frequency 21 21 Hz 22™ sensor

22 Frequency 22 22 Hz 23" sensor

23 Frequency 23 23 Hz 24™ sensor

24 Frequency 24 24 Hz 25™ sensor

25 Frequency 25 25 Hz 26" sensor

26 Frequency 26 26 Hz 27" sensor

27 Frequency 27 27 Hz 28™ sensor

28 Frequency 28 28 Hz 29™ sensor

29 Frequency 29 29 Hz 30™ sensor

£30 Frequency 30 30 Hz 31% sensor
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31 Frequency 31 31 Hz 32" sensor
32 Frequency 32 32 Hz 33" sensor
£33 Frequency 33 33 Hz 34™ sensor
34 Frequency 34 34 Hz 35" sensor
35 Frequency 35 35 Hz 36" sensor
36 Frequency 36 36 Hz 37" sensor
gpa Geopotential Anomaly [J/kg] gpa J/kg Calculated in SBE Data
Processing's Derive module
GTDDOP0 GTD-DO Pressure [mb] GTDDOP mb 1% sensor
GTDDOP1 GTD-DO Pressure, 2 [mb] GTDDOP2 mb 2nd sensor
GTDDOPdiff |GTD-DO Pressure, Diff, 2 - 1 [mb] GTDDOPdiff mb 2nd sensor - 1st sensor
GTDDOTO0 GTD-DO Temperature [deg C] GTDDOT deg C 1% sensor
GTDDOT!I GTD-DO Temperature, 2 [deg C] GTDDOT2 deg C 2nd sensor
GTDDOTdiff |GTD-DO Temperature, Diff, 2 - 1 [deg C] |GTDDOTdiff deg C 2nd sensor - 1st sensor
GTDN2PO GTD-N2 Pressure [mb] GTDN2P mb 1* sensor
GTDN2PI GTD-N2 Pressure, 2 [mb] GTDN2P2 mb 2nd sensor
GTDN2Pdiff GTD-N2 Pressure, Diff, 2 - 1 [mb] GTDN2Pdiff mb 2nd sensor - 1st sensor
GTDN2TO0 GTD-N2 Temperature [deg C] GTDN2T deg C 1™ sensor
GTDN2T1 GTD-N2 Temperature, 2 [deg C] GTDN2T2 deg C 2nd sensor
GTDN2Tdiff  |GTD-N2 Temperature, Diff, 2 - 1 [deg C] |GTDN2Tdiff deg C 2nd sensor - 1st sensor
latitude Latitude [deg] latitude deg From NMEA device
lisstBC LISST-25A, Beam C [1/m] lisstBC 1/m
lisstOT LISST-25A, Optical Transmission [%] lisstOT %
lisstMD LISST-25A, Sauter Mean Diameter [u] lisstMD u
lisstTVC LISST-25A, Total Volume Conc. [ul/l] lisstTVC ul/l
longitude Longitude [deg] longitude deg From NMEA device
meth Methane Conc., Franatech METS [umol/l] |meth umol/l
methT Methane Gas Temp., Franatech METS [deg |methT deg C
C]
modError Modulo Error Count modError
mod Modulo Word mod
newpos New Position newpos
n2satML/L Nitrogen Saturation [ml/1] N2sat ml/l ml/l
n2satMg/L Nitrogen Saturation [mg/1] N2sat mg/l mg/l
n2satumol/kg  |Nitrogen Saturation [umol/kg] N2sat umol/kg umol/kg
obs OBS, Backscatterance (D & A) [NTU] obs NTU 1* sensor
obsl OBS, Backscatterance (D & A), 2 [NTU] obs2 NTU 2nd sensor
obsdiff OBS, Backscatterance (D & A), Diff,2 -1 |obsdiff NTU 2nd sensor - 1st sensor
[NTU]
nephc OBS, Chelsea Nephelometer [FTU] nephc FTU
obs3+ OBS, D & A 3plus [NTU] obs3+ NTU D&A OBS 3+; 1™ sensor
obs3+1 OBS, D & A 3plus, 2 [NTU] obs3+2 NTU D&A OBS 3+; 2nd sensor
obs3+diff OBS, D & A 3plus, Diff, 2 - 1 [NTU] obs3+diff NTU D&A OBS 3+; 2nd sensor - 1st
sensor
haardtT OBS, Dr. Haardt Turbidity haardtT
diff OBS, IFREMER diff
stLs6000 OBS, Seatech LS6000 stLs6000 Sea Tech LS6000 or WET Labs
LBSS; 1* sensor
stLs60001 OBS, Seatech LS6000, 2 stLs60002 Sea Tech LS6000 or WET Labs
LBSS; 2nd sensor
stLs6000diff OBS, Seatech LS6000, Diff, 2 - 1 stLs6000diff Sea Tech LS6000 or WET Labs
LBSS; 2nd sensor - 1st sensor
obsscufa OBS, Turner SCUFA [NTU] obsscufa NTU 1*" sensor
obsscufal OBS, Turner SCUFA, 2 [NTU] obsscufa2 NTU 2nd sensor
obsscufadiff OBS, Turner SCUFA, Diff, 2 - 1 [NTU] obsscufadiff NTU 2nd sensor - 1st sensor
obrflITCO Optical Brighteners, Turner Cyclops [ppb  |obrfITC ppb QS 1™ sensor
QS]
obrflTC1 Optical Brighteners, Turner Cyclops, 2 [ppb |obrflITC2 ppb QS 2nd sensor
QS]
obrfITCdiff Optical Brighteners, Turner Cyclops, Diff, 2 |obrfITCdiff ppb QS 2nd sensor - 1st sensor
- 1 [ppb QS]
orp Oxidation Reduction Potential [mV] orp mV
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sbeox(0V Oxygen raw, SBE 43 [V] sbeoxV \ 1* sensor
sbeoxOF Oxygen raw, SBE 43 [Hz] sbeoxF Hz 1™ sensor
sbeox1V Oxygen raw, SBE 43,2 [V] sbeoxV2 \ 2nd sensor
sbeox1F Oxygen raw, SBE 43, 2 [Hz] sbeoxF2 Hz 2nd sensor
sbeoxOML/L Oxygen, SBE 43 [ml/1] sbeox ml/l ml/l 1* sensor
sbeoxOMg/L Oxygen, SBE 43 [mg/1] sbeox mg/l mg/1 1™ sensor
sbeox0PS Oxygen, SBE 43 [% saturation] sbeox %S % saturation _ |1* sensor
sbeoxOMm/Kg |Oxygen, SBE 43 [umol/kg] sbeox mm/kg umol/kg 1™ sensor
sbeoxOMm/L Oxygen, SBE 43 [umol/l] sbeoxMm/L umol/l 1™ sensor
sbeox0dOV/dT |Oxygen, SBE 43 [dov/dt] sbeox dov/dt dov/dt 1™ sensor
sbeox IML/L Oxygen, SBE 43, 2 [ml/1] sbeox2 ml/l ml/1 2nd sensor
sbeox1Mg/L Oxygen, SBE 43, 2 [mg/1] sbeox2 mg/l mg/1 2nd sensor
sbeox1PS Oxygen, SBE 43, 2 [% saturation] sbeox2 %S % saturation  |2nd sensor
sbeoxIMm/Kg |Oxygen, SBE 43, 2 [umol/kg] sbeox2 mm/kg umol/kg 2nd sensor
sbeox1Mm/L Oxygen, SBE 43, 2 [umol/I] sbeoxMm/L2 umol/l 2nd sensor
sbeox1dOV/dT |Oxygen, SBE 43, 2 [dov/dt] sbeox2 dov/dt dov/dt 2nd sensor
sbeoxOML/Ldiff |Oxygen, SBE 43, Diff, 2 - 1 [ml/1] sbeox ml/I diff ml/l 2nd sensor - 1st sensor
sbeoxOMg/Ldiff |Oxygen, SBE 43, Diff, 2 - 1 [mg/1] sbeox mg/I diff mg/l 2nd sensor - 1st sensor
sbeoxOPSdiff Oxygen, SBE 43, Diff, 2 - 1 [% saturation] |sbeox %S diff % saturation  |2nd sensor - 1st sensor
sbeoxOMm/ Oxygen, SBE 43, Diff, 2 - 1 [umol/kg] sbeox mm/kg diff ~ [umol/kg 2nd sensor - 1st sensor
Kediff
sbeoxOMm/Ldiff|Oxygen, SBE 43, Diff, 2 - 1 [umol/l] sbeox mm/1 diff umol/l 2nd sensor - 1st sensor
sbeoxpd Oxygen raw, SBE 63 phase delay [usec] sbeoxpd usec 1™ sensor
sbeoxpdv Oxygen raw, SBE 63 phase delay [V] sbeoxpdv \ 1™ sensor
sbeoxpdl Oxygen raw, SBE 63 phase delay, 2 [usec] |sbeoxpd2 usec 2nd sensor
sbeoxpdv1 Oxygen raw, SBE 63 phase delay, 2 [V] sbeoxpdv2 \ 2nd sensor
sbeoxtv Oxygen raw, SBE 63 thermistor voltage [V] |sbeoxtv \Y 1™ sensor
sbeoxtvl Oxygen raw, SBE 63 thermistor voltage, 2  |sbeoxtv2 v 2nd sensor
V]
sbeoxTC Oxygen Temperature, SBE 63 [ITS-90, deg |sbeoxTC ITS-90, deg C |1 sensor
Cl]
sbeoxTF Oxygen Temperature, SBE 63 [ITS-90, deg |sbeoxTF ITS-90, deg F |1 sensor
F]
sbeoxTCl1 Oxygen Temperature, SBE 63, 2 [ITS-90, |sbeoxTCl1 ITS-90, deg C |2nd sensor
deg C]
sbeoxTF1 Oxygen Temperature, SBE 63, 2 [ITS-90, |sbeoxTF1 ITS-90, deg F |2nd sensor
deg F]
sbeopoxML/L  |Oxygen, SBE 63 [ml/1] sbeopox ml/l ml/1 1*" sensor
sbeopoxMg/L  |Oxygen, SBE 63 [mg/l] sbeopox mg/1 mg/1 1™ sensor
sbeopoxPS Oxygen, SBE 63 [% saturation] sbeopox %S % saturation  |1* sensor
sbeopoxMm/Kg |Oxygen, SBE 63 [umol/kg] sbeopox Mm/Kg umol/kg 1* sensor
sbeopoxMm/L  |Oxygen, SBE 63 [umol/1] sbeopox Mm/L umol/l 1™ sensor
sbeopoxML/L1 |Oxygen, SBE 63, 2 [ml/1] sbeopox ml/12 ml/1 2nd sensor
sbeopoxMg/L1 |Oxygen, SBE 63, 2 [mg/1] sbeopox mg/12 mg/1 2nd sensor
sbeopoxPS1 Oxygen, SBE 63, 2 [% saturation] sbeopox %S2 % saturation  |2nd sensor
Sbeopox Oxygen, SBE 63, 2 [umol/kg] sbeopox Mm/Kg2  [umol/kg 2nd sensor
Mm/Kgl
sbeopoxMm/L1 |Oxygen, SBE 63, 2 [umol/l] sbeopox Mm/L2 umol/l 2nd sensor
opoxML/L Oxygen Optode, Aanderaa [ml/1] opox ml/l ml/l
opoxMg/L Oxygen Optode, Aanderaa [mg/1] opox mg/l mg/l
opoxPS Oxygen Optode, Aanderaa [% saturation] opox %S % saturation
opoxMm/L Oxygen Optode, Aanderaa [umol/1] opox Mm/I umol/l
oxC Oxygen Current, Beckman/YSI [uA] 0XC uA 1% sensor
oxsC Oxygen Current, Beckman/YSI, 2 [uA] oxc2 uA 2nd sensor
oxTC Oxygen Temperature, Beckman/YSI [deg C] |oxT C deg C 1™ sensor
oxTF Oxygen Temperature, Beckman/YSI [deg F] |oxT F deg F 1™ sensor
oxsTC Oxygen Temperature, Beckman/YSI, 2 [deg |oxT2 C deg C 2nd sensor
C]
oxsTF Oxygen Temperature, Beckman/YSI, 2 [deg |oxT2 F deg F 2nd sensor
F]

165




Manual revision 7.23.2

Appendix VI: Output Variable Names

SBE Data Processing

Short Name Full Name Friendly Name Units Notes/Comments
oxML/L Oxygen, Beckman/YSI [ml/1] ox ml/l ml/l 1™ sensor
oxMg/L Oxygen, Beckman/YSI [mg/1] ox mg/l mg/l 1™ sensor
oxPS Oxygen, Beckman/YSI [% saturation] ox %S % saturation _|1* sensor
oxMm/Kg Oxygen, Beckman/YSI [umol/kg] ox mm/Kg umol/kg 1* sensor
oxdOC/dT Oxygen, Beckman/YSI [doc/dt] ox doc/dt doc/dt 1*" sensor
oxsML/L Oxygen, Beckman/YSI, 2 [ml/] ox2 ml/l ml/l 2nd sensor
oxsMg/L Oxygen, Beckman/YSI, 2 [mg/1] ox2 mg/l mg/l 2nd sensor
oxsPS Oxygen, Beckman/YSI, 2 [% saturation] 0xs %S % saturation  |2nd sensor
oxsMm/Kg Oxygen, Beckman/YSI, 2 [umol/kg] oxs mm/Kg umol/kg 2nd sensor
oxsdOC/dT Oxygen, Beckman/YS]I, 2 [doc/dt] oxs doc/dt doc/dt 2nd sensor
iowOxML/L Oxygen, IOW [ml/1] iowox ml/l ml/l
oxsolML/L Oxygen Saturation, Garcia & Gordon [ml/l] |oxsol ml/l ml/l
oxsolMg/L Oxygen Saturation, Garcia & Gordon [mg/1] |oxsol mg/l mg/l
oxsolMm/Kg Oxygen Saturation, Garcia & Gordon oxsol Mm/kg umol/kg
[umol/kg]
oxsatML/L Oxygen Saturation, Weiss [ml/1] oxsat ml/1 ml/l
oxsatMg/L Oxygen Saturation, Weiss [mg/1] oxsat mg/l mg/l
oxsatMm/Kg Oxygen Saturation, Weiss [umol/kg] oxsat Mm/kg umol/kg
par PAR/Irradiance, Biospherical/Licor par Biospherical, Licor, or Chelsea
sensor; 1% sensor
parl PAR/Irradiance, Biospherical/Licor, 2 par2 Biospherical, Licor, or Chelsea
sensor; 2nd sensor
ph pH ph
phycyflITCO Phycocyanin, Turner Cyclops [RFU] phycyflITC RFU 1* sensor
phycyflTC1 Phycocyanin, Turner Cyclops, 2 [RFU] phycyfITC2 RFU 2nd sensor
phycyfITCdiff |Phycocyanin, Turner Cyclops, Diff, 2 - 1 phycyfITCdiff RFU 2nd sensor - 1st sensor
[RFU]
phyeryflITCO Phycoerythrin, Turner Cyclops [RFU] phyeryflITC RFU 1™ sensor
phyeryflITC1 Phycoerythrin, Turner Cyclops, 2 [RFU] phyeryflITC2 RFU 2nd sensor
phyeryfITCdiff |Phycoerythrin, Turner Cyclops, Diff, 2 -1  |phyeryflTCdiff RFU 2nd sensor - 1st sensor
[RFU]
pla Plume Anomaly pla
potemp090C Potential Temperature [ITS-90, deg C] potemp 90 C ITS-90, deg C |1% sensor
potemp090F Potential Temperature [ITS-90, deg F] potemp 90 F ITS-90, deg F |1% sensor
potemp068C Potential Temperature [IPTS-68, deg C] potemp 68 C IPTS-68, deg C|1% sensor
potemp068F Potential Temperature [IPTS-68, deg F] potemp 68 F IPTS-68, deg F |1 sensor
potemp190C Potential Temperature, 2 [ITS-90, deg C] potemp2 90 C ITS-90, deg C |2nd sensor
potemp190F Potential Temperature, 2 [ITS-90, deg F] potemp2 90 F ITS-90, deg F |2nd sensor
potemp168C Potential Temperature, 2 [[PTS-68, deg C] |potemp2 68 C IPTS-68, deg |2nd sensor
C
potemp168F Potential Temperature, 2 [IPTS-68, deg F]  |potemp2 68 F IPTS-68, deg F|2nd sensor
potemp90Cdiff |Potential Temperature, Diff, 2 - 1 [ITS-90, |potemp diff 90 C ITS-90, deg C |2nd sensor - 1st sensor
deg C]
potemp90Fdiff |Potential Temperature, Diff, 2 - 1 [ITS-90, |potemp diff 90 F ITS-90, deg F |2nd sensor - 1st sensor
deg F]
potemp68Cdiff |Potential Temperature, Diff, 2 - 1 [IPTS-68, |potemp diff 68 C IPTS-68, deg |2nd sensor - 1st sensor
deg C] C
potemp68Fdiff [Potential Temperature, Diff, 2 - 1 [IPTS-68, |potemp diff 68 F IPTS-68, deg F|2nd sensor - 1st sensor
deg F]
pta090C Potential Temperature Anomaly [ITS-90, pta 90 C ITS-90, deg C |1% sensor
deg C]
ptaO90F Potential Temperature Anomaly [ITS-90, pta90 F ITS-90, deg F |1% sensor
deg F]
pta068C Potential Temperature Anomaly [IPTS-68, |pta 68 C IPTS-68, deg |1 sensor
deg C] C
pta068F Potential Temperature Anomaly [IPTS-68, |pta 68 F IPTS-68, deg F|1% sensor
deg F]
ptal90C Potential Temperature Anomaly, 2 [ITS-90, |ptal 90 C ITS-90, deg C |2nd sensor
deg C]
ptal90F Potential Temperature Anomaly, 2 [ITS-90, |ptal 90 F ITS-90, deg F |2nd sensor
deg F]
ptal68C Potential Temperature Anomaly, 2 [IPTS-68,|ptal 68 C IPTS-68, deg |2nd sensor
deg C] C
ptal68F Potential Temperature Anomaly, 2 [IPTS-68,|ptal 68 F IPTS-68, deg F|2nd sensor
deg F]
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prM Pressure [db] prM db User-entry for moored pressure
(instrument with no pressure
sensor)

prE Pressure [psi] prE psi User-entry for moored pressure
(instrument with no pressure
sensor)

ptempC Pressure Temperature [deg C] ptemp C deg C Temperature measured by
pressure sensor

ptempF Pressure Temperature [deg F] ptemp F deg F Temperature measured by
pressure sensor

prDM Pressure, Digiquartz [db] pr M db Digiquartz pressure sensor

prDE Pressure, Digiquartz [psi] prE psi Digiquartz pressure sensor

fgp0 Pressure, FGP [KPa] fgp KPa 1% FGP pressure sensor

fgpl Pressure, FGP, 2 [KPa] fgp2 KPa 2nd FGP pressure sensor

fgp2 Pressure, FGP, 3 [KPa] fgp3 KPa 3rd FGP pressure sensor

fgp3 Pressure, FGP, 4 [KPa] fgp4 KPa 4th FGP pressure sensor

fgp4 Pressure, FGP, 5 [KPa] fgp5 KPa 5th FGP pressure sensor

fgp5 Pressure, FGP, 6 [KPa] fgp6 KPa 6th FGP pressure sensor

fgp6 Pressure, FGP, 7 [KPa] fgp7 KPa 7th FGP pressure sensor

fgp7 Pressure, FGP, 8 [KPa] fgp8 KPa 8th FGP pressure sensor

prSOM Pressure, SBE 50 [db] prS0 M db 1% SBE 50 pressure sensor

pr5S0E Pressure, SBE 50 [psi] pr50 E psi 1% SBE 50 pressure sensor

pr5OM1 Pressure, SBE 50, 2 [db] pr50 M2 db 2" SBE 50 pressure sensor

pr5SOE1 Pressure, SBE 50, 2 [psi] pr50 E2 psi 2" SBE 50 pressure sensor

prSM or prdM  |Pressure, Strain Gauge [db] prM db strain-gauge pressure sensor

prSE or prdE Pressure, Strain Gauge [psi] prE psi strain-gauge pressure sensor

pumps Pump Status pumps

rfuels0 Refined Fuels, Turner Cyclops [ppb NS] rfuels ppb NS 1% sensor

rfuelsl Refined Fuels, Turner Cyclops, 2 [ppb NS] |fuels2 ppb NS 2nd sensor

rfuelsdiff Refined Fuels, Turner Cyclops, Diff, 2 -1 |rfuelsdiff ppb NS 2nd sensor - 1st sensor

[ppb NS]

rhodfITCO Rhodamine, Turner Cyclops [ppb] thodfITC ppb 1* sensor

rhodfITC1 Rhodamine, Turner Cyclops, 2 [ppb] rhodfITC2 ppb 2nd sensor

rhodfITCdiff Rhodamine, Turner Cyclops, Diff, 2 - 1 rhodfITCdiff ppb 2nd sensor - 1st sensor

[ppb]

wl0 RS-232 WET Labs raw counts 0 wl Counts 1™ sensor

wll RS-232 WET Labs raw counts 1 wi2 Counts 2nd sensor

wi2 RS-232 WET Labs raw counts 2 wli3 Counts 3rd sensor

wli3 RS-232 WET Labs raw counts 3 wl4 Counts 4th sensor

wl4 RS-232 WET Labs raw counts 4 wl5 Counts 5th sensor

wl5 RS-232 WET Labs raw counts 5 wl6 Counts 6th sensor

sal00 or sal Salinity, Practical [PSU] sal PSU 1* sensor

salll Salinity, Practical, 2 [PSU] sal2 PSU 2nd sensor

secS-priS Salinity, Practical, Difference, 2 - 1 [PSU] [sal2-sall PSU 2nd sensor - 1st sensor

scan Scan Count scan

nbin Scans Per Bin nbin Calculated in SBE Data
Processing's Bin Average
module

sfdSM Seafloor depth [salt water, m] sfdS M salt water, m

sfdSF Seafloor depth [salt water, ft] sfdS F salt water, ft

sfdFM Seafloor depth [fresh water, m] sfdF M fresh water, m

sfdFF Seafloor depth [fresh water, ft] sfdF F fresh water, ft

svCM Sound Velocity [Chen-Millero, m/s] svCM Chen-Millero, |1* sensor

m/s
svCF Sound Velocity [Chen-Millero, ft/s] svC F Chen-Millero, |1 sensor
ft/s

svDM Sound Velocity [Delgrosso, m/s] svD M Delgrosso, m/s 1% sensor

svDF Sound Velocity [Delgrosso, ft/s] svDF Delgrosso, ft/s 1% sensor

svWM Sound Velocity [Wilson, m/s] svW M Wilson, m/s  |1* sensor

svWF Sound Velocity [Wilson, ft/s] svW F Wilson, ft/s 1% sensor
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svCM1 Sound Velocity, 2 [Chen-Millero, m/s] svC2 M Chen-Millero, |2nd sensor
m/s
svCF1 Sound Velocity, 2 [Chen-Millero, ft/s] svC2 F Chen-Millero, |2nd sensor
ft/s
svDM1 Sound Velocity, 2 [Delgrosso, m/s] svD2 M Delgrosso, m/s |2nd sensor
svDF1 Sound Velocity, 2 [Delgrosso, ft/s] svD2 F Delgrosso, ft/s |2nd sensor
svWM1 Sound Velocity, 2 [Wilson, m/s] svW2 M Wilson, m/s  |2nd sensor
svWF1 Sound Velocity, 2 [Wilson, ft/s] svW2 F Wilson, ft/s 2nd sensor
iowSv Sound Velocity, IOW [m/s] iowSv m/s IOW sound velocity sensor
sbeSv-iowSv Sound Velocity Diff, SBE - IOW [m/s] svSbeC-svIOW m/s SBE CTD - IOW SV sensor
spar SPAR/Surface Irradiance spar
specc Specific Conductance [uS/cm] specc uS/cm
speccumhoscm  |Specific Conductance [umhos/cm] speccumhoscm umhos/cm
speccmsm Specific Conductance [mS/cm] speccmsm mS/cm
speccmmhoscm |Specific Conductance [mmhos/cm] speccmmhoscm mmhos/cm
sva Specific Volume Anomaly [10"-8 * m”3/kg] |sva 107-8 *
m"3/kg
E Stability [rad"2/m] E rad"2/m Calculated in SBE Data
Processing's Buoyancy module
E107-8 Stability [10"-8 * rad"2/m] E10"-8 10M-8 * Calculated in SBE Data
rad"2/m Processing's Buoyancy module
t090Cm, Temperature [ITS-90, deg C] t90 C ITS-90, deg C |1% sensor
t4990C, tnc90C,
or tv290C
t090F, t4990F, |Temperature [ITS-90, deg F] t90F ITS-90, deg F |1% sensor
tnc90F, or
tv290F
t068C, t4968C, |Temperature [IPTS-68, deg C] t68 C IPTS-68, deg 1% sensor
tnc68C, or C
tv268C
t068F, t4968F, |Temperature [IPTS-68, deg F] t68 F IPTS-68, deg F|1% sensor
tnc68F, or
tv268F
t190C or Temperature, 2 [ITS-90, deg C] 290 C ITS-90, deg C |2nd sensor
tnc290C
t190F or Temperature, 2 [ITS-90, deg F] 2290F ITS-90, deg F |2nd sensor
tnc290F
t168C or Temperature, 2 [IPTS-68, deg C] t2 68 C IPTS-68, deg |2nd sensor
tnc268C C
t168F or Temperature, 2 [IPTS-68, deg F] t2 68 F IPTS-68, deg F|2nd sensor
tnc268F
T2-T190C Temperature Difference, 2 - 1 [ITS-90, deg |T2-T190 C ITS-90, deg C |2nd sensor - 1st sensor
C]
T2-T190F Temperature Difference, 2 - 1 [ITS-90, deg |T2-T1 90 F ITS-90, deg F |2nd sensor - 1st sensor
F]
T2-T168C Temperature Difference, 2 - 1 [IPTS-68, deg |T2-T1 68 C IPTS-68, deg |2nd sensor - 1st sensor
C] C
T2-T168F Temperature Difference, 2 - 1 [IPTS-68, deg |T2-T1 68 F IPTS-68, deg F|2nd sensor - 1st sensor
F]
t3890C or Temperature, SBE 38 [ITS-90, deg C] 3890 C ITS-90, deg C |1% sensor
t38 90C
t3890F or Temperature, SBE 38 [ITS-90, deg F] t38 90 F ITS-90, deg F |1% sensor
t38_90F
t3868C or Temperature, SBE 38 [IPTS-68, deg C] 3868 C IPTS-68, deg |1 sensor
t38_68C C
t3868F or Temperature, SBE 38 [IPTS-68, deg F] t38 68 F IPTS-68, deg F 1% sensor
t38_68F
t3890C1 Temperature, SBE 38, 2 [ITS-90, deg C] t38 90 C2 ITS-90, deg C |2nd sensor
t3890F 1 Temperature, SBE 38, 2 [ITS-90, deg F] t38 90 F2 ITS-90, deg F |2nd sensor
t3868C1 Temperature, SBE 38, 2 [IPTS-68, deg C]  [t38 68 C2 IPTS-68, deg |2nd sensor
C
t3868F1 Temperature, SBE 38, 2 [IPTS-68, deg F]  |t38 68 F2 IPTS-68, deg F|2nd sensor
tsa Thermosteric Anomaly [107-8 * m"3/kg] tsa 107-8 *
m”3/kg
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Short Name

Full Name

Friendly Name

Units

Notes/Comments

timeS

Time, Elapsed [seconds]

time S

seconds

Elapsed time (seconds) based
on first scan in data file and
sample rate (profiling) or
sample interval (moorings);
sample rate is defined by
configuration (.con or .xmlcon)
file.

timeM

Time, Elapsed [minutes]

time M

minutes

Elapsed time (minutes) based
on first scan in data file and
sample rate (profiling) or
sample interval (moorings);
sample rate or interval is as
defined by configuration (.con
or .xmlcon) file.

timeH

Time, Elapsed [hours]

time H

hours

Elapsed time (hours) based on
first scan in data file and
sample rate (profiling) or
sample interval (moorings);
sample rate or interval is as
defined by configuration (.con
or .xmlcon) file.

timeJ

Julian Days

time J

julian days

Elapsed time (Julian days)
based on first scan in data file
and sample rate (profiling) or
sample interval (moorings);
sample rate or interval is as
defined by configuration (.con
or .xmlcon) file.

timeN

Time, NMEA [seconds]

timeN

seconds

From NMEA device: Seconds
since January 1, 1970; only for
SBE 45

timeQ

Time, NMEA [seconds]

timeQ

seconds

From NMEA device: Seconds
since January 1, 2000;
everything but SBE 45

timeK

Time, Instrument [seconds]

timeK

seconds

Seconds since January 1, 2000,
based on time stamp in 16plus
V2 or 19plus V2 (in moored
mode).

timeJV2

Time, Instrument [julian days]

timeJV2

julian days

Julian days, based on time
stamp in 16plus V2 or 19plus
V2 (in moored mode).

timeSCP

Time, Seacat plus [julian days]

timeSCP

julian days

Julian days, based on time
stamp in 16plus or 19plus (in
moored mode). Not applicable
to V2 versions.

timeY

Time, System [seconds]

timeY

seconds

Computer time (seconds) since
January 1, 1970, appended by
Seasave V7 if 'Scan time added'
selected in configuration (.con
or .xmlcon) file.

userl

User Defined Variable

user

1* sensor; user selects variable
name for file imported to ASCII
In

user2

User Defined Variable, 2

user2

2nd sensor; user selects variable
name for file imported to ASCII
In

user3

User Defined Variable, 3

user3

3rd sensor; user selects variable
name for file imported to ASCII
In

user4

User Defined Variable, 4

userd

4th sensor; user selects variable
name for file imported to ASCII
In

userS

User Defined Variable, 5

users

5th sensor; user selects variable
name for file imported to ASCII
In
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Short Name Full Name Friendly Name Units Notes/Comments

seaTurbMtr Turbidity, Seapoint [FTU] seaTurbMtr FTU 1* sensor

seaTurbMtrl Turbidity, Seapoint, 2 [FTU] seaTurbMtr2 FTU 2nd sensor

seaTurbMtrdiff |Turbidity, Seapoint, Diff, 2 - 1 [FTU] seaTurbMtrdiff FTU 2nd sensor - 1st sensor

turbfITCO Turbidity, Turner Cyclops [NTU] turbfITC NTU 1™ sensor

turbfITC1 Turbidity, Turner Cyclops, 2 [NTU] turbflITC2 NTU 2nd sensor

turbfITCdiff Turbidity, Turner Cyclops, Diff, 2 - 1 [NTU] |turbfITCdiff NTU 2nd sensor - 1st sensor

turbWETbb0 Turbidity, WET Labs ECO BB [m"-1/sr] turb WETbb m”-1/sr 1*' sensor

turbWETbb1 Turbidity, WET Labs ECO BB, 2 [m"-1/sr] [turbWETbb2 m”-1/sr 2nd sensor

turbWETbb2 Turbidity, WET Labs ECO BB, 3 [m"-1/sr] [turbWETbb3 m”-1/sr 3rd sensor

turbWETbb3 Turbidity, WET Labs ECO BB, 4 [m"-1/sr] |turbWETbb4 m"-1/sr 4th sensor

turb WETbb4 Turbidity, WET Labs ECO BB, 5 [m”-1/sr] [turbWETbb5 m”-1/sr Sth sensor

turbWETbbdiff |Turbidity, WET Labs ECO BB, Diff,2 -1 |turbWETbbdiff m”~-1/sr 2nd sensor - 1st sensor
[m"-1/sr]

turbWETntu0  |Turbidity, WET Labs ECO [NTU] turbWETntu NTU 1% sensor

turbWETntul | Turbidity, WET Labs ECO, 2 [NTU] turbWETntu2 NTU 2nd sensor

turbWETntu2 | Turbidity, WET Labs ECO, 3 [NTU] turbWETntu3 NTU 3rd sensor

turbWETntu3  |Turbidity, WET Labs ECO, 4 [NTU] turb WETntu4 NTU 4th sensor

turbWETntu4  |Turbidity, WET Labs ECO, 5 [NTU] turbWETntu5 NTU 5th sensor

turbWETntu5  |Turbidity, WET Labs ECO, 6 [NTU] turbWETntu6 NTU 6th sensor

turbWETntudiff |Turbidity, WET Labs ECO, Diff, 2 - 1 turb WETntudiff NTU 2nd sensor - 1st sensor
[NTU]

upoly0 User Polynomial upoly 1*" user polynomial sensor

upoly1 User Polynomial, 2 upoly?2 2nd user polynomial sensor

upoly2 User Polynomial, 3 upoly3 3rd user polynomial sensor

v0 Voltage 0 v0 Vv 1* voltage sensor

vl Voltage 1 vl \Y 2nd voltage sensor

v2 Voltage 2 v2 \Y 3rd voltage sensor

v3 Voltage 3 v3 \Y% 4th voltage sensor

v4 Voltage 4 v4 \ 5th voltage sensor

v5 Voltage 5 v5 \ 6th voltage sensor

v6 Voltage 6 v6 \ 7th voltage sensor

v7 Voltage 7 v7 \Y 8th voltage sensor

v8 Voltage 8 v8 \Y 9th voltage sensor

v9 Voltage 9 v9 \ 10th voltage sensor

v10 Voltage 10 v10 \ 11th voltage sensor

vll Voltage 11 vll \Y 12th voltage sensor

v12 Voltage 12 v12 \Y 13th voltage sensor

v13 Voltage 13 v13 \Y 14th voltage sensor

v14 Voltage 14 v14 \ 15th voltage sensor

v15 Voltage 15 vl5 \ 16th voltage sensor

zaps Zaps [nmol] zaps nmol
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Absolute Salinity and related Thermodynamic Parameters (TEOS-10)

Short Name Full Name Friendly Name |Units Notes/Comments
gsw_saAl Absolute Salinity [g/kg] gsw_sa g/kg 1* sensor
gsw_saAl Absolute Salinity, 2 [g/kg] gsw_sa2 g/kg 2nd sensor
gsw_deltasaA0 Absolute Salinity Anomaly [g/kg] gsw_deltasaA0 g/kg 1* sensor
gsw_deltasaAl Absolute Salinity Anomaly, 2 [g/kg] gsw_deltasaAl gkg 2nd sensor
gsw_adlr0A adiabatic lapse rate [K/Pa] gsw_adlr0A K/Pa 1™ sensor
gsw_adlrlA adiabatic lapse rate, 2 [K/Pa] gsw_adlrlA K/Pa 2nd sensor
gsw_ctA0 Conservative Temperature [ITS-90, deg C] gsw_ct ITS-90, deg C 1* sensor
gsw_ctAl Conservative Temperature, 2 [ITS-90, deg C] gsw_ct2 ITS-90, deg C 2nd sensor
gsw_ctfA0 Conservative Temperature Freezing [ITS-90, deg C]  |gsw_ctfA0 ITS-90, deg C 1* sensor
gsw_ctfAl Conservative Temperature Freezing, 2 [ITS-90, deg C] |gsw_ctfAl ITS-90, deg C 2nd sensor
gsw_densityAQ density, TEOS-10 [density, kg/m"3] gsw_densityAQ density, kg/m*3 |1* sensor
gsw_sigma0AQ density, TEOS-10 [sigma-0, kg/m"3] gsw_sigma0AQ  |sigma-0, kg/m"3 |1* sensor
gsw_sigmal AQ density, TEOS-10 [sigma-1, kg/m"3] gsw_sigmal AO sigma-1, kg/m"3 |1 sensor
gsw_sigma2A0 density, TEOS-10 [sigma-2, kg/m”"3] gsw_sigma2A0 sigma-2, kg/m"3 |1 sensor
gsw_sigma3A0 density, TEOS-10 [sigma-3, kg/m"3] gsw_sigma3A0 sigma-3, kg/m*3 |1* sensor
gsw_sigma4A0 density, TEOS-10 [sigma-4, kg/m"3] gsw_sigma4A0 sigma-4, kg/m"3 |1% sensor
gsw_densityAl density, TEOS-10, 2 [density, kg/m"3] gsw_densityAl density, kg/m*3  |2nd sensor
gsw_sigma0Al density, TEOS-10, 2 [sigma-0, kg/m"3] gsw_sigma0Al sigma-0, kg/m”"3 |2nd sensor
gsw_sigmalAl density, TEOS-10, 2 [sigma-1, kg/m"3] gsw_sigmalAl sigma-1, kg/m"3 |2nd sensor
gsw_sigma2Al density, TEOS-10, 2 [sigma-2, kg/m"3] gsw_sigma2Al sigma-2, kg/m"3 |2nd sensor
gsw_sigma3Al density, TEOS-10, 2 [sigma-3, kg/m”"3] gsw_sigma3Al sigma-3, kg/m"3 |2nd sensor
gsw_sigma4Al density, TEOS-10, 2 [sigma-4, kg/m"3] gsw_sigma4Al sigma-4, kg/m"3 |2nd sensor
gsw_dynenthAO |dynamic enthalpy [J/kg] gsw_dynenthA0 |J/kg 1* sensor
gsw_dynenthAl |dynamic enthalpy, 2 [J/kg] gsw_dynenthAl |J/kg 2nd sensor
gsw_enthalpyAO |enthalpy [J/kg] gsw_enthalpyAO |J/kg 1™ sensor
gsw_enthalpyAl [|enthalpy, 2 [J/kg] gsw_enthalpyAl |J/kg 2nd sensor
gsw_entropyAO  |entropy [J/kg/K] gsw_entropyA0  |J/kg/K 1* sensor
gsw_entropyAl entropy, 2 [J/kg/K] gsw_entropyAl  |J/kg/K 2nd sensor
gsw_gravA gravity [m/s"2] gsw_gravA m/s"2

gsw_icAQ internal energy [J/kg] gsw_icAQ J/kg 1™ sensor
gsw_icAl internal energy, 2 [J/kg] gsw_icAl J/kg 2nd sensor
gsw_icA0 isentropic compressibility [1/Pa] gsw_icA0 1/Pa 1* sensor
gsw_icAl isentropic compressibility, 2 [1/Pa] gsw_icAl 1/Pa 2nd sensor
gsw_lheAO latent heat of evaporation [J/kg] gsw_lheAO J/kg 1™ sensor
gsw_lheAl latent heat of evaporation, 2 [J/kg] gsw_lheAl J/kg 2nd sensor
gsw 1hmA0Q latent heat of melting [J/kg] gsw 1hmA0Q J/kg 1™ sensor
gsw lhmAl latent heat of melting, 2 [J/kg] gsw lhmAl J/kg 2nd sensor
gsw_ptAQ potential temperature [ITS-90, deg C] gsw_ptAQ ITS-90, deg C 1* sensor
gsw_ptAl potential temperature, 2 [ITS-90, deg C] gsw_ptAl ITS-90,deg C  |2nd sensor
gsw_sstarAQ Preformed Salinity [g/kg] gsw_sstarAQ g/kg 1™ sensor
gsw_sstarAl Preformed Salinity, 2 [g/kg] gsw_sstarAl g/kg 2nd sensor
gsw_srAQ Reference Salinity [g/kg] gsw_srAQ g/kg 1* sensor
gsw_srAl Reference Salinity, 2 [g/kg] gsw_srAl g/kg 2nd sensor
gsw_betaAQ saline contraction coefficient [kg/g] gsw_betaAQ kg/g 1™ sensor
gsw_betaAl saline contraction coefficient, 2 [kg/g] gsw_betaAl kg/g 2nd sensor
gsw_ssAQ sound speed, TEOS-10 [m/s] gsw_ssAQ m/s 1* sensor
gsw_ssAl sound speed, TEOS-10, 2 [m/s] gsw_ssAl m/s 2nd sensor
gsw_specvolA0 specific volume, TEOS-10 [m"3/kg] gsw_specvolAO0  |m"3/kg 1* sensor
gsw_specvolAl specific volume, TEOS-10, 2 [m"3/kg] gsw_specvolAl  |m”3/kg 2nd sensor
gsw_svolanomAOQ [specific volume anomaly, TEOS-10 [m"3/kg] gsw_svolanomAQ |m"3/kg 1™ sensor
gsw_svolanomA1 [specific volume anomaly, TEOS-10, 2 [m"3/kg] gsw_svolanomAl |m”3/kg 2nd sensor
gsw_tfA0 temperature freezing [ITS-90, deg C] gsw_tfA0 ITS-90, deg C 1* sensor
gsw tfAl temperature freezing, 2 [ITS-90, deg C] gsw tfAl ITS-90, deg C 2nd sensor
gsw_alphaAQ thermal expansion coefficient [1/K] gsw_alphaA0Q 1/K 1™ sensor
gsw_alphaAl thermal expansion coefficient, 2 [1/K] gsw_alphaAl 1/K 2nd sensor
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